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Biopac Student Lab PRO 

 
Welcome! 
Welcome to the Biopac Student Lab PRO. The Biopac Student Lab PRO System includes both hardwa
and software for the acquisition and analysis of life-science data. You can u

re 
se the Biopac Student Lab 

PRO for data acquisition, analysis, storage, and reporting and retrieval. 

The Biopac Student Lab PRO not only makes data collection easier, but also allows you to quickly and 
easily perform analyses that are impossible on a chart recorder. You can edit data, cut and paste sections 
of data, perform mathematical and statistical transformations, and copy data to other applications (such as 
a drawing program or spreadsheet). 

The PRO software uses the familiar point-and-click interface common to most applications. Complex 
tasks such as digital filtering or fast Fourier transformations are now as easy as choosing a menu item or 
clicking your mouse. 

This manual covers use of the Biopac Student Lab PRO and details a variety of common applications. If 
the application you desire is not addressed, visit the BIOPAC web site at http://www.biopac.com/ to 
download one of over 50 Application Notes, or call to request a hard copy. 
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Using this Manual 
The Biopac Student Lab PRO Guide is divided into five parts: 

Part A  
Introduction 

You should look through the Introduction whether you’re new to computer-
based data acquisition systems or an old hand at physiological monitoring. 
This section covers the basic features of the BSL PRO System. 

Part B 
Recording Data 

Tells you how to be up and running with the Biopac Student Lab PRO in just 
a few minutes. Use this section to acquaint yourself with how the system 
works and the most frequently used features. 

Part C 
Acquisition Functions 

Explains data acquisition features and gives a detailed summary of different 
acquisition parameters. Provides an in-depth description of the commands 
used to determine acquisition rate, acquisition duration, and specialized 
functions such as triggering, averaging, and online calculations. 

Part D 
Analysis Functions 

Details information on analysis features; covers the range of post-acquisition 
analysis functions and transformations available with the Biopac Student Lab 
PRO software. Describes how to edit data, take measurements and perform 
basic file management options (save, print, etc). 

Part E  
Appendices 

Answers frequently asked questions, offers hints for working with files, 
includes information on upgrading from previous versions, discusses 
electrode use and digital filtering. 

 
Additional Guides 

In addition to The Biopac Student Lab PRO Guide, you should have the following Guides: 

Installation Guide The Installation Guide was packaged with your BIOPAC software CD. It 
contains complete, step-by-step instructions for connecting the MP unit to 
your computer and details the installation process screen shots. 

BSL Hardware Guide The BSL Hardware Guide is part of the Biopac Student Lab documentation 
– see the User Support folder. It provides instructions for connecting external 
devices to the MP35/30 acquisition unit (electrodes, transducers, stimulators, 
and so forth) and also includes practical examples of how the BSL PRO is 
used with different components for common types of data acquisition and 
sample results and applications for widely used test procedures. 

 
 

IMPORTANT SAFETY NOTE 

BIOPAC Systems, Inc. components are designed for life science education and research 
applications with humans and animals. BIOPAC Systems, Inc. does not condone the use 
of its instruments for clinical medical applications. Instruments, components, and 
accessories provided by BIOPAC Systems, Inc. are not intended for the diagnosis, cure, 
mitigation, treatment, or prevention of disease. 
BIOPAC Systems, Inc. accepts no liability, or consequential liabilities, for the loss, 
effects of loss, or corruption of data caused when using any BIOPAC instruments. 

Visit the online support center at www.biopac.com 
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Where do I find help? 
The Introductory sections are intended to provide you with enough information to get up and running 
with the Biopac Student Lab PRO, and familiarize you with some basic functions. There are far more 
features than described in the first few pages, so here is a guide for how to continue using this manual. 
The Help menu includes options to launch your web browser and go the BIOPAC site for PRO Lessons 
or launch Adobe Acrobat and open the complete Software or Hardware Guide as a searchable PDF 
document (see page 242 for details). 

Biopac Student Lab PRO software 
Information about how to edit, display and transform data can be found in Part D — Analysis 
Functions. It explains how to import and export data, how to save files, and other file management 
commands. This section also explains how to use all of the post-acquisition features of the BSL PRO 
software. 

Connecting input devices 
To find out how specific modules connect to the MP35/30 acquisition unit, refer to the BSL 
Hardware Guide that was included with your Biopac Student Laboratory Manual. This section 
describes how to connect electrodes, transducers and input/output devices to the MP35/30. 

Acquiring data 
For more specific information on different types of acquisitions, see Part C — Acquisition Functions. 
It covers basic acquisition parameters in detail, and describes some acquisition features (such as peak 
detection techniques and online calculation channels) not covered in the Getting Started section. 

Working with large files 
Acquisitions with fast sampling rates or long duration can generate large data files (several 
megabytes) that can be difficult to load, store, and view. The Biopac Student Lab PRO can handle 
such acquisitions — see Appendix B for information on how to optimize setup for these types of 
acquisitions. 

Troubleshooting 
Includes a list of the most frequently asked questions regarding the Biopac Student Lab PRO. Check 
this section (in Appendix A) for commonly encountered problems and solutions. For software 
problems or hardware conflicts, also check the troubleshooting section of the Biopac Installation 
Guide. 

Contact BIOPAC Systems, Inc. 
To speak directly with a representative, check the How to Contact BIOPAC Systems, Inc. directory 
of worldwide representatives (included at the back of this manual, in a separate section after the 
Index). You can visit the BIOPAC web site at www.biopac.com for product information and 
application guidelines, or send an email to info@biopac.com. 

http://www.biopac.com/
mailto:info@biopac.com
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Biopac Student Lab PRO Features 
Biopac Student Lab PRO 3.7 includes many of the features you have been asking for! Click any of the 
links below for more detailed information...  

   New Features in 3.7 

• Output Control Panels—Stimulator, Pulses, Digital, Voltage, Analog CH 
• Segment Overlap for Append 
• More Powerful Markers—Distinguish Appended Segments from Events, Pre-Label markers, etc. 
• Rewind—Delete last recorded segment 
• Help menu—quick access to PDF support files and the BIOPAC web site 
• USB1.0 and USB2.0 Options 
• Horizontal Scale: Hold Relative Position  
• Horizontal Axis Format  
• Standard Curve for Colorimetery 
• Manual Documentation Updates 
• MP35 Software Adjustments 
• MP35 required Digital Channels: 8 Input and 8 Output 
• Windows OS Only Japanese Language Support 
• Windows OS Only Works on XP Home/Pro/Media Operating Systems 

   Additional Features in 3.7.1 

• Security Options utilize “Limited”or “Restricted” user account setup 

• Preset Enhancements: Organization tools, new Newtons force, new EEG & Gamma 

• Marker Manager allows access to all markers in the record (vs. previous limited view of 127) 

• Data Selection Enhancement simplifies switching cursor styles and retaining selection 

• Display Enhancements—right-click option to "Paste measurements to Journal” from graph 

• Plot options—display a “thicker” line for any channel’s data plot. 

• MP35 only Triggering via I/O: Synch acquisition to SuperLab interface or Stroboscope— 

• Mac only Capture to QuickTime and Playback 

• New for Mac Install both BSL Lessons and BSL PRO with a single, simpe installer 

 
See the Features Overview on page 15 or see the corresponding section of the manual for each item. 

Visit the online support center at www.biopac.com 
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Features Overview 
In conjunction with your computer, the Biopac Student Lab PRO is a complete system for acquiring 
almost any form of continuous data, whether digital or analog. The Biopac Student Lab PRO can perform 
a range of recording tasks, from high-speed acquisitions (up to 100,000 samples/sec) to long duration 
acquisitions. Generally speaking, for physiological applications, the Biopac Student Lab PRO is limited 
only by the speed of your computer and its available memory or disk space. Features of the Biopac 
Student Lab PRO include: 

BSL PRO 3.7 
Feature Description 

NEW 
Output Control 
Panels 

Different control panels are used for different output devices: 
1. CH3 or Selected CH#  
2. Digital Outputs (if MP35 is connected) 
3. Pulses 
4. Voltage 
5. Stimulator – BSLSTM 
6. Stimulator – SS58L cable from MP35 

The new Output Control panels attach to the graph window for consistency and 
their compact design leaves more display space for graphs. Access the Preference 
dialog for each output by right-clicking on the dialog. Save settings, much like a 
preset but within the graph or template; access is via a pull-down menu in the 
control panel. 

NEW 
Segment 
Overlap 

A new "Overlapping Segment" toolbar button is available in the Append acquisition mode 
to overlap appended sections of data in viewed in Scope or Chart mode. It acts like the 
scope mode applied to horizontal sections of data and can be very handy for data 
comparisons. Choose the active segment to take measurements and display markers; the 
active segment will be highlighted in the graph display and you can use a pull-down menu 
showing segment labels to change it. 

NEW  
Marker Controls 

The application includes three types of markers instead of just one: 
1.  Append Markers appear as triangles located above the marker label region 

and will be automatically inserted at the start of each recording segment in the 
Append acquisition mode. Append markers are blue when active. 

2.  Automatic Event Markers appear as green inverted triangles located below 
the marker label region (just as in BSL 3.6.7) and use labels that are generat
automatically when the assigned function key is pressed. Event markers are yellow 
when active. 

ed 

� You can pre-establish Automatic Event marker labels as sequential or 
fixed. 

3.  Manual Event Markers appear as inverted triangles with a line above them and 
are located below the marker label region (in the same region as the Automatic 
Event Markers). Event markers are yellow when active. 

Marker tools have been improved, too. Check out these new Marker features... 

1. Marker menu additions 

2. Pre-establish Labels 

3. Automatic Time Stamp 

4. New Journal Summary Preference 
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BSL PRO 3.7 
Feature Description 

 
NEW  
Digital Channels 
MP35 required 

Use the new digital channels to work with visual presentation programs like SuperLab and 
E-Prime. 
8 Digital Input Channels — Use the Setup Channels dialog from the MP35 menu to 
establish up to eight digital input channels (use the arrows to scroll channel # up or down). 
8 Digital Output Channels — Use the "I/O Port" on the back of the MP35 to establish up 
to eight Digital Output channels, and use the Output Control and Preferences to establish 
parameters. 

  
NEW  
Rewind A  “  

data (ju g dialog 
will app pend 

Rewind” toolbar button allows you to erase the last recorded segment of appended
st like in the BSL Lessons software). When this button is pressed, a warnin
ear and if you proceed, the last segment will be deleted along with the Ap

Marker for that segment. 

NEW  
Help menu 

Now you get our exclusive real-time System Manual, Hardware Guide, Sample Files, etc., 
with easy-to-use navigational tools. Search the manual (pdf files) while you are running 

ng digital 

uide” 

in 

BSL PRO for on-the-spot, targeted help. New Help menu contains the followi
support items: 

1. PRO Lessons from Web... Opens the default browser, goes to our website and 
shows all available PRO lessons. 

2. Open MP30 Hardware Guide... Looks for the “PDF” file; “MP30 Hardware G
located in Application Folder\Documents and if present, opens it in Acrobat 
Reader. 

3. Open BSL PRO Manual... Looks for the “PDF” file; “BSL PRO Manual” located 
Application Folder\Documents and if present, opens it in Acrobat Reader. 

4. About Biopac Student Lab provides version details for Tech Support. 

NEW  
LANGUAGES 
Windows/PC only 

Spanish, with more translations on the way! 
BSL PRO menu items and dialogs have been translated into Japanese. Also available in 
English, French and 

Visit the online support center at www.biopac.com 
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BSL PRO 3.7 
Feature Description 

NEW USB he USB1W connector works with USB1.0 and USBT 2.0 driver files. 

NEW  
Horizontal Scale 
— Hold Relative 

Zoom in on a section of data and have the next acqui
Once, Append etc.) hold the relative position of the horizo
convenient for many experiments such as Compound 
performing multiple acquisitions where the signal remains

 
 same.

sition (in any acquisition mode; Save 
ntal scale. This is extremely 

Action Potential when one is 
 in the same location for each 

acquisition. This is very convenient when trying to do short duration, high speed 
acquisitions, where the signal of interest is in the same position when one performs 
acquisition (like when the stimulator, where you would like to be able to zoom in on the
signal of interest and have the relative position (from the start of acquisition) stay the

NEW  
Horizontal Axis 

T

 

 

his option in the Display menu generates a “Set 
Horizontal Axis format” dialog with two time format 
options. 

NEW  
Standard Curve 

The BSL PRO can be used with common Colorimeters used in most Physiology labs to 
generate a Standard Curve (“best fit” line) plot of Absorbance vs. Concentration. The 
Standard Curve can then be used to find the concentrations of unknown solutions. 

 A new tool bar button is available when the graph is in the X/Y mode that generates a 
“Plot Standard Curve” dialog. Step through a simple calibration procedure to produce 
accurate Absorbance vs. Concentration plots for a specific solution type. 

 

NEW 
Documentation 

3. 

5. 

t).

1. Updated algorithm information and formulas. 
2. New BSLSTM and BSLSTMA Specifications in the Hardware Guide. 

New USB Troubleshooting Guide. 
4. New information about A/D resolution. 

Updated GSR information in the Hardware Guide. 
6. Updated descriptions for Cut, Copy and Paste. 
7. Description of advanced analysis using the ECG arrhythmia data (from PhysioNe

NEW  
MP35 
Adjustments 

d, 

ve 

The BSL PRO will detect whether an MP30 or MP35 is connected. If an MP35 is detecte
the application will automatically make the following changes to optimize performance 

1. The Setup Channels dialog will include a region for “DIGITAL INPUT CHANNELS”. 
2. The High Speed mode will be eliminated. Communications at sample rates abo

2,000 s/s will be the same as at 2K and below. 
3. The “Setup Triggering” dialog will have an additional item in the “Source” menu 

called “External” allowing it to work with the “External trigger” BNC on the back of 



18 Biopac Student Lab PRO 

BSL PRO 3.7 
Feature Description 

the MP35.  
4. The system will be optimized for MP35 performance (i.e., USB communication, 

“Gain” and “Input Ranges” settings may be changed). 
 

NEW  
Security 

In B  3
XP) “R
the Wind
individua

SL .7.1, the system (or network) administrator can set user accounts to “Limited” (Windows 
 or estricted” (Windows 2000)  access to achieve a good level of security when running under 

ows 2000 or XP Operating Systems. A Limited or Restricted user account can handle 
ls or groups of students and allows the option of password protection (recommended).  

• See the “Biopac Student Lab User Account & File Location Guide” provided on the 
installation CD for more information.  

NEW  
Preset 

cements 

•  a 
og Input Channels 

 the Calculation Channels presets list.  
 the preset 

 

g Channel Preset available for the SS25LA Hand Dynamometer that 
 which is 

ly used.  
Preset available: 

with the 
ma 

Enhan

The Preset pull-down listing is now organized into two groups,  Human and Animal, with
separator (horizontal line) between them. This applies to both the Anal
and

• Preset separators (horizontal lines) can be added by the user when customizing
listing. The separator could be manually placed in the: MP35 > Organize Channel Presets
dialog.  

• There is a new Analo
is scaled to units of Newtons: “Clench Force (N).”  This is a proper unit of force
“more scientific” than the units of Mass (Kilogram and Pounds) that are common

• There is a new, higher bandwidth, EEG Analog Channel 
“Electroencephalogram (EEG), .5 - 100 Hz w/notch”.  When used in conjunction 
new “EEG gamma (30 - 90 Hz)” Calculation Channel Preset, it allows for the gam
frequency band to be recorded. The gamma frequency band seems to be correlated to 
information processing and cognitive functions of the brain.  

NEW  
I/O Triggering 

 

MP35 only 
The user may now specify triggering (start the acquisition) when a change of logic level 
occurs on any of the 8 digital Input lines (“I/O Port”, DB25 on rear of unit). This can be useful
for synchronizing the start of acquisition to un-isolated external devices, such as SuperLab 
interface, or a Stroboscope.  

NEW  
Marker Manager 

BSL 3.7.1 adds a “Marker Manager” option that allows access to all markers in the file. 
Previous versions limited the number of markers (to 127) that could be accessed in the 
Marker menu > Show Event Marker or Append Marker listings.   

NEW  
Data Selection 
Enhancement 

Following a single data point selection using the A
selected, manually or using the "Ctrl + I" buttons; 

rrow cursor, if the "I-Beam" cursor is 
the cursor will be placed at the last data 

point selected.  It is useful for users who have found data using the arrow cursor to preserve 
this position when they switch to the other cursor style.  

NEW  
Display 
Enhancements 

When in the Chart or Scope display modes, there is a new option in the right mouse pull-
down menu (when cursor is in the wave plotting region) to "Paste measurements to Journal 
".  This is a common option for some users and accessing it from the right click menu is 
much faster then accessing it through the Edit menu.  

NEW  
Plot Option 

The user now has the option to display a “thicker” line for any channel’s data plot. The 
Display > Show > Dot Size is available when the mode is "Line Plot".  A thicker line can 
work better for display on projectors or when printing data.  The line thickness for each 
channel will saved with the data file. 

NEW Mac only Open saved files

Playback mode  
 and replay as if acquiring data. 

NEW Mac only 
Capture to 
QuickTim 

Create a QuickTime movie for demonstrations, training, or presentations. 

NEW Mac only 
 

  

New Expression Functions for enhanced analysis options.
 

Expressions

 
! 

 

Visit the online support center at www.biopac.com 
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Biopac Student Lab PRO Benefits 
Easy to use 

 other applications 
 

Flexible setup 

which 

asuring alpha waves or collecting zoological 

rates re 

Flexible menu ily customize menu displays to show only the functions you are 

Online calculations c Student Lab PRO software provides an extensive array of 
s 

raw 

monitoring of data filtered 

urements 
data point(s). These options are 

Grid options 

Presets 

Graph templates 
riment. A sample 

a chart recorder 

The Biopac Student Lab PRO offers the same convenient and easy-to-use 
features that Windows® users are accustomed to. Since the Biopac Student Lab 
PRO software runs under these environments, you can run
while you are collecting data. In terms of hardware setup the Biopac Student
Lab PRO uses simple plug-in connectors and standard interface cables. You 
don’t need a degree in electronics to set up your system. 

The Biopac Student Lab PRO can be configured for a wide variety of 
applications, from single channel applications to multiple-device (up to 4 
analog) measurements. You control the length of acquisition, the rate at 
data is collected, how data is stored, and more...all with a few clicks of the 
mouse button. Whether you’re me
data, the Biopac Student Lab PRO can meet your needs. 

The BSL PRO can acquire data from 1 to 100,000 samples/sec. This allows 
recording of almost all physiological parameters from slow moving temperatu
data to fast response action potential data. This means you can use the BSL 
PRO System to replace both your chart recorder and oscilloscope.  

You can eas

Flexible acquisition 

display using, thereby reducing the risk of error or confusion in the lab. This is 
particularly powerful for laboratories working to GLP guidelines and is also 
useful for teaching applications. 

Although the Biopa
measurements and transformations you can apply to collected data, sometime
you need to perform computations while data is being collected. The Online 
Calculation functions allow you to calculate new channels based on incoming 
signals. This feature allows you to compute BPM, for instance, based on 
ECG data. 

Many times, it is preferable to filter data as it is being collected, rather than 
having to wait until after the fact, so now you can apply filters to incoming data 
and view the results in real time. That means online 

Online filtering 

to suit your needs. 

The Biopac Student Lab PRO software can instantly compute over a twenty 
measurements and computations for any given 

Online meas

available from pull-down menus and include: mean; peak-to-peak value; 
standard deviation; frequency; and BPM. 

You can apply several different grid styles to your data to help with analysis. 
UNLOCKED grids help you view the data display on the monitor whereas 
LOCKED grids help more with printing. You can set the Grid Options to create 
printouts that look similar to chart recorder output. 

There are over 50 factory-established “Presets” that allow you to easily 
configure hardware parameters. These presets can be modified, and/or new 
presets can be created and saved for later use.  

This powerful feature allows instructors to predefine experiments. Students 
simply open the template file and click “Start” to run the expe
graph template file (HeartTemplate.gtl) is included with the PRO installation. 

Whether you want to replace a chart recorder or simply supplement an existing 
setup, the BSL PRO is fully compatible with most major recording devices. 
What’s more, the BSL PRO is compatible with most popular input devices, so 

Replace (or augment) 

you can continue using the same transducers, electrodes and sensors. 
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Biopac Student Lab PRO Benefits 
Preview your data 

 

 

 
ou 
 on 

Digital filtering 
transformations 

or 

X/Y plotting 
e 

Histogram function y of 
suit 

ons 

s 
 one wave from another). 

Annotation  

  

Event markers  t is 
r, so 

r function allows you to 
er. 

File compatibility 
ou can output data in either text or graphical form, and 

a 
 

Similar to chart recorders, the Biopac Student Lab PRO allows you to change 
both the vertical scale and the horizontal scale. You can change the amplitude 
scale or the time scale to any value you wish, or you can have the Biopac 
Student Lab PRO software automatically scale them for you. 

Simplified editing It used to be that once your data was collected, the only way to edit it was with 
scissors and adhesive tape. Now you can delete unimportant sections of your 
data with a keystroke. You can “paste” together sections from different waves,
or edit out noise spikes from individual waves. 

Append mode For some applications, data only needs to be recorded during some portions of a 
long experiment. The Biopac Student Lab PRO software has added an Append 
mode that lets you pause the acquisition for as long as you wish, and resume the
acquisition as many times as needed. When data are acquired in this mode, y
can start and stop a recording as you would with a chart recorder. This saves
storage space and processing time for transformations. 

All data contains measurement error and noise. Now you can reduce or 
eliminate that error by using the digital filters and smoothing 
included in the Biopac Student Lab PRO software. You can smooth data 
filter out noise from any frequency or bandwidth you wish. 

You can view and acquire data in the form of an X/Y plot, with one channel on 
the horizontal axis and another on the vertical axis. This allows you to explor
relationships between different channels and opens up a whole range of 
applications, from chaos plots to respiration analysis to vectorcardiograms. 

You can easily examine the variability and the measures of central tendenc
any waveform data with the histogram function. Set the plotting options to 
or let the software determine the “best fit” for graphing data. 

Math functi In many cases, simply collecting raw data is not enough. The BSL PRO 
software has an array of built-in mathematical functions ranging from simple 
absolute value functions to computation of integrals, derivatives, and operation
involving multiple waveforms (such as subtracting
You can even chain multiple functions together to form complex equations. 

The Biopac Student Lab PRO software has a journal you can use to append 
comments concerning the input data, either online or after the fact. This is 
especially useful for noting the characteristics of an acquisition (what was 
involved, what manipulations took place, and the like) for future reference.

Triggering If you need to measure response times or start data collection only after some 
event has occurred, the Biopac Student Lab PRO software allows you to trigger 
an acquisition in a number of different ways. You can trigger on the level of a 
signal, or with an external synchronizing trigger. 

Many times, especially during a long acquisition or in a laboratory setting, i
useful to make a note of when specific events (such as manipulation) occu
that any changes in the data can be noted. The marke
insert symbols in the record and add up to 80 characters of text for each mark
Markers can be added either while data is being collected or after the fact. 

With the Biopac Student Lab PRO software, you can save data in a number of 
different formats. Y
export or use the clipboard to place data in other programs. Use BSL PRO dat
in word processing programs like Microsoft Word®, spreadsheet programs like
Microsoft Excel®, drawing programs like Aldus IntelliDraw®, or desktop 

Visit the online support center at www.biopac.com 
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Biopac Student Lab PRO Benefits 
publishing programs like Aldus PageMaker®. Biopac Student Lab PRO 

Pattern recognition 
s. 

ing abnormal waveforms (such as irregular ECG waves) 

Peak detection 

nd 

Printing options tions, and 
also print several graphs 

per page, even if you only have one-channel recordings. No special printer 
drivers are required. 

Sample data files The Biopac Student Lab PRO installation disk includes sample data files from: 
a 4-channel recording, Blood Pressure, EEG, EMG with Force, Finger Twitch. 

User support Whether you have a question about compatibility with existing equipment or 
need to develop a specialized measurement device, BIOPAC’s Applications 
Department can address the problem. Plus, you can visit the BIOPAC website at 
www.biopac

software will even read-in raw data from a text file. 

Using an advanced pattern search/recognition algorithm, the Biopac Student 
Lab PRO software can automatically find a specific pattern within waveform
This is useful for find
within a data file. 

The Biopac Student Lab PRO software has a built in algorithm to find either 
positive or negative peaks from any size data file. You can even search for all 
the peaks with one command and automatically log statistics like peak time a
area to the journal. 

The Biopac Student Lab PRO software provides a range of printing op
allows you to fit data on one page or many. You can 

.com for answers to frequently asked questions, product 
information, and a wide array of Application Notes. 
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Application Notes 
If you need information about an application not covered in this manual, visit the Support section of the 
BIOPAC web site at http://www.biopac.com to review more than 50 available Application Notes. The 
notes are static pages that provide detailed technical information about either a product or application. 
View or print the Application Note you need, or call to request a hard copy. The following table provides 
a partial list of application notes. 
APP NOTE Application www.biopac.com > Support 
Sofware 

 
Hardware 

 
Updates 

 

Visit the online support center at www.biopac.com 

http://www.biopac.com/
http://www.biopac.com/
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PRO Lessons 

 
PRO Lessons illustrate the scope of the Biopac Student Lab System. Each lesson describes the required 
hardware and software setup (channel setup, acquisition setup, gain, scaling, etc.) and outlines the basic 
procedure necessary to record and analyze a variety of applications on human and animal subjects. 
When applicable, a downloadable template file (*.gtl) is included with the lesson to further simplify 
setup. The template file includes all the appropriate settings for the lesson — just open the file, connect 
the hardware and begin recording! 
� If you have developed lessons for your course, we invite you to make your lessons available to other 

users. You will receive full credit for the lesson. Just provide us with a copy of your lesson plan and a 
sample data file. We will add your lessons to the list and other users can benefit from your efforts. 
Please don't worry about formatting issues — the important part is the lesson plan and instructions. 
We'll take care of the formatting for you.A partial list of available lessons follows. 

Visit our website or quick-click to the Lessons menu using “Help menu>PRO Lessons from web” for the 
most up-to-date listing and downloadable files. An overview of available BSL PRO Lessons follows. 
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Visit the online support center at www.biopac.com 
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Visit the online support center at www.biopac.com 
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Human Anatomy & Physiology Society Position Statement on Animal Use 

Adopted July 28, 1995 

It is the position of the Human Anatomy and Physiology Society that dissection and the manipulation of 
animal tissues and organs are essential elements in scientific investigation and introduce students to the 
excitement and challenge of their future careers. 

The Human Anatomy and Physiology Society (HAPS) is a national organization of science educators 
dedicated to the task of providing instruction of the highest quality in human anatomy and physiology. 
A fundamental tenet of science is the ordered process of inquiry requiring careful and thoughtful 
observation by the investigator. As subdivisions of biology, both anatomy and physiology share a long 
history of careful and detailed examination, exploration and critical inquiry into the structure and function 
of the animal body. Consistent with the origins and nature of scientific inquiry, HAPS endorses the use of 
animals as essential to the laboratory experiences in both human anatomy and human physiology. 

Historically, the principal tool of investigation in anatomy has been dissection. A properly directed 
dissecti  insights on experience goes beyond naming structures and leads the student to conclusions and
about the nature and relatedness of living organisms that are not otherwise possible. To succeed in their 
future careers, students must become thoroughly familiar with anatomical structures, their design features 
and the hat ir relationships to one another. Dissection is based on observational and kinesthetic learning t
instills a recognition and appreciation for the three-dimensional structure of the animal body, the 
interconnections between organs and organ systems, and the uniqueness of biological material. While 
anatomical models, interactive computer programs, and multimedia materials may enhance the dissection 
experience, they should not be considered as equivalent alternatives or substitutes for whole animal 
dissection. 

HAPS s ovided their use is in strict upports the use of biological specimens for anatomical study pr
compliance with federal legislation and the guidelines of the National Institutes of Health and the United 
States Department of Agriculture and that such use fulfills clearly defined educational objectives. 

Physiology experiments involving live animals provide an excellent opportunity to learn the basic 
elements specific to scientific investigation and experi entation. It is here that students pose questions, m
propose hypotheses, develop technical skills, collect data, and analyze results. It is here that they learn 
to remain focused on the details of procedure and technique that may influence the outcome of the 
experiment and the responses of the animal. When faced with unexpected and even erroneous results, 
students develop and improve their critical thinking and problem solving skills. 

Com tions and video programs are useful tools that help students acquire aputer simula  basic 
understanding of physiologic principles. However, due to the inherent variability and unpredictable nature 
of biological responses, such programs fail to fully depict the uniqueness of living organisms 
and should not be viewed as equivalent alternatives or substitutes for live animal experiments. HAPS 
supports the use of biological specimens in physiology experiments provided their use is in strict 
compliance with federal legislation and the guidelines of the National Institutes of Health and the 
United States Department of Agriculture and that such use fulfills clearly defined educational objectives. 

Scie have a nce educators have in common a respect and reverence for the natural world and therefore 
resp nce of a serious onsibility to share this with their students. They must communicate the importa
approach to the study of anatomy and physiology. HAPS contends that science educators should retain 
responsibility for making decisions regarding the educational uses of animals. Furthermore, it opposes 
any legislation that would erode the educator's role in decision making or restrict dissection and animal 
experimentation in biology. 

Used with permission of: The Human Anatomy and Physiology Society (HAPS) 
222 South Meramec, Suite 203, St. Louis, MO 63105 
1-800-448-HAPS 
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Part A — Introduction 
Part A - Introduction covers the basics of data acquisition and analysis with the BSL PRO System. Al

ection is covered in more detail in subsequent sections (see Using this Manual on 
l of 

the material in this s
page 12 for a guide to sections). 

 
 

 
 Overview of the BSL PRO System 

ms two basic functions: acquisition and analysis. The 
acquisition settings determine the basic nature of the data to be collected, such as the amount of time data 
will be collected for and at what rate data will be collected. All of the acquisition parameters can be found 
under the MP35/30 menu. The other menu commands pertain to analysis functions such as viewing, 
editing, and transforming data. 
The BSL PRO System is a computer-based data acquisition system that performs many of the same 
functions as a chart recorder or other data viewing device, but is superior to such devices in that it 
transcends the physical limits commonly encountered (such as paper width or speed). Data collection 
generally involves taking incoming analog signals and sending them to the computer, where they are 
 (a)  displayed on the screen, and 
 (b)  stored in the computer’s memory (or on the hard disk). 
These signals can then be stored for future examination, much as a word processor stores a document or a 
statistics program saves a data file. Graphical and numerical representations of the data can also be 
produced for use with other programs. 

l filtering and rate detection) 

s incoming signals and 
converts them into digital signals that can be processed with your computer. The MP35/30 connects to 
your computer via the USB adapter (USB1W). 

Chapter 1
The Biopac Student Lab PRO System perfor

The Biopac Student Lab PRO consists of several major components, including hardware and software. 
The BSL PRO software allows you to edit data and control the way it appears on screen, and performs 
four general functions: 

1. Controls the data acquisition process 
2. Performs real-time calculations (such as digita
3. Performs post-acquisition transformations (such as FFT’s and math functions) 
4. Handles file management commands (saving, printing, etc.) 

The heart of the BSL System is the MP35/30 data acquisition unit. This unit take
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Launching the Biopac Student Lab PRO sof
The first step is to launch the software. 

tware 

Dou ebl -click the application icon  on the
do s® OS users can also choose Start menu > P

 desktop (Windows) or the Applications (Mac) folder. 
Win w rograms and then select: 

 
 

p
g

Q
w

 
H
A

L
B
Y
P

T
re
re

th
If
th
a
b

ab (lessons) are both installed using default installation. 
ne copy of BSL PRO at a time and you cannot run BSL 

RO if BSL Lessons are running. Each application must be run individually—it is not 
ossible to run BSL PRO and BSL Lessons at the same time. An error prompt will be 
enerated to describe any application launch conflict: 

Another copy of BSL is still running. You must quit BSL before you can use BSL PRO. 
or 

Another copy of BSL PRO is still running. You must quit BSL PRO before you can use BSL. 
uit the running application to enable launching the other. To quit an application, make it the active 
indow and use File > Quit to exit the program. 
TIP You can activate some BSL PRO analysis options within the BSL Lessons “Review Saved Data” 

mode to increase analysis functionality. To activate the BSL PRO analysis options, see “Menu 
Customization Options” in the BSL Orientation Guide. 

ardware prompts 
fter you launch the program, you may receive a warning prompt regarding the hardware, as shown here: 

aunch errors 
SL PRO and Biopac Student L
ou cannot run more than o

 
o use the Biopac Student Lab PRO software without the MP35/30 hardware, click “OK.” When you’re 
ady to acquire data at any subsequent time, connect and/or switch on the MP35/30 hardware and then 
start the software. If the MP35/30 is properly connected, you will not get a warning and the light next to 

e  button in the display window will change from grayed-out to green. 
 the MP35/30 unit is connected and you receive the Hardware warning when you launch the software, 
ere are two possibilities: 

) You have not properly connected everything and/or you have not powered up the MP35/30. 
) You may have a device or software (init) conflict, which may prevent you from using the BSL PRO 

software. If you have any problems communicating with your computer, there is probably a setting in 
your computer conflicting with the setting used by the BIOPAC program. See your System 
Administrator and then, if necessary, contact BIOPAC for Technical Support. 
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Windows USB 

Visit the online support center at www.biopac.com 

Driver installation applies to the specific USB port the MP3X is connected to during installation. 

ver separately to each 

 Win XP+MP35 If the signed MP35 driver is installed to one particular USB port and the MP35 unit is later 
plugged into a different USB port on the same computer, the following prompts will occur 
automatically in rapid succession. It is not necessary to install the dri
port. 

   
 Win 2000+MP3X If you switch the MP3X to another USB port, you must repeat driver installation for that port. 

BIOPAC recommends that you install drivers to all potential USB ports at the same time 
(repeat the procedure for each port). 

Mac OS X 10.3 – 10.4 User Account Settings 

Under Mac OS X, different user 
accounts can have different choices of 
MP hardware. If the installer  detects a 
previous Mac 3.7.1 installation, the 
following prompt will  be generated:  

 “Use for New Users Only” will apply the 
MP hardware choice and line frequency 
setting to new user accounts added 
to the operating system; existing 
preferences will be unaffected. 

“Apply for All Users”" will apply the MP hardware choice and line frequency setting to all 
existing user accounts and new user accounts added to the operating system 

 
Graph Window and Start 
After personalizing your copy — and assuming you have already connected the MP35/30 to your 
computer — you will see the following: 

   
This will flash briefly each time Biopac Student Lab is launched. This screen lists the Biop

RO
ac Student Lab 

 release number, which is useful if you ever need to call BIOPAC for technical support. The same 
About Biopac Student Lab” option of the Help menu. 

ly connected and there are no conflicts, an empty Biopac Student Lab PRO 
graph window will be generated (like the one above). 
A “window” is the term used ta is displayed and/or 

anipulated. Data can be displayed during acquisition. The graph window on the screen is designed to 
provide you with a powerful yet easy-to-use interface for working with data.  

P
information is accessible via the “
Assuming everything is proper

 for the area on your computer’s screen where da
m



Introduction 31 

At this point, you can use the new window, open a 

. It’s a good idea to create a new 

choose File>Open and then choose a file 
from the list in the dialog box. If you 
choose to open an existing file, you may 

To open rnal windo

template, or open an existing data file. 
• To create a new graph window, choose 

File>New
graph window for each acquisition. 

• To open an existing data file or a template, 

want to close the new, blank window. 

 a Jou w, click the journal  
hoose icon on the toolbar (or c

Display >Journal
 

>Show ). 
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iles 
For purposes of illustration, you are encouraged to open a sample data file and follow along with the 
Sample F

manual text. Default installation provides five sample data files at C:\Program Files\BIOPAC\BSL 
3.7\BSL PRO 3.7\Samples (see page 243 for a static graph of each sample file). 

 
 
Open the 4Channel.ACQ sample file from the Samples folder. 

 
“4Channel.acq” Sample File Display 

The h 
waveform display. To the left of each waveform is a vertical strip containing a channel label text string 
that can be used to identify each waveform: ECG, PPG, Respiration, etc. 
The horizontal scale along the bottom denotes when the data was recorded relative to the beginning of the 
acquisition. Only eight seconds of the total data record are visible in the display window, although the file 
contains the complete record. The data displayed on the left edge of the window represent events that 
occurred about 12 seconds into the record, and the data displayed at the right edge of the screen represent 
events that occurred about 20 seconds after the acquisition was started. The display scale can be adjusted 
to virtually any value range. 
The vertical scale along the right edge contains the amplitude unit range for each channel. 

4Channel.acq sample file contains four different types of data, with a border between eac
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The Data Viewing Screen 

 
Parts o iopac Student Lab PRO screen  

 
f the B
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Software Controls 
Use the left mouse button when a mouse function is referenced, except as noted for special shortcuts. See 

ht-click shortcuts. 
Menu Structure 
The pull-down menu structure runs across the top of the display window. 

page 37 for information about rig

 
 

Menu Type of Commands 

File General file management commands, including opening, saving, and closing 
files. “Save as” to export data files. Set program preferences. 

Edit Select, cut, copy, and paste between and within files. 

Transform Mathematical transformations and functions, from simple arithmetic to digital 
filtering and spectral analysis. 

Display Control how data appears on the screen either during or after an acquisition. 

Window Standard Windows functions. Refer to the Windows System Guide for 
detailed information. 

MP35/MP30 Acquisition parameters, including channel, acquistion, and trigger setup. 
Output Control, including stimulator. 

Playback Mac only—when Capture to QuickTime is active, the MP menu changes to a 
Playback menu and the Start button changes to  Replay. 

Help Access to BSL PRO lesson (requires browser), hardware and software 
documentation as real-time, searchable documents (requires Acrobat Reader), 
and information about the MP35, BSL software, and firmware. 

 

Visit the online support center at www.biopac.com 



Introduction 35 

Toolbar 

 
The toolbar contains button shortcuts for many of the most frequently used features. Click an icon to 
activate it. The toolbar is displayed beneath the menu bar. To show or hide the toolbar, click Display 
menu > Show >Tool Bar or right-click at the top of the display screen in the menu bar region. 

Icon Function 
Change display to Scope mode. 

 
Cha gen  display to Chart mode (default). 

 
Change display to X/Y mode. 

 
Change display to Overlap Segments mode—overlaps appended segments of data. 

 
Autoscale, Vertical (active waveform only along the vertical axis). 

 
Optimize Ra 35. nge—adjusts vertical scale of active channel to display full range of data; see pages  42 and 2

 
Autoscale, H aorizontal (all waveforms along the horizontal xis). 

 
Center waveforms vertically in the active window (X/Y mode only). 

 

 

Center waveforms horizontally in the active window (X/Y mode only). 

Find the peak of a selected area. 
 

 
Find the next peak (after peak has been defined). 

 
Open a recently-used file. Select from a list of BSL PRO files in the current folder, or browse to open. 

 
Show/Hide gridlines in the graph window. 

 
Show/Hide measurement pop-up windows.  

 
Show/Hide channel selection boxes. 

   
¾ Channel selection boxes are displayed above the graph window; see page 55. 
¾ To select a channel, click the corresponding channel number box. 
¾ To hide a channel, Ctrl-click the channel box. A slash mark indicates the channel is hidden. 

Show/Hide Marker region and Marker tools; see page 164. 
 

 
Show/Hid
¾ Macin

 Jo ournal window. Journal tools are: 

e Journal window 
tosh: Journal must be opened via the File menu. Once open, this icon toggles the display. 
urnal toolbar is displayed in the J

 
¾ The

 Journal time, date, and auto-time paste functions. 

 Journal file functions: new, open, save, and print. 

 
Plot Standard Curve (X/Y mode only); see page 80. 

 
Rewind (only active in Append acquisition mode). Delete the last recorded segment; see page 54. 
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ard shortcuts 

MENU 
File menu 

Keybo
  
BSL PRO 3.7 is Section 508 Compliant; contact BIOPAC for a detailed Compliance Statement. 
 

ITEM WINDOWS SHORTCUT MAC SHORTCUT 
 

Ctrl-N New N 
Open Ctrl-O O 
Close Ctrl-W W 
Save Ctrl-S S 

Ctrl-P Print P 
Quit Ctrl-Q Q 

Edit menu  
Undo Ctrl-Z (only shows when applicable) Z 
Cut Ctrl-X X 

Ctrl-C Copy C 
Paste Ctrl-V V 

r Clea Delete n/a 
Duplicate waveform no shortcut D 
Select all no shortcut A 
Journal>Paste Measurement Ctrl-M M 
Journal>Paste Wave Data Ctrl-D n/a 

Transform menu  
Find Peak Ctrl-F F 
Find Next Peak Ctrl-E E 
Find All Peaks Ctrl-R R 
Find Ra Ctrl-A n/a 

Display menu 
te 

 
Zoom Back Ctrl-minus (works up to 5 times) - 
Zoom Forward Ctrl-plus (works up to 5 times) + 

rrow Ctrl-B Cursor Style: A B 
Cursor Style: I-beam Ctrl-I I 

oom Cursor Style: Z Ctrl-G G 
0 menu MP35/3  

AutoPlotting Ctrl-T (toggles) T 
unctions Miscellaneous F  

Insert Marker 
Start/Stop acqu

F9 Esc 
isition Alt-spacebar (toggles) Control-Spacebar 

Stop plot 
Zoom out en Zoom selected) n/a 

Esc n/a 
Alt-click (wh
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Right-click Shortcuts 
Click the right mouse button in cuts: 

 win
 the designated window to generate the following short

If the Graph dow is active: 

   
If the Journal window is active: 

 
In the menu bar region, to show/hide the Toolbars: 

 
By clicking on the horizontal scale, to change the “Update screen interval” setting: 
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 Cursor Styles

 
When working with data, you will often want to select only a portion of a waveform to edit or analyze. 
Once you have selected an area, you can perform a variety of operations—such as editing, measuring, 
transforming or saving data. The tool icons control the cursor style, which varies based on the editing or 
analysis function selected. The data selection tools are in the lower right corner of the display window. 
Click the desired icon to activate the corresponding cursor style. You can also set the cursor style under 
the Display menu. 

 
Arrow 

The Arrow icon activates a general-purpose cursor tool. It can be used to select a 
waveform or channel, pull-down menus to select options for editing, measurement, etc., 
scroll through data, and resize chart boundaries between waveforms. 
All other cursors default to this style when moved outside of the graph window. 

 
Selection 
(I-beam) 

This is a standard I-beam area selection tool. The cursor changes to an I-beam when 
placed in the graph window. It is used to select an area of a waveform (or multiple 
waveforms) to be edited or transformed. This cursor is always selecting at least one 
sample point. Se

T

e page 56 for details on using the I-beam to select an area.  

he I-beam cursor becomes a crosshair  cursor in X/Y mode. 

 
Zoom 

T  glas hen placed in the graph 
w ave. S e page 56 for details on 
u

If the I-Beam curs le data point selection is made 
with the Arrow cu point selected. This is useful for 
preserving the dat

bars 
You can use the h
horizontal scale, o

ou to  move 
 

end of the record. 
You can use the v

he wav
 display

To use a scroll bar e 
in smaller increme

Display menu. The Autoscale horizontal command fits the entire data file into the window, 
regardless of the total length of the acquisition. You can identify the duration of the record by 

 
L

9 TIP You can “jump” to a different point in time by entering a “Start” value in the Horizontal Scale 
dialog. See the following section for more information. 

 

his is a standard Zoom tool. It changes to a magnifying
indow. It can be used to magnify any portion of any w
sing the Zoom tool to select an area. 

or is selected (manually or using “Ctrl + I”) after a sing
rsor, the I-beam cursor will be placed at the last data 
a selection when switching the cursor style. 

s w
e

 
Scroll 

orizontal scroll bar to move to different points in the record. As indicated by the 
nly a portion of the sample data file is displayed on each screen. The horizontal scroll 

bar allows y move around in a data file, just as the scroll bar in a word processor allows you to
to different points in a document. Points left occured earlier in the record, points right occurred toward the

The horizontal scroll bar runs along the bottom of the display window. 
ertical scroll bar to change the amplitude offset of a selected channel. This will 

reposition t eform up or down within its display “track.” The vertical scroll bar runs along the right 
edge of the  window. 

, click the bar and drag the box. Click the arrows at either end of the scroll bar to mov
nts. 

9 TIP To display the entire waveform (in terms of duration), choose Autoscale horizontal from the 

choosing Display > Statistics. This will generate an information dialog that includes the
ength of the record. 
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Scale 
Any changes you make in terms of rescaling (either horizontal or vertical) will only affect the way data is 
displayed, and will not change the basic characteristics of your data file. Horizontal scale options affect 
all channels; vertical scale options can be set independently for each channel. 

Horizontal scale runs along the bottom of the display window and is where the numerical units are 
listed. You may show/hide the scale via the Show>X-scale command. The default 
setting uses four divisions (vertical lines) per screen. You can change the 
horizontal scale setting to control the amount of data that appears on the screen at 
any given time. See page 39 for details. 

Vertical scale  runs along the right edge of the display and controls the range of amplitude values 
displayed for each waveform. You may show/hide the scale via the Show>Y-scale 
command. You can set the scale midpoint (the value that appears in the center of 

 multiple channels are , thick 

. If Scale is set to 3 mVolts per 
 a 

ing only applies to the Scale. You must set measurement result precision 

zontal Scale dialog. The Horizontal 
low. Note that the Horizontal Scale 

cked.” See page 166 for a discussion of Grid Options and how locking 
ck Grid Lines) affects the Horizontal Scale 

 

the vertical scale) for each channel. When  displayed
horizontal lines separate each waveform into its own vertical “track.” 

 As with the horizontal scale, there are four divisions on the vertical axis, and the 
display range will equal the Scale value x 4
division, 12 mVolts of data will be displayed. You can use the Range Guide as
visual aid to establish the proper Gain..  

Note: The Scale Precision sett
separately. 

 
Horizontal scale 
Click the cursor in the horizontal scale area to generate the Hori
Scale dialog — when display grids are not locked — is shown be
dialog will vary if grids are “lo
grids (Display>Show>Grid Options Display>Grid Options: Lo
dialog. 

    
Horizontal Scale dialog (Grid

Scale  The Scale setting controls how much of the at any 
given time. When grids are unlocked, the scr s the horizontal scale value 
multiplied by four. Larger values will display more data and smaller values will display 
less data. 

Start  Enter a number in the Start box to “jump” to a certain point in the data display. This 
does not affect the data file, just the display. To view data from the beginning of the 
sample record, enter a Start value of 0 seconds. 

 In the time scale shown above, the first data displayed (at the left edge of the graph 
window) was collected at the beginning of the acquisition (Time 0.0000 seconds). Also, 
the scroll box is fully to the left, indicating that the data on the screen represents data 
collected earliest in the record. 

 Unlocked) 

record will be displayed on the screen 
een display
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e 

ated. This setting is for scale 
precision only; you must set the measurement precision separately under Display > 

 9 TIP To display the entire waveform (in terms of duration) in the data window, 
 

ect to the start of acquisition. This is convenient when doing short-

 
acquisition is started with the horizontal scale such that it falls between acquisition 
segments, this feature is not implemented. 
When Hold relative position is checked, if you zoom in on a section of data that has 

ompletely within one appended segment, the scale of 
 appended segment such that it remains relative to 

the start of acquisition for that segment and updates the measurements. If the selected 
. 

 If you click in the horizontal scale area again, the same dialog will appear, and this tim
the value in the Start box should have changed from 12.0 to 0.00 to reflect the new 
section of data being displayed on the screen. 

Precision  The Precision setting determines the number of digits to follow the decimal (default is 
2). Significant digits will be rounded rather than trunc

Preferences > General. 

choose Display > Autoscale Horizontal. Use Autoscale Waveforms to
adjust the vertical display and bring all data into view. 

Hold 
Relative 
Position 

Hold relative position is an option available only in the Append acquisition mode. 
When checked, the display for appended acquisitions will show the same relative 
position with resp
duration, high-speed acquisitions where you want to be able to zoom in on the signal of 
interest and have the relative position (from the start of acquisition) stay the same. If the

been selected (highlighted) and is c
the selected area changes with each

data area falls within two or more appended segments, this feature is not implemented
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Vertical s
 to 

play grids are not locked — is 
shown below. Note that the Vertical Scale dialog will vary if grids are “locked.” See page 166 for a 

ptions Display>Grid Options: 

cale 
Click the cursor in the vertical scale area (on the right edge of the window, where units are displayed)
generate the Vertical Scale dialog. The Vertical Scale dialog — when dis

discussion of Grid Options and how locking grids (Display>Show>Grid O
Lock Grid Lines) affects the Vertical Scale dialog. 

 
Default Vertical Scale (Grid Unlocked) 

Channel Use this option, available only when grids are not locked, to jump to another channel 
and set its vertical scale options without having to close out of the dialog. 

Scaling… The Scaling… button appears in the "Vertical Scale" 
dialog regardless of the scale or grid mode if there is 
hardware ass
access to the Change Scaling Parameters dialog for 
calibrat
followi
the same fo

ociated with the channel. This gives fast 

ion control. Scaling changes will be applied 
ng the next start of acquisition, and must remain 

r all appended segments. 
 

ines how many units (usually Volts) are displayed in each track. Smaller 
s increase the apparent amplitude, larger values decrease the apparent 

ntering a num  the current value will cause the am

Scale  This determ
Scale value

y. E plitude of 
ave to

Midpoint  This sets th  and 
ent m  

set to 2 mV
mVolts.  

Precision This setting r of digits to follow the decimal (default is 2). 
ficant ion 
g app

you must s l. 
lick in thi

 

TIP Use Display > 
vertical scale p ale) 
will be displaye

variabilit
the w

ber about half
 appear to double. 
e median value display for the track. You can vary the midpoint

appar agnitude of each waveform by changing the Midpoint entry. If Midpoint is
olts, the selected channel will display a range from - 4 mVolts to + 8 

 determines the numbe
Signi
settin

 digits will be rounded rather than truncated. The vertical scale precis
lies only to the specified channel. This setting is for scale precision only; 
et measurement precision separately under Display > Preferences > Genera

All Channels C
o

s box to apply the setting to all channels rather than to the selected channel 

Autoscale Waveforms to have the software automatically adjust the 
arameters so all ampoitude data in the current time slice (horizontal sc
d. 

nly.

9 



42 Part A 

Visit the online support center at www.biopac.com 

Range Guide 

   
 Figure 1 Figure 2 Figure 3 
The Range Guide is a green bar that runs along the vertical scale in the graph window for analog 
channels (fig. 1). It displays the maximum signal range for the Gain established for that channel. You can 
use the Range Guide as a visual aid to establish the proper Gain.  
The MP35/30 measures the actual input voltage and compensates for the Gain. As Gain increases, the 
peak-to-peak of a waveform stays constant but the resolution increases. Proper Gain will have a 
smoothing effect on the signal. 

or the best resolution, establish Gain such that, allowing for 
nd the maximum peal-to-peak of 
al display is close to the maximum 

to i
Gai  resolution. 
Dif n source show 
that
 H (fig. 4, top) 
 L fig. 4, bottom) 
To d ale. 
� Gain guidelines

F
baseline drift (if applicable) a
the signal, the maximum sign
range. If the signal is clipped (fig 2.), lower the Gain. If the 
signal is small compared to the range (fig. 3), increase the Gain 

mprove signal resolution.  
n settings create a trade-off between range and
fere t gain settings applied to the same signal 
 
igher Gain Æ better resolution + lower range 
ower Gain Æ worse resolution + higher range (

isplay the full range (Fig. 2 vs. Fig. 4, for example), adjust the Vertical Sc
Figure 4   

 are included in the MP35/30 Input and Offset Range table on page 97. 
The Range Guide will always reflect changes made to the channel Scaling.  
To quickly see the total range of each input channel, select Optimize Ranges from the Display menu. 
This will automatically adjust the upper and lower viewable limits of the Vertical Scales for all channels.  

  

 When Optimize Range is selected using the 
toolbar icon or the right-click mouse 
shortcut, only the active channel range 
guide is optimized. See page for 235 
details.  
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Display modes 
BSL PRO offers several display modes to change the way data appears on the screen at any time, even 
during an acquisition: Chart mode, Scope mode, Overlap Appended segments, and X/Y mode. To change 
the display mode, click the corresponding icon in the toolbar or make a selection from the Display > 
Show menu options. When in Chart or Scope mode, you have the additional option to display appended 
data in the Overlap Segments mode, activated from the Toolbar. 
Chart mode 

 Chart  is the default display mode and plots with Time on the horizontal axis. 

 
Cha m ith 
bor s  
Wavefo

e chan . To remedy this, choose Autoscale Waveforms and the software will select the “best 

Sco m

rt ode emulates a chart recorder. Each channel of data is in its own “track” across the screen, w
der  between channels. The waveforms will not cross boundaries into the tracks of adjacent channels.

rms cannot overlap in Chart mode, but it is possible for the waveform to be plotted off the scale of 
nel trackth

fit” for waveforms to their tracks. 
When the active channel is disabled in Chart Mode, the first channel (of the remaining enabled channels) 
becomes the new (default) active channel and its Horizontal and Vertical Scales are displayed.  
 

pe ode 

 Scope plots with Time on the horizontal axis. 

 
Scope mode emulates an oscilloscope. All waveforms are in a single window with no borders between 
channels. Waveforms can overlap. 
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 separate the waveforms in the graph window and 
ion. This can be useful when overlapping 

s that are of different units and scales. 
abled channels) 

bec ayed. 
e and Chart modes are identical. 

 
Ove p

The autoscale waveforms command will automatically
autoscale each as if it were the only waveform in the display reg
waveform
When the active channel is disabled in Scope Mode, the first channel (of the remaining en

omes the new (default) active channel and its Horizontal and Vertical Scales are displ
Note:  When only one waveform is present, the Scop

rla  Segment mode 

 Ov aerl p Segments plots with Time on the horizontal axis. 

 
Overlap Segments mode overlaps appended segments of data a
Ove oolbar icon is 

nd is useful for comparing waveforms. 
enabled only when the acquisition mode 

has y mode has first 
bee
In C  toggled on, all data segments of each channel are overlapped in 
thei s  displayed in a single 
win
The active s abel 
are displaye displayed in this mode—see page 164 for Marker details.) To choose 
 new activ n the cursor is over the graph and select Show Segment from the 
op-up menu. 

 
X/Y mode 

rlap Segments may be toggled on and off; its T
 been set to Append, at least one segment of data has been acquired, and the displa
n set to Chart or Scope. 
hart mode, when Overlap Segments is

r re pective channel “tracks.” In Scope mode, all segments of all channels are
dow. 

egment is highlighted and its Horizontal scale, automatic Append marker, and marker l
d; Event markers are not 

e segment, right-click whea
p

 X/Y mode plots one channel on the horizontal axis against another channel on the vertical axis. 
When a channel is plotted against itself, a straight line will be displayed. 
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X/Y mode can be useful for chaos investigations and respiration studies. 

rd Curve, which is useful for colorimetry studies. 

e X-axis is displayed above the waveform 
axis is displayed to the left of the waveform 

s generates a pull-down menu of all currently 
 the list to plot it on the selected axis. 

� When X/Y mode is selected, you can Plot Standa
See page 80for Standard Curve setup. 

In X/Y Mode, the label for the channel being plotted for th
window. The label for the channel being plotted for the Y-
window. 
Clicking once in either the X-axis or Y-axis label area
plotted channels. Select a channel from

  
X/Y plot of BPM (X) and lagged BPM ( Y) 

 

BSL PRO functionality changes when in X/Y mode 

I-beam tool The I-beam tool changes into a crosshair  cursor and when it is m
into the graph window, the coordinates of the crosshair 

oved 
are displayed in the 

ir. 

Plot Standard Cu  

Autoscale Wavef
tical 

d 

 

upper left corner of the graph window. The X value is the horizontal 
coordinate and the Y value is the vertical coordinate of the crossha

rve The Plot Standard Curve function is enabled in X/Y mode. This function
plots a curve used in colorimetric measurements. See page 80. 

orm The Autoscale Waveform function changes to read Autoscale Vertical, 
which plots the vertical channel so that it takes up two-thirds of the ver
channel space. This function controls the “height” of the data being plotte
in the graph window. 

Autoscale Horizontal The Autoscale Horizontal function plots the waveform so that the 
waveform is plotted in the center two-thirds of the window. This function
controls the “width” of the data being plotted in the graph window. 

Tile Waveforms / Since only two channels can be displayed at a time in X/Y mode, the Tile 
W f d C W f d l d b h
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BSL PRO functionality changes when in X/Y mode 
pare Waveforms WCom aveforms and Compare Waveform commands are replaced by the more 

relevant Center Horizontal and Center Vertical. These two center 

dpoint of the scale is equal to the mean value 
 display 

y 

 not 
meaningful in X/Y mode. Instead, when the cursor is the X/Y plotting region 
of the graph, the measurement region displays the X-axis and Y-axis 
coordinates of the data point closest to the cursor. If the left mouse button is 
pressed, horizontal and vertical lines track the cursor movement. 
If the right mouse button is pressed (even while the left mouse button is 
down) and a journal is open, a “Paste Values to Journal” option is available 
from the pop-up menu.  

 

commands change the midpoint of the horizontal and vertical scales 
(respectively) so that the mi
(average) for that channel. These features are useful for centering the
so that it is easier to interpret. Whereas Autoscale commands adjust the 
center point and the range of data displayed, Center functions adjust onl
the midpoint. 

Channel boxes The channel numbering boxes are disabled in X/Y mode since they are not 
meaningful in X/Y mode. 

Measurement region The measurement windows are disabled in X/Y mode since they are

 
 

a gr turns the data stored in the graph file. 

1. Select File > Open for Playback.  
2. Locate a graph file and then click Open. 
3. A new graph window will be generated. 
4. Press Replay to begin playback. 

Playback Mode – Mac only 
Use Playback mode to replay (or simulate) acquisition using a previously acquired graph file. The data in 

aph file can be used to simulate an MP unit that re

  
(The “Start” button becomes “Replay”) 

5. Select Playback > Exit Playback mode to 
return to MP menu and acquisition options. 
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QuickTime Movies of Acquisitions 

 
You can create a fter 
acquisition (from a gr lotting, results of autoscaling, 

ing, and
postponing QuickTim

file size — ovies can be gigabytes in size and it’s a hassle to accidentally run out of 
disk space 

Flattening—Quic
and flattened at th platform compati
Windows™ PCs. e 6, flattening may take 10 minutes. 

ck Time

QuickTime movie of Biopac Student Lab PRO window content during or a
aph file saved on disk). Capture waveform p

autoscroll
• By 

 any other visual changes to the graph window that occur during acquisition. 
e creation, you can make sure data is clean and optimize settings to reduce 

QuickTime m
in the middle of an acquisition. 
kTime movies are generated in the “Animation” format with no compression codec used 
e end of the acquisition. Flattened movies are cross- ble with 

 Due to limitations of QuickTim
 
Save Qui  Movie Options 

—The disk where the movie is saved should have several gigabytes free space available 
nger than 3 minutes. 

• Location
for movies lo

• al
operation all of the data from the start of the acquisition to 

d. 

ze graph size and display

Autosc e final frame—Creates the last frame of the movie after an Autoscale Horizontal 
 so the last frame of the movie shows 

the en
 
Optimi  settings 
The actu
display w

al dimen
ill help 

• Optimize gra
o S

dimensions of the m
T oth 
s

o Do not resize the graph window while a QuickTi
• Optimize

o H
o Set the scales such that details of the waveform(s) will be discernable in the small graph 

window plotting area. 
rm autoscaling as necessary to get appropriate vertical scales for the entire data file. 

ntal axis to zero, either through clicking on the 

sions of the movie will be taken from the size of the graph window, so optimizing the 
reduce file size and emphasize signal representation(s). 

phs size 
elect Display > Size Window and enter the smallest reasonable size for the visual 

ovie (e.g. 400x300). 
he smaller the size of the graph window, the smaller the resulting movie will be (in b
ize on disk and visual dimensions). 

o 

me capture is in process. 
 display settings for the reduced graph size 
ide toolbars, events, hardware menu, measurements, etc. 

o Perfo
o Optimize the horizontal scale for the reduced display region. 
o Set precision of the axes (usually 2-3). 
o Set the “Initial time offset” of the horizo

axis or scrolling all the way to the left. 
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Create a QuickTime file from a Saved Graph File 
Preferred Method —This procedure requires two acquisitions 
Stage 1 

1. Select File > Open File for Playback (the MP menu will change to “Playback”). 
2. Select the file containing the source data for the video. 
3. Disable (uncheck) Playback > Capture to QuickTime. 
4. Set the acquisition storage mode to “Save once to Memory” (Playback > Set Up Acquisition). 
5. Press “Replay” in the graph window and wait for acquisition to terminate. 

• This acquires all of the original data into the graph window so all of the data is present for 
determination of vertical scaling appropriate for the entire acquisition. 

Stage 2 
6. Optimize graph window size and display settings to reduce movie file size. 

kTime file to flatten (may take 10 minutes). 

7. Select Edit > Select All. 
8. Select Edit > Clear All. 
9. Enable (check) Playback > Capture to QuickTime. 
10. Press “Replay” in the graph window. 
11. Set options in the “Save QuickTime Movie” dialog and then click Save. 

• Watch for error dialogs and wait for playback acquisition to finish. 
• Wait for the Quic

12. Open the movie in QuickTime Player and check for any problems. 
13. If necessary, go back to the playback graph window and repeat from Step 6. 

 
Create QuickTime file during Acquisition 
Riskiest method — You are more likely to run out disk space 

1. Enable MP1#0 > Capture to QuickTime. 
2. Optimize graph window size and display settings to reduce movie file size. 
3. Press Start in the graph window. 
4. Set options in the “Save QuickTime Movie” dialog and then click Save. 
5. Stop acquisition (automatically or via the Stop button). 

a. The QuickTime file will automatically be saved (separately from the acquisition). 

 

 

b. Save the graph file. 
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Part B — Recording Data 

ion from an 

ions 

ana log signals (up to ± 10 

Part B – Recording Data  covers the basics of data acquisition and analysis with the Biopac Student Lab 
PRO. All of the material in this section is covered in more detail in subsequent sections (see Using this 
Manual on page 12 for a guide to sections). 

Chapter 2 Acquisition Overview 
Collecting data / acquisition 
Acquisition is defined as data collect
external source (such as electrodes connected to an 
amplifier). BSL PRO acquisitions require hardware 
connections and software setup. 
Hardware Connect
The MP35/30 is designed to accept amplified small 

log signals and large ana
Volts). Specific connections to the MP35/30 acquisition 
unit will vary greatly, depending on the amount and type 
of data collected. The most common applications of the 
BSL PRO involve amplified signals collected from 
electrodes and/or transducers. Input connection to the MP35/30 

 

 
MP35 Front and back Panels — see page 265 for MP35/30 specifications and symbology 

The two common types of input devices that connect to the front of the MP35/30 to interface between the 
subject and the hardware are electrodes and transducers. Electrodes directly reflect the electrical signal 
generated by the body, and transducers convert a physiological signal into a proportional electrical signal. 
You can also connect I/O devices to the MP35/30. 

Electrodes are relatively simple instruments that attach directly to a subject’s skin surface and pick 
up electrical signals in the body. Electrode lead cables connect to the electrodes and 
send the signal to the MP35/30 unit. The MP35/30 amplifies the signal and sends it to 
the computer and the Biopac Student Lab PRO software. Depending on where 
electrodes are placed, different types of signals will be picked up. 

nic 
nse) to a proportional electrical signal. One example of this is the 

respiration transducer, which is like a rubber band that stretches with your chest. It 
s how much larger your chest becomes when you breathe in, and how much 

t 
Lab PRO System and relayed to your computer, where it is plotted on the screen. 

I/O devices are specialized I

Transducers convert a physiological parameter (such as clench force, blood pressure, or Galva
Skin Respo

measure
smaller it becomes when you exhale. A device inside the transducer converts this 
physical change into an electrical signal, which can then be sent to the Biopac Studen

nput/Output devices, such as push-button switches and headphones. 
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Regardless of the type of d ry sensor or I/O device connects to the MP35/30 
acquisition unit using a “Si r is designed so that 

, so you don’t have to worry about plugging things in 
 to screw the end of the Simple Sensor into the 

r you to experiment with different transducers. 
ion on the Simple Sensors available for use with the 

nd the acquisition parameters to use for each channel, 
gth. 

 MP35/30 is turned on and connected to your 
your computer and/or not turned on, a warning will be 

need more information on installation 
. 
n via t Start menu (Windows) or double-click the 

udent Lab PRO icon from the program/application folder or desktop. 
hould see a window similar to the following: 

evice connected, eve
mple Sensor” connector. The Simple Sensor connecto

there is only one way to plug it into the MP35/30
upside down or into the wrong socket. You don’t have
computer port unless you want to — this makes it easy fo
¾ See the BSL Hardware Guide for more informat

Biopac Student Lab PRO. 
Software Setup 
You must set up the input channels to acquire data a
such as sample rate, data storage, and acquisition len
¾ Before you begin software setup, make sure the

computer. If the MP35/30 is not connected to 
generated when you launch the BSL PRO Software. If you 
and connections, refer to the Installation Guide

1.  Launch the Biopac Student Lab PRO applicatio he 
Biopac St

 BSL PRO opens to a new graph window. You s

 
2.  You must setup the specific channels to acquire data on
3. You must setup the acquisition parameters (such as sa

options). See Setting up Acquisition for details. 

. See Setup Channels for details. 
mpling rate, acquisition length, and data storage 
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Set 
Select  S
you wil

up channels 
et up Channels from the MP35/30 menu. This will generate a Set up Channels dialog where 

l designate the channels to be acquired, and the parameters for data acquisition. 

 
Setup Channel Options 

Channel The Channel column contains the alpha-numeric channel numbers. “Analog” (or 
continuous) input channels begin with “CH” and run from CH1-CH4. “Digital” input 
channels begin with “D” and run from D1-D8. “Calculation” channels begin with “C” 
and run from C1-C12. 

� Display is limited to four channels of each type. Use the scroll button  to set up 
additional Digital or Calculation channels. 

Acquire When the Acquire Data box is checked for a given channel, data will be collected on 
that channel. 

Plot If Plot on Screen is also checked, data will be plotted on screen in real-time during the 
acquisition. If the plot box is unchecked, data will still be recorded for that channel, but 
the waveform display will be disabled. To display the waveform plot after the acquisition 
is over, show the channel. 

Enable 
Value 
Display 

Checking the Enable Value Display box means that you can choose to display 
(numerically and/or graphically) the values for each channel in real time. To display the 
values, you must also select Show Input Values (via the MP35/30 menu). Input values 
are displayed in a separate window from the main graph window. 

Default The default is to collect one channel of data on analog channel 1 (CH1), and to plot and 
bl l di l f hi h l

MP35 required 
for Digital Input 
Channels 
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le value display for this channel 
ta on 

racters to identify the 

Pre

enab

9 TIP Usually, you will want to check all three boxes for each channel you acquire da

Label The Label entry for each channel allows you to type in up to 38 cha
channel. 

sets 

 
Presets for common applications configure the hardware gain, filters, etc. 
Clicking on the Presets button will generate a menu of available presets for the channel. 

¾ For a detailed summary of Analog Input channel, Digital Input channel, and 
Calculation channel options see the Presets section beginning on page 73. 

View/Change To View/Change Parameters for a Preset, click the wrench icon. If you change the 

 established parameter
parameters, you have the option of creating a New Channel Preset to make the 

s available to other channels. 

ill be If you make a change to a preset and start recording in the Append mode, you w
prompted as follows. Choose Abort, save your data, and then change the presets to 
aquire as a new data file. 

  
 
Setup A

 can 

 
ta collection) rate, and the acquisition length. 

cquisitions 
Once you have set up the channel parameters, the next step is to specify the acquisition settings. You
do this by choosing Setup Acquisition from the MP35/30 menu. This generates a dialog box that will 
describe the type of acquisition about to be performed. 
There are a number of options here, but the basic parameters involve specifying: where data should be
stored as it is being acquired, the sample (da
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Data storage — At the top of the Acquisition Setup dialog box, you should see a display that reads 
Record and Append using PC Memory. This is the default option for collecting data and tells the 

Student Lab PRO to automatically record data into single continuous file, and to store the data in 
PC 

e acquisition. You will need to 

oftware 

tation of the signal 
ecomes more accurate — however, so does the demand for system resources memory, disk space, etc.). 

t Lab PRO’s sampling rate has a lower bound of 1 sample per second, and an upper 
amples per second (2 kHz). Choose the best sample rate from the pull-down menu 

Acquisition s how long an his can be 
scaled in sec onds or numbe e pull-down 
menu. S r in th roll box left 
(to decre
Repeat  function is an advanced

Biopac 
computer memory (RAM) during the acquisition. The third pop-up menu (which defaults to 
Memory) allows you to specify where the data should be stored during th
choose PC Memory or Hard Disk storage. Computer memory (RAM) is usually faster (but less 
abundant) than disk space. If your system uses any virtual memory, the Biopac Student Lab PRO s
will use as much as possible. 
Sample rate — This is analogous to “mm/sec” on a chart recorder, and refers to how many samples the 
MP35/30 System should take each second. As the sample rate increases, the represen
b
The Biopac Studen
bound of 100,000 s
generated when you click the Sample Rate entry. 

9 A good rule of thumb is to select a sampling rate at least four times the highest frequency of 
interest for the signal. 

 Length — This entry control
onds, minutes, hours, millisec

acquisition will last (duration). T
r of samples, as selected from th

et this value by entering a numbe
ase) or right (to increase). 

— The Repeat

e Acquisition Length box or by moving the sc

 operation and is discussed on page 91. 
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Starting an acquisition 
After you have setup the cha y to 
start the acquisition. If a file  

In the lower right corner of 

nnels to contain data and defined the channel parameters, you are read
 window is not already open, choose File > New to generate a graph window.

the screen, next to the  button, you should see a button with
dicates the status of the communication

 a 
circle next to it. The circle in  link between your computer and the 

You can start the acquisition by positioning the cursor over the 

MP35/30. If the MP35/30 is properly connected to the computer and is turned on, the circle should be 
solid and green. If the MP35/30 is not properly connected, a solid gray circle will appear (on 
monochrome displays, the circle will appear solid when the MP35/30 is connected properly, and unfilled 
when the MP35/30 is not communicating with the computer). 

 button and clicking the 
mouse button or by selecting “Alt + Spacebar.” If there are no input devices (e.g., electrodes or 
transducers) connected to the MP35/30, it will collect a small value of random signal “noise” with a mean 
of about 0.0 Volts. 
¾ For information on how to connect measurement devices to the Biopac Student Lab PRO, see the 

BSL Hardware Guide. 
 You may also start an acquisition using a variety of “triggers,” which are discussed on page 140. 

Once acquisition starts, the 

¾

 button in the acquisition window changes to . The 
two opposing arrows to the right of the button indicate that data is being collected. Also, the “Busy” 
status indicator light on the front of the MP35/30 will illuminate, showing that data is being collected. 
 
Stopping an Acquisition 

To stop an acquisition at any time, click the  button in the lower right corner of the screen or 
select “Alt + Spacebar.” An acquisition will stop automatically when it has recorded an amount of data 
equal to the Acquisition Length entry. 
 
Rewind 

 The Rewind button on the Toolbar allows you to erase the last recorded data segment and continue 
to Append data to the existing data file. This function will erase the last segment along with the Append 
Marker  for that segment; the application will keep track of Append Marker labels, so that the label 
always matches the segment number. 

  
� If the “Warn on Overwrite” option is active, a warning dialog will be generated before the 

segment is deleted.  
 
Saving acquisition data 
To save a data file, pull-down the File menu and choose the Save command (see page 176 for details). 
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Chapter 3 Analysis Basics 

aveform at a time is considered 

 transformations on a given channel. 
 the upper left corner of the graph window there 

f numbered boxes that represent each 

Selecting a waveform / channel 
Although multiple waveforms can be displayed, 
only one w
“active.” Most software functions only apply to the 
active waveform, which is also referred to as the 
selected channel. Selecting a channel allows you to 
highlight all or part of that waveform, and enables 
you to perform
In
is a series o
channel of data. The numbers in the boxes 
correspond to the channel used to acquire the data 
(the specifics of setting up channels are discussed 
on page 51).  
In the sample file, ECG is on channels 1 and 2, 
with respiration is on channel 3 and blood pressure 
is on channel 4.  

 To select a channel, position the  cursor over the channel box that 
esponds to the desired channel and click the mouse button or position the corr

 
 

 cursor on the waveform of interest and click the mouse button. Note that the 
selected channel box appears depressed and the channel label to the right of the 

nnel boxes changes to correspond to the selected channel. Additionally, the 
nnel label in the display (o

cha
cha n the left edge of the track) will be highlighted  
for the active channel. 
Channel Labels 
 Each channel has a label on the left edge of the track to entify the contents of the chaid nnel. 
When a channel is active, its label is highlighted and also appears by the channel boxes. 

To change the label for a given channel, double-click th
can change the text. You can also change the Label entry in the 
When you change the Label this way, the change will not take effect until 
Hide a channel 
You can “hide” a waveform display without changing the 
data file. To hide a channel, hold down the Ctrl key and 
click in the channel box. When a channel is hidden, the 
channel box will have a slash through it. You may view a 
hidden channel by holding down the Ctrl key and clicking in 
the channel box again. Channels 2 and 4 are hidden in the 
following display. 

9 When the active channel is hidden in Chart or Scope 
Mode, the first channel (of the remaining enabled 
channels) becomes the new (default) active channel 
and its Horizontal and Vertical Scales are displayed. 

9 The hide/show function should only be used after acquisition, not during. The entire Graph 
window will be refreshed when channels are shown or hidden during an acquisition. For large 
acquisitions, the refresh may interfere with the acquisition and generate an “Acquisition buffer 
overflow” and stop acquisition. 

e track label. A dialog will be generated so you 
MP35/30 > Setup Channel dialog. 

you start an acquisition. 
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Selecting 
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an area 

ou 
Once you have selected a channel, you can “edit” parts of that channel by selecting a section of the 
waveform. The options available to you include cutting, copying, and pasting sections of waveforms. Y
can also transform and analyze entire waveforms or specific sections of waveforms. 
¾ IMPORTANT: When multiple waveforms are present, the highlighted area appears to include all of 

the waveforms, but most modifications and transformations apply only to the selected channel. 
For any of these functions, you will need to use the I-beam  tool to select (or highlight) an area. 
To select the I-beam tool, position the cursor over the  icon in the lower right hand corner of the screen
and click the mouse button. Now move the cursor to the first point in the area that you wish to select. As 
you move the cursor int

 

o the graph area, you will see it change from an arrow cursor to a standard I-beam 
editing tool. 
To highlight a section of a waveform: 

 the I-beam at the left edge of the desired area and hold down the mouse button. 
e mouse to the right until the desired area is selected

1) Position
2) Move th  and then release the mouse button. 

To select an area that spans multiples screens: 
e I-beam at the start (left edge) of the section to be highlighted. 
 horizontal scroll bar to move to the desired endpoint (right edge) in th

1) Click th
e record. 

he Shift key while you position the cursor and click the left mouse button. 
This method  specific 
range of dat

2)  Use the
3)  Hold down t

 of selecting an area allows you to “fine tune” the selected area to include only a
a. To fine tune: coarsely select an area, then zoom in (using the Zoom tool) on either edge
ck with the I-beam to precisely select and/or align the

 
and shift-cli  edge of the selected area. 

To deselect an area: 
Click a 

Once a channel an operate on and edit that 
e waveform. The editing commands behave much the same way as the editing functions in a 

word processor.
most cases (dep
menu, or by usin
Selecting a port e 
entire area or all surements for parameters 

 The measurement options are 

Zoom 
Another way to tion of 
any wave and m
To use the Zoom

1. Click the 

new point of data with the I-beam tool to deselect the last area. 
has been selected and a section of data highlighted, you c

section of th
 You can cut, copy, delete or paste sections of data as defined by the selected area. In 
ending on available memory) you may undo an edit by choosing Undo from the Edit 
g the CTRL + Z shortcut. 

ion of a waveform allows you to apply transformations to a particular area, rather than th
 waveforms. Selecting an area also allows you to take snap mea

such as delta T, mean, standard deviation, frequency, and so forth.
discussed on page 149. 

select an area is to use the “zoom” tool. The zoom tool allows you to select any por
agnify it for closer analysis. 
 tool: 

 icon in the lower right portion of the screen. 
2. Positioning the cursor at one corner of the data region of interest and hold down the left mouse 

button. 
3. Drag the crosshair horizontally, vertically, or diagonally to form a “box” which encompasses the area 

you need to zoom in on. 
4. Release the mouse button. 
When you draw a Zoom box, the Biopac Student Lab PRO software will automatically adjust the 
horizontal and vertical scales for all waveforms, not just the selected one. 
To “unzoom” or repeat the zoom one level at a time, choose Zoom Back or Zoom Forward from the 
Display menu. You can select either function up to five times per zoom. Keyboard shortcuts are Ctrl-
Minus (Zoom Back) and Ctrl-Plus (Zoom Forward). 
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You can also use Zoom/Ctrl-Zoom to zoom in and out by a factor of 2 without drawing a zoom box.  
 

rids 
ou

Click the Grid 

G
Y  can apply several different grid styles to data to help with analysis.  

 icon in the toolbar or select Display > Show > Grids to toggle grid display on and 
off. 
Sele r 
divisions, line c tor 
whereas LOCKE
look similar to c
 
Measurement

To display the measurement windows, select Display > Show > Measurements or use the  

ct Display > Show > Grid Options to set grid options such as locked/unlocked, major/mino
olor, and line width. UNLOCKED grids help you view the data display on the moni

D grids help more with printing. Using the Grid Options, you can create printouts that 
hart recorder output or clinical ECG. See page 166 for Grid details. 

s 

  icon  
Onc he 
following measu 3 for a full explanation of measurements): 

e you have selected a channel, you can quickly and easily take measurements on each waveform. T
rements are available (see page 15

Single-point measurements Selected range measurements 

Delta S, Lin_reg, Max, Max T, Area, BPM, Correlate, Delta, Delta S, Delta 
/X (based on units), Frequency (time domain), Min, Min T, Samples, Time, Value, 

X-axis T/F/X 
T/F
Integral, Lin_reg, Max, Max T, Mean, Median, 
Median T, Min, Min T, p-p, Samples, Slope, 
Stddev 

 
ea

ways selecting either a single point or an area spanning 

area
the 

ea
ac

M surement Area 
It is important to remember that the software is al
multiple sample points. When a single point is selected, the cursor will “blink.” Otherwise, the selected 

 will be highlighted. If an area is defined and a single point measurement is selected (such as Time), 
measurement will reflect the last selected point. See page 150 for further explanation.  

 
M surement Window 

h measurement window consists of three boxes: E

  
 

C

reflect the contents of the selected channel. 

hannel selection Allows you to calculate a measurement either for the selected channel (SC) 
or from a numbered channel in the record. To switch between the channel 
options, click in the channel window. The pop-up menu shows the channel 
numbers for all channels in the file. By default, each measurement will 
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ment function Allows you to choose between different types of measurements. To choose a 
ent 
e 

values on the selected channel. Some of the measurements that depend on a 
selected area look at differences in the horizontal axis, such as the delta T 
measurement, which returns the difference in time between the first sample 
point in the selected area and the last sample point in the selected area. Other 

rtical scale information 
 

n the 
following example, the BPM for the selected channel (SC) is 230.7, whereas 
the mean for the selected area of channel 1 is 0.18030, and the integral 
calculation for channel 40 is 0.04557. 

The number of measurement windows depends on (a) the width of the screen and (b) the number of rows 
selected in the File > Preferences > General dialog box. By default, only one row of measurement 
windows is displayed. As the screen gets wider, more measurement windows can be displayed in the area 
above the graph windows. 

Measure
measurement, click the measurement pop-up menu and select a measurem
from the list. Depending on the nature of the measurement being taken, th
windows can display information regarding a single point or a range of 

range measurements also select an area, but use the ve
in calculating measurements, like the peak to peak (p-p) measurement, which
computes the difference in amplitude between the maximum value in the 
selected area and the minimum value in the selected area. 

Measurement result Lists the result for the selected measurement across the selected area. If no 
data is selected, or if not enough data is selected for a meaningful 
measurement, the measurement result box will display “****.” I
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Transforming
The Biopac Stu are i orm data or 

erform mathematical calculations on waveform data. All of these options can be found under the 

gital filtering, for instance), so if a single point is selected the entire waveform will be 
transfor
 
Marker
In many ces it is useful to have th are “remember” an vent during 
an acquisition so it can be referenced lat , you may want to note when a treatment began or 

s. 
 and 

 after recording (off-line). 
ert event markers during an acquisition by pressing the F9 key on a PC. 

 will activate the text line entry so 

¾ To enter an event marker after the recording session, click the cursor in the area beneath the marker 
ar ker x 

To vie  the selection tool over the marker and click the mouse 
button

Y

 data 
dent Lab PRO softw ncludes a vast library of functions, which can transf

p
Transform menu, and are discussed in detail in the Transform Menu Commands section beginning on 
page 192. 
When performing transformations, keep in mind that when a section of a waveform is highlighted, the 
transformation will apply to that section. Also, if no area is defined, the BSL PRO software will always 
select a single data point. Some transformations can only be performed on a selected area (spectral 
analysis and di

med.  

s 
 instan e BSL PRO softw  occurrence or e

er. For instance
when an external event occurred so you can examine any possible reaction. 
The Biopac Student Lab PRO software uses “markers” which are placed above the data to record event
“Append markers” are automatically inserted each time you record a new segment in “append” mode,
you can enter an “Event markers” either during an acquisition or
¾ You can automatically ins

This will insert a marker at the exact time the key is pressed and
you can immediately enter a comment to be associated with the marker. 

ea. This will insert a marker. To add text describing the event, click the cursor in the mar bo
and key the desired text. 

w the text associated with a marker, position
. 

ou can also move from marker to marker by using the  icons in the marker toolbar. 
R  description of markers and marker functions, 
in d nction keys for different labels. 

efer to the Marker section on page 164 for a detailed
clu ing options to pre-establish marker labels and set fu
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Journals 
 

n a 
an 

paste in values from waveform data for further 
analysis.  
Once a Journal is open, you can enter text, data or both. To enter text, just click the cursor in the journal 
area and begin typing. This is especially useful for noting the date and time of a recording, what was 
involved, and so forth. 
You may also paste measurements and waveform data into the journal. 

¾ To paste measurements into an open journal, select the desired area or point and 
choose Paste measurements from the Edit > Journal menu. This will paste all 
visible measurement window data into the journal. 

¾ To paste waveform data into the journal, select the desired area and choose Paste 
Wave Data from the Edit > Journal menu. This will insert a text file of the 
waveform into the journal, where points and trends can be analyzed. 

Open a Journal 

 C

The journal is a general-purpose text editor built into the PRO software. The journal is essentially an
“electronic notepad” that allows you to record notes and data at the same time you are acquiring data. 
Using the journal, you can store waveform data (in numeric format) or make notations and comments i
text file. One common function of a journal is to save comments and other similar information about 
acquisition in a text file, so that this information can be referenced later. The journal works in connection 
with Find Peak and other measurement functions to 

lick the Journal  icon oose Display>Show>Journal on the toolbar or ch . 
 

 the top of the Journal window and drag it 

Ent
 text, just begin typing when the journal is open. To automatically “wrap” the 

text to fit the screen width, use the wrap option in the File > Preferences > Journal 
click the right-mouse button in the Journal window and select 
Window from the shortcut menu. To change the font or tabs of 

the Journal, use the Display > Preferences > Journal dialog. 
Time Stamp, Date Stamp and Auto-time functions 

Each graph window has its own “embedded” journal. The journal is displayed below the
graph window and will be saved with the graph file. 

Resize a Journal 
To resize the journal window, click the bar at
up (to increase the size) or down (to decrease the size).  

er Text 
To enter

submenu. PC users can 
Wrap Text > Wrap to 

 These options are available in the upper left corner of the journal window 
and refer to the computer’s clock to record the time and/or date directly into the Journal. 
The Time option is a clock icon and the Date option is a calendar icon. Just click the icon 
to activate the option. The Auto-time function records the time at the instant the carriage 
return is pressed, which is useful for tagging commands as data is collected. To activate 
“Auto-time” click the clock icon with the left-pointing arrow. 
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Journal File Functions 

 The Journal file icons perform the following functions (as displayed from left to right): 
 

New The page icon will clear the Journal and provide a blank page. 
fil ill be lost. 

 
Op text” from any simple text file, including 

sed, the open folder icon will generate a 
he default file type is “text.” Only files of type “text” (.txt) can 

be opened and loaded into the Journal. Upon selecting a file, the text in the selected file 
will be “loaded” into the Journal. If there is already text in the Journal, the new text will 

n, the cursor location moves to the 
end of the newly inserted text block. 

 
Save  The disk icon will generate a Save As function dialog. The data in the journal will be 

saved in simple text (.txt) format. 
 
Print  The printer icon will generate a Print function dialog. 

 
Paste measurements and data into the journal 

To paste measurements into an open Journal, select an area, then select Edit > Journal > paste 
measurements (Ctrl+M). The measurements in the measurement windows are copied into the 
Journal. By changing the Journal Preferences, you can simultaneously record measurement name, 
channel number, and units. 

 
Paste waveform data into the journal 

To paste waveform data into a journal, select an area, pull down the Edit menu, select the Journal 
option and choose Paste Wave Data (Ctrl+D). The result is a text file of wave data from the selected 
area for all channels pasted into the active journal. 

 
Note: See pages 152 and 190 for more information about pasting data to the Journal. 

 
 
Saving data 

Once data has been collected, it can be saved as a file and opened later. The data file can be moved, 
copied, duplicated and deleted just like any other computer file. By default, files are saved .ACQ 
files, which use a proprietary format designed to store information as compactly as possible. 
Although these files can only be opened with the Biopac Student Lab PRO software, the data in these 
files can be exported either as a text file or as a graphic image. 
Exporting data to a text file allows you to examine the data using other programs, such as a 
spreadsheet or statistical analysis package. Saving data as a graphic (.WMF format) enables you to 
work with the data in graphic format. 

 
 

age layout programs. To learn more about these options, turn to 
the Save As

 
 

Any Journal entry not saved to a separate e w

en The open folder icon is used to “load 
previously saved journal files. When pres
standard “Open” dialog. T

be inserted at the current cursor location. After insertio

� One of the most useful applications of the Save As options is the ability to edit and place Biopac
Student Lab PRO data as it appears on the screen. You can use this feature to paste graphs into word
processors, drawing programs, and p

 section beginning on page 176. 
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Printing 
In some cases, it is important to have a hard copy of the data. The Biopac Student Lab PRO software 
allows you to
choose Prin

 produce high-resolution plots of graphs much as they appear on-screen. To print a file, 
t from the File menu. An example of the print dialog box follows.  

 
Print dialog box 

 
If you click d on the selected printer. 
¾ To print Autoscale Horizontal from the Display menu first, so that the screen 

Often, you may want to print the contents of a file across several pages. To do that, change the value in 
the 4” in this box, for instance, will place the length of the page evenly 
acro fo

OK, the contents of the screen will be printe
 the entire file, choose 

contains the entire record. 

Fit to __ pages box. Entering “
ss ur epag s when printing. To find out more about the Print command, see page 179. 
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Chapter 4 Creating Your Own Lessons 
 
The multi-level learning features of the BSL software let you control the material and method o
experiment. Use our 17 guided- BSL Lessons for introductory concepts, modify them with your ow
procedures or analysis techniques, choose from 35+ PRO Lesson

f each 
n lab 

s for advanced concepts, or easily create 
L for graduate programs and advanced research. BSL lesson 

experiments are included in a number of the leading published lab manuals and have been successfully 
used to study: 

ECG  
EEG  
EMG 
EOG  
GSR (EDR) 

Biofeedback 
Bioimpedance/Cardiac 
Output 
Blood Pressure  
Heart Sounds 

Nerve Conduction 
Pulmonary Function 
Respiration 
Rea tion Time 
Temperature

By combining two of the new features it is possible to create your own lessons. The graph template 
function (described on page 174) allows you to save custom settings. The menu customizing function 
(described on page 64) allows you to remove menu options that are not required in your lesson. This 
prevents students from being confused by unnecessary options. 
To create your own lesson: 

) Set the channel, acquisition, and display options ou require.  
Type any comments and/or instructions for your students into the Journal window. 

¾  To open a journal window: Select Display > Show > Journal or click the toolbar icon 

your own lessons. You can even use the BS

c

1
2) 

 y

. 
3) Select “File > Save as” and choose “Graph 

Template” from the file type options in the 
dialog. 

4) Create a new folder, then name it appropriately 
for your lesson. 

5) Save as a graph template (.gtl) file in the new 
folder for your lesson. To further protect your file 
settings, set the Read-only attribute in the file 
Properties dialog. 

6) Clear the Journal window using the clear journal 
icon in the journal tools section. 

Journal tools =   
clear journal / open file /save file /print journal 

7) Copy and revise the Startup menu to turn  “OFF” 
the menu items you do not require (page 64). 

ave the Startup file as directed. 8) S
 

Menu customization will be applied when the BSL PRO 
soft
 

 
 

 

ware is next launched 

See Application Note PS202 at www.biopac.com for more detailed instructions. 
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Customizing Menu Functionality 
The BSL PRO software includes a powerful customization feature that lets you choose the program 
features to display as menu options. If you have a specific procedure, you can limit the menu options to 
list only those functions you need, thereby reducing the chance for confusion or error in your lab. For 
instance, you might want to display (or not display) the menu options for BSL PRO, as discussed in 
“Adding BSL PRO Analysis Features to BSL” on page 68.Or you might want to choose to remove Setup 
options from the MP35/30 menu, as shown below:  

 
 0 menu Customized MP35/30 menu 
When B
translate ap
that are not unit is connected (only if installed for Hardware). If 
disconnected, it generates the communications error prompt. 
Follow the simple procedure below to customize the startup for your own needs. 

1) Open the BIOPAC Program folder (default installation used C>Program Files>Biopac Student 
Lab>BSL 3.7). 

Default MP35/3
SL PRO is first launched, a “startup” routine runs to establish any global application variables; 

plication prompt and dialog text (mainly if language other than English); remove any menus 
used in the PRO; and check if the MP 

 
2) Open the BSL PRO 3.7 folder. 
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3) Copy the Startup file. 

a. Right-click the Startup file and scroll to select 
“Copy.” 

b. Right-click in the folder and scroll to select 
“Paste.” 

 

 

 

is for backup). 
a. Choose to select a program from a list and 

select Microsoft WordPad if prompted for a 
program to open Startup with. 

 

4) Open the original Startup file (“Copy of startup” 

 
5) Follow the instructions provided in the Startup file.  
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 The Startup script is sensitive to syntax errors, font change, name change, etc., so be extremely 
careful not to change anything — just add or delete semicolons at the start of the line that contains 
the menu item you want to change. 

a. Remember to use File > Save (not Save As!) to save your changes so the script file name 
is exactly the same — the program will not recognize an altered file name. 

b. Do not alter lines above or below the specified area. 

c. To hide a menu/menu item, delete the semicolon (“;”) at the start of the line that lists it. 

Visit the online support center at www.biopac.com 
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d. To show  it.  a menu/menu item, add a semicolon (“;”) at the start of the line that lists

 
 

6) Select File>Save
a. DO NOT E the “SAVE AS” option. 
 

7) Restart the BSL P
 
8) Check your menu

a. The MP r step 
5e above re no 
longer in

b. If you ha am 
folder. 

 to save the revised Startup file. 
 US

RO 3.7 program. 

 listing. 
menus on page 64 show the result of changing the MP35/30 Menu items pe
. Note that the Setup options, AutoPlotting, and Organize Channel Presets a
cluded in the menu listing (rather than simply being disabled and grayed-out). 
ve the desired menu result, you may delete “Copy of Startup” from the progr
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Adding BSL PRO Analysis Features to BSL Review Saved Data Mode 
tween each level of the Biopac Student Lab is the number of software options The primary difference be

employed. The standard version uses pre-configured lessons to manage the setup, collection, and analysis 
of data. The PRO version affords a greater degree of control over the setup and data collection 
parameters, although with a slightly different “look and feel.” The following PRO features can be 
activated within Review Saved Data mode of the BSL Lessons: 
BSL PRO Analysis Tools in RSD Mode Default BSL Analysis Tools 
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To activate the PRO software features for the Review Saved Data mode of the BSL Lessons, you must set 
the PRO menu option in the BSL Lesson startup file. The procedure is outlined below, and more fully 
detailed in “Customizing Menu Functionality” on page 64. 

1) Locate the BIOPAC Program folder (default 
installation used C>Program Files>BIOPAC). 

2) Open the BSL v 3.7 folder. 
3) Open the BSL Lessons Folder. 
4) Copy the Startup file to create a backup. 
5) Open the original Star

text editor such as Word Pad. 
tup file (not the copy) with a 

6) Locate the “REVIEW SAVED DATA MODE OPTIONS” section. 
Set Q = 0 to enable BSL PRO menus, as noted in the comments. 

 
7) Select File>Save to save the revised Startup file. 
� DO NOT USE the “SAVE AS” option. The file must retain the exact same name as the 

original startup file. 
8) Close the Startup file. 
9) Restart the BSL program. 
10) Check the menu listings. 
� If you have successfully configured the startup script, the menus will now have the BSL PRO 

options specified on page 68 and you may delete the copy of the startup file that you created 
as a backup from the program folder.
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Part C — Acquisition Functions: The MP35 Menu 
 

 
 

This section describes the 
MP35 Menu. Acquisitio

various acquisition parameters for the Biopac Student Lab PRO that can be set under the 
n is defined as data collection from an external source (such as electrodes connected to an 

 

 
 

 d) Set a
 

isplay values numerically and graphically during an acquisition 

e Setup Channels and Setup Acquisition menu items are inactive (grayed) during acquisition. 

 more  
d

MP35 input channel). Biopac Student Lab PRO software adds acquisition and control capability to the BSL System. 
The MP35 Menu commands and procedures can be used to: 
 

a) Setup channels for data acquisitions 
 
b) Control acquisition parameters such as sampling rate and duration 
 
c) Perform online calculations and apply digital filters 

cquisitions to begin on command from a mouse click or external trigger 

 e) D
 

 f) Output waveforms and digital signals during an acquisition 
 

 g) Control the on-screen waveform display characteristics 
 
Note: Th
Recording Data (Part B) covered some of the basic functions involved in setting up an acquisition. This section will 
cover the same functions in  detail, as well as describe some features not discussed in Part A or Part B. All the
commands covered here can be foun  under the MP35 menu. 
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Chapter 5 Recording Basics — Acquisition Overview 
Setup Channels 

Basic PRO Channel Setup 
Before you acquire data, you must specify which channels you will collect data from and establish their respective 
input parameters. The first step is channel setup. To access the channel setup options, select Setup Channels from 
the MP35 menu. 
The minimum setup is to acquire analog data from one channel, which is the default (on CH1). You must set Setup 
Channels options prior to starting the acquisition. You cannot change the channel setup during acquisition. The 
MP35/30 > Setup Channels menu item is inactive (grayed) during acquisition. 
BSL PRO can record and display up to four analog input signals from devices connected to the analog inputs on the 
front of the MP35 Acquisition Unit. It can record and display signals from up to eight digital inputs signals 
connected to the I/O port on the back of the MP35. In addition, BSL PRO can perform calculations based on the 
inputs and display and save them as separate signals. All three types of signals are referred to as “channels.”  

 
up Channels dialog is divided into sections for Analog Input Channels, Digital Input Channels, and The Set

a) 
b) 
c) 
d) 

Calculation Channels. Each channel type has options for:  
Acquire Data 
Plot on screen 
Enable Value Display 
Label 

MP35 required 
for Digital Input 
Channels 
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Analog Input and Calculation channels have options to select Presets and View/Change Parameters. 

ferences between 
the types of data each channel is designed to handle. Setup options will be discussed briefly

 
Note: Setup options function similarly for each channel type, although there are considerable dif

 here. See the 
Advanced Channel Setup

 
 beginning on page 73 fo more details. r 

Setup Channels Dialog 
Channel Channels are designated alpha-numerically. Analog (or continuous) Input 

channels begin with “CH” and run from CH1-CH4. Digital Input channels 
begin with “D” and run from D1-D8. Calculation channels begin with “C” 
and run from C1-C12. Display is limited to four channels of each type. Use 
the scroll button to set up additional Digital and Calculation channels. 
 

Acquire Data The Acquire data box must be checked for the software to collect data 
from a channel. 
 

Plot on Screen The Plot on Screen box indicates whether or not data for each channel will 
be plotted on the screen. When unchecked, data will still be collected (if 
the Acquire box is checked), but it will not be displayed during the 
acquisition.  
 

Enable Value Display 
 

This option enables incoming data values to be displayed during an 
acquisition, either numerically and/or in “bar chart” format. Values are 
displayed in a separate Show Input Values window activated unde the 
M
 

You may attach an editable “label” to each channel. Channel labels allow 

hannel, position the cursor in the Label box and revise the text. 
 

Presets 
 

Preset parameters are provided for specific kinds of physiological data 
(e.g., ECG, EEG. EMG, etc.). Set the preset the parameters for each 
channel to match the type of data you are collecting. The preset values are 
designed to be good starting points for most acquisitions, though you may 
wish to modify them for your particular laboratory situation. 

Click the Presets button 

r 
P35 menu. 

Label 
 you to provide a brief description for each channel. To change the label for 

any c

 to generate a list of available presets. 
Scroll to select the Preset you want to apply to the selected channel. You 
can also establish custom parameters and save your own Presets. 
Presets are available for Analog Input and Calculation channels but not for 
Digital Input channels. 
 

View/Change Para Click the Settings button meters  to generate an Input Parameters dialog for 
the selected Preset. To access the scaling parameters, click the Scaling 
button at the bottom of the Parameters dialog. 
View/Change Parameters options are available for Analog Input and 
Calculation channels but not for Digital Input channels. 

Visit the online support center at www.biopac.com 
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Advanced Channel Setup 

tions involve collecting analog signals and then displaying them on screen. It is frequently useful, 

 Channels, and 
 da  on, there are three options: Acquire Data, Plot on 
quiring, plotting, enabling value display, labeling) are 

siderable differences between the types of data each 
 Input channels and Calculation channels allow you to 

The previous section covered the basic options used in almost all acquisitions. In addition to the features described 
above, a number of other options are available in terms of setting up channels. These advanced features are also 
found under the MP35>Setup Channels menu item. 
Most acquisi
however, to collect other types of data (digital data, for instance) or to perform transformations (calculations) on data 
as it is being acquired or after it has been acquired.  
The Setup Channels dialog is divided into three sections, Analog Input Channels, Digital Input
Calculation Channels. For each channel you wish to collect
Screen, and Enable Value Display. The general features (ac
the same for each type of channel, although there are con

ta

channel is designed to handle. Additional options for Analog
set Presets and View/Change Parameters.  
 

 
 
Channel 
This is the alpha-numeric channel designation. Analog Input channels are designated CH1-CH4, Digital Input 
channels are designated D1-D8 and Calculation channels are designated C1-C12. The dialog displays only 4 
channels at a time. Use the scroll button to display and set up additional Digital Input and Calculation channels. 

MP35 required 
for Digital Input 
Channels 
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Channel Types 
Acquisitions involve collecting analog or digital signals and then displaying them on screen. It is frequently useful, 
however, to perform transformations on da fter it has been acquired. Channels 
containing transformed data signals are ref lect up to four Analog 
Input channels, 8 Digital Input channels, and 12 Calculation channels. Analog and digital channels may be acquired 
in any combination, and the only requirem
channel (either analog or digital). 
Analog Input channels are the most comm inuous” 
values. Examples of this include nearly all
electrodes) produce a continuous stream of
range of ±50 mV, although voltages as hig
displays up to four analog signals from dev of the MP35 
Acquisition Unit. 

s 

up 

ta as it is being acquired, or a
rred to as Calculation channels. The MP35 can cole

ent for Calculation channels is that they be based on at least one input 

on type of channel and are used to acquire any data with “cont
 physiological applications where input devices (transducers and 
 varying data. The range of values for analog channels is typically in the 
h as ±50 V can be measured with BSL PRO. BSL PRO records and 
ices connected to the analog input ports on the front 

Digital Input channels, in contrast to analog input channels, are designed to collect data from a signal source with 
only two values (0 and 1). This type of data can be useful in recording whether a switch is open or closed, and 
ascertaining if a device is on or off, as in reaction time studies or control applications. Input values for digital 
channels have two values, +5 Volts and 0 Volts. The MP35 interprets +5 Volts as a digital 1 and interprets 0 Volts a
a digital 0. Since digital channels have a fixed value, the parameters and scaling options are disabled for these 
channels. The main function of digital channels is to track on/off devices such as push-button switches and/or to 
receive digital signals output by timing devices. Similarly, these channels are also used to log signals from devices 
that output auditory/visual stimulus for examination of stimulus response patterns. BSL PRO records and displays 
to eight digital signals from devices connected the I/O port on the back of the MP35 acquisition unit. 
 

0 volts

+5 volts

Positive edge Negative edge 

(binary "1")

(binary "0") 

 

Calcula o). 
The orig
channel
math fu
Up to 12 put for 
another channel, as long a
is p
Thi
filtering ECG data then computing BPM. 
Eac
memory requ y want to consider performing some 
of t

Not are OFF by default. To turn a Calculation channel on, click the 

Digital Input Channels Have a Fixed Value 
 

tion channels transform incoming data in some way (rather than collect external data as input channels d
inal data is not altered — it is just stored in a modified form on a new channel. You can use Calculation 

s to compute a host of new variables by using transformations (such as BPM, integration calculations, and 
nctions). 
 Calculation channels can be acquired. You may use the output of one Calculation channel as the in

s the output channel has a higher channel number than the input channel. In other words, it 
ossible for Calculation channel 3 to include the result of Calculation channel 1, but not the other way around. 
s allows for complex Calculations to be performed that involve two or more Calculation channels, such as 

h Calculation channel acquired will reduce the maximum possible sampling rate and increase the amount of 
ired to store data both during and after an acquisition. Thus, you ma

hese functions after the fact if high sampling rates are needed for your particular application. 

es: Calculation channels  Presets button 
for that channel and make a selection from the menu. 

9 TIP All of the calculations that can be performed online can also be performed after an acquisition has 
been completed. These options are available under the Transform menu. 

Visit the online support center at www.biopac.com 
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Acquire Data 
Check the option Acquire Data if you wish to collect data on a channel. Unless you specify otherwise, BSL PRO by 
default will only collect data on Channel 1. To collect data on other channels, position the cursor over the Acquire 
box (on the far left) and click the left mouse button. Toggle the Acquire box to uncheck. 
¾ With BSL PRO, it is possible to leave hardware connected to the MP Acquisition Unit, but have the software 

essentially “ignore” the channel by leaving the Acquire box unchecked. Thus, if an input device (such as a 
force transducer) is connected to the CH3 input on the MP, data from that channel will not be collected unless 
the CH3 Acquire box is checked. 

Plot on Screen 
The second option determines whether or not data for each channel will be plotted on the screen. In most cases, you 
will want to check this option. When this box is left unchecked, data will still be collected when the Acquire box is 
checked, but it will not be displayed during the acquisition. 
Disabling Plot on Screen can be useful for 
a) Large scale acquisitions (i.e., multiple channels and/or high sampling rates). This will allow for faster display 

rates (see Appendix B - Hints for worki ptions). 
b)  but not need to see 

the 
Enable l
The thir ng data values to be displayed either numerically and/or in a “bar chart” format in a 
separate 
window (by o
the Enable Val
¾ te, respiration rate, or 

con t
to page 

9 TIP Hold down the Ctrl (PC) or Option (Mac) key while you check an Acquire, Plot, or Enable Value Display 
box to to  Acquire boxes are 

l be 

You
label fo s. 
When a
A ch n
cha  
Presets 

meters. There are two ways to establish channel parameters. You make a 

ng with Large Files for other o
Calculation channel setup. For example, you may need the ECG Rate data for a calculation,

ECG display. 
Va ue Display 
d option enables incomi
window during an acquisition. Checking Enable Value Display allows you to open an Input Values 

 ch osing Show Input Values... under the MP35 menu) that displays the value for each input that has 
ue Display option checked. 

This option is especially useful for tracking slowly changing values such as heart ra
cen rations of chemicals in a substance. For more information on how input values are displayed, please turn 

142. 

ggle the entire column of boxes for that option. In other words, if none of the
checked and you check the Acquire box for CH1 with the Ctrl key depressed, the Acquire boxes wil
checked for all channels. If the Acquire box for CH1 is then unchecked while the Ctrl key is depressed, 
the Acquire boxes for all channels will be unchecked.  

 
Label 

 may attach an editable “label” to each channel to provide a brief description for each channel. To change the 
r any channel, position the cursor in the Label box and enter a text label. You may key up to 38 character
 Preset is selected, a corresponding preset Label description will be automatically entered. 
el’s label is used in the displayan  window and for a variety of software dialogs. If you revise a label entry, the 

nge will display after you start an acquisition. 

Presets are like “templates” for channel para
selection from the Presets  menu and (1) use the corresponding default parameters or (2) modify the Preset

g the View/Change Parameters 
 

usin  tool. 
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Analog Input Channel presets Calculation Channel Presets 

esets button Click the Pr  to generate a list of available presets. Scroll to select the Preset you want to apply to 
the elected preset name. 
Preset param
the para t
good startin
situa Presets. 
Ana
the t
See log Presets beginning on page 250 and the 
Tab  that each preset specifies.  
 
An importa

selected channel. When you select a Preset, the channel Label will change to reflect the s
eters are provided for specific kinds of physiological data (e.g., ECG, EEG, EMG, etc.). Set the preset 

me ers for each channel to match the type of data you are collecting. The preset values are designed to be 
g points for most acquisitions, though you may wish to modify them for your particular laboratory 
ou can also establish custom parameters and save your own tion. Y

log Input Presets and Calculation Presets are mutually exclusive and control different settings, as appropriate for 
ype of data each channel contains. Presets are not available for Digital Input channels. 
Channel Presets on page 92 for more information. The Table of Ana
le of Calculation Presets beginning on page 260 provide details on the settings

nt concept to understand about Presets is that each channel uses its own set of parameters. When you 
select a s  
parameters nnel, the settings are no longer tied to the Preset. That is to say, any modifications you 
mak t the 
Pres f

If you want
availabl o

meters 
you establish. 
You will see the following dialog if you have been successful: 

 Pre et, the software performs a one-way dump into the channel to establish the parameters. Once the preset
are set in the cha

e to the settings in the Input Parameters dialog after you select the Preset will affect only that channel, no
et  Iile. f you choose the Preset from the menu again, the original, default settings of the Preset will be used. 

 to create a new preset so your modified parameters are 
e f r other channels, just change the Channel Preset name 

et to a new, unique name. This enables the New Channel Pres
button. Click the button to create a new Preset with the para

 

Note: You can use the Organize Channel presets option from the MP35 menu to rename, rearrange or delete 
Presets. For instance, you might move frequently used Presets to the top of the list. See page 145 for more 
information. 

 You can use the Save As Template option from the File menu to save setup parameters in a BIOPAC graph 
template file (.gtl). A Graph Template never contains data; it only contains the setup parameters. Templates 
only save MP35 Menu functions — this includes calculation channel functions, but not their Transform 
menu counterparts. Graph templates will open to the same window displays and positions you closed the file 
with. See page 174 for more information. 

Visit the online support center at www.biopac.com 
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View/Change Parameters 

The settings for a Preset can be accessed via the  Vie /Change Parameters button in the Setup Channels 
dialog. This will generate an Input Channel Parameters dialog for the specified channel Preset. 

w

 
Sample Analog Input Channel Parameters Dialog 
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Sample Calculation Channel Parameters Dialog 
 
Scaling 
To acce bot
Change

ss the scaling parameters, click the Scaling button at the tom of the Parameters dialog. This generates the 
 Scaling Parameters dialog. 

  
Analog Scaling  Calculation Channel Scaling  

 Scaling options vary based on the channel type. For Calculation channels, the Input value must be 1,000x the Scale
Value for a 1-to-1 scaling (mapping) result. See the following pages for further explanation of scaling. 

Visit the online support center at www.biopac.com 
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Analog scaling 
The PRO software allows you to rescale the signal on analog channels to more meaningful numbers. As an example, 
let’s say a temperature transducer is connected to channel 1. Ordinarily, the values from the input channel would be 
read in as milliVolts. For this acquisition, the signal from the transducer should be expressed in terms of degrees 
Fahrenheit. 
To calibrate the transducer, you would bring it to two known temperatures. At the first temperature you’d take a 
voltage reading by selecting Show input values from the MP35 menu. At 90° F, you’d get a reading of 0 Volts. The 
transducer would then be brought to a temperature of 95° F, and you’d get a reading of +1 Volts. 

To have the software map the incoming signal to degrees F, 
click the “Scaling” button at the bottom of the Parameters 
dialog to open the Change Scaling Parameters dialog. 
The Input value and Scale value boxes reflect the value of 
the incoming signal and how it will be plotted on the screen, 
respectively. Enter these numbers into the Channel Scaling 
Parameters box, type in the new units as “degrees F,” and 
click the OK button. Then click OK again to close out of the 
Input Channel parameters. 

 See Calibration Guidelines on page 273. 
The software calculates the slope and offset from the two 
points entered. Each data sample from channel 1 will be 
scal
prev

 

ed according to the slope and offset calculations 
iously made. When an acquisition is performed, the 

amplitude scale (vertical axis) will reflect the rescaled units. 

 
Scaling set to rescale from Volts 

s 

s 
 

the transducer to another known value that is considerably higher or lower than the first, click Cal 2 and 

to degrees Fahrenheit 

Note:  An incoming signal of +1 Volts would be plotted as 95° F, whereas a signal of 0 Volts would be plotted as 
90° F. The software will perform linear extrapolation for signal levels falling outside this range (i.e., -2 Volt
will be mapped to 80 ° F), as well as perform similar interpolation for values between this range. 

As a shortcut for scaling analog channels, you can use the Cal 1 and Cal 2 buttons. Click either one of these button
to read the current voltage for the selected channel. Set the transducer to a known value (i.e., temperature) and click
the Cal 1 button, then enter the value in the Scale value box for Cal 1. 
Then bring 
enter the new known value in the Scale value box for Cal 2. The software calculates the slope and offset from the 
two points entered. Each data sample from the selected channel will now be scaled according to the slope and offset 
calculations previously made. When an acquisition is performed, the amplitude scale (vertical axis) will reflect the 
rescaled units. 
 

It is important to note Cal 1 Cal 2 that  and  may be set when data is being acquired but will not take 
effect until the acquistion is stopped and then restarted. A channel must be calibrated before data 
acqui e calibration for a given channel, connect the input device to the MP35 and sition. To set th
power up the BSL PRO System, then perform calibration before starting data acquisition. 
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Calculation channel scaling 

 
Input value 10 V constant 
 
Scale valu ut value x (sample rate/samples to be mean averaged) 
 

e Inp

 

It is important to note that this rescaling should be performed 
independen ny rescaling performed on analog channels themselves. t of a
Even if an analog channel is being rescaled to some other units, the Input 
values in t culation channel scaling should be set to +10 Volts (next he cal
to Cal 1) a  Volts (next to Cal 2). 
 

The "Scaling" option for Calc n Channels corresp  to the source Analog Channel input (and not the source 
channel's mapped value). Typically, the default scaling settings will be fine. However, if the calculation values will 
be on a different scale than the original units, you nee ange the scale of the calculation channel to reflect the 
new units (i.e., liters/sec to liters). Click the Scaling… n to generate the Change Scaling Parameters dialog, 
which includes options that allow you to modify the units or linearly scale the output. 
Rescaling involves multiplyin  a r determined by the sampling rate and number of samples 
mean averaged across. As an example, if data was acq  at 75 samples per second and you wanted to integrate 
across an in f 10 samp ou would set the Integrate > Scaling parameters so that an Input value of +10 
Volts corr  to a Scale value of 75 and an Inpu e of -10 Volts corresponded to a Scale value of -75. 

Plot Standard Curve 

nd -10

ulatio onds

d to ch
 butto

g the “Input value” by  facto
uired

terval o les, y
esponded t valu

 

 The Plot Standard Curve command is only available in X/Y mode. A Standard Curve   is a graph used 
in colorimetry to help determine the concentration of a solution, wherein the light absorbance value of the 
solution is compared to standard values. 
BSL PRO can generate a Standard Curve on a plot of Concentration vs. Absorbance of known solutions, which 
can then be used to determine the concentrations of unknown solutions. 

About Standard Curve 
Colorimeters, or spectrophotometers, are useful for determining such things as the amount of glucose, 
cholesterol or protein in blood. Colorimeters use a monochromatic light source (composed of a single 
wavelength). They output an Absorbance value, which is a measure of the percent transmission of light 
through a liquid. Because the light is monochromatic, Beer's Law can be applied. Beer’s Law states that the 
absorbance value is directly proportional to the concentration of the solution. One or more solutions of 
known concentrations, called Standards, are used to generate a “Standard Curve”plot. The concentrations of 
unknown solutions can then be determined from the Standard Curve data. 

 
Before plotting a Standard Curve, you must first set up two Channels in a BSL PRO file to represent your X-axis 
(normally “Concentration”) and Y-Axis (normally “Absorbance”). Refer to “Setting up a file to plot a Standard 
Curve” on page 82. 

9 Consider starting with the sample file “StandardCurve.acq” for preset X-Axis and Y-axis units and scale. 
Review the sample file “StandardCurveData.acq” for sample data. 

Plot your curve by pressing the Plot Standard Curve button on the Toolbar.  This will generate the Plot 
Standard Curves dialog. 

Visit the online support center at www.biopac.com 
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Plot S

1. For each
tand d Curve Dialog ar

 standard data point to be plotted, place a sta
a. Enter values for the X

ndard in the colorimeter and then 
[Concentration (mg/100mL)] and the Y-axis (Absorbance) from the 

t it from the list and click Delete. If a curve has been previously plotted, 
 points generates an alert that the previous curve will be deleted. 

2. Once all data points have been entered and added to the list, click Plot Curve. 
n the g as a “best 

a.. 

-axis 
colorimter 

b. Press Add to List. 
• To delete a data point, selec

adding and deleting

• The standard data will be displayed i
fit” line drawn through the standard dat

raph as dots and the standard curve will be plotted 

 
A typical Standard Curve (blue line) plotted through Standard data (red dots) 

When you click a plotted data point in the graph window with the Cursor, its X-axis and Y-axis values are 
displayed in the measurement region. You may record these values to the journal, if the journal is open, by right-
clicking and choosing “Paste Values to Journal.” 

To determine the concentration of an “Unknown” solution: 
1. Place unknown solution in the Colorimeter and obtain the Absorbance value. 
2. To find the Absorbance value in the graph, click and hold the left mouse button, which activates the “snap 

to” data function, and move the mouse to the left or right until the Absorbance value is displayed in the 
cursor reading (upper left portion of graph). When the Absorbance value is displayed, its corresponding 
Concentration will be shown.  

3. To paste the Absorbance and Concentration values into the journal, right-click (while the left button remains 
pressed) and choose “Paste Values to journal” from the pop-up menu. 
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Standard Curve Settings 
Standard Curve Settings sets parameters for the Standard Curve to be plotted. If a curve has been previously 

to 1 
units. Enter new range values to expand or limit the points on 
your list that are referenced when plotting the curve. 
Plot using: Sets the resolution, or number of samples, of the 
plotted curve. The default is 100. 
When plotting Standards, use: Allows control of dot color 
and size of the standard points on the list to be plotted. 
Choose from the pull-down menu to enter a new setting. 

rve is a signed on the X-
king in e graph and 

etting up a file to plot a Standard Curve 
PRO file with default parameters.  

d set CH1 and CH2 for Acquire Data and Plot on Screen. 
“Concentration” and change Scaling units to “mg/100 ml.” 

or Channel 1 and change the channel Label to “Concentration.” Click 
abel to “mg/100 ml.” Click OK to accept the new scaling parameters. 

n to close out of the Input Channel Parameters dialog. 
4. Change the Label for Channel 2 to “Absorbance” and change Scaling units to “A.” 

rs for Channel 2 and change the channel Label to “Absorbance.” Click 
 label to “A.” Click OK to accept the new scaling parameters. Click OK 

nnel Parameters dialog. 
. 

n of the graph window to acquire a small amount of data. 
king its icon on the Toolbar.  

tablish “Concentration” for the X-axis and “Absorbance” for the Y-axis. 
yed above the waveform window and choose Ch1, Concentration for 

l displayed to the left of the waveform window and choose Ch2, Absorbance 
for the Y-axis. 

9. Scale the X-axis (Horizontal Scale) and Y-axis (Vertical Scale) appropriately for your experiment. 
nd set the “Concentration” scale to go from 

your experiment. 
ale

Setup is now complete and 

plotted, an alert is generated and the graph is immediately updated to reflect the new settings. 
Plot From/To: Defines the range of Y-axis values for the 
data points to be plotted. The default range is from 0 

(Note: The color of the standard cu
axis channel, selected by right-clic
choosing the Color option.) 

s
 th

S
1. Launch BSL PRO to a new BSL 
2. Choose MP35>Setup Channels an
3. Change the Label for Channel 1 to 

• Click View/Change Parameters f
Scaling and change the Units l
Click OK agai

• Click View/Change Paramete
Scaling and change the Units
again to close out of the Input Cha

5. Close the Setup Channels dialog
6. Press the Start and then the Stop butto
7. Go to the X/Y display mode by clic
8. Es

a. Click in the X-axis label displa
the X-axis. 

b. Click in the Y-axis labe

• For example, set the “Absorbance” scale to go from 0 to 1, a
0 to 100 mg/100 ml. Your actual scale settings will depend on 

• To set the sc s, click in the horizontal and vertical scale regions, respectively. 
you are ready to plot the curve. 

Visit the online support center at www.biopac.com 
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Chapter 6 Set up Acquisitions 

 
Once you have selected the channels to be acquired, the next step is to set up the acquisition parameters under the 
MP35 menu. Among other things, these options control where data will be stored during an acquisition, the sample 
rate for data collection, and the duration (length) of each acquisition. The dialog box that allows these options to be 
set is generated via Set up Acquisition under the MP35/30 menu. You must establish acquisition parameters prior to 
pressing the “Start” button. The MP35 > Setup Acquisition menu item is inactive (grayed) during acquisition. 
Data storage options 
There are three pull-down menus at the top of the Set up Acquisition dialog that allow you to control how and 
where the acquisition data will be saved. 
 
1)  Record/Record last controls whether the software saves all the data or only the most recent segment. 

• Record will store data for the amount of time specified in the acquisition Length box. This is the 
default and is appropriate for almost all types of acquisitions. 

• Record last  will acquire data continuously, but store only the most recent segment of data (equivalent 
to the duration in the acquisition Length dialog box). That is, if the value in the acquisition Length box 
is 30 seconds and Record last is selected, data will be acquired data ad infinitum, but BSL PRO will 
store only the most recent 30 seconds of data. 

 
2)  Save once/Autosave file/Append allows you to vary how the data is saved to a file. By default, BSL PRO will 

append acquisition data to a single continuous file. 
• Save once  will begin an acquisition when the  button is clicked and will stop acquisition either 

when the acquisition Length has been reached or when the  button is clicked. 
• Autosave file  enables you to perform several acquisitions one after another and save the data from 

each acquisition in a separate file. 

When Autosave file is selected, a  button will 
appear by the Sample Rate entry cking on
File… button generates an “Autosave File Setup” 
dialog that prompts you to choose the root file name 
for the data from each acquisition. 

box. Cli  the 
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• Append allows
periods. Append m

 you to pause the acquisition for arbitrary 
arkers  are automatically inserted to 

set marker labe .) The Append mode is 

indicate where each appended acquisition segment 
begins. (See page 164 to customize append markers 
and/or pre ls
unique in that clicking on the  button only 
pauses the acquisition, which can then be restarted by 
clicking on the  button. This can be helpful when 
recording only a few key events that will occur randomly 
over a long period of time, since it will reduce data 
storage and transformation processing. 

 

 When Append is selected, a Reset button is generated in the Setup Acquisition dialog. Clicking on 
the Reset button erases the acquired data file and “continue” the acquisition. (This is essentially the same as 
saying yes to an “Overwrite existing data?” prompt.) 
Each time an acquisition is restarted, an append marker  is automatically inserted into the record sho
the time at which the MP35 restarted data acquisition. 

wing 

 

 When Append is selected, the display mode is set to Chart or Scope, and at least one segment of data 
has been acquired, the Overlap Segments icon is enabled on the Toolbar. The Overlap Segments display 
mode overlaps appended segments of data. See Overlap Segments, page 44. 

lthough you can pause for any period of time, the Biopac SA tudent Lab PRO will only acquire data for the 
amount of time indicated in the Acquisition Length box. 
Data can only be acquired in Append mode while being saved to PC memory. 
When used in conjunction with the external trigger, the Append mode can be a very useful acquisition tool. 
An acquisition that takes place over a long period of time with brief events which are few and far between 
can be set up in the following manner: the researcher watches for the events, triggers the acquisition to start, 
and then lets the pre-defined acquisition length run out. When another event of interest occurs, the researcher 
triggers the next acquisition. This acquisition will be “appended” onto the end of the first acquisition. 
Memory is the only limit as to how many “appendages” can be added. 
 

3)  PC Memory/Hard Disk controls where data is stored during an acquisition. The best choice depends in large 
part on the nature of the acquisition itself and the type of computer being used. 

• PC Memory  will store data in computer memory (RAM) during an acquisition. After the acquisition is 
finished you will have to select Save As... from the File menu to permanently save this to your 
computer’s hard disk. This usually allows for faster acquisition rates, although most computers have 
less available RAM than disk space. 

• Hard Disk will save data directly to the computer’s hard disk during an acquisition. Hard Disk mode 
is fast enough (in terms of maximum sampling rate) for many applications, especially when only a few 
channels are being acquired. Saving data to Hard Disk allows for longer acquisitions, since most 
computers have more hard disk space free than free RAM. An advantage of saving data directly to disk 
is that if there is a system failure (including power outage), all the data collected up to that point has 
been saved on the hard disk and can be recovered, whereas data saved to PC Memory would be lost. 
 

Visit the online support center at www.biopac.com 
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— IMPORTANT NOTE — 
If you are saving files in Hard Disk mode, always be sure to save files under a different name BEFORE you 
start each acquisition. Otherwise, any previous data in that file will be overwritten. In PC Memory mode, 
you simply go through the standard procedure of saving the file after the acquisition. Once data has been 
acquired and is stored in a file, it is stored on a hard isk or other similar device. 

 
Sam

 d
 

ple Rate 

 
The “Sample Rate” value indicates how many samples the MP35 should acquire per second on each channel du
data acquisition. The default Sample Rate is 200Hz, but can be changed by clicking on the pull-down menu. Use
pull-down menu to select a sample rate between 1 sample/sec. and 100,000 samples/sec. You must select one of the 
menu options — you cannot enter a custom sample rate. You need to scroll up to see the higher sample rates. 

MP30 users: It is important to note

ring 
 the 

 that Sample Rates above 2,000 samples/sec are considered “high speed” 
rates and the software behaves differently in High Speed mode (see page 88). 

Depending on the nature of the data being acquired, the “best” choice for Sample Rate will vary. 
Technically speaking, the minimum sampling rate should be at least twice the highest frequency component of 

terest. This means that if the phenomenon you are interested in observing has frequency components (of interest) 
of 100Hz, you should sample at least 200 times per second. Fourier analysis (FFT) can be used to determine what 
frequency components are present in the data (see page 215 for a more detailed description of the FFT function). 
Applications that typically involve higher sampling rates are ECG, EEG and evoked response acquisitions. In less 
technical terms, slower sampling rates can be used for data with slowly changing values (respiration, GSR, and the 
like), whereas higher sampling rates should be set for data where values change markedly (either in magnitude or 
direction). 
The disadvantage of acquiring data at high sampling rates is that each sample point takes up memory, whether it is 
RAM or hard disk space. Moreover, once the file is saved, it will require more hard disk space than a file of similar 
duration sampled at a slower rate. 
The maximum allowable sampling rate is 100,000/second, but rates over 2,000/second are considered “high speed” 
and do have limitations (see below). Set the Sample Rate from the pull-down menu options. 

9 TIP  A good rule of thumb is to select a sampling rate at least four times the highest frequency of interest 
for the signal. 

Notes: 1) A waveform is considered “compressed” when more than three sample points are plotted per pixel on the 
screen. Using the default horizontal scale (which plots eight seconds of data on the screen), any data 
sampled at more than 250 samples per second would be considered compressed. 

in
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  Standard VGA displ  this type monitor would be 
any type of waveform on the screen at any one time. 

hich 

ib

The acquis
will terminate the acquisition and display a message indicating 

e acq
Data acqui
but the Sam
acquisition

ays are 640 pixels wide, so a compressed waveform on
 displaying more than 2000 samples (approximately) 

Use the Draft mode for compressed waves option to plot compressed waveforms in draft mode, w
results in faster plotting time, although the display is not exact. 

 2) It is poss le to set a Sample Rate that is too high.  

ition will begin normally, but the BSL PRO System 

that th uisition buffer has overflowed: 
red up to the overflow prompt will have been saved, 
ple Rate must be set to a smaller value to continue 

. 
 

Sample Rate 
(samples/Sec) MP35 MP30 

1 YES YES 
2 YES YES 

2.5 NO YES 
5 YES YES 

10 YES YES 
20 YES YES 
25 NO YES 
50 YES YES 

100 YES YES 
200 YES YES 
250 NO YES 
500 YES YES 

1,000 YES YES 
2,000 YES YES 
5,000 YES YES 

10,000 YES YES 
20,000 YES NO 
25,000 YES YES 
40,000 NO YES 
50,000 YES NO 

100,000 YES YES 
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EXAMPLES OF SAMPLE RATE E FECT ON ECG WAVEFORMS 

ls 

ht, the data is 

form sampled at the faster rate, more 
sam n the same period of time that 
allo s of 
the wav

F
The sample ECG waveforms that follow illustrate the effect of different sampling rates on obtaining varying leve
of fidelity when reproducing the data. 

In the first waveform to the rig
sampled relatively slowly, and it is difficult to make 
out the shape of the waveform. 
In the wave

ples are taken i
ws for higher resolution of some component

eform. 
 Representation of ECG waveform sampled with 
relatively few samples per second. 

The “true” E over dots 
that indicate sample points. As you can tell, under-
sam mpletely misses the QRS complex of 
this ugh it might detect components 
of the QRS in subsequent beats. 
Althoug r-
sampling can affect digitally processed data, it is 
important to 
sampled has plications for the 

terpretation and analysis of data. 

 
 
 

CG wave is superimposed 

pling co
 waveform, altho

h this is an extreme example of how unde

note that the rate at which data is 
important im

in

 
Above waveform as it would look if plotted in 

BSL PRO (with data points superimposed) 

he third waveform to the right illustrates the 
pling data at relatively high rates 

measurements t ld be 
able to better establish the maximum 
time interval between different wavel

T
advantage of sam
— namely, increased resolution of the waveform. 
Waveform components that were obscured at slow 
sampling rates are now well defined, and 

aken on this waveform wou
amplitude, 
ets, etc. 

Representation of same ECG waveform sampled 
at a relatively higher sampling rate. 
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High Speed Mode—MP30 only 
� The MP35 handles all acquisition the same, with no distinction for high speed. 

The  nerve 
conduction and action potential. When you select a Sample Rate over 2,000 samples/sec. it is considered a High 

pe d acquisition and the following alert will be generated: 

 High Speed mode is designed for acquisitions that utilize a high-sample rate/short duration setup, such as

S e

 
In High Speed mode, the MP30 acquires 
data and saves to its internal buffer so 
storage is locked to MP30 Memory setting. 
  

The following status window will be 
generated during High Speed acquisition. 
Data downloads to your PC RAM after the 
acquisition is completed. Because of that, the 
current memory size is limited to 100,000 
samples or 200,000 bytes. 

At or below a Sample Rate of 25,000, you 
can mix and match any or all of the four 
analog channels. At a Sample Rate of 40,000 
only one or two analog channels can be 
active (if two channels are selected, they 
must be CH1 and CH2). If your Channel 
Setup is incorrect, you will be prompted to 
correct it: 

At 100,000 samples/sec. only one channel 
can be acquired. If your setup is incorrect, 
you will be prompted to correct it: 

The following limitations are enforced during High Speed acquisition: 

Calculation channels  Cannot calculate channels during High Speed acquisition; channels will be 
calculated after the data is downloaded from the MP30 to the PC. The 
calculation lag factor depends on the speed of the computer and the 
complexity of the calculation. 

Marker functions  Disabled during High Speed acquisition; can be added after acquisition. 

Real-time digital filters  Not available during High Speed acquisition 

Show Input Value  Display is not available during High Speed acquisition. 

Plot on Screen  Plot display is not available during High Speed acquisition. 

Save options Cannot save to PC Memory or Hard Disk. 

Visit the online support center at www.biopac.com 
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Stimulator functions  Can only use the “Start/Stop stimulator with Start/Stop of Acquisition” 

top stimulator with button in Stimulator window” option 
functions normally when data is not being acquired, but is not available 

setting; no manual control options are enabled during High Speed acquisition. 
The “Start/S

during High Speed acquisition. If the “Start with button” option is selected, 
the Stimulator window will be grayed (not selectable) during acquisition. 
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Acquisition Length 

 
To se
will be recorded. 

t the duration of an acquisition, ent umber in cquisitio ength  By default, 30 seconds of data 

P35/30 automatically limit th ximum recording lengt he am  of availa emory on 
 storage d ice (PC M ory or Ha isk). The  t uration specified in 

uisition ngth box
l-down nu to the t of the L  box allo u to scal he dura  of the acq tion in term

minutes, hours, or samples. Changing this option will not of the acquisition, 
 used to describe it. Thus you can describ e ac tion as ting 30 se s, or 0.5 minutes, 

00 milliseconds. Scaling the dura f an acqu n in terms of samp s essentia e same as the time 
scaling options, except the length of the acquisition will be expressed in the total number of samples to be collected 

um

er a n the A n L box.

The M  will e ma h to t ount ble m the 
target ev em rd D default is to record one acquisition of he d
the Acq  Le . 
The pul  me  righ ength ws yo e t tion uisi s of 
milliseconds, seconds, 
only the units

 change the length 
 lase the sam quisi cond

or 30, 0 tion o isitio les i lly th

on one channel. 
The maxim  acquisition length and, on the PC only, current acquisition requires, are calculated based on all the 

ameters. 

SL PRO requires 2 bytes per analog sample and 8 bytes per calculation sample. The memory calculation does not 
ately 25KB per file for header information. 

ing to 
 all 

th. 
 ill need to 

active channels, the types of channels activated (analog or calculation), and the other acquisition setup par
This reference information is displayed above the Acquisition Length section of the Setup Acquisition dialog. The 
B
include approxim
� In the default Append mode, “max acquisition length” reflects the total available length—if you are go

record more than one segment, you need to set the acquisition length so that the combined length of
appended segments falls within the specified maximum leng

� If you are using the Repeat function, the memory calculation is based on one acquisition; you w
multiply by the number of repetitions to calculate the total memory required. 

Regardless of what scale you use to determine the length of acquisition, the MP35 will stop acquiring data when the 
value in the Acquisition Length box is reached. You may also stop the acquisition at any time by clicking on the 

button in the lower right hand corner of the graph window. 
The Acquisition Length parameter has a somewhat different interpretation in the Record laNote st mode; see page 
83 for more information about settings for this mode. 
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Repeat 
The Repeat mode allows you to acquire data from repeated trials using the same parameters for each trial. When the 
Repeat every box at the bottom of the Acquisition Setup box is checked, a series of menus at the bottom of t
dialog box are enabled. These allow you t

he 
o establish the repetition interval and the number of repetitions. 

 
1)  Repeat every controls how long the software will pause between the start of one acquisition and the start of the 

next acquisition. The pull-down menu options are seconds, minutes, or hours. 
It is important to note that this value measures the interval between the start of two adjacent trials, rather than 
the interval between the end of one trial and the start of the subsequent trial. If the repeat interval is set for 15 
minutes and the acquisition Length is set to 60 seconds, then there will be a 14 minute pause between the end of 
the one trial and the beginning of the next. For the fastest possible interval (least possible delay) between 
repeating acquisitions, set to repeat every 0 seconds. 
¾ When Repeat every is unchecked, the acquisitions will repeat as soon as possible (usually instantaneously, 

but slightly longer if data must be saved to a file between trials). 
2)  For/Forever controls how many trials will be acquired. The two general options are to perform a finite number 

of trials, or to perform an infinite number of trials. 
¾ For will acquire a fixed number of trials equal to the number entered in the box to the right. 
¾ Forever will acquire an infinite number of trials. Trials will be repeated at the specified interval until either 

a) the acquisition is stopped by clicking on the  button in the graph window or b) there is not 
enough free memory on the target storage device. 

Data for each trial will be acquired according to the acquisition parameters specified in the dialog box. In the 
preceding dialog, each trial of data will be sampled at 50Hz and will be repeated every 15 minutes for a total of 8 
trials. 

— IMPORTANT NOTE — 
By default, each acquisition will be appended to the data from the previous acquisition. You can change this by 
selecting the Autosave file option from the Save once/Autosave file/Append option at the top of the Setup 
Acquisition dialog. When the Repeat option is checked and Autosave is selected, the Biopac Student Lab PRO will 
save the data from each trial using the file name and extension indicated by the Autosave feature (see page 83 for 
details). 
When Save Once is selected, a prompt to overwrite existing data will be generated at the beginning of each 
acquisition using a Repeat/Autosave setup, so you will probably want to uncheck the Warn on overwrite option 
from the MP35/30 menu to disable the prompt. 
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Chapter 7 Channel Presets 
ber, Channel Preset, 

g channel or the destination channel for a calculation. It 

Channel Pre nnel Preset entry lists the Preset that was selected from the Presets

In addition to the Preset specific settings, each Parameters dialog includes: Channel Num
Channel Label, Source, New Channel Preset, and Scaling features, which are detailed here: 
Channel Number This is the selected analo

corresponds to the Channel in the Setup Channels dialog. 
 

set The Cha   
menu. If you edit this field the “New Channel Preset” button will automatically be 
activated. 
 

Channel Label This is a modifiable d t parameters. Any change you make 
ch as the graph 

Source 
This is the source channel for the calculation. The source channel defaults to CH1 
but can be changed via the pull-down menu. Source options includes any Analog 
channels being acquired and any enabled Calculation channels. The units of the 
Source channel are displayed for easy reference. 
The Math and Function calculations use two source channels and the Expression 
calculation can use multiple source channels. 

escription of the Prese
here will be reflected in other label displays for that channel, su
window label or dialog box channel label. 
 
Calculation channels only 

IMPORTANT! 
Calculation Presets can only work in conjunction with Analog 
input presets, or with other calculation channels that are ultimately 
pointing to an Analog source channel. You must pay close 
attention to Source Channel and choose it carefully. 

 
New Channel 
Preset button 

The New Channel Preset button will be activated if you change the Channel 
Preset entry. When you click it, the newly named preset will be added to the menu 
available to every channel. If you change other settings but keep the Channel 
Preset entry the same, the changes only apply to the selected channel and the 
original Preset settings will be applied if you select the Preset from the menu again 
(for any channel). 
 

Scaling… button When you click the Scaling… button, a Change Scaling Parameters dialog will 
be generates for the selected channel. Scaling is explained in detail beginning on 
page 78. 

 
 See Calibration Guidelines on page 273. 

Visit the online support center at www.biopac.com 
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Analog Channel Presets 

 
Selecting an Analog Presets eset 
values for the type of data designated for that channel. These preset values are designed to be good starting points for 
most people, and you may m esets for 
various physiological signals. 

 option automatically configures the Gain, Filter and Coupling options using pr

odify them as you see fit. The table beginning on page 250 lists the default Pr
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The P
hardw
includ

Digital Filters 
Â For MP30 users, digital filters are 

only applied if sample rate is 2,000 
samples/sec or less 

Gain 
Offset 
Analog Filters 
Â Click the View/Change Parameters 

RO software allows you to set a number of 
are parameters for analog acquisitions, 
ing: 

 button in the Setup Channels 
dialog to view or change the preset 
parameters. 

 
 S

 
ee Calibration Guidelines on page 273.  

al Filters Digit
The P re allows you trengths 
and weaknesses of each so th

RO softwa  to control three types of digital filters and it is important to understand the s
at the best combination of filter settings can be achieved. 

3 types of Digital Filters 

2 Real-time 1 Post-acquisition 
Hardware Software  
Three stage digital filters Calculation channels FIR filters 

Two of the filter types operate in real time (as data is being collected) and of those, one performs the filtering within 
the MP35/30 hardware itself (before the data is displayed on your computer). This section discusses only this 
hardw ring. The  
described on page 194. See Appendix E for a general overview of filters. 
The MP35/30 hardw d dently. The 
hardware filtering is designed  for 
filtering data to retain physio
The digital filters apply to an disabled 
and therefore non-selectable d
You must specify a filter typ
As a general rule, if only one
with a Q of about 
wherea  
Some common applications o aliasing.” Other filters are 
available l (see 
page 98). 
The “Q” setting refers to the n some cases, it 
may be desirable to over- or under-dampen a filter, depending on the particular requirements. 

9 TIP Choose a Preset that matches your signal of interest to automatically configure all three filters. 
 

 

are-based filte  calculation channels are described on page 73 and the post-acquisition filters are

are-base  filter is a cascaded set of three second-order filters that can be set indepen
 primarily for basic signal conditioning (e.g., removing 60 Hz noise), rather than

logical signals of interest (such as retaining alpha activity from an EEG signal). 
alog channels and cannot be used to filter data below 30 Hz. Digital filters are 
uring High Speed acquisition. 

e (low pass, high pass, band pass, band stop), filter center point, and Q setting. 
 filter is to be used, that filter should be a low pass filter set to 1/2 the sampling rate 

0.707. If two filters ar
s the other has a Q of

e used, both should be low pass filters, and one should have a Q of 0.5 
1. 
f these filters are removing 60 Hz noise and preventing “

 for broadly limiting the frequency range and removing low frequency “drift” of the incoming signa

skew of the filter, and an optimally dampened filter has Q of 0.707. I

Visit the online support center at www.biopac.com 
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More about MP35 Hardware Filters 
The MP35 e c (second order) Infinite Impulse Response (IIR) mploys three user-configurable, sequential, biquadrati
filters. These filters are typically configured by choosing a Preset via MP menu > Set up Channels >Presets. To 
change the filter setting(s) to a different bandwidth (than provided by a Preset), select MP menu > Set up Channels > 
View/Change Parameters fo arameters” r a Channel Preset. In the “Digital Filters” section of the “Input Channel P
dialog that is  adjugenerated, st the Type, Freq, and Q for Filter 1, 2, and/or 3, change the Channel Preset name, and 
then save as a l Preset.   New Channe
The MP35 IIR filters are imp ilters are implemented as lemented via an internal Digital Signal Processor (DSP). The f
32 bit, fixed point. The MP3 Hz, 25kHz, 50kHz or 100kHz, 5 internally samples all input data at a rate of 20k
depending on the rate chosen  rates less than 20kHz, the MP35 will  via the BSL software application. For all sample
initially sample the analog d  are ata stream at 20kHz and then downsample after the internal IIR filter calculations
performed, before sending the data to the BSL software application.  
To in 35 wil  a sure that the MP l not alias input data, the MP35 implements a high-order lowpass FIR filter that has
brea  the intkpoint of 45% of ernal sampling rate used by the MP35. 
� For example, if the internal rate is 20kHz, the FIR lowpass will have a breakpoint of (0.45)*(20kHz) = 9kHz. 

As a in ,  further constraint aga st aliasing, the MP35 also employs an analog lowpass filter in all the input channels
which limits the band edge to 20kHz maximum.  
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Hard
The H  as 
well a
Gain settings 
The Gain setting spec atically set when a 
data type is select ttings e only educa  guesses and should be 
used as initial starting values. You m on or another depending on how 
the amplified signal appears once sa cluded in the MP35/30 Input and 
Offset Range tabl

To select a Gain setting for a given cha down
menu next to 
The software offers a variety of settings to amplify the raw analog signal from 
100 times to 50,000 times. 
Larger values are associated with higher gain settings, and thus greater 
amplification. 
The x100 Gain setting 
absolutely required as  range in this mode 
and will be clipped. 

 

ware settings 
ardware settings allow you to control the Gain, Offset, and Input coupling (AC vs. DC) for each channel,
s two additional hardware filters. 

ifies the extent to which an incoming signal is amplified. The Gain is autom
ed from the available Presets. The preset Gain se ar  ted

ay need to adjust the gain settings in one directi
nmple data is collected. Gain guidelines are i

e on the next page. 

nnel, choose a value from the pull-  
Gain. 

is range-limited and should not be selected unless 
 the data will not operate under the full

 

Some types of signals (su h ication than other types of signals (such as ECG or 
EMG), although ideal gain settings are best deter -case basis. 
¾ Setting the Gain to a val  signal will result in data that typically appears as a “flat 

line” centered on 0. 
¾ Setting the Gain to a value result in data that is “clipped” or limited at 

either the extreme
For the best resolution, establish Gain pplicable) and the maximum peal-to-
peak of the signal, the maximum signal display is close to the maximum range. 
You can use the Range Guid f the signal is clipped, 
lower the Gain. If the signal  signal resolution. 
Offse
To correct the offset of an incoming analog signal, you can add or subtract a constant to the signal prior to 
amplification. Offset can occur if a transducer or electrode has inherent offset, and is especially true of signals 
collected in DC mode (in AC coupled mode the Offset entry has no effect on the data).  

By default, Offset is set to zero, and the 
range will vary dependi
values. The PRO uses
channel for the offset 
If you exceed the limits, an e
generated: 

c as EEG) typically need greater amplif
mined on a case-by

ue that is too small for a given

 that is too large for the input signal will 
 positive or negative levels. 

such that, allowing for baseline drift (if a

e (see page 42 ) as a visual aid to establish the proper Gain. I
is small compared to the range, increase the Gain to improve

t 

allowable entry 
ng on the Gain and Scaling 

 the scale and units of the source 
units. 

rror prompt will be 
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____ ___________________________________________________ 
MP3 /30 Inp  

Gain 
Setting 

(X) 

MP35 
Inp

Sign
Range 

(+/- mV) 
Range V) 

Offset 
Rang

MP30 
Offset 
R  

mV) 

MP35 Offset 
Resolution 

(uV) 

MP30  
Offset 

Resolution 
(uV) 

_
5

____________________________
ut and Offset Range 

MP30 MP35 MP30 MP35 
ut 
al 

Input 
Signal 

Input 
Resolution 

Input 
Resolution e ange

(+/- mV) (10 bit mode) 
(u (uV) (+/- mV) (+/- 

10 1000 N/A A 8.24  N/A 30.5 N/A 100 N/

20 N/A 100 N/A 8.24 N/A 500 N/A 15.3 

50 200 N/A 6.1 N/A 100 N/A 8.24 N/A 

100 100 70* 3.0 195 10 10 .82 78.1 

200 50 50 1.5 97.7 10 10 .82 78.1 

500 20 20 .61 39.1 10 10 .82 78.1 

1000 10  .30 19.5 4 10 .32 78.1 10

2000 5 10 .32 78.1 5 .15 9.77 4 

2500 N/A N/A 10 N/A 78.1 4 N/A 7.81 

5000 2 3.91 4 10 .32 78.1 2 .06 

10,000 1 4 10 .32 78.1 1 .03 1.95 

20,000 .5 A 4 10 .32 78.1 N/A .015 N/

25,000 N/A /A 10 N/A 78.1 .4 N/A .781 N

50,000 .2 4 10 .32 78.1 .2 .006 .391 

 
This is a special case limit of the voltage range onlyNotes: *  for a gain of 100. 
The actual range from unit to unit may vary by as much as 20%. 

____________________________________________________________________________________ 
 
Input coupling 
The Input Coupling hardware setting enables you to record data as AC Coupled or DC Coupled signal values. 

• DC Coupling is appropriate for Temperature, GSR, Airflow, BNC, Switch, Pressure, Force, Hand 
dynamometer, Stimulator, Strain gauges, and similar data.  

• AC Couplin priate for ECG, EEG, EMG, EOG, PPG, Respiration, and similar data.  
There are a number of  main issue is Offset. Offsets are 
values which impact istinctions between “absolute” vs. “relative” accuracy are 
related to Offset. 

• DC Coupled signals usually have a non- plitude that drifts during the course of the 
recording. DC C u irectly to account for the Offset. 

• AC Coupled signals are centered on zero, so Offset is not a factor. 
Other hardware settings, such as Gain cantly between AC and DC, but AC 
Coupled signals can use som  slightly higher resolution. 

g is appro
 technical differences between these coupling settings, but the

the location of transducer zero. Most d

zero Offset in am
o pled measurements can be calibrated d

values or sensitivities, don't change signifi
ewhat higher Gain settings, resulting in
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Hard
In add
that c f s filter and the other is a 
switch
1) T is AC coupled (see page 97 for a description 

of
¾
¾ f AC 

2) The second filter allows you to select a 1 kHz or 5 kHz low pass filter. 
¾ mpling rate of the MP30 is presently limited to 2,000 Hz per channel, the filter 

should almost always be set to 1 kHz. 
¾ You may want to set this filter to 5 kHz when you are collecting data that will be directed to OUTPUT or 

when the input channel is being used as a trigger. 
When a data type is selected from the Presets menu, both the high pass and low pass filters are set to the standard 
setting for that type of measurement. Of course, you may adjust these if you need to. 

ware filters—MP30 
ition to the three programmable digital filters in the setup dialog, there are also two selectable hardware filters 

an be controlled rom software. One is a switchable 0.05 Hz / 0.5 Hz high pas
able 1 kHz / 5 kHz low pass filter. 

he 0.05 Hz / 0.5 Hz filter is only enabled when the input channel 
 this setting). When DC-coupled data is being collected this filter is bypassed. 
 The 0.05 Hz setting for this filter is appropriate for data ECG and respiration data. 
 The 0.5 Hz setting is appropriate for EEG, pulse plethysmograph, EMG, and most other types o

Coupled data. 

 Since the maximum sa

Visit the online support center at www.biopac.com 
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Calculation Channel Presets 

 
Calculation Channels are OFF by default. To turn a Calculation Channel on, click the  Presets butt

Acquire box for each Calculation channel you want to 
on and 

make a selection from the menu. You must then check the 
compute (the Plot and Value boxes are opti

For an
source
transfo

To view or change the parameters specified for each Preset, click the 

onal). 
y Calculation channel, you will (minimally) need to specify the 
 channel to be transformed and the nature of the 
rmation. 

 View/Change Parameters button in 
the Setup Channels dialog box to generate the corresponding Parameters dialog. The Preset specific settings are 
discussed on the following pages. 

IMPORTANT! 
Calculation Presets can only work in conjunction with Analog 
input presets, or with other calculation channels that are 
ultimately pointing to an Analog source channel. You must pay 
close attention to Source Channel and choose it carefully. 
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Calculation Preset: Integrate 

 
Integrate Calculation dialog  

Option 
The online Integ

Average over 
samples 

 the moving average (mean) of the specified number of samples. 
dd further functionality. 

h
on
� This option is useful for smoothing noisy data, real-time “integration” of EMG, 

 

Reset via channel P
Perform potentially variable number of sample 
points. This feature is extremely useful for converting flow signals into volumetric 

lume. For example, when recording airflow 
with a pneumotach, volume can be precisely calculated as the flow varies in a 
cyclic fashion. 

s option is useful for real-time conversion of flow signals into volume 
olume) and any 

processing involving a need for a cyclic, continuous integral calculated in real 
time (Acceleration Æ Velocity; Velocity Æ Distance; Frequency Æ Number 
of cycles; Power Æ Energy). 

rate calculation offers two basic operations: 

Calculates
Additional parameters (Rectify; Root mean square) a
Used typically, these features allow you to process EMG signals and will display 
t e integrated (rectified, then sample averaged) or Root mean square calculation 

 the original raw EMG data. 

real-time “root mean square” evaluation of EMG. 

ermits real-time integration of input data over a data-defined time interval. 
 a real-time integration over a 

equivalents. The integral of flow is vo

� Thi
signals (Blood flow Æ Blood volume; Air flow Æ Air v
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Average over samples option 
Online sample averaging can be useful when there is a high degree of noise present in the data. At least 
some of this noise can be “averaged out” by pooling some number of adjacent data points together, taking 
the average of these points, and replacing the original values with the new averaged values. This process 
creates a “window” of moving averages that moves across the waveform smoothing the data.  

  
Integration used to smooth

e represents th
present, you can use the Aver a 
moving average. When data i
(equivalent to the number of s hey will reflect a number of 

To sp , enter a value in the 
Samples
rate y r 
sampl a smaller number 
of sam
across amples specified in the samples 
box in ta 
will d
 

Click
option

Rectify The A
envel aveforms frequently contain 
high f ow 
frequency  option is 
check
and a 
will b ption is only used for processing raw EMG and 
similar types of applications. 

Root mean square This feature provides the exact root mean square (RMS) of the input data 
(typically EMG) over the specified number of samples. 

Remove baseline This feature provides the exact standard deviation of the input data (typically 
EMG) over the specified number of samples. When the mean of the input data 
equals 0-0, the standard deviation and the RMS will be equivalent. 

 noisy data. Online “Average over samples” feature used as an envelope 
detector 

Since an averag e sum of a series of data points divided by the number of data points 
age over samples calculation to provide the information needed to create 
s averaged in this way, a portion of the data at the beginning of the record 
amples being integrated) should be ignored, as t

zero values being averaged in with the first few s

Samples 

amples of data. 

ecify the number of data points to average across
 box. The number you select will depend in large part on the sampling 

ou select and the type of noise present. All things being equal, for slowe
ing rates you will probably want to mean average across 
ples. As you increase the sampling rate, you will probably want to integrate 
 more and more samples. As the number of s
creases, the amount of high frequency information contained in the da
ecrease. 

Parameters  in the box to the left of Parameters to enable the options, then choose an 
: 

verage over samples calculation can also be used for producing an 
ope of modulated data. For instance, EMG w
requency information, which is often of little interest compared to the l

 information also contained in the data. When the Rectify
ed, the PRO will take the absolute value of the input data prior to summing 
plot of the waveform’s mean envelope over a specified number of samples 
e obtained. Typically, this o
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Reset via channel option 
This feature is used to integrate data over a data-dependent interval. Either the source channel or a 
different channel can control the integration process. 

 
 

trol channel: Allows the selection of any active channel as theCon  control channel for the 

Res

In the case of airflow conversion to volume, the flow signal will vary positively 
and ne

Reset et trigger polarity dete  on which slope (Positive ↑ or Negative ↓) 
gi

Mean e ata evaluated during the integration 
d. If this option is selected, tegration will only proceed after all the data 

ee cted. When collected, the mean value of all 
ted from each data point in the integration period. In this 

 the corrected data points ral 
e e integr
av ration

ecified

Max cycle period: The max cycle period should be set to a value that is longer than the maximum 
 event to trigger event in the control data channel. 

transformation. 

et Thresholds: The threshold is to be set at points surrounding the flow level. 
LOW is typically a negative value close to 0.00 
HIGH is typically a positive value close to 0.00 

gatively around zero flow. 

 trigger: The Res rmines
the integration process will be

 Subtraction: This option will subtract the m
perio

n and end. 

an from the d
 the in

in the integration period has b
the data is subtrac

n colle

fashion, the integral of
returning to exactly zero at th
option will result in “well-beh
delayed by a fixed amount of tim

 will result in the integ
nd of the 
ed” integ
e, as sp

ation interval. Although this 
s, the integrated data will be 
 by the max cycle period. 

time expected from trigger
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Int
The f-
line

egrate — formulas 
 Integrate formula is the same in the calculation (online, real-time) mode and the transformation (of
, post-processing) mode, and varies only based on the parameters selected. 

Note:  For the first points, value of index “i” will be less than or equal to zero; it means 
that for summation you have only values beginning with ( )1xf . 

� For the first point for summation you have: ( )xf ,1− ( ), ( )0xf 1xf . 
( )1−xf  and ( )f  - don’t  exist, so you have only ( )0x 1xf . 

� For the second point for summation you have: ( )0xf , ( )1xf , ( )2xf . 
( )0x  - doesn’t exist, so you have only f ( )1xf + ( )2xf . 

1. Via samples, no extra parameters selected 

( ) ( ) xxfxF
j

sji
ij ∆= ∑

+−=

*
1

 

Where: 
i - index for source values (***the real range is 1..j); 
j - index fo
n - number of samples; 

r destination values (1..n); 

ix , jx - values of points at horizontal axis; 

( )ixf - values of points of a curve; 

( )jxF - integrated values of points of a curve; 

s – number of samples to average across; 

1
1

−
−

=∆
n

xx
x n  - horizontal sample interval; 

 - values at horizontal axis at the endpoints of selected area. 

  2. Via samples, rectify 

Where: 

1, xxn

( ) ( )( ) xxfABSxF
j

sji
ij ∆= ∑

+−=

*
1

 

          
- index for source values (***the real range is 1..j); 

j - index for destination values (1..n); 
n - number of samples; 

- values of points at horizontal axis; 

- values of points of a curve; 

i

ix , jx

( )ixf

( )jxF - integrated values of points of a curve; 

s – number of samples to average across; 

1
1

−
−

=∆
n

xx
x n  - horizontal sample interval; 

 - values at horizontal axis at the endpoints of selected area. 

 
1, xxn
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Integrate formulas, continued… 
 

Note:  For the first points, value of index “i” will be less than or equal to zero; it means 
that for summation you have only values beginning with ( )1xf . 

� For the first point for summation you have: ( )1−xf , ( )0xf , ( )1xf . 
( )1−xf  and  - don’t  exist, so you have only( )0xf  ( )1xf . 

� For the second point for summation you have: ( )0xf , ( )1xf , ( )2xf . 
( )0xf  - doesn’t exist, so you have only ( )1xf + ( )2xf . 

1. Via samples, root mean square 

( )
( )( )

1−s
xF j  

Where

1

2

=
∑

+−=

xf
j

sji
i

: 
 inde

j - inde
n - num

 valu

i - x for source values (***the real range is 1..j); 
x for destination values (1..n); 
ber of samples; 

ix , jx - values of points at horizontal axis; 

( )ixf - es of points of a curve; 

( )jxF - integrated values of points of a curve; 

s – number oss. 

 ro

of samples to average acr

2. Via samples, ot m baseline ean square, remove 

( )

( )
( )

1

1

1

−

⎥
⎥
⎥
⎥

⎦

⎤

⎢
⎢
⎢
⎢

⎣

⎡

−

=

∑
∑

+−=

+−=

s

k

xf
xf

xF

j

sji

j

sjm
m

i

j  

2

Where: 
i and m- indexes for source values (***the real range is 1..j); 
j - index for destination values (1..n); 
n - number of samples; 
x , x - values oi j

( )ixf - values of points of a curve; 

f points at horizontal axis; 

( )jxF - integrate values of points of a curve; 

s – number of samples to average across. 
k – coefficient : 
For the first few points that have index j < s  k=j, for the other points with j > =s    k=s 
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INTEGRATE — EXAMPLE USING AIRFLOW/VOLUME RECORDING 
***This is a simplified example. For more complete details, see the Application Note. 
Click the MP35/30 menu and select Setup Channels. 

Use the Preset  pull-down menu to set a calculation channel to Integrate. 
Set the Source channel (Airflow). 
If necessary, adjust the Reset thresholds to suit the flow signal. 
Optionally, to avoid problems caused by a drifting airflow signal, select Mean Subtraction. (This will 
cause a delay in the display because Mean Subtraction requires a complete cycle to perform the mean 
subtraction). The Mean subtraction function will remove any offset on a breath-by-breath basis. 

The following graph shows an 
airflow signal with its 
corresponding volume: 
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Calculation Preset: Smoothing 
The Smoothing Calculation functions 
online and permits Median or Mean 
smoothing. (Smoothing can also be 
performed off-line using the 
smoothing option of the “Transform” 
menu). This function is very useful if 
you are trying to remove noise of 
varying types from a data set. 

 
Smoothing factor Enter the number of samples to use as a smoothing factor. 

en 

 
Calculation Preset: Di
The Difference calcula

nce between two
ecified number of i

 Calculation
calculating an approxim
derivative of a data set 
The Difference Calcula
you to specify the sourc
number of intervals bet

Use Median value The default setting uses Mean value smoothing. Use Mean value smoothing wh
noise appears in a Gaussian distribution around the mean of the signal. 
Click in the box to activate Median value smoothing if some data points appear 
completely aberrant and seem to be “wild flyers” in the data set. 

fference 
tion returns the 

differe  data samples over 
a sp
Difference

ntervals. The 
 is useful for 
ation of the 

in real time. 
tion dialog allows 
e channel and the 

ween samples over 
which the difference is to be taken. 

Source 
the 

on relatively smooth data. 

Difference is calculated with respect to the number of intervals between points 

proximate a continuous derivative, shifted one 
point to the right. 

When the Source channel contains relatively high frequency data, using the 
Difference Calculation may result in a very noisy response, so it’s best to use 
Difference Calculation 

Interval 
(rather than the number of sample points). For instance, two sample intervals span 
three sample points: 

POINT<interval>POINT<interval>POINT 
If the Interval is “1” and the source and the output are displayed using Line Plot, 
then the difference plot will ap
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Calculation Preset: Rate 

 
on extracts inT lculati formation about the interval between a series of peaks in a waveform.  

Function The Function pop-up menu includes options to scale the rate in terms of Hz, BPM, 
Interval, Peak Time, Count Peaks, Peak Minimum/Maximum, Peak-to-Peak, Mean 
Value, or Area. See the table on page 108 for an explanation of each Rate Function. 

Note: Parallel functions can be performed after

he Rate Ca

 data has been acquired. All of these Rate 
Function options are available in the post-acquisition mode through the Transform > 
Find rate function described on page 230. 

Peak Detect For Rate Calculations involving data with positive peaks (such as the R-wave in ECG 
data), you will want to click the button next to “Positive” in the Peak Detect section. 

Remove 
baseline 

This will perform a hidden moving difference function on the waveform and is useful 
for tracing data that has a wandering or drifting baseline. 

Noise 
rejection 

Constructs an interval around the threshold level. The size of the interval is equal to the 
value in the % of peak box, which by default is equal to 5% of the peak-to-peak range. 
Checking this option helps prevent noise “spikes” from being counted as peaks. 

Auto 
Threshold 
detect 

 The most convenient way to calculate a Rate channel online is to use the PRO to 
automatically compute the threshold value (the “cutoff” value used to discern peaks 
from the baseline). This is done by checking the Auto Threshold detect box. 

Window These parameters define the range of expected values for the Rate calculation and are 
activated when “Auto threshold detect” is enabled. When the Rate calculation is set to 
automatic, you should also specify a minimum rate and a maximum rate. By default, 
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these are set to 40 BPM on the low end and 180 BPM on the high end. The Rate 
Calculation will use these values to find and track the signal of interest, assuming the 
input BPM range is reasonably well bracketed by these values. Depending on the shape 
of the input cycle waveform, the Rate window settings may be closer or further from the 

nction.” 
 specify the unit after the Function. 
 menu will be disabled. 

expected rates. 
Windowing Units are related to the selected “Fu

• Rate Functions related to peak or peak time
This is a fixed unit, so the Windowing Units

 
• Rate Functions related to data within a cycle can be specified in units of 

frequency (Hz) or time (BPM or seconds). The Windowing Units menu will be 
enabled,a nd when a unit is selected the software will convert the Min and Max 
settings to the selected units. 

 

See also: Application Note #PS142 for further information. 

 
Rate > Function Options 
The Function pull-down menu of the Rate dialog includes the following options: 

 

Area Computes the area of the signal between two peaks, on a cycle-by-cycle 
basis.  

Count (on the 
 

measurements (in the measurement windows), this is a convenient way to 
calculate how many peaks occur within a selected area. 

peaks This peak counting function produces a plot of the number of peaks 
vertical axis) vs. time (on the horizontal axis). When used with the delta

Interval (sec) Returns the rate value scaled in terms of a time interval (sec), which is 
computed as the time difference (delta T) between the two peaks. This is 
sometimes referred to as the inter-beat interval or IBI. This measurement is 
perfectly correlated with the BPM calculation. 

Mean value Computes the mean of a pulsatile signal on a cycle-by-cycle basis between 
two peaks. It will also produce a staircase plot. 

Peak maximum 
Peak minimum 

Tracks the value of the peak. Peak maximum correlates to the systolic 
pressure in blood pressure readings (the ECG R-wave). 
Peak maximum locks the “Peak detect” option of the dialog to “Positive” 
and Peak minimum locks it to “Negative.” 
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Peak to peak Determines the amplitude of a pulsatile signal. It looks at the vertical 
 difference between the maximum and minimum values of the waveform on

a cyclical basis.  

Peak time (sec)  
last peak time will be plotted 

will resemble a 
to taircase” plot. 

Returns the time (in seconds) at which the peak occurred. Like the other rate
functions (e.g., BPM and Hz), the value of the 
until a subsequent peak is detected. The resulting plot 
mono nically increasing “s

Rate (BPM) qual t a T. E o 60 times the frequency calculation, or 60/delt

Rate (Hz) turns mputed by 
vidin rfectly correlated 
h th

Re  the rate value scaled in terms in Hertz (Hz), which is co
di g 1 by delta T. This frequency measurement is pe
wit e BPM calculation. 
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Rate Usage Guidelines 
1) One of the most frequent applications of the Rate Calculation is to compute BPM online for ECG, 

pulse, or respiration data. Waveform intervals can be scaled in terms of BPM (the default), frequency 
(Hz), or time interval between peaks. 
¾ The BPM (or beats-per-minute) Rate function is used as a measure of peaks or events that occur 

in a sixty-second period. 
¾ The frequency (Hz) Rate function is commonly used to describe the periodicity of data, or the 

amount of time it takes for data to complete a full cycle (from one peak to the next peak). 
¾ The Interval Rate function returns the raw time interval between each adjacent pair of peaks, 

which is essentially the inter-beat interval (IBI), frequently used in cardiology research. 
These three functions essentially provide the same information in different formats, since a frequency 
of 2Hz is equal to an inter-peak interval of 0.5 seconds, both of which are equivalent to a BPM of 
120. Other options allow you to record the maximum or minimum value of all peaks (the peak 

ill closely bracket the expected values. 
 mor

blood pressure or respiration), the Rate window will closely bracket the expected rate on the high-
 

or your application. If the simplest 
mode do ample, if the “Fixed threshold” 
mode ca  If the “Auto threshold detect 
mode” i r adding the “Remove baseline” 
option (
 

max/min option), or to count the aggregate number of peaks (the count peaks option). 
2)  Calculate systolic using the Peak Maximum Rate Function, diastolic using the Peak Minimum Rate 

Function, and mean blood pressure using the Mean Value Rate Function. 
3)  For ECG-type data (where the waveform peak is narrow with respect to the waveform period), the 

Rate window values w
4) For e sinusoidal data, with the waveform energy distributed over the waveform period (as with 

end, but can be up to twice the actual measured rate at the low-end.
5) Generally, it’s best to use the simplest Rate mode that is suitable f

esn’t work, add layers of sophistication one at time. For ex
n’t or will not work, use the “Auto threshold detect” mode.
s similarly impaired, try adjusting the “Noise rejection” o
if selectable). 

Find Rate : Operational Mode Suggestions 
If the waveform data has Like Use 
Clear
are consistently higher (in magnitude) than the 

he waveform 
or Air flow 
data 

ly defined positive or negative peaks that 

rest of t

Respiratory Fixed threshold 

Clearly 
determine the rate of the crossings 

defined zero-crossing and you want to EMG Fixed threshold 

Wide, rounded peaks, but the peaks are 
otherwise larger in magnitude than other parts 
of the waveform and/or if the waveform data 
has a moving baseline 

Blood 
pressure 
signals 

Auto threshold detect 
*You may need to adjust the 
Noise rejection (Hysteresis) 
to optimize performance. 

 
High narrow peaks that may or may not be 
larger in magnitude than other parts of the 
waveform and/or if the waveform data has a 
moving baseline 

ECG Remove baseline and Auto 
threshold detect 
*You may need to adjust the 
Noise rejection (Hysteresis) 
to optimize performance. 
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6) The following stipulations dict
a) If e op ted. 
b) The Auto threshold detect feature can be used independently of the Remove baseline option. 
c)  The Noise rejection setting and the Window setting are automatically enabled when the Auto 

threshold detect option is selected. 
d)  The Remove baseline option is disabled when the following measurements are chosen: 

Peak-Peak, Peak Maximum, Peak Minimum, Area, and Mean. 
e)  The Auto threshold detect option creates a variable threshold for positive or negative peak 

tive peaks: (Peak max – Peak Min)(.25) 
s 

can be placed in the largest Window size (time). When the Rate 
) the threshold is changed to the 

 of the ve s operation pe ry in 

f)  The Noise rejection setting 

ate the Rate Detector options available: 
 the Remove baselin tion is selected, the Auto threshold detect option is also selec

detection, defined as follows: 
Positive peaks: (Peak max - Peak Min)(.75) 
Nega

In addition, the Rate Detector will construct a moving average of data points defined by 1.5 time
the number of samples that 
detector loses sync (no threshold crossing inside the Window
mean value
the event of spurious waveform

 moving a rage of data points. Thi
 data values. 

rmits successful recove

 creates hysteresis around the variable 
 as follo

is
Remove baseline n old d

(0.025)(samp  N ffe
The difference waveform is th previously described hold 

ate m ove baseline an
tion

threshold ws: 
 = Noise rejection (%) • (Peak Max – Peak
combined with the Auto thresh

 Min) 
etect option causes the Rate 

Hysteres
 optiog)  The 

Detector to perform an automatic (and hidden) 
ling rate) =

moving difference function 
umber of points over which the di
en processed as 

on the waveform data: 
rence is performed 
 under the Auto Thres

detect option. 
h) The sample r

detect to func
ust be greater than 40 sa

 properly. 
mples/second for rem d auto-threshold 
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Cal

 

culation Preset: Math 

  
The Math Calculation performs standard arithmetic calculations using two waveforms or one waveform 
and a constant.  

Source To use a summed waveform as an input for another Math Calculation channel, 

urce must have a lower channel number than the Math calculation channel. 

Operand Use the pull-down operand menu to select a math function. 

select the calculation channel as a Source. The calculation channel used as a 
So

Operand Result  
+ Addition 
- Subtraction 
* Multiplication 
/ Division 
^ P we

K (constan

Scaling ation channel for dividing the 
ling function to perform the same task. To 

o r 
t)  Enter a value to be used as the constant for the calculation. 

As an alternative to creating an additional Calcul
summed waveform, you can use the Sca
do this, click Scaling… button and then set the Scale values for the summed 
waveform equal to +5 and -5 (to correspond to Input Volts values of +10 and -10 
respectively). This will effectively plot the sum of channels A1 and A2 as the 
arithmetic mean of the two waveforms. 

See also… 
For addition
online Expres complex 
operations on  be “chained” together to form complex 
alculations (wherein the output from one serves as the input for another), a separate channel must be 

Additionally, chaining more than three or four channels together can require 

the 
features available online in the Math Calculation channels can be computed after an acquisition using the 
Waveform Math option (see page 213), which will eliminate the problem of system overload. 

al libraries of online calculation options, consult the sections on Function Calculation and the 
sion Calculation. These types of calculation channels can be used to perform more 

 waveforms. Although calculation channels can
c
used for each function. 
considerable system resources. 
For complex calculations (such as squaring a waveform then adding it to the average of two other 
waveforms) the Expression calculation is a more efficient solution (see page 116). Also, all of 
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Acquisition Functions 113 

Calculation Preset: Function 

  
The Function calculation can be used to perform a variety of mathematical functions using two 

 a constant. Function calculation channels compute new waveforms in a 
ike Math 

calc ons (such as taking 
the absolute l
waveform on an

waveforms or a waveform and
manner similar to the Math calculation, but provide access to higher order functions. L

ulations, Function calculations can be chained together to produce complex functi
 va ue of a waveform on one channel and calculating the square root of the transformed 

other channel). 
Fu inct on Operation 
Abs Returns the absolute value of each data point 
ATan Computes the arc tangent of each data point 
Exp Takes the ex power of each data point 
Lim  outside specified boundaries it Limits or “clips” data values that fall
Ln Computes the base e logarithm for each data point 
Log Returns the base 10 logarithm of each value 
Noise Creates a channel of random noise with a range of ± 1 Volt 
Sin Calculates the sine (in radians) of each data point  
Sqrt Takes the square root of each data point. 
Threshold Converts above an upper threshold to +1 while converting data below a 

lower threshold to -1. If the initial data lies between the upper threshold 
(UT) and the lower threshold (LT), the output is undefined. 

old values are +1 and 0 (see page 200). Note: Off-line Thresh

 
See also… 
For post-acquisition operations, these functions are available under the Transform menu (page 192). 
Function calculations can be chained together to produce complex calculations, but it is more efficient to 
program complex functions using the Expression calculation; many of these functions are also found in 
the online Expression calculation (see page 116). 

Top: Signal + Noise 
Middle: P-P Noise > UT-LT

Bottom: P-P Noise < UT-LT



114 Part C 

Calculation Preset: Filter 

 
The l filtering on Analog or Calculation channels.  
Out
options

l types of filters: low pass, high 
e the technical aspects of digital filtering can 
nd these types of filters is relatively simple. 

 you to set a cutoff point (for the low and high pass 
the band pass and band stop filters). 

 
Freq 

Q 
Q coefficient. The Q value entered in the filter setup box 

f this parameter, 
endix D. 

In the dialog box above, the signal on analog channel one (CH1) is run through a Low Pass filter that 
attenuates data above 50Hz. The “Q” for this filter is 0.707, which is the default. 
Note: One possible application of the online filtering option is in conjunction with the Show Input 

Values option (see page 142). Raw EEG data, for instance, can be filtered into distinct 
bandwidths (alpha, theta, and so forth) using one source channel and multiple Filter calculation 
channels. The filtered data can then be displayed in a bar chart format during the acquisition 
using the Show Input Values option. 

See also…

Fi el performs real-time digital 
put (filter 

) 
The Output pull-down menu lists the four genera

ter Calculation chann

pass, band pass and band stop. Whil
be quite complex, the principle behi
Each of these filters allows
filters) or a range of frequencies (for 
See filter table on next page.

This is the frequency cutoff or range (Low/High) for the selected filter type.  

The online filters are implemented as IIR (Infinite Impulse Response) filters, 
which have a variable 
determines the frequency response patterns of the filter. This value ranges from 
zero to infinity, and the “optimal” (critically damped) value is 0.707 for the Low 
pass and High pass filters, and 5.000 for the Band pass and Band stop filters. If 
you wish, you may change the Q. A more detailed explanation o
and digital filters in general, can be found in App

 
Digital filtering can also be performed after an acquisition using the same types of filters. You can choose 
from the different filter types by selecting Digital filters from the Transform menu. The filters available 
after the acquisition use a different algorithm but operate in essentially the same way. 
For more information on digital filters and filters that can be applied after an acquisition, turn to the 
Digital Filtering section on page 194 or Appendix D. 
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FILTER 
Output Performance 
Low Pass Allows you to specify a frequency cutoff that will “pass” or retain all frequencies 

below this point, while attenuating data with frequencies above the cutoff point. 
High pass Retains only data with frequencies above the cutoff, and removes data that has a 

cy below the specified cutoff (opposite of the Low Pass filter). frequen
Ba
(lo

 need to 
 a range 
e are 

 
h pass filter, which emulate the behavior of a band pass filter. 

 

order to retain on data, such as alpha wave activity. 

nd pass 
w + high) 

Allows a variable range of data to pass through the filter. For this filter, you
specify a low frequency cutoff as well as a high frequency cutoff. This defines
or “band” of data that will pass through the filter. Frequencies outside this rang
attenuated. The Band pass (low + high) is actually a combination of a low pass and a
hig
This type of filter is best suited for applications where a fairly broad range of data is to
be passed through the filter. For example, this filter can be applied to EEG data in 

ly a particular band of 
Band Pass Requires only a single frequency ng, pecifies the center frequency of the 

band to be passed through the filter. Whe pe of filter is selected, the “width” of 
the band is determ etting (p ger Q values result 
i and hereas smaller ated with a wider band 

ilter. This filter has a bandwidth equal to Fo/Q, 

, and to 
attenuate data around this center frequency. 

 setti which s
n this ty

ined by the Q s reviously discussed). Lar
n narrower b widths, w  Q values are associ

of data that will be passed through the f
so the bandwidth of this filter centered around 50Hz (with the default Q=5) would be 
10Hz. 
This type of filter, although functionally equivalent to the band pass (low + high) 
filter, is most effective when passing a single frequency or narrow band of data

Band Stop Defines a range (or band) of data and attenuates data within that band (opposite of the 
Band Pass filter). A center frequency is defined and the Q value determines the width 
of the band of frequencies that will be attenuated. 

Band Stop – 
Line Freq 

Defines a band stop at 50 Hz or 60 Hz, based on the line frequency selected during 
installation. 
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Calculation Preset: Expression 

  
The online 
with th
and will s
Unlike the ls at a time—
the bine data from multiple analog channels and allows you to specify 
o put channels for an Expression. Computations performed by the 
Expr e a single 
output ch e ly it by the sum of two other channels, 
and divide the a single Expression Calculation 
channel, whic ation channels together. 
While the Exp lation channels, each Expression 
Calculation re esources than other Calculation channels do. This essentially means 
that acquisitions that utilize Expression Calculations are limited to a lower maximum sampling rate than 
ac ion calculations. 
For ea ion(s) to be performed, and any 
Opera ype directly into the E

Expression evaluator can be used to perform complex computations that cannot be managed 
e Math or Function calculations. The Expression evaluator uses standard mathematical notation 

ymbolically evaluate complex equations involving multiple channels and multiple operations. 
 Math and Function Calculations—which can only operate on one or two channe

Expression calculation can com
ther calculation channels as in

ession evaluator eliminate the need for “chaining” multiple channels together to produc
ann l. For example, you can square one channel, multip

 product by the absolute value of another waveform on 
h is more efficient than chaining five Math and Function Calcul
ression evaluator is more powerful than other Calcu

quires more system r

quisitions without Express
ch expression, you need to specify at least one Source, the Funct
tors to be used. Make a selection from the pull-down options or t xpression 

box. 
Note:  It  im unctions, and operators can be 

refere  or future sample points. That is, 
data f n some way with data from waveform 
two a e (on any channel) cannot be 
combined with data from oint in time (on any channel). See the section on post-
acquisition E ys around this limitation.  

is portant to keep in mind that while different channels, f
nced, this Expression Calculation cannot reference past
rom waveform one can be transformed or combined i
t the same point in time, but data from one point in tim

 another p
xpression commands (beginning on page 211) for wa

Visit the online support center at www.biopac.com 
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Source Sources are typically analog channels, but you may select Time from the Sour

menu to return the value of the horizontal axis (usually Time) for e
point. When the horizontal axis is set to Frequency (in the Displa

ce 
ach sample 

y > Horizontal 
axis dialog), the “Time” item will switch to “Freq.” 

Function The Expression calculation offers the following functions: 
 Function Expression result 
  each data point. ABS Returns the absolute value of
 ACOS Computes the arc cosine of each data point in radians. 
 ASIN s the arc sine of each value in radians. Calculate
 ATAN Computes the arc tangent of each sample point. 
 COS Returns the cosine of each data point. 
  value. COSH Computes the hyperbolic cosine of each selected
 t. EXP Takes the ex power of each data poin
 ogarithm of each value. LOG Computes the natural l
 LOG10 Returns the base 10 logarithm of each value. 
 ROUND Rounds each sample point the number of digits specified in the 

parentheses. 
 SIN Calculates the sine (in radians) of each data point. 
 SINH Computes the hyperbolic sine for each sample point. 
 SQR Squares each data point. 
 SQRT Takes the square root of each data point. 
 TAN Computes the tangent of each sample point. 
 olic tangent of each samTANH Calculates the hyperb ple point. 
 TRUNC Truncates each sample point the number of digits specified in the 

parentheses. 
Operator The following operators are available in the Expression dialog: 
 Operator Operation 
 + Addition 
 - Subtraction  
 * Multiplication 
 / Division 
 ^ Power 
 ( Open parentheses 
 ) Close parentheses 
See also… 
The same features that are available in online Expression calculation are also available under the 
Transform menu for evaluation of complex equations after acquisition. Also, simple calculations such as 
summing two channels or dividing one channel by another (and so forth) are best performed in either the 
Math calculation channels or the Function calculation channels. 
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Calculation Preset: Delay 

  
D  to use a n
i  channel is rec nning of the channel (equal to 
the value of the delay) that ad 
w ” with gin
b
D  interval can be s and cannot exceed 

the Delay
prompt will be generated. To correct the error, decrease 
the Delay value or increase the Acquisition Length
under MP35/30 > Setup Acquisition.  
In the graph shown above, the Delay channel contains 
0.25-second interval of zeros at the beginning of data 
Delay plots are useful for producing nonlinear (“chaos”) plots in X/Y display mode (see page 
45).  

 

9 TIP Although there is not a parallel function in post-processing mode, the same effect can be 
obtained by selecting a section of one waveform equal to the desired delay interval and 
choosing the Edit > Cut function or the Edit > Clear command to remove a section of the 
waveform. 

elay allows you
nterval. When a Delay

aiting to “catch up
egins to plot actual data. 
elay  The Delay

the acquisition length. 

calculatio  channel to plot another channel lagged (delayed) by an arbitrary 
orded, there is a segment at the begi

 will re as 0 Volts. This is normal and occurs because the Delay channel is 
the ori al signal. The PRO fills this buffer with zeros until the Delay channel 

pecified either in terms of samples or seconds 

 If  entry exceeds the acquisition length, an error 

 entry 

a 
file. 

Visit the online support center at www.biopac.com 
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Chapter 8 Output Control — MP35/30 Menu 

 
The MP35 and the MP3
used to connect to BIO  has an additional I/O Port which is used to 
output digital (TTL Lev

Parameters for output signa
MP35>Output Control su
There are six Output Contro

Output Control S MP30 Functionality 

CH# to Output 

0 can output pulses or analog voltages via the Analog Out port; this port is also 
PAC’s external stimulators. The MP35
el) signals. 

ls are set via Output Control. Access to a specific Output Control is via the 
bmenu. 
ls for the MP35 and four for the MP30: 

ee page MP35 Functionality 

page 121 Direct analog CH1-4 to output Direct analog CH3 to output 
listen to signals 

Digital Outputs page 121 Control 8 digital outputs Not available 

Voltage – 5 V page 137 Output Voltage Level (0 – 4 V 
DC) 

Output Voltage Level (0 
DC) 

Pulses pa Use with third-party devices; ge 123 Use with third-party devices; 
software can control pulse width 
and repetition. 

software can control pulse 
width and repetition. 

Stimulator - BSLSTM  Stimulator page 137 Use with BSL Stimulator Use with BSL

Stimulator - SS58L page 139 Use with SS58L Low Voltage 
Stimulator; software can control 

Not available 

pulse amplitude, width and 
repetition (-10 to +10 V) 

To open an Output Control, select it from the MP35>Output Control submenu. A checkmark appears 
next to the submenu selection and an Output Control panel is displayed, bordered in red beneath the 
BSL PRO Toolbar in the active data window. To close an Output Control, select from the menu again 
(toggles between display
Only one Output Contr
change the display and ope ontrol panel. 

put d  
Volts, built-in software

� See page 138 for safety notes regardin
The following applies t

1. The output w ll
2. When an Outpu ut 

goes to 0 Volts, preventing the output device from sending pulses. 
3. When an Outpu

ON/OFF switc
acquisition win  Control, which outputs immediately, and 
the Digital Out

 and hide) or right-click in the open control panel and choose Close. 
ol panel may be open at any time. Switching between different data files can 

ration of the c
Because some out evices can be used for stimulation on humans and can achieve voltages up to 100

 logic makes output control as safe as possible. 
g human subjects. 

o all Output Controls. 
 not operate unless its software control panel is open. 
t Control panel is closed, or the BSL PRO application is closed, MP35 outp

i

t Control panel is opened, output is always OFF until activated by a click of the 
h in the control panel or, if parameters allow, a click of the Start button in the data 
dow. (Exceptions are the Voltage Output
puts Control when set to the preference “Set each output immediately.”) 
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4. Output preference parameters are local and are saved with the data file or a graph template file. 
The data or tem See 
“Save as Graph
display and operation of the control panel since the settings in each graph are independent 
entities. 

Controlling Output Si

plate file holds the output parameters as established when the file was saved. (
 Template,” page 174.) Switching between other open graphs can change the 

gnals 
ntrol panel and its respective Preferences dialog to control the output signal. 
nces  dialogs establish the parameters for output. Preferences dialogs are only
esponding Output Control panel is open and active. Voltage does not have 
 MP30 only, CH3 to Output does not h

Use both the Output Co
Output Control Prefere  
available when the corr
Preferences, and on the ave Preferences. 
To generate the Prefer

1. Open an Outpu e a pop-up menu. 
Choose Prefer

ences dialog, either: 
t Control panel and then right-click anywhere in it to generat
ences to open the dialog (Close will close the control panel). 

 or  
2. Open an Output Control panel and then choose File>Preferences and select from the submenu to 

open the dialog. 

 
box is grayed or disabled, its values may be established, or limited, by settings i
If Preferences parameters allow, enter values directly in the Output Control 

If a control panel entry n 
the Preferences dialog. 
panel. 

   
a. Key into the entry boxes and then enter the value by pressing the Enter key. 
b. Use the Tab key or mouse to move to another entry box. 
c. Click the OK button if in the preference dialog. 

Values entered into a control panel or its Preferences dialog that are outside the specifications of the 
output device, or outside the limits defined by the Preferences dialog, may change automatically to reflect 
either the closest value to that requested that the the hardware can achieve, or the closest increment 
defined by the limits in Preferences. (The system will not check while you type, it checks and may make 
changes after the value is entered.) 

� For example, if a Pulse width of 5 ms is entered into the Pulses Output Control panel entry box, 
but Preferences defines a range limit of .5 to 2 ms for Pulse width, the system will 
automatically change the new entry to 2 ms.  

 
Saving Panel settings: 
Output Control panel settings will be retained until a file is closed or saved. If a file is closed but not 
saved, settings will be lost (defaults established); if a file is saved, panel settings will be saved.

Visit the online support center at www.biopac.com 
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CH# to Output Output Control 

 
The CH# to Output Out of 
the MP35/30. The signa d and plotted as it normally 
would. 

� MP35 users ma
� MP30 users mu

This Output Control is used a
coming in on an analog input ch
clinical procedure physicians us
To display this control panel: 

1) Choose MP35>Outpu
• Channel 3 is th her channel N has been designated, the menu will 

read “CH<N>.
• OFF groun

2) Use the control panel ON/OFF S
3) If desired, MP35 users may set P ut. 

a. Open the Preferences dialog
control panel or choose File>
Output). 

b. Use the pull-down menu to s
channel CH 1-4 to use for th

K t
 pan

MP30 User
output. When outputting the signal, you may want to
rather than 1 kHz (see page 98) to allow higher frequency

Note Only the Hardwa
g) from th

X > Set up Chan rench) will be 
applied since outp

ig

ee page 272 for MP35 Inp
 

put Control redirects an analog input signal to the Analog Out port on the back 
l from the assigned channel will continue to be recorde

y use analog input CH1-CH4. 
st use CH3. 

 m inly when attaching headphones to the MP35/30 to listen to signals 
annel. One common use is listening to the EMG (muscle) signal, a 
e to actually hear certain problems with muscles. 

t Control>CH# to Output to open the control panel. 
e default setting. If anot
” 

ds the output so no signal (or sound) should be present. 
witch to start and stop output. 
references to designate which channel to redirect to outp

 (right-click in the 
Preferences>CH# to 

elect the desired 
e output. 

c. Click O
control

o set the output channel and return to the 
el. 

s: The Preferences option is disabled because you may only redirect Channel 3 to � 

Couplin
(MP3

processing of D
 

 set the low pass hardware filter to 5 kHz 
 output. 

re settings (Gain, Offset, Input 
e Input Channel Parameters dialog 

nels > W
ut is established prior to the 
ital Filters.  

ut>Output Scaling values. S
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Digital Outputs Control — MP35 only 

 
 
� MP30 Users: The Digital Outputs Control panel is not available when using an MP30. 

The Digital Outputs Co
connector on the back of the . The digital output uses stardard 
TTL levels which corre

Contr

ntrol allows control of signal output on each of eight digital lines via the I/O Port 
 MP35. Use it to control external devices

spond to the control panel setting as follows:  

ol Panel setting   Output Voltage level (Volts) 

0 0 

1 +5 

To display this control 
1) Choose MP35>Ou ital Outputs Control panel 
2) Click each digi
3) If desired, you may

Outputs. 
a. Open the P

control panel or
File>Preferenc

b. Select from

• Set eac
output 
button t upon clicking its toggle 
button. 

• Set all utputs when ou to toggle the state of each digital 
output e, but t ll no anged until th ed on 
the control panel. In this m
Set button is clicked, all eight digital lines will update simultaneously. 

c. Click OK to set Preferences and return to the control panel. 

panel: 
tput Control>Digital Outputs to open the Dig

tal output line to set its digital state to 0 (off) or 1 (on). 
 set Preferences for Digital 

references dialog (right-click in the 
 choose 
es>Digital Outputs). 

 the following two options: 

h output immediately (default) allows you to toggle the state of each digital 
line between 0 and 1, and change the state immediately. In this mode, no Set 
is available in the control panel. Output for each line is se

o  Set button is pressed allows y
lin he states wi t physically be ch e Set button is click

ode, a Set button is available in the control panel. When the 

Visit the online support center at www.biopac.com 
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Voltage Output Control 

 
The Voltage Output Control is used to output a voltage level (DC voltage) via the Analog Out port on the 
back of the MP35/30 to control another piece of equipment. 
To use this control panel: 

1) Choose MP35>Output Control>Voltage to open the Voltage Output Control panel. 
2) Enter a value manually, or use the scroll or arrow buttons to increase or decrease values. 

• When using the scroll box, a change will not occur on the output until the mouse button is 
released. 

• The display shows the value that is to be output. If an entry exceeds the voltage range limits 
of the MP Acquisition Unit, the value automatically rounds to the nearest obtainable value. 

MP Voltage Output 
 MP35 MP30 
Range 0 - 4.096 Volts 0 - 5 Volts 
Resolution  1 mVolt 19.5 mVolts 

There are no Preference
When multiple graph w
and the new active grap
Output Control panel is

s for the Voltage Output Control. 
indows are open, Voltage Output stops (goes to 0 Volts) if the graphs are switched 
h contains its own Output Control panel. When the graph containing the Voltage 
 made active again, Voltage Output goes back to the previously set level.  
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Pulses Output Control 
Stimulator – BSLSTM O

S58L Output Control 
utput Control 

Stimulator – S

Control panel options for Pulses, Stimulator – BSLSTM and Stimulator – SS58L 
 

 
Additional control panel options for Stimulator – SS58L (MP35 only) 
The BSL PRO System offers a variety of pulse ouput options. Exercise caution when using any of the 
options with human subjects—see the Safety Note on page 138. 
� Pulses Output Control 

Select this Output Control for general pulse output, or when synchronizing to 3rd-party devices. 
 for react

“clicks” (puls  
times by calculat  t

• Use with the BIOPA e 
responses to visu r
tests (e.g. P300), ir

• Use to trigger ano e
starts). 

• Use to control a 3rd-p e of the BIOPAC BSLSTM 
Stimulator with the MP35 se the 
Stimulator - BSLST
 

� Stimulator – BSLSTM 
utpu

• Use with sti
stimulati
as lower voltage (0 - +10 Vo ) gen
stimulation, such is used with amp  

erve pre
 

ator – SS
his Outpu

 
• Use with

stimulati
as lower 
stimulati
nerve pre

• Outputs through a BNC connector so it can be used  
with most sti ose that  
terminate in a needle probe). 

• Use ion time measurements, where a subject listens with headphones for a series of 
es) and responds as quickly as possible with a button press. Determine reaction

ing he time between the start of the pulses and the responses. 
C STP30W Stimulus Presentation System (SuperLab) to measur

al o  auditory stimuli. To perform sophisticated evoked response averaging 
pa  triggers with different visual or auditory stimuli. 
th r device (automatically send a pulse from the MP35/30 when acquisition 

arty stimulator. BIOPAC recommends us
/30 and BSL PRO software. If using the BSLSTM Stimulator, u

M Output Control instead of this Pulses Output Control. 

Select this O t Control when using the Biopac Student Lab stimulator (BSLSTM) 

mulation electrode HSTM01 for safe 
uman subjec  (0 –on of h ts  100 Volts), as well 

lt eral-purpose 
hibian muscle or

n parations. 

� Stimul
Select t

58L 
t Control when using the SS58L connector for 
- +10 Volt), direct drive stimulation. 
 stimulator electrode HSTM01for safe, 
on of human subjects (0 – 100 Volts), as well 
voltage (0 - +10 Volt) general-purpose 

low-voltage (-10

on, such is used with amphibian muscle or 
parations. 

mulation cables (such as th

Visit the online support center at www.biopac.com 
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To use one of these control panels: 
1. Choose MP35/30>O

SS58L. 
utput Control and then select Pulses, Stimulator – BSLSTM, or Stimulator – 

Control panel options for Pulses, Stimulator – BSLSTM and Stimulator – SS58L 
 

 
anel options for Stimulator – SS58L only Additional control p

2. Right-click in the O >Preferences and select from the sub-menu) 
to generate the Out

utput Control panel (or choose File
put Preferences dialog. 

 
3. Set the Preferences. 

• General
• Advance

 (SS58L onl
renc ation — see page  

4. Once configured, P  
the button at the bottom

5. Confirm the setting
Preferences. 

Entry limits

: ON/OFF, Number of pulses, Marker options — see page 129 
d: Pulse width, Pulse repetition (rate) — see page 

y): Pulse level — see page • Level
• Refe e Channel (SS58L only): Channel assignment, signal gener

references may be saved using the Save Settings command, activated by pressing
 of the Preferences dialog (see page 128). 

 

s in the control panel. Adjust as desired within the parameters established in 

: Se he 
Output Control panel e  the control panel 
only if parameters estab grayed or 
disabled, its va

6. Initiate the pulse sequence 

ttings entered into the Preferences dialog may establish, or limit, the values in t
ntry boxes. You may enter pulse settings directly into
lished in Stimulator Preferences allow. If an entry box is 

lue is set or limited by Preferences. 
as defined in Preferences (see page 129). 

 ON/OFF Butto el. n in Output Control Panel uses the switch in the Control pan

 Reco
 
To close an Output Control
Right-click anywhere in th Close, or 
select it (or another output cont  l submenu. 

rding uses the Start /Stop button in the data acquisition window. 

 panel: 
e Ouput Control panel to generate a pop-up menu and then choose 

rol) from the MP35/MP30 > Output Contro
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Pulse Definitions 
s ar

 BSLSTM 
The following term
Stimulator –

e used in the Output Control panels, Preferences, and guidelines for Pulses, 
and Stimulator – SS58L. 

 
Delay before first 
Pulse 

quisition to start of first pulse. Initial delay from start of ac

Number of pulses t the specified Pulse Width, 
ont). 

Number of successive pulses that will be sent out a
Repetition and Level. Set for Single (1), Multiple, or Continuous (C

Pulse Level 

� 

Amplitude of the pulse, expressed in Volts. 

Note: The output of the BSLSTM is 0 Volts when the pulse is not active. 

Pulse Repetition 

Also called — 
Events per second 

y 
  

Pulse train 
rate 
in 

ne 
ulse to the start of the next pulse. 

 Pulse frequenc
Pulse sequence

Repetition 
Sample tra

Can be expressed as Period (ms) or Rate (Hz). 

Period: Time between pulses; measured in milliseconds from the start of o
p

Rate: Number of pulses that occur in a one-second interval; measured in
Hertz. 

Rate relates to Period as: Rate (Hz) = 1000 / Period (ms) 

Pulse Width Time that the pulse is in the non-zero or active state. 

Visit the online support center at www.biopac.com 
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Output Control 
The Output Control panels for Pulses, S r – BSLSTM and S  – SS58L wo
conjunction with Preferences to c

timulato timulator rk in 
ontrol pulse output. Control panel functions are detailed here: 

OUTPUT CONTROL PANELS 

Genera lse p eters can  with other. 
� For example, the pulse repetition period cannot be set to a value less than the 

pul
rder  t n id rri ntries as 

d s the prio paramete
ple, if the pulse width is changed such that it exceeds the pulse 

repetition period se rep n period will be automa y adjusted to 
acc idate the new pulse width entry.  If, however, the pulse repetition 
per anged t is an the pulse width, the repetition period 
will be changed, upon attempte ry,  to the closest value that can be 
achieved without changing the pulse width.  

Entrie cessary to meet limitations 
of the 
W
mu
� s are the “Voltage Output” control panel and the “Digital 

utput immediately” is selected; these 
iately. 

means that they are stored at the data 
ave as graph template (File > Save As) 

n to use existing Preferences in new data files. 
 a file is saved with an Output Control panel visible and then closed, the panel 

ned. 

l Notes Pu aram  interact each 

se width. 
In o  to simplify he interactio , the Pulse w th entry ove des other e
require ; it i rity r. 
� For exam

, the pul etitio ticall
om
iod is ch  such that i  less th

d ent

s are checked and rounded (not truncated) as ne
hardware or the Preferences. 

hen a file is opened, the output device will not turn ON automatically. A user 
st manually press either the “Record” button or the “Start” button. 
The exception
Outputs” control panel if “Set each O
settings will output values immed

Output control settings are “local,” which 
file level, not the program level. Use the s
optio
If
will be visible when that file is re-ope

Preferences  control panel to generate the Preferences dialog, and then select a 
tab t
Right-click a

for he settings you want to adjust. 

 
You can also use the File>Preferences menu option to generate the Preferences 
dialog. 

Output Settings 

 

 

Displays the name of the current Preferences setting. The pull-down menu lists 
the names of all output Preferences saved using the Save Settings button (see
page 128). The pull-down menu is not accessible when an output pulse train is in 

 

e name of the 
, 

erences dialog options will be updated. 

progress. 
If no settings configurations have yet been saved, when the Output Control panel 
is first opened and no parameters are changed, the Output Settings box displays 
“Default.” If any parameters parameters are changed (but not yet saved), it 
displays “Custom.” 
When output settings are saved, the Output Settings box displays th
last selected setting. Use Organize List to change the display order of the menu
rename, or delete items (see page 128). 
When a saved setting is selected from the pull-down menu, the Output Control 
panel and all Pref
For Reference Channel—SS58L only: All Output Settings must use the same 
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OUTPUT CONTROL PANELS 
reference channel assignment; othr paramters can be unique for each setting. 

 

 
Once configured, Preferences may be saved using the Save Settings button at the 
bottom of the Preferences dialog. Save Settings generates a dialog to name and 
save a defined configuration of Stimulator output settings. Saved configurations 
are accessible via the Output Settings pull-down menu in the Output Control 
panel. When a setting is selected from the menu, all current output parameters are 
updated to reflect the saved settings. 
You can save multiple configurations as long as each has a unique name; the Save 
button will be inactive if the name you enter is not unique.  
Output settings configurations are local presets that are saved with the data file or 
a template file. The data file or template file holds the output parameters as 
established when the file was saved plus any other named configurations of 
Output Settings. 

 

 
Use the Organize List button at the bottom of the Preferences dialog to order, 
rename or delete saved Preferences settings. The up or down arrows are only 
available if two or more settings have been saved. Select a setting and then click 
the up and down arrows to set the position, or choose rename or delete. If you 
choose “Delete All,” all saved settings will be deleted and the default and Custom 
options will be reactivated. 

Visit the online support center at www.biopac.com 
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GENERAL TAB (OUTPUT PREFERENCES) 

General Tab 

 
Number of Pulses Indicates the number of pulses to be output. When the Output Control panel is 

 

). 

 in 

selected, the Pulse Repetition scroll bar is activated in the 
Output Control panel. 
 

MP30 Only If using High Speed mode (>2,000 s/s) and “Initiate pulse 
sequence with Recording” is selected, the stimulator cannot be 

ontrol 

d will have to be manually turned back on after the 

closed, the pulse output will be immediately stopped. 
• Single will establish a single pulse for outputting. All pulse repetition

options, entry boxes and scroll bars in both the control panel and 
preferences windows will be disabled (grayed

• Multiple will establish a specific number of pulses for outputting. The 
selection will activate an entry box where you can enter 1-254 pulses. 
When this option is selected, the Pulse Repetition scroll bar is activated
the Output Control panel. 
Continuous will establish a continuous pulse train for outputting. When 
this option is 

turned off manually since the MP30 will not accept any 
commands from the computer until the recording has stopped. 

 If “Initiate pulse sequence with ON/OFF button in Output c
panel” is set, the pulse sequence will be stopped prior to 
acquisition an
recording. 

 

Initiate pulse 
sequence with… 
ON/OFF Button 

 
OFF (red) 
 

 
ON (green) 
 

 
AUTOMATIC START 

n Rate 
nd 

t 

e 
” 

Controls the start and stop of pulses. Changes to Pulse Width and Repetitio
can be made in the Output Control panel entry boxes during a pulse sequence, a
during a recording, if all other Preferences parameters allow it. Any change in the 
pulse output will occur immediately. This lets you change the stimulator outpu
“on the fly.” 
 
When “Initiate pulse sequence with ON/OFF button” is selected: 
� The ON/OFF button controls pulse output independent of the acquisition 

status. 
� OFF is always available. 
� The ON/OFF button reflects the current output state, with one exception: if th

pulse sequence lasts less than 0.5 seconds, the button will remain in the “ON
state for at least 0.5 seconds to indicate that the ON state occurred. 
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GENERAL TAB (OUTPUT PREFERENCES) 
(yellow) 
 

� When the Number of Pulses selected is Multiple, ON/OFF acts as a 

�

momentary switch. Press the ON (green) button to start pulses; 
it will automatically turn OFF (red) at the end of the specified pulse train. 
The switch defaults to OFF. Saving a data file or saving as a Graph Template 
will save all stimulator preferences except the status of the pulse switch, which 
will always be saved in the OFF position. 

 

Recording When “
If the preference setting “Initiate pulse sequence with: ON/OFF button” is active, 
the con
during a ext time the stimulator 

�

Initiate pulse sequence with Recording” is selected: 

trol panel changes will take effect immediately. If settings are changed 
 pulse train, changes do not take effect until the n

starts. 

 
Start button 
 

 
Stop button 

 Pulse output turns ON and OFF corresponding to the Start and Stop of the 
recording. In other words, the Pulse output can only occur during a recording. 

� When in this mode, and not recording, the ON button will display as yellow , 
indicating that pulse output will automatically begin at the “Start” of the 
recording. 

� Pulse outputting can be turned OFF during a recording, but it cannot be turned 
back ON until the end of the recording. 

� When a Repeat sequence is running, pressing the OFF button will turn OFF 
the output for the entire recording sequence and the button will display as OFF 
until after the last sequence, when the switch will display as yellow ON 
(automatic start) indicating that pulse output will begin again at the “Start” of 
the next recording sequence. You cannot turn pulse outputting back ON during 
a repeated recording sequence. 

� When the acquisition stops, all stimulator pulses will cease, regardless of the 
Output Control panel settings. 

� The pulse train will stop concurrent with the end of the acquisition, even if the 
specified pulse train is not completed before the acquisition ends. When a new 
acquisition is started, the pulse train will start from the beginning. 

� In this mode, no changes can be made in the Output Control panel until the 
recording stops. Changes made after recording stops will take effect when a 
new recording is started. 

� When a pulse is sent out, the marker label and indicator arrow will be 
generated (if the marker preference is turned ON and markers are displayed). 

After initial delay After initial delay of … is enabled only when “Initiate pulse sequence with 
Recording” is chosen. Specify a delay interval from the start of recording to the 
start of the first pulse. This is useful for viewing data prior to the stimulus pulse. 
The BIOPAC output device determines the delay range. 
INITIAL PULSE DELAY MP35 MP30 or BSLSTM 
 Range 0 - 100 milliseconds 0 or .5 - 100 milliseconds* 
 Resolution 10 microseconds 1.953 microseconds 

*Entries greater than 0 milliseconds must be at least 0.5 milliseconds. 
 

Visit the online support center at www.biopac.com 
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GENERAL TAB (OUTPUT PREFERENCES) 

Pulse Markers 

 

 
An advantage of using the BSL PRO software for output signals is that information 
regarding the pulse is automatically recorded along with the data. On most c
recorders, information regarding the pulse level (amplitude), pulse rate, and p
width must be noted by hand, a process that can be inefficient, time-consumin
and er

hart 
ulse 
g 

nd labeled for each Reference pulse or 
tain the Pulse width and Pulse rate 

tamp if selected). 

atically recorded and archived with the 

 to “Create marker when output is 

arker Preferences available under the 

ror-ridden. With the BSL PRO: 
� The amplitude reflects the output pulse level. 
� Markers can be automatically inserted a

change in pulse train. The label will con
(and system time s

� Markers reflect setting changes made during an acquisition.  
� All output pulse information is autom

saved data. 
Set the marker option by clicking in the box
changed.” 
Set the time stamp option with the global M
File menu (see page 171). 

 
The marker label accurately captures pulse data, but the marker arrow may not 
always line up exactly with the leading edge of the pulse; this typically is not a 

 the actual stimulus pulse which can be 

ding on the acquisition Sample Rate, the leading edge of the pulse in the 
exact time the pulse was sent—it may be 

 one sample period. If the marker precision is critical for your 
recording, increase the Sample Rate. 

 stimulator should be set to 10V or 

problem because the recording will include
used for timing measurements. 
• Depen

recording may not correspond to the 
off by as much as

• To display markers, use the toolbar icon or Display>Show>Markers. 
The Range switch on the front of the BSLSTM
100V prior to recording and should not be changed during recording; if using a 

ing Preset should also be selected prior to recordingPreset, the correspond . The 
e determined by moving the decimal to the right or left 
 range was switched.  

pulse level can then b
depending on how the
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ADVANCED TAB (OUTPUT PREFERENCES) 

Ad anced Tab v

P

A

L

C
a
M

 
Only for MP30 BSLSTM
 
ulse Width 

 

Indicates the Pulse Width setting, which determines the maximum Pulse Rate 
frequency. You may enter a Pulse Width value, unless limited by Preferences. 

• The entry is activated when the value is changed and the Tab or Enter key 
is pressed; it does not require a stimulator restart to take effect. 

• The Pulse width entry overrides other entries as required; it is the priority 
parameter. 

• An entry may be automatically changed if any of the following conditions 
apply, in which case the closest possible value will be selected: 
a) It falls outside the allowable range. 
b) It is rounded to .01 millisecond increments (MP35 resolution). 
c) Width has been limited by the Pulse Width: Limit Entry settings of 

Preferences. 
llow any entry Pulse width is limited to the output capabilities of the BIOPAC MP device. This 

option allows any entry within the allowable range specified below: 
PULSE WIDTH RANGE MP35 unit  MP30 unit  
Range  .050 – 100 milliseconds .049 – 100 milliseconds 
Resolution 10 microseconds 1.953 microseconds 

ock entry to This entry locks the width to a single, specified value (within the allowable 
range). No other value can be entered. 

alibration 
djustment 
P30 BSLSTM only 

The pulse width from the MP30 output connector is very accurate, but the 
BSLSTM hardware may add 0 to 150 microseconds to the pulse width in its 
internal circuit. This value can vary somewhat from unit to unit but mainly 
depends on the revision of the BSLSTM which is determined from the serial 
number on the back of the unit. To adjust for this, the BSL PRO software can 
subtract a specified amount of time from each requested pulse width. 
To determine a calibration adjustment value which will get one very close (within 
+- 5%) of the requested pulse width, refer to the following table: 

Serial No. Calibration adjustment value (microseconds). 
<= 308A 5100  70  

>= 310A 100 0 (default value) 
 

Visit the online support center at www.biopac.com 
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A ANCED TAB (OUTPUT PREFERENCES) DV
If you are using an older model manual control (no LED) BSLSTM stimulator, try 
using 110ms—and then contact BIOPAC for a free product upgrade. 
If pulse width accuracy greater than +- 5% is required, calibrate your specific 
BIOPAC BSLSTM stimulator (requires an oscilloscope) and enter a specific 
adjustment time from 0 to 150 microseconds (entries outside this range will be 
clipped). 
Calibration adjustment—MP30 BSLSTM only 
1. Connect a BNC to BNC cable from the BSLSTM output connector to an 

oscilloscope input.  
2. Set the “Calibration adjustment: subtract” to “0.” 
3. Specify a pulse width of .2 ms. 
4. Send out a stimulus pulse. 
5. Measure the actual pulse width out of the BSLSTM stimulator with an 

oscilloscope.  
6. The Manual Test button on the back of the BSLSTM cannot be used to make 

the oscilloscope measurement. 
7. Calculate the time required to make the pulse width exactly .2 ms.   
8. Enter this time, in microseconds (1 ms = 1000 microseconds), into the 

“Calibration adjustment: subtract” entry box. 
Pulse Repetition 

 

Indicates the Pulse Repetition period (Hz or ms). 
� The Pulse period must be greater than the Pulse width. See  “TBPMIN” in 

the Output Preference > Advanced Tab Limits table on the next page. 
� The full range of acceptable Pulse Rate values is from .2 to 6,667 Hz (MP35) 

7 Hz (MP30). or .2 to 6,82
� The maximum Pulse rate (PRPMAX) depends on the Pulse width setting: 

Pulse width 100 ms Æ maximum Pulse rate = 9 Hz 
Pulse width .020 ms Æ maximum Pulse rate = 3333 Hz 

� The formula for pulse width vs. pulse repetition is PRPMIN = PW + TBPMIN 
Where: PRPMIN = the MINimum Pulse Repetition Period allowed. 
 PW = Pulse Width setting 
 TBPMIN = MINinum Time (in ms) betw en successive pulses 

ifications) 

de the allowable range. 

l 
ts” 

e
       for the output device (see device spec

If “Limit changes from ___ to ____” is selected in Advanced preferences, 
then PRPMAX will be determined by the formula above or the specified 
limit, whichever is greater. 

� An entry may be automatically changed: 
a) If it falls outsi
b) To round it to .01 Hz increments (resolution of system). 
c) To make it at least 0.1 millisecond greater than the Pulse width. 
d) By the Pulse Repetition Rate: Limit entry Preference. 
e) By the Pulse Repetition: Adjust entry increments Preference. 

� You may manually enter any value for pulse width, but when using the scrol
bar or arrows, entries will be constrained by the “Adjust entry incremen
Preference setting. 
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ADVANCED TAB (OUTPUT PREFERENCES) 
Pulse Repetition 
Scroll Bar 

The Pulse Repetition Scroll Bar adjusts rate or period by the increment of change 
and limits established in Preferences. With each click of the scroll bar arrows, the 
rate will be increase by the specified increment. 
� When “Initiate pulse sequence with ON/OFF button in Control Panel” is 

selected, changes take effect upon release of the scroll box as long as the 
stimulator is running. 

� The scroll bar is disabled when Number of Pulses is set to “Single” or Pulse 
Repetition is set to Lock Entry to...” 

Display as Pulse repetition can be dispalyed as 
� Pulse Rate (expressed in Hz), or 
� Pulse Period (inverse of Pulse Rate, expressed in milliseconds). 
Pulse Repetition Rate relates to the Pulse Repetition Period as: 

Pulse Rate (Hz) = 1000 / Pulse Period (milliseconds) 

4. The Pulse Repetition: Lock entry Preference. 
. 

illiseconds (ms), 
ange will be converted by the formula: 

Period increment in ms = Round to nearest whole number [Period Range 
te increment in Hz /Rate Range in Hz)] 

For example, if the Range was 1Hz to 10 Hz with an adjustment increment of 
ional calculation would be Period increment = 900 ms (1Hz / 9 

The “Display as” units selection is also used for: 
1. Pulse repetition entries in the control panel. 
2. Scroll bar increments. 
3. The Pulse Repetition Rate: Limit entry Preference. 

5. The Pulse Repetition: Adjust entry increments Preference
When units are changed from Rate in Hertz (Hz) or Period in m
the limits of the Pulse Repetition r

* (Ra

1Hz, the proport
Hz) = 100 ms 

Allow any entry Pulse width is limited to support the output capabilities of the BIOPAC output 
device. See Output Preference > Advanced Tab Limits table for allowable range. 

Limit entry Establishes minimum and maximum values that can be manually entered or 
changed with the scroll bar. 

Lock entry Locks the Repetition to a single, specified value (within the allowable range). No 
other value can be entered in the control panel. 

Adjust entry Controls the scroll bar or scroll arrow increment; does not apply to manual entry. 
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Output Preference > Advanced Tab Limits 
 Pulses 

MP35 MP30 
BSLSTM 

MP35 MP30 
SS58L 

MP35 Only 

Pulse width      

 Range (ms): .050 – 100 .049  – 100  .050 – 100 .049  – 100 .050 – 100 

 Resolution (ms): .010 .001953  .010 .001953 .010 

Pulse Repetition      

 Rate range (Hz): .2  – 16,667 .2 – 10,204 .2 -  2,000  .2 – 2,004  .2  – 10,000 

 Period range (ms) .060 – 5,000 .098  - 5,000  .500 – 5,000 .499 – 5,000  .10 – 5,000 

 TBPMIN Minimum time  
 between Pulses  (ms): 

.010 .049 .450 .450 .050 

 Resolution (ms): .010 .001953 .010 .001953 .010 

Initial Pulse Delay      

 Time range (ms): 0 – 100 0 or .5 - 100  0 – 100 0 or .5 - 100 0 – 100 

 Resolution (ms): .010 .001953 .010 .001953 .010 

 
LEVEL TAB (OUTPUT PREFERENCES) 

About Level 
 

Â The SS58L stimulator allows the softare to specify the pulse amplitude.  The 
amplitude can be set to any value within the limits of the SS58L which is -10 
to +10 Volts. 

Pulse Level 
SS58L only 

 

The Level entry box allows the user to 
manually ente
of the system
Preference se
 
The Level entry
(grayed) if: 

1. 
2. If “Initiate pulse sequence with Recording” is active (from the General 

tab) and a pulse sequence is in progress or  “wait for trigger” is in 
progress. 

Use the entry box or the scroll bar to set the Pulse level. When a value is entered 
which is out of range, the value will be rounded to the closest value obtainable 
after the “Enter” or “Tab” key is pressed. 
If “Initiate pulse sequence with ON/OFF button in control panel” is active (from 
the General tab), then values entered during a pulse sequence will take place 
immediately. 
If “Initiate pulse sequence with Recording” is active (from the General tab), any 
entry made between acquisitions will take place on the next “Start” of acquisition. 

r any value within the limits 
, or within the limits of the 
ttings from the Level tab. 

 box will be inactive 

The Level preference “Lock entry to” is active. 

Allow any entry The level is limited from -10 to +10 V to support the output capabilities of the 
SS58L. This option allows any entry within that range. 

Limit entry This entry reduces the range (within the -10 to +10 V range limit). 
Lock entry This entry locks the level to a single specified value (between -10 and +10 V). 
Adjust entry This setting affects the scroll bar or scroll arrow increment only; it does not apply 

to manual entry. 
The smallest increment is 5 mV, as limited by the MP35. The specified increment 
is used to round manual entries to the closest obtainable value. 
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REFERENCES TAB (OUTPUT PREFERENCES) 

Reference Channel 
SS58L only 

 

 
This option allows you to “Monitor” the output signal on one of the analog or 
digital input ch aking any physical connections. This is an 
internal, hardware/firmware, feature that recreates the output signal and allows 
recording in “real time.” The assigned reference channel will override any “real” 

is connected to CH 1, and CH1 is chosen as the 
n the signal coming from the transducer will not be 

erence signal generated internally. 

annels without m

input signal. 
� For example, if a transducer 

reference channel, the
viewable, and will not conflict with the ref

The reference signal is not the real signal, but is a very accurate “estimate” of the 
real signal. The pulse timing accuracy will be within 100 microseconds. If an 
analog input channel is used as the reference channel, the pulse level will be 

that reduces or distorts the 

 +5 Volts. 

accurate within 5%. If the SS58L encounters a load 
pulse output, the reference signal will not reflect this amplitude distortion. 
If a digital input channel is used as the reference channel, only a digital 
representation of the pulse will be generated. In other word, regardless of the 
pulse level, when no pulse is occurring, the level will be 0 Volts, and when the 
pulse is occuring, its level will be shown as

Channel Assignment Use the pull-down menu to choose which analog or digital input channel will be 
used as the output reference channel. 
When a new reference channel is assigned, a warning will be generated to alert 
you that this setting will overwrite the existing Channel Setup parameters for the 
selected channel. 

 
� For example, if you set up CH1 for ECG data and then select CH1 for the 

lect 

The reference Channel label should read: “Stimulator-SS58L Reference Out”. 
When an Analog Input Channel is assigned as the Reference channel, that 
channel, as viewed from the MP35>Set up Channels dialog, will be in a “Lock-
Out” mode. This means that the Preset pull-down menu icon for that channel will 
be grayed (inactive). The assigned reference channel will be inactive for “real” 
in

Reference Channel, your ECG parameters will be replaced. If you then se
another channel, CH1 will be restablished with the default analog input 
parameters, and you would need to recreate your ECG settings (by using 
Presets or manual entry). 

puts until the Reference Channel Preference is changed to “None” or another 

Visit the online support center at www.biopac.com 
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REFERENCES TAB (OUTPUT PREFERENCES) 
channel. The wrench button, when pressed for the Reference channel, will still 
allow viewing of the channel parameters, but all entry boxes and pull-down 
menus will be inactive. 
When a “Stimulator – SS58L” control panel using an assigned Reference chan
is closed, the channel that was assigned as the reference channel 

nel 
will be removed 

from “Lock-Out” and will automatically change to the default, “CH X Input” 
settings. The reference channel assignment will be saved in the template or data 
file, so that if the “Stimulator – SS58L” control panel is reopened, the reference 
channel will be automatically re-assigned, without any warning prompt given. 

Generate using You can specify how the Reference signal should be shown. 
� If using analog input from CH1 - CH4, you may select actual or fixed (max) 

amplitude and actual pulse or fixed pulse width. Fixed pulse widths are useful 
 rate) 

� For example, for Frog muscle stimulation, you may choose to use a 1 ms 
pulse width, but a sample rate of 200 samples/sec. to capture the muscle 
response. At this sample rate, the stimulus pulse could not be reliably 
recorded. By extending the displayed pulse width to 100 ms, you will be 
guaranteed to always record the stimulus pulse. 

� If using digital input from D1 - D8, select actual or fixed (15ms) pulse width. 

when the pulse width is much smaller than the sample interval (1/sample
being used. 
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Usage Guidelines & Setup Summary for BSLSTM Output Control 

HUMAN SUBJECT SAFETY 
• Before using the stimulator on human subjects, it is very important to 

limit the energy the stimulator outputs. For optimal safety: 
• Before powering on the BSLSTM stimulator, set the voltage level to 

zero by rotating the LEVEL knob on the front of the BSLSTM fully 
counterclockwise. 

• Use BIOPAC HSTM Series Probes. You MUST use these probes 
order to limit the energy the stimulator can output. 

• Never create an electrical path across the heart. 
• Never use on subjects with pacemakers. 
• Read this manual and the BSL Hardware Guide to become familiar 

with Stimulator operation. 

1. Connect the BSLSTM Stimulator to the MP35/30 and power on both units. (For instructions on how 
to connect the BSLSTM to the MP35/30 Acquisition Unit, refer to the BSL Hardware Guide.) 
a. Connect the Stimulator Trigger cable to the Analog Out port of the back of the MP35/30. 
b. Connect the Stimulator Reference Output cable to an Input Channel on the front of the MP35/30. 

This channel will be set up in Step 3 as the Stimulator Reference Channel. 
• The Reference pulse has a fixed Pulse width of 15 milliseconds, so chosen so that the 

Sample Rate of the recording may be as low as 100 samples/second and still capture the 
Reference pulse. 

c. Before powering on the BSLSTM stimulator, set the voltage level to zero by rotating the LEVEL 
knob on t

2. Launch BSL PRO
a. Confirm that Markers are activated. 

• Markers are activated by default. If not activated for a given recording, choose Display> 
Show>Markers. 

3. Set up the Stimulator Reference Channel. This is the 
Analog Input Channel on the front of the MP35/30 that 
receives the Stimulator Reference Output cable from the back 
of the BSLSTM. 
a. Choose MP35/30 > Set up Channels. This will generate 

a Set up Channels dialog. 
b. Select the Acquire, Plot and Enable options for the 

analog channel to be set up as the Stimulator Referenc
Channel. 

c. Click Presets and scroll to select “Stimulator (0-10V)” or 
“Stimulator (0-100V)” to match the Range switch setting 
on front of the BSLSTM. 

d. Click View/Change Paramet rs. This will generate an 
Inpu

th the unit 
any preset parameters. 

d other input parameters as desired. 
meters.  

ndow.  

he front of the BSLSTM counterclockwise all the way to the left. 
 software to a new data acquisition window. 

e 

e
t Channel Parameters dialog. 

• Read the entire Stimulator section of this manual and familiarize yourself wi
and its options before ch

• You may set the Gain an
e. Click OK to accept the para
f. Close the Set up Channels wi

anging 

Visit the online support center at www.biopac.com 
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Adjust the voltage output of the stimulator by using the Level control on the front of the BSLSTM. 
 Rotate the Level knob clockwise to increase and counterclockwise to decrease, reading the voltage in 

the BSLSTM’s digital display. 
timulator Safety Features

•

S  
t operate unless its Output Control panel is open. 

 the Stimulator Output Control panel must be OFF in order to open and 
configure Stimulator Preferences. 

� If the Stimulator Output Control panel (or the BSL PRO application) is closed in the 
middle of a pulse train while the stimulator is running, the stimulator will shut down and 
the pulses will stop. 

quisitio  window is activated, the stimulator will stop and remain OFF 
d using the parameters associated with the new data window. The only 

� The stimulator canno
The Pulse ON/OFF Switch on

� If another data ac
unless restarte

n

exception is that if t
stimulator param
end of the acq

he stimulator is ON and the data window corresponding to current 
eters is acquiring data, then the stimulator will continue to run until the 

uisition. 
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Chapter 9 ommands MP35/30 Menu — Other C

  
This cha ill cover t 0  on Setup 
Channels and Setup Acquisition. 
Playba – Mac
When “Open for Playback” is select  the File menu, the MP menu changes to a Playback menu and 
includes opti
 
Set up Triggering 
Using a trigger allows yo n ut 
channel (CH1 to CH4). By default, t and during a normal acquisition, the MP35/30 will 

egin collecting data following a mouse click the 

pter w he MP35/3  Menu commands not discussed in the preceding chapters

ck menu  only 
ed from

ons to Capture to QuickTime and Exit Playback Mode. See page 46 for details. 

u to start a  acquisition “on cue” from a trigger connected to an analog inp
he trigger is off, 

b  button in the lower right hand corner of the 

reached
To begin th a trigger: 
1)  Selec  from the MP35/30 menu the Set up Triggering dialog: 

screen. When Set up Triggering is used, acquisition will begin when the established trigger level is 
. 

an acquisition wi
t Set up Triggering  to generate 

   
Set up Triggering dialog box and Source options 

2)  Choose a channel from the Source pull-down menu. You can select CH1, CH2, CH3, CH4 (MP35 
front panel) or an external Trigger (MP35 back panel). 
Â External Trigger requires a TTL signal from a third-party device such as a stimulator, pump, 

presentation program or force plate. 
3)  Choose Pos Edge or Neg Edge from the menu to indicate whether you want a positive or negative 

edge to trigger the acquisition. Look at the nature of the signal to determine which is most 
appropriate. 
Â A Positive edge occurs when the signal begins below the threshold and crosses above it. 
Â A Negative edge occurs when the signal begins above the threshold and drops below it. 

4)  Set the Trigger level by keying in a value or by moving the scroll bar to adjust the threshold value. 
When setup is complete, close the Set up Triggering window and click the  button to begin 
acquisition as soon as the trigger is activated. 
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The dialog et t  analog 
channel 4. 

box shown above is s o begin acquisition when a level of 25.00 Volts is reached on
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Show Input Values 

  
Whe  MP35/30 menu, a new window appears on the screen and 
displ setup to Enable Value Display (see Note below). The Input 
Valu y position on the screen. If the MP35/30 is disconnected 
or wi ll read “OFF.”  
Valu opriate analog channels whether an acquisition is in progress 
or no  to or after an acquisition; calculation channels will only 
be di g acquisition. 
The t ains the Input Values (IV) window options. 
Note  High Speed acquisition (see page 88). 

tion channels when the recording is stopped or while 
e triggering level. 

 ust be checked for Input Values display to work. 

n Show Input Values is selected from the
ays the values of all channels that were 
es window can be resized and moved to an
thout power, the Input Values dialog wi
es are displayed in real time for the appr
t, which allows you to display values prior
splayed durin
able on the following pages expl
: The IV window is disabled during

The IV window does not update calcula
waiting for a trigger device to reach th
The Enable Value Display option m

 
9 rformed in real time (i.e., during an 

mulate online spectral analysis using several 
online filters and the Input Values window. 

See also…

 TIP The FFT transformation cannot be pe
acquisition), but you can e

 
Save as Graph Template, page 178. 
 
Show Input Values Display options 
Incoming data can be displayed either as numeric values or in a “bar chart” format. These options are 
represented by icons that can be selected from the mode menu at the top of the Input values display. 

 
Clicking the Options button of the Input values display generates an Input Values Setup dialog where 
you can set additional display parameters: 

Visit the online support center at www.biopac.com 
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Show Input Values—Window Visibility & Position 
 
The visible state of the Input Values window display… 
� for active graphs displaying “.acq” or Lesson data will depend solely on the visible state of the last 

active graph. 
� for “.gtl” graphs will depend on the state when the file was saved, or changed since it was last 

opened. 
 
When only one graph is open: 
� When opening .acq or lesson files, the Input Values window will be hidden, regardless of how the 

file was saved. You must choose MP35(MP30) > Show Input Values to make it visible. Once 
made visible, the Input Values display will appear in the same position as when it was saved. 

� When opening .gtl (template) files, the Input Values window will open as it was saved (both 
visibility and window position).  

 
When more than one graph is open: 
� For multiple “.acq” files, if any Input Values window is visible, then the Input Values window 

will be visible for all graphs regardless of visible state when the graph was saved. The position of 
the window, however, is graph specific and will depend on the coordinates when saved or where 
it was moved to since it was opened in that file. If a template file is alos open, the visibility of the 
Input Values display when the “.acq” file is made the active graph will depend on the last visible 
state of the active “.gtl” file. 

� When switching between open “.gtl” (template) files, the visible state of the Input Values window 
will appear as it was saved or altered since it was opened (both visibility and window position). 
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Electrode Checker—MP35 

 
 
Electrode Checker 
Th  Electrode Checker, in conjunction with

use this feature
ttach the electrodes as you no

e  the P35/30 unit, measures how well electrodes are making 
contact with the surface of the skin. To : 
1) A rmally would. 
2) C
3) I r end of 

4) C
Thi
num lectrode/skin contact, with lower 
num g
displayed on t ker” on 
the MP35/30 u

 

M

onnect the electrodes to an electrode lead set (such as the SS2L). 
nstead of connecting the electrodes to one of the four analog inputs, connect the Simple Senso
the electrode lead to the Electrode Check port on the front of the MP35/30 acquisition unit. 
lick the MP35/30 menu and scroll down to select Electrode Checker. 

s will generate a small “thermometer-like” display. At the bottom of the display you should see a 
ber with kΩ after it. This value describes the impedance of the e
bers bein  associated with better conductivity. The better the conductivity, the “cleaner” the signal 

he screen. If the MP35/30 is off or no nothing is connected to the “Electrode Chec
nit, the Electrode Checker display will say “OFF.” 

   
 

o decrease the impedance of an electrode connection, you may want to “abrade” the 
surface of the skin with an ELPAD abrasive pad (included with the Biopac Student Lab 

. This removes a thin layer of dead skin cells and should result in a signal that 
little noise. 

 
 

MP30 Poor contact MP30 Good contact MP30 Off 

9 TIP While there are few absolutes as to what constitutes “good” contact, one rule of thumb is 
that this number should be below 10 kΩ, and the lower the better. 

9 TIP T

PRO System)
has relatively 

Visit the online support center at www.biopac.com 
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Au
d ling both control how data appears on the screen. By default, the most recently 

” so that th lw
When AutoPlott ed and S be cleared when the data 
reaches the right edge of the screen, a
When both Scrol d AutoPlottin be plotted until the screen 
is full. Once the screen is full, data will continue to be collected, but only the first screen is displayed. B  
default, the MP35/30 will display the first eight seconds of the data record, but this can be reset manually 
by changing the horizontal scale. To turn AutoPlotting ON or OFF in the middle of an acquisition, select 
Ctrl+T on the keyboard to toggle Au . 
 
Warn on Overwrite 
The Warn on Overwrite option will prompt yo
toggles on/off each time it is selected from the 

toplotting and Scrolling 
AutoPlotting an  Scrol
collected data will be display
“scroll

ed first and, if m
e newest data is a
ing is check

ore than one screen of data is collected, the time scale will 
ays on the right edge of the screen. 
crolling is deselected, the screen will 
nd plotting will continue from the left edge again. 
g are unchecked, the incoming data will ling an

y

toPlotting

u each time you start a new acquisition. The option 
menu. 

   
 
The OverwriteYES/NO prompt appears using Re etup. 

Click Yes to overwrite (erase) the current data
Click No if you do not want t  window. 

 
The File Exists OK/CANCEL prompt appears using a Repeat/Autosave acquisition setup. 

Click OK to overwrite (erase) the current data file with the new acquisition data. 
Click Cancel if you do not want to era ing in, and then choose a new 
file name. 

You can uncheck the Warn on overwrite option from the M
 
 

peat/Save Once acquisition s
 file with the new acquisition data. 

o erase the file that you are working in, then open a new

se the file that you are work

P35/30 menu to disable the prompt. 
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Organize Channel Presets 
The Organize Channel Presets option of the MP35/30 menu is related to the channel presets in the 
MP35/30 > Setup Channels dialog. You can organize the Presets (established or new) to place the most 
frequently selected at the top of the menu or to group related Presets, such as the established ECG Presets 
with any new channel Presets you create. Click a Preset description to select it, and then use the buttons to 
organize the Presets. The up and down arrows will move your selection one space at a time, and the Top 
and Bottom buttons will jump to the start or end of the list. 

  
Organize Channel Presets dialog and resulting Presets menu display 

  
nel Presets dialog and resulting Presets menu display Rev e Chan

 
To delete or rename a Preset, select 
the Preset name from the listing and 
click the Delete or Rename button. 
Or, click the right mouse button to 
select the Preset from the listing and 
scroll to the desired option. 

ised Organiz
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Rename a Preset by typing in a new 
description and clicking OK. 

 
 

Delete a Preset by selecting that 
option. You cannot delete the 
Default Analog Input preset. When 
you delete a Preset, you will be 
asked to confirm the request 
because it is an irreversible action.   
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Part D — Analysis Functions 
This part describes data analysis functio
well as editing data, performing mathematical transformations, and displaying data in various ways. In 
most cases, analysis is performed after the d omputed during 
an acquisition (primarily transformations a
Functions. 
The menu bar runs across the top of th

 

ns, which can involve creating, managing, and saving files, as 

ata has been collected. Features that can be c
ions) were discussed in Part C — Acquisition nd calculat

e display window. Menu bar structure is shown below: 

 
Chapter 8 (page 149) provides advanced descriptions of t
Descriptions of specific menu functions can be found in the chapte File, Edit, 

orm, and 

he Measurement, Marker and Grid functions. 
rs describing the 

Transf Display menus. 

Menu Details Type of Commands 

File page 171 General file managemen ands, including ope
saving, and closing files. Export data files. 

t comm ning, 

Edit page184 Cut, co , and 
f

py paste between and within files. Export data 
iles. 

Transform page 192 M
a

athematical transformations and functions, from simple 
rithmetic to digital filtering and spectral analysis. 

Display page 233 C or after 
an acquisition. 

ontrol how data appears on the screen either during 

 
Note: If you are not yet familiar wit the “look and fee

Working With the BSL Software for a review 
* Data window 
* Journ
* Tools on, I-beam
* Channel display 

 

h l” of the Biopac Student Lab PRO Software, see 
of these basic functions: 

* Scales 
* Scrolling 

, zoom * Keyboard Sh
al window 
 — selecti ortcuts 

* Right-mouse button shortcuts 
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Chapter 10 Measurements, Markers & Grids 
Measurement Basics 

 
A convenient feature in the BSL PRO  is the pop-up measurement windows. A variety of 
different measurements can be taken, and yo  
and/or similar measurements from different 
Measurement Display Windows 

To display the measurement windows

 software
u can display different measurements from the same channel
waveforms. 

 in the area above the graph window, click the  icon or select 
he number of measurement windows per row depends on the widthDisplay > Show > Measurements. T  

of the screen; stretch the display wind .  

By default, only one row of measurement 
windows is displayed. To display more 
measurement rows, choose File > Preferences 
> General, and choose a number between one 
and eight from the pull-down Show __ 
measurement rows menu. 

ow horizontally to increase the total number of windows per row

 
When the number of measurement rows is changed under General Preferences, all current measurement 
settings are cleared (set to “None”). 
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Taking a Measurement 

1) Select a channel for measurement. The PRO software can display measurements for the selected 
n the measurement box) or for any other channel. By default, the channel (as denoted by an “SC” i

software displays measurements f the 
cursor over the part of the measur
a channel number from the pop-u to the 
numbers in the channel boxes in t t corner of the graph window. Note: If “none” is chosen 
as the measurement function in th ayed. 

 
 a mea

rom the selected channel. To select a different channel, position 
ement window that reads “SC.” Click the mouse button and choose 
p menu. The channel numbers in the pop-up menu correspond 
he upper lef
e adjoining box, no measurement value will be displ

2) Select surement area. U
t the I-beam alway

se
s

function is chosen (such as Time)
area. 

Single-point measurements: 
When a sing cted, there is 
no area defined and the I-beam cursor 
will “blink.” The graph to the right 
shows how measurements for a single 
point can be selected with the I-beam. 
The cursor will flash when a single point 
is selected. 

 the I-beam cursor to select an area to measure. It is important to 
 selects at least one sample point. If a single point measurement 
, the measurement will reflect the last selected point in the defined 

remember tha

le point is sele

 

Selected range measurements: 
To select an area spanning multi
sample points, click-and-drag th
cursor to highlight the desired ar
is similar to highlighting in a word 
processor). See page 56 for selection 
details. 
The following window shows how an 
area can be selected for measurement 
with the I-beam. 
Note: If you have selected an area, but 
chosen a single point measurement 
function (such as Time), the 
measurement will reflect the last selected 
point in the defined area. 

ple 
e I-beam 
ea (this 
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IMPORTANT! The first data point the is “plotted” at time zero (1/2 dot on the left edge of the graph); 
first visible data point is sample point 1. The selected areas below demonstrate this concept. The data 
slection is inclus point ive of the end selections. 
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3) Select a measurement, position t easurement box and click the mouse button. 
Choose a me urement function from the pop-up menu. The measurement function in the upper half 
of the menu reflect amplitude measurements, or measurements which contain information about the 
vertical (amp measurement functions  the horizontal 
axis (usually  found section of the pop-up menu below the dividing line. Some of 
the measurement options change (or are disabled) if units are selected for the horizontal scale. 
Some of the values are single poi hers require at least two points to be 
selected. 

he cursor on a m
as

litude) scale. Other 
 Time) and are

 use information taken from
 on the 

nt measurements while ot

Single-point measurements Selected range measure ents m

Delta S, Lin_reg, Max, Max T, 
Min, Min T, Samples, Time, Value, 
X-axis T/F/X 

a, BPM, Correlate, Delta, Delta S, Delta 
ain), 

gral, Lin_reg, Max, Max T, Mean, Median, 

Are
T/F/X (based on units), Frequency (time dom
Inte
Median T, Min, Min T, p-p, Samples, Slope, 
Stddev 

 
w the r4) Revie esult. If the meas

, move the 
ure

unit is cut-off cursor ov
result window to display the full 
measurement result below it. 

ment 
er the 

In some case tions i  measurement can produce nonsensical results (such 
as dividing by zero, or calculating a BPM from a single point). In those cases, you may get a 

ment for 
The measure will disp cted, or if there are not enough data 
points selecte  for a meaningful m
functions and nimum samp

s, the computa nvolved in the

measure  value like INF (
ment result 

infinite). This means that the result was undefined at this point.  
lay “****” if no data is sele

d easurement. For a complete description of each of the measurement 
les for each, turn to page 153.  the mi

NOTE: You can validate measurements with the ValidateMeasurements.acq sample file that was 
inc  softw  to the “Sample data fileluded with the are. Pay attention ” section of the 
measurement definitions th age 153, and where included, note which sample at begin on p
poi idatnts to use for val ion (i.e., the first four sample points are used to validate the 
Co ment

 
Copying measurements  

To the journ e most useful options is to paste measurements to the journal. The journal 
is a general-purpose text editor that allows you to open, edit, and save standard text files. You can 
“paste” meas ements into the journal exactly as appear in the graph window by selecting Edit > 

rnal > Pa t. 
To the clipbo u can cop er 
applications. This means you can
and then past ata into a wor
Clipboard > Copy measuremen in the measurement windows will be copied to the 
clipboard. 

 
ting measurements 

One of the most important reason
software allows you to store and e
settings, only the measurement values themselves are copied to the journal or clipboard. You can 
change the settings to allow the m asurement name and other options to be included via File > 

rences > 

rrelate measure  using the ValidateMeasurements.acq file). 

al — One of th

ur
Jou ste measuremen

ard — Yo y measurements to the clipboard, where they are available for oth
 copy measurements (as they appear on the screen) to the clipboard 
d processor or other application. To do this, select Edit > e the d
ts and the values 

Expor
s to take measurements is to save them; Biopac Student Lab PRO 
xport these measurements in different formats. Under the default 

e
Prefe Journal.
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The table below explains the measurement options available and the range required for each. 

Measurement Area Explanation  

Area aMinimum are : 
3 samples 
 
Uses: 
All points of 

lected arease  

es the total area among the waveform and the straight line 

Area is expressed ed by horizontal 

Area comput
that is drawn between the endpoints. 

in terms of (amplitude units multipli
units) and calculated using the formula: 

( ) ( ) ( ) ( )( )
211 iiii

1
i

n x
xyxfxyxfArea

∆
∗−+−= ∑

1i

−

=
++  

Where: 

 – number of samples; n
1); i – index (i = 1.n-

1, +ii xx  - values of two neighboring points at horizontal axis ( 1x – the 
first point, nx – the last point); 

( ) ( )1, +ii xfxf  - values of two neighboring points of a curve (vertica
axis); 

l 

( ) ( )1,i xyxy +i  -  values of two neighboring points of a straight line 
(vertical axis). 

At the endpoints y( = d  y )= f( ). 1x )  f( 1x ) an ( nx nx

1−
∆

=∆xi n
ne can be found by formula: 

X - horizontal sample interval; 

The value of a straight li

( ) bxmxy +ii ∗=  

( ) 11 xmxfb ∗−= -  intercept; 

X
Ym

∆
∆

= - slope of the straight line; 

( ) ( )1xfxfY n −=∆  - vertical distance of increase at vertical axis; 

1xxX n −=∆ - horizontal distance of increase at horizontal axis. 

Sample plot: 

 
The area of the shaded portion is the result. 

Note: The Area measurement is similar to the Integral measurement 
except that a straight line is used (instead of zero) as the baseline for 
integration. 
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Measurement Area Explanation  

 
Results: This calcu  lation will always return a positive result.
Units: Volts - sec. 
Sample data file: “ValidateMeasurements.ACQ” 
 Result: 0.4533 Volts - sec. 

BPM 
(Time domain 
only) 

um areaMinim : 
2 samples 
 
Uses: 
Endpoints of 
selected area 

BPM (beats per minute) computes the time difference between the first 
and last points and extrapolates BPM by computing the reciprocal of this 
difference, getting the absolute value of it and multiplying by 60 (60 sec). 
The formula for calculation of BPM is: 

601

1

∗⎟
⎠

⎜
⎝ −

=
xx

BPM
n

 

Where: 

⎟⎜
⎞⎛

 

nxx ,1 - values of the horizontal axis at the endpoints of selected area. 

Note: This measurement provides essentially the same information as the 
Delta T and Freq measurement. 
Results: Only a positive value. 
Units: BPM. 

Calculate aMinimum are : 

 
Uses

2 sources 

: 
Results of 
measurements 
used in 
calculation 

Calc e used to p
meas  divide the m re by 

box disappears. 

ulate can b erform a calculation using the other 
urement results. For example, you can ean pressu

the mean flow. 
When Calculate is selected, the channel selection 

 
The result box will read “Off” until a calculation is performed, and then
will display the result of the calculation. As y

 it 
ou change the selected area, 

ht mouse button click) 
eform 

the calculation will update automatically. 
To perform a calculation, Ctrl-Click (or on PC, rig
on the Calculate measurement type box to generate the “Wav
Arithmetic” dialog. 
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Measurement Area Explanation  

 
Use the pull-down menus to select Sources and Operand. 

  
Measurements are listed by their position in the measurement display grid 

 

 

. 

(i.e., the top left measurement is Row A: Col 1). Only active, available 
channels appear in the Source menu. 
You cannot perform a calculation using the result of another calculation, 
so calculated measurement channels are not available in the Source menu.
The Operand pull-down menu includes: Addition, Subtraction, 
Multiplication, Division, Exponential. 
The Constant entry box is activated when you select “Source: K, 
constant” and it allows you to define the constant value to be used in the 
calculation. 
To add units to the calculation result, select the Units entry box and define
the unit’s abbreviation. 
Click OK to see the calculation result in the calculation measurement box

Correlate Minimum area: 

Uses

2 samples 
 

: 
All points of 

lected area 

, 
ent of a linear relationship 

se

Correlate provides the Pearson product moment correlation coefficient, r
over the selected area and reflects the ext
between two data sets: ix  - values of horizontal axis and ( )ixf  - values 
a curve (vertical axis). 
You can use Correlate to determine whether two rang

of 

es of data move 
together. 

Association  Correlation  
Large values with large values Positive correlation 
Small values with large values Negative correlation 
Unrelated Correlation near zero 

The formula for the correlation coefficient is: 

Correlate = 
( )( ) ( )

( ) ( )( ) ( )
⎥⎦⎢

⎢
⎣

⎟
⎠

⎞
⎜
⎝

⎛
−∗∗

⎥
⎥
⎦⎢

⎢
⎣

⎟
⎠

⎞
⎜
⎝

⎛
−∗ ∑∑∑∑

==== 11

2

11

2
n

i
i

n

i
i

n

i
i

n

i
i xfxfnxxn

 

⎥
⎤⎡⎤⎡ 22

 

Where:

⎟
⎠

⎞
⎜
⎝

⎛
∗⎟

⎠

⎞
⎜
⎝

⎛
−∗∗∑ ∑∑

= ==1 11

n

i

n

i
i

n

i
iii xfxxfxn

 
n – number of samples;  
i – index (i = 1..n); 
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Measurement Area Explanation  

ix  –  values of  points at horizontal axis ( – the first point, – the last 1

point); 
x  nx

( ) values of points of a curve ( vertical axis). ixf - 

Results: 
Returns a dimensionless index that ranges from -1.0 to 1.0 inclusive. 
Units: None 
Sample data file: “ValidateMeasurements.ACQ” 
 Result: -0.74825(for whole wave) and 0.95917  (for 

first four sample points). 

Delta Minimum area: 
2 samples 
 
Uses: 
Endpoints of 
selected area 

Delta returns the difference between the amplitude values at the endpoints 
of the selected area. 

Delta  ( ) ( 1xfxf n )−=  

Where: 
( )1xf , ( )nxf  – values of a curve at the endpoints of selected area. 

Results: 
If the data value at the starting location is greater than the data value
ending location of the cursor, then a negative delta will resu

 at the 
lt. Otherwise, a 

positive delta will result. 
Units: Volts 
Sample data file: “ValidateMeasurements.ACQ” 

his result shows the 
absolute value of change of amplitude (2) and the 

 Result: -2 Volts (for whole wave). T

minus sign means a decrease of amplitude. 

Delta S  Minimum area: 
1 sample 
 
Uses: 

Results

Endpoints of 
selected area 

Delta S returns the difference in sample points between the end and 
ing of the selected area. beginn
: This calculation will always return a positive result. 

tsUni : Samples 
 

Delta T(time) 
Delta F 
(frequency) 
Delta X 
(arbitrary unit) 

Minimum area: 
2 samples 
 
Uses: 
Endpoints of 

The Delta T/F/X measurement shows the relative distance in horizontal 
units between the endpoints of the selected area. Only one of these three 
units will be displayed in the pop-up menu at a given time, as determined 
by the horizontal scale settings. 

Measurement Horizontal Axis 

) 

a T

Delta T Time 
Delta F Frequency (FFT

selected area 

Delta X Arbitrary units (Histogram Bins) 
 
The formula for Delta T/F/X is: 

Delt 1xx n −=  

Where: 

nxx ,1 - values of horizontal axis at the endpoints of selected area. 
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Measurement Area Explanation  
Results: 
If the data value at the starting location is greater than the data value at the 
ending location of the cursor, then a negative delta will result. Otherwise, a 
positive delta will result. 

For Delta T measurements with the horizontal axis format set to 

in 

HH:MM:SS format value 
 ange the horizontal scaling 

options). 
Units

HH:MM:SS. 

9 For values less than 60 seconds, you will get a value 
decimal seconds. 

9 For values greater than 60 seconds, you will see an 

(See page 39 for details on how to ch

:  
Delta T: Seconds (sec.) 
Delta F: Hz 
Delta X: ”arbitrary unit” 

Sample data file: “ValidateMeasurements.ACQ” 
 Result: 0.12 sec. (for whole wave). 

Freq (time 
domain only) 

Minimum area: 
2 samples 
 
Uses: 
Endpoints of 
selected area 

Freq computes the frequency in Hz between the endpoints of the selected 
area by computing the reciprocal of the absolute value of time difference 
in that area. 
The formula for Freq is: 

Freq ⎟
⎟
⎠

⎞
⎜
⎜
⎝

⎛

−
=

1

1
xxn

 

Where:  
- values of horizontal axis at the endpoints of selected area. 

The information provided by this measurement is directly related to the 
Delta T and BPM measurements, and is related to a lesser extent to Delta S 
measurement. That is, if the Delta T interval between two adjacent peaks is 
calculated, the BPM and Freq measurement can be extrapolated.  
If the sampling rate is known, the Delta S can also be derived. 

nxx ,1

 

In this example, you can see 
Delta T, Freq and BPM 
measurements for the 
selected area. The Delta S 
can also be derived. 
The graph shows the selected 
area with measurements that 
describe the same interval in 
different terms. 
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Measurement Area Explanation  
Note: This does not compute the frequency spectra of the data. To perform 
a spectra analysis, use the FFT function (described on page 215). 
Freq (or frequency) is only ows. 
Results

 available in time domain wind
: This calculation will always return a positive result. 

Units: Hz 
Sample data file: “ValidateMeasurements.ACQ” 
 Result: 8.33 Hz (for whole wave). 

Integral Minimum area: 
2 samples 
 
Uses: 

Integral computes the integral value of the data samples between the 
endpoints of the selected area. This is essentially a running summation of 
the data. 

All points of 
selected area 

Lin_reg Minimum area: 
2 samples 

 

This plot 
graphically 
represe
Integral 
calculat
The are
shaded 
is the re

nts the 

ion. 
a of the
portion 
sult. 
ine support center at www.biopac.com 

 
Integral s expressed in terms of (amplitude units multiplied by 
horizontal units) and calculated using the following formula. 

 i

Integral = ( ) ( )[ ]
21

1
i

ii

1n

xfxf ∗+∑ ix∆−

=
+  

Where: 
n – number of samples; 
i – index (i = 1.n-1); 

 - values of  two neighboring points at horizontal axis ( – the 
first point, – the last point); 

1, +ii xx 1x
 nx

( ) ( )1, +ii xfxf  - values of two neighboring points of a curve (vertical 
axis); 

1−
∆

=∆
n

Xxi  - horizontal sample interval; 

1xxX n −=∆ - horizontal distance of increase at horizontal axis.  

Results: The Integral calculation can return a negative value if the 
selected area of the waveform extends below zero. 
Units: Volts – sec. 
Sample data file: “ValidateMeasurements.ACQ” 

Result: 0.300 Volts -sec.(for first 6 sample points) and 
–0.155 Volts -sec.(for last 6 sample points – the wave 
below zero). 

Linear regression is a better method to calculate the slope when you have 
noisy, erratic data. 
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Measurement Area Explanation  
 
Uses: 

Lin_reg computes the non-standard regression coefficient, which 
describes the unit change in f (x)

All points of 
selected area 

 (vertical axis values) per unit change in x 

the line 
owing formula: 

(horizontal axis). 
For the selected area, Lin_reg computes the linear regression of 
drawn as a best fit for all selected data points using the foll

Lin_reg = 
( )( ) ( )∑ ∑∑

= ==

⎟
⎠

⎞
⎜
⎝

⎛
∗⎟

⎠

⎞
⎜
⎝

⎛
−∗∗

n

i

n

i
i

n

i
iii xfxxfxn

1 11

( )∑ ∑
= =

⎟
⎞

⎜
⎝

⎛
−∗

n

i

n

i
ii xxn

1 1

2

Where
⎠

2  

: 
n – number of samples;  

is – the first point, – the last 
point); 

i – index (i = 1.n); 

ix  –  values of  points at horizontal ax ( 1x  nx

( )i

Note

xf - values of points of a curve ( vertical axis). 

: For a single point, Lin_reg computes the linear r
line drawn between the two samples on eithe

egression of the 
r side of the cursor. 

Results: 
If the data value at the starting location is greater than the data value at the 

hen a negative delta will result. Otherwise, a ending location of the cursor, t
positive delta will result. 
Units: Volts/sec. 
This value is normally expressed in unit change per second (time rather 
then samples points) since high sampling rates can artificially deflate the 
value of the slope. If the horizontal axis is set to display Frequency or 
Arbitrary units, the slope will be expressed as unit change in 
corresponding vertical axis values (frequency or arbitrary units, 
respectively). 
Sample data file: “ValidateMeasurements.ACQ” 

Result: 230.00 Volts/sec. (for 1-4 samples) and 
–170.00 Volts/sec. (for samples 4-7). 

Max Minimum area: 
1 sample 
 
Uses: 
All points of 
selected area 

Max (maximum) shows the maximum amplitude value of the data samples 
between the endpoints of the selected area. To compare peak heights, 
select each peak — you can easily see the maximum peak values or paste 
the results to the journal. Also, since you can simultaneously obtain 
measurements for different channels, you can easily compare maximum 
values for different channels. 
Note: For a single point, Max shows the amplitude value in this point. 
Units: Volts 

Max T Minimum area: 
1 sample 
 
Uses: All points 

Max T shows the time of the data point that represents the maximum 
value of the data samples between the endpoints of the selected area. 
Note: For a single point, Max T shows the time value in this point. 
Units: Seconds 

Mean Minimum area: 
2 samples 

Mean computes the mean amplitude value of the data samples between the 
endpoints of the selected area, according to the formula: 
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Measurement Area Explanation  
 
Uses: 
All points of 
selected area 

Mean = ( )∑
=

∗
n

i
ixf

n 1

1
 

Where:  

n – number of samples; 
i – index (i = 1.n); 

zontal a – the  last 
point); 

ix  –  values of  points at hori xis; ( 1x – the first point, nx

( )ixf - values of points of a curve ( vertical axis). 

Units: Volts 
Sample data file: “ValidateMeasurements.ACQ” 

Result: 1.538462 Volts (for whole wave). 

Median Minimum area: 
2 samples 
 
Uses: 

oints of 
ted area 

Median shows the median value from the selected area. 
Note

All p
selec

: The median and calculation is processor-intensive and can take a 
long time, so you should only select this measurement option when you 
are actually ready to calculate. Until then, set the measurement to “none.” 
Units: Volts 

Median T Minimum area: 
2 samples 
 
Uses: 
All points of 
selected area 

Median T shows the time of the data point that represents the median 
value of the selected area. 
Note: The median and calculation is processor-intensive and can take a 
long time, so you should only select this measurement option when you 
are actually ready to calculate. Until then, set the measurement to “none.” 
Units: Seconds. 

Min Minimum area: 
1 sample 
 
Uses: 
All points of 
selected area 

Min (minimum) shows the minimum amplitude value of the data samples 
between the endpoints of the selected area. 
Note

 

: For a single point, Min shows the amplitude value in this point. 
Units: Volts. 

Min T Minimum area: 
1 sample 
 
Uses: 
All points of 
selected area 

Min T shows the time of the data point that represent the minimum value 
of the data samples between the endpoints of the selected area. 
Note: For a single point, Min T shows the time value in this point. 
Units: Seconds. 

None n/a None does not produce a measurement value. It’s useful if you are copying 
a measurement to the clipboard or journal with a window size such that 
several measurements are shown and you don’t want them all copied. 
 
 

P-P Minimum area: 
2 samples 

P-P (peak-to-peak) shows the difference between the maximum amplitude 
value and the minimum amplitude in the selected area. 
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Measurement Area Explanation  
 Results: The result is always a positive value or zero. 

Units: Volts 
Sample data fi

Uses: 
All points of l
selected area 

e: “ValidateMeasurements.ACQ” 
Result: 13 Volts (for whole wave). 

Samples Minimum area: 
1 sample 
 
Uses: 
All points of 

s shows the exact number of samples of the selected waveform at 
 position—the first data point is not displayed, but is plotted at 

zero. 
See page 151 for examples of selected area Samples. 
Note

Sample
the cursor

: When an area is selected, the measurement will indicate the number 
 the waveform at the last position of the cursor.  

Units
selected area samples in

: Samples. 

Slope Minimum area: 
2 samples 
 
 
Uses: 
All points of 
selected area 

Slope computes the non-standard regression coefficient, which describes 
the unit change in f (x) (vertical axis values) per unit change in x 
(horizontal axis). 
For the selected area, Slope computes the slope of the straight line that 
intersects the endpoints of the selected area and can be found using the 
formula: 

Slope = 
( ) ( )

1xxn −
1xfxf n −

 

Where: 

( )1xf , ( )nxf  – values of a curve at the endpoints of selected area. 

- values of horizontal axis at the endpoints of selected area. 

This value is normally expressed in unit change per second (time rather 
then samples points) since high sampling rates can artificially deflate the 
value of the slope. 
Note

1x , nx

: Lin_reg (linear regression) is a better method to calculate the slope 
when you have noisy, erratic data. 
For a single point, Slope computes the slope of the line drawn between the 
two samples: the selected sample point and the sample point to its left. 
Results: 
If the data value at the starting location is greater than the data value at the 
ending location of the cursor, a negative delta will result. Otherwise, a 
positive delta will result. 
Units: Volts/sec. (or corresponding to Freq or Arbitrary setting) 
Sample data file: “ValidateMeasurements.ACQ” 

Result: 233.33333 Volts/sec. (for samples 1-4) 
r samples 4 ) and 
 whole wave). 

-166.66667 Volts/sec. (fo
-16. 66667 Volts/sec. (for

-7

Stddev Minimum area: 
2 samples 
 
Uses: 
All points of 
selected area 

Stddev computes the standard deviation value of the data samples between 
the endpoints of the selected area. Variance estimates can be calculated by 
squaring the standard deviation value. 
The formula used to compute standard deviation is: 

Stddev = ( )∑
=

−

⎟
⎠
⎞

⎜
⎝
⎛ −∗

−

n

i
i fxf

n 1

2

1
1
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Measurement Area Explanation  
Where: 
n – number of samples;  
i – index (i = 1.n); 

–  values of  points at horizontal axis ( – the first point, – the  last 
point); 

ix  1x  nx

( )ixf - values of points of a curve ( vertical axis); 

=
−

f ( )∑
=

∗
n

i
ixf

n 1

1
 

between the endpoi

- the mean amplitude value of the data samples 

nts of the selected area. 
Results: The result is alway  positive value or zero. s a
Units: Volts 
Sample data file: “ValidateMeasurements.ACQ” 

Result: 3.09570 Volts (for samples 1-4), 
1.000 Volts (for samples 10-12). 

Time Minimum area: See the X-axis: T
1 samples 
 
Uses: 
All points of 
selected area 

 measurement for explanation. 

Value Minimum area: 
1 sample 
 
Uses: 

he cursor 

ition of the 
cursor, corresponding to the direction the cursor was moved (the value will 

m right to left). 

Value shows the exact amplitude value of the waveform at t
position. 
For the selected area, Value indicates the value at the last pos

All points of 
selected area 

be the left-most sample point if the cursor was moved fro
Units: Volts 

X-axis
(horizontal 

:T/F/X Minimum area: 
1 sample 
 
Uses: 
All points of 
selected area 

Measurement

The X-axis measurement is the exact value of the selected waveform at the 
cursor position, based on the Horizontal Axis setting: 

 Horizontal Axis Setting    Units  
X-axis: T Time Sec. 
X-axis: F Frequency Hz. 
X-axis: X Arbitrary units Arb. units

For X-axis: T

units) 

 
 measurements, the time value is relative to the absolute time 

offset, which is the time of the first sample point. 
The X-axis: F measurement applies to frequency domain windows only 
(such as FFT of frequency response plots). The Freq function for time 
domain windows is described on page 157. 
Note: If a range of values is selected; the measurement will indicate the 
horizontal value at the last position of the cursor. 
Results: This calculation will always return a positive result. 
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Markers 

 
Wh
willwill

en Markers is selected from the Show submenu, the Marker region at the top of the graph window 
 be activated, and any markers associated with the data file will be displayed. 

from the Show submenu, the Marker region at the top of the graph window 
 be activated, and any markers associated with the data file will be displayed. 

 
You can insert “markers” into a record that act as bookmarks to record when an event occurs during the 
record. These markers appear as downward pointing triangles at the top of the graph window, and can be 
labeled to describe the associated event. Markers can be edited, displayed, or hidden from view. 
Markers can be inserted during an acquisition (except in high Speed mode) or off-line. 
¾ To add a marker while an acquisition is in progress, click the F9 key on a PC; 

the marker will be insert
¾ To add m

mous
When Display > Show g 
marker tools: 

ed at the exact time the key is pressed. 
arkers after an ac

e button. 
quisition, position the cursor in the marker area and click the 

 > Markers is selected, icons are generated in the marker region for the followin

 Find uss the previo  marker in the record. 

 Finds the next marker in the record. 

 Generates the marker pull-down menu, which lists all markers in the current file. To move to a 
select the desired marker label and release thegiven marker, scroll to  mouse button. 

The Summary to Jour arker 
time, and marker label open. 
Printing markers: The s 
from being printed, hid
indicators will be layer

nal feature copies marker information to the Journal. The marker number, m
are copied. This option is not selectable (grayed-out) when the Journal is not 
 markers will be printed when the marker display is enabled. To keep the marker
e the markers before printing. If the display is compressed, marker labels and/or 
ed when printed to prevent overlapped text. 

Visit the online support center at www.biopac.com 
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EXAMPLE OF MARKERS 

rk, open the 4channel.acq sample file. To see ho  wow Markers

 

er icons near the top right of the display. If the marker icons are not showing, c
r (flag) icon from the toolbar or Display > Show, then dr

 
Locate the mark lick 
select the marke ag right and down to 

select Marker t
To view the text associ
mouse button. 

To move from m  t

s. Selec ing either of these again will “hide” the marker area. 
ated with a given marker, position the cursor arrow over the marker and click the 

arker o marker, use the arrow buttons in the marker area.  
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Grids 
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o activate a grid display, click  in the toolbar or select Display > Show > Grids. T

Grid Display Off Grid Display On (unlocked) 
Grid Options 

To control the style and functionality of the grid display, 
select Display > Show > Grid Options. The Grid 
Options control grid format (line type, style, width and 

 
Overview of Locked and Unlocked Grids 

Grid functionality and dialog options for Horizontal Scale and Vertical Scale change based on whether 
grids are locked or unlocked in the Grid Options dialog (see above). 
  Locked Grid  

color), whether or not minor divisions are displayed, grid 
lock, and scale adjustment when grids are locked. 
 
 

  
  Unlocked Grid 
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U
Unl
sele  
and  grids are more helpful 
as a v nalysis tool. 
When n  into four major divisions (four vertical grid 
lines), r be set to represent time, frequency, or 
amplitu
When n r major divisions (four horizontal lines across the 
screen)  scope mode or X/Y mode; the grid cuts each track into four major divisions 

our horizontal lines per waveform) if the display is set to chart mode. 
B ugh the unlocked grid will be retained if the waveform is printed, saved as a graphic 
ima
Thi
 
Locked Grids 
Locked grids are helpfu ata 
for all functions. The default settings for the grid when in locked mode are: 

For

ded to the nearest whole number. 
ult setting for Channel, gain of 200, 

V / Division.) 
For horizontal scale: 

ase Point  = 0; 
Major Division = 1 second if sam
 = 50

When gr ked,

nlocked Grids 
ocked grids help you view the data display on the monitor. The Unlocked setting, enabled by NOT 
cting “Lock Grid Lines”, displays four major grid divisions across the horizontal and vertical axes,
 will generate interval numbers as needed to match the zoom factor. Unlocked

isual aid than an a
ot locked, the grid always cuts the horizontal scale
egardless of the horizontal axis setting, which can 
de values for an X variable. 
ot locked, the grid cuts the vertical scale into fou
if the display is set to

(f
eware!  Altho

ge or copied to the clipboard, the BSL PRO software will “round” the scale values. 
s process does not affect the nature of the data, only the scale used to plot it. 

l with analysis and printing. Selecting “Lock Grid Lines” locks the grid to the d

 vertical scale: 
Base Point  =  0; 
Major Division = 1/10 full scale range roun
  (For example, with the defa
  the major division would be set to 10m

B
ple rate is <= 2,000 s/s. 

 ms if sample rate is > 2,000 s/s. 
ids are loc  you may set the grid interval (see next page). 
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Grid Interval 
Grid Interval follows th
given channel or for all  horizontal and 
v r /Range as the 
p then set the scale range and grid interval options in the Vertical Scale and 
Hor
to u scale 
whe

e settings established in the Vertical scale and Horizontal scale options for the 
 channels. When grids are locked, interval parameters for the
mined in the Grid Options dialog. Choose Start/End or Middle Pointertical scales are dete

arameters to use and 
izontal Scale dialogs, respectively. Scaling button generates the scaling dialog, which you may want 
se to adjust the display of units. See page 39 for a discussion of Vertical scale and Horizontal 
n grids are unlocked. 

Grid Options : Lock option Vertical scale options Horizontal scale options 

Unlocked Grid (default) 

 

 
 

Loc
Sta

ked Grid: 
rt/end parameters 

 
 

 
 

Note: The Base Point Æ 
is the point from 
which the first grid 
line will be drawn. 
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Grid Options : Lock option Vertical scale options Horizontal scale options 

Lock Grid Lines: 
Midpoint/range parameters 

 
 

Note: The Base Point Æ 
is the point from 
which the first grid 
line will be drawn. 

 

 
A few Grid Option compa
familiarize yourself with t

Using Grid Options with
can very closely match c

Note  The standard (“clinical”
major divisions of 0.2 se

 on the v
divisions at one-fift
horizontal and 0.1m

 

risons follow, but you are encouraged to experiment with grid settings to 
he effect each option has on the data display. 

 the Print Options, you 
hart recorder output: 

) ECG uses a grid with 
c on the horizontal 

and 0.5 mV ertical, and minor 
h of that, or 0.04 sec 
V vertical. 

Grids On/Unlocked with Scale increased 2x Grids On/Locked with Scale increased 2x 
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Grids On/Locked using start/end point adjustment 

 
Grids On/Locked using middle point/range adjustment 

Visit the online support center at www.biopac.com 
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Chapter 11 File menu commands 

  
Most File menu commands are standard menu items that foll
New 

ow the standard OS conventions. 

In almost all cases, you will need to create a new graph window before beginning an acquisition so that 
the data may be displayed on the screen. To create a new graph file, choose File>New. A new graph 
window will be generated similar to the one pictured. 

 
the window parameters, including horizontal scale, vertical scale, window size 

n, you can also set the acquisition parameters for sampling rate, number of 
n length. These settings take effect o

You can modify any of 
and position. In additio
channels, and acquisitio nce an acquisition begins. 
Note Choosing File>

settings as the a
window with th
application def

You may also open a new 

New from an open, active graph window generates a new window with the same 
ctive window. Choosing File>New when all windows are closed generates a new 
e same settings as the last saved window. To generate a new file with the 

ault settings, you must quit and relaunch the BSL PRO application. 
Journal file, which will be linked to and saved with the Graph window.  
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To open a ne l w Journa file, click the Journal icon  of the graph window toolbar or choose 
al. (Mac: Choose File>Open>Journal). The journal window will open below theDisp  

graph window
Open 
The File > Open comm
different file formats fr
either text files or Biop
format. You can view t
(*.Ldd), Text (*.TXT), r All BIOPAC Files. The Open dialog points to the 
last loca

lay>Show>Journ
. 

and generates the standard file open menu, and allows you to open a variety of 
om the pull-down menu at the bottom of the dialog box. Data can be read in from 
ac Student Lab (PRO or Lesson) files, and can be saved in text, graphic, or binary 
he files by type from the following options: BSL PRO (*.ACQ), BSL Lesson 
 Graph Template (*.GTL), o

tion used by the BSL PRO Open function. 

 
SL PRO files (*The default display is B .ACQ). The File type option you select limits the file listing. If 

“ , only
files are listed. If “All B

BSL PRO files (*.AC
T

m ut how the data was collected (i.e., for how long 
and at n

PC: Click the icon 

Text” is selected  text files are listed; if “GraphTemplate” is selected, only BIOPAC graph template 
IOPAC Files” is selected, all files in formats that BSL PRO can open are listed. 
Q) 

he default file for
compact .ACQ for

mat (.ACQ) is referred to as a “BSL PRO” file. BSL PRO files are stored in the 
at that retains information abo

what rate) a
editable and can be

d is the standard way of displaying waveforms in BSL PRO. BSL PRO files are 
 modified and saved, or exported to other formats using the Save as command. 

PRO file, only the graph window will be displayed by default. To display the When you open a BSL 
Journal that is associated with the file:  

of the toolbar display or choose Display>Show>Journal. 
Mac: >

BSL Less L
BSL PRO c n  
files are ope th  and 
journal files are bot  
file in BSL PRO, y tudent Lab file. You must save the new file in the BSL PRO 
format or alternate 

 Choose File
on files (*.

Open>Journal. 
dd) 

an ope
ned, 

 lesson files generated in the Biopac Student Lab program. When BSL Lesson
ey mimic the “Review saved data” mode of the Student Lab such that the data
h opened and properly positioned. If you open and make changes to a BSL Lesson
ou cannot save as a S
format. 
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Text files (*.TXT) 
Text files are a useful way to transfer information between applications. BSL PRO can both import 
and export text files. Most spreadsheet and statistics programs are capable of importing or exporting 
data in a text file format. 
BSL PRO assumes  columns and rows, 
and that there is som olumn represents a 

inct variable or 
variable at differen lotted as 

ata in a  
 in as a 

IMPORTANT! Files saved with headers store the header information on the first line and start 
ot the first). The Read Text Options default reads from 

Line 1 to the end, so you should adjust the line number if the file has a header. 
Te

that the text file to be opened contains numeric data laid out in
e delimiter between each column. It also assumes that each c

dist channel of data. Normally, the values in each row represent the state of each 
t points in time. When a text file is opened, the numeric values will be p

waveform d
data is read

 standard graph window and non-numeric values will be ignored. Each column of
separate channel. 

data on the second line (n

xt Options 
When the “Tex

g on th
t files” option is selected, an Options button will be activated in the Open dialog. 

Clickin is button generates a Read Text Options dialog box that allows you to control the 
a pmount and ty e of data to be read in, as well as the time scale for data display. 

 
Read Text Options : File > Open > *.TXT > Options… 

Read line This entry controls how much data is read in and indicates which row contains the
first data point in the series. By default, text files will be read in starting at line 
one. 

By default, text files will be read until the 

 

To end of the file is reached. You may want 
to set it to another value since some applications (usually spreadsheets) generate a 

ation at the top of a file. You can limit the amount of data 
 clicking next to line and entering a value in the box that is activated; the 

n this box indicates the line to end the data on. 

trol the horizontal scale (usually time) for the text file after it is 
ints, 

ted at 50 samples per second, there is an interval 
between sample points of 0.02 seconds. The BSL PRO software would then 
assume that there is a 0.02 second “gap” between the data point in row two and the 
data point in row three (and all subsequent pairs of adjacent rows). Likewise, if 

 that spans 10 seconds and has 100 rows of data, the interval 
oints will be 0.01 seconds. 
 time domain data, although some applications generate 
 data (the results of a spectral analysis, for example). The 

principle here is the same as with time data, that there is some interval between 
different frequencies. If a text file contains 20 sample points covering the range 
between 0 and 60Hz, then the interval would be set to 3Hz per sample. 

Column 
delimiter 

This setting determines what characters indicate a “gap” between two columns. All 
text files must have some sort of column delimiter, unless there is only one channel 

End/Line 
“header,” or text inform
read in by
value i

Set to You can con
displayed in the graph window by changing the interval between sample po
which can be expressed either in terms of time or frequency. 
For example, if data were collec

you have a data file
between sample p
Most files contain
frequency domain

f d Thi b b
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Read Text O ons : File > Open > *.TXT > Options…pti  
of data present. This can be set to tab, comma, space, or auto. 

Tab Tab delimited text files are the most common, and in this type of text file a tab is
placed between each column for every row of data. These files are most often 
generated by spreadsheets and similar packages. 

 

Comma Comma delimited files place a comma between each column of data for each row, 

place 

Auto If you are not sure which delimiter to use, select Auto and the BSL PRO software 
will automatically select a delimiter. 

o numeric values between 
a, 

07,, 0.894992 

 
ill contain six data points, the first being 0.301424 and the last 

 

mas). The 
third channel will contain five data points, starting with 0.045015 and ending with 
0.894992. 

 
Graph Template files (*.GTL) 

The Graph Template option allows you to open a file that contains master settings. Graph template 
files are master files that open to previously saved window positions and setup parameters (as 
established under the MP35 menu). 
When a Graph template file is opened, the graph window does not contain any data. The journal 
window can contain text saved with the template. The Journal display will use the default Tab setting, 
so you may need to adjust Tabs under File > Preferences > Journal. 
After acquiring data using a graph template, the Save As option must be used to save the data. 

much the same way as a tab delimited file. These types of files are frequently 
created by statistics programs such as BMDP and SAS. 

Space Space delimited files are also commonly created by statistics packages, and 
some number of spaces (usually two) between each column of data for every row 
which contains information. 

Note: When either Tab or Comma is selected, the software will read in a new column 
each time it sees a delimiter, even if there are n
delimiters. For example, the following text file will read in three channels of dat
although the channels will be of different lengths:  

0.301424, 0.276737, 0.045015 
0.338723, 0.808811, 0.542627 
0.354271, 0.506313, 0.715995 
0. 001325,, 0.762115 
0.9462
0.926409,, 

Sample text file
The first channel w
value being 0.926409. The next channel will contain three data points, starting
with 0.276737 and continuing through 0.506313 (the software considers that there 
are no other data values for the second channel; notice the double com
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This feature is especially useful for recreating protocols in the classroom. Instructors set up an 
 
 

stallation — see page 249. 

experiment and save it as a Graph template and then set the Read-only attribute in the file Properties
dialog. Students then simply open the Graph template file and click the Start button. See the Save As
Graph template section for more details.  
A sample graph template file is included with the BSL PRO in
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Open f
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or Playback 
Mac only – see page 46. 
 
Close 
You can close the active window without quitting the application by selecting Close from the File menu. 

Alternately, you can click in the  in the upper right corner of the window or use the Ctrl-W keyboard 
shortcut. 
Save 

item will save anyThis menu  changes you have made to a file. This includes changes to the Journal, 

ue working. The Graph and 
RO 

file at used to store binary data. 
der the MP35 menu) and window positions, 

cluding the Journal window. 

 

markers, measurements, etc. If more than one file is open, this command only applies to the active 
window. For untitled files, you will be prompted to name the file you wish the data to be saved in. 
The file will remain open after you have saved it, allowing you to contin
Journal are both saved when Save is selected. By default, all files are created and saved in the BSL P

format, a proprietary form
Saving a file saves the setup parameters (established un
in
 
Save As… 
Choosing Save As… produces a standard dialog box that allows you to set the format and location to save
the data in. The Save As dialog points to the last location used by the BSL PRO software Save/Save As 
function. All Save features apply to the Save As function. You can use Save As to save a file to a 
different file name or directory than the default settings. 

 
The default file format for the Save As… command is to save data as BSL PRO (*.ACQ) files. The other 
opti te (*.Gtl). These 

pti e
ving a file in the BSL PRO format saves data in the most compact format possible and takes 

 

ons are to save data as a Text file (*.TXT), a Metafile (.WMF), or a Graph Templa
ons can b  selected from the pop-up menu at the bottom of the dialog box. o

As a rule, sa
up less disk space than other file formats. Except in exceptional cases, you will save graph windows in the
BSL PRO format. 
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BSL PRO files (*.ACQ) 
Selecting *.ACQ from the pop-up menu in the Save As… dialog box will save a file as a BSL PRO 
file, which is designed to be as compact as possible. These files can only be opened by BSL PRO 
software, but data can be exported to other formats once it has been read in. 

Option button 
When you Save As a BSL PRO (*.ACQ) file, an 
Option button is enabled in the Save As dialog 
box. Click the Option button to generate a Save 
Options dialog that allows you to control how 
much data is saved. 

 
Text files (*.TXT) 

 graphs can also be saved as text files through the Save As… dialog box.  
IMP

 on 
n. 

O

Data from BSL PRO
ORTANT! The Save As Text option will only save the graph data as text, you will lose all 

journal data. If you have journal data you want to save, you must first save the 
journal as a separate text file with a unique filename using the Save As option
the Journal Toolbar. Then save the graph data using the Save As Text optio

ptions button 
When you Save As a Text (*.TXT) file, there is an 
Options b
Click the Options button to generate a Save 

g that allows you to control how 

utton in the Save As dialog box. 

Options dialo
much data is saved and the format it is saved in. 
 
 

Save Options : File > Save As > *.TXT > Option… 

Include Includes a  “header” on the first line of the text file that co
 sampling rate, number of channels, date created, header 

ntains information 

ill 
nsical 

 
using a text editor or the journal. With this option, data starts on Line 2. 

ith 
 file 

brief segment of a long file.  

Horizontal 
scale 
values 

Allows you to include the horizontal scale values in the text file, along with the 
data to be saved. This allows you to produce time series plots in other applications, 
as well as correlating events to time indexes in graphing and statistical packages. 
Since a separate row is generated for each sample point, it is possible to exceed the 
limitations of programs if data is collected at a fast sampling rate (many 
spreadsheet programs are limited to about 16,000 rows). See page 210 for 
information on resampling data after an acquisition is completed. 

Column 
delimiter 

Controls the type of delimiter used to separate columns of data in the text file. 
When data is saved as a text file, each channel of data is saved as a separate 
column, with the number values for each data point saved in rows. Select tab, 
comma, or space from the delimiter menu. By default, a tab is placed between each 

about the and other information 
relating to the data. This information is frequently useful, but some programs w
attempt to read in the header information as data, which could result in nonse
results. You may wish to include the header as it can always be edited out later

Selected 
section 
only 

Allows you to save only a portion of the data file. This saves the area selected w
the I-beam tool from all channels as another file and will not affect the current
that you are working in. This is useful for saving a 
¾ When only one data point is selected, the entire file will be saved. 
¾ If you want to save only a portion of the selected channel, you can either 

remove other channels or copy the data through the clipboard (see page 
188 for more information). 
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Save Options : File > Save As > *.TXT > Option… 
column for every row of data. This format is called a tab-delimited text file and 
almost all applications will read in tab-delimited text files. 

file (*.WMF) 
ddition to graph and text files, the BSL PRO software also supports formats for saving graphical 
rmation —Windows Metafile (.WMF). Most drawing, page layout, and word 

Meta
In a
info processing 
pro  
ope
par

grams can read .WMF files. This is particularly useful for writing reports. A .WMF file can be
ned in any standard drawing program and can then be embellished or used to highlight any 
ticular phenomena of interest. 
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When data is saved as a graphic, only the data currently on the screen is saved. So, if you have a data 
file that spans eight hours but y two minutes is display he screen, only two minutes of data 
will be converted to a graphic file. To save data in this format, choose .WMF from the pop-up menu 
at the bottom of the Save As dialog box. Since BSL PRO uses information about the computer screen 
in creating the graphic file, the default resolution of the file will be the same as the window. Most 
word processors and graphics packages allow for some way to resize and scale graphics. 

Graph Template (*.GTL) 
The Save As Graph template option saves the setup parameters (established under the MP35 menu) 
and window positions, including the Journal window. Any windows and controls (such as Input 
Values, Triggering Setup, and Output Control) that were active when the Graph template was saved 
will retain the same positions and settings when the Graph Template is reopened.  
IMPORTANT! Saving as a Graph Template does not save any data – it only saves the setup 

parameters and window positions. You must select Save / Save as to save the 
graph and/or journal data. 

When a Graph template file is opened, it does not contain any data. After data acquisition, the Save 
option will not be selectable; you must use the Save As option. This feature can be especially useful 
for recreating protocols in the classroom. Instructors can set up an experiment and save it as a Graph 
template and then set the Read-only attribute in the file Properties dialog., and then students can 
simply open the Graph template file and click the Start button. 
When this feature is used with the menu.dsc customization feature (on page 64) it is easy to create 
your own personal lessons in addition to those featured in the Biopac Student Lab Manual— see page 
63. 

  

This is an example of a 
Windows Metafile (.WMF) 
file that was copied to the 
clipboard, pasted into this 
Word for Windows 
document and resized to 
better fit this page. 

 

onl ed on t
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Print 
 
The Print menu generated 
by the BSL PRO software is 

rint Options” that add 
functionality. 

s 
apply only to graph 

ply 

Print _ ed. 
Printing more than one plot per page has the effect of “snaking” graphs on a 
page much the same way text appears in a newspaper. This option allows you 

 printouts, and is 
 printed. 
ots were printed per 

page, the BSL PRO software would divide the amount of data to be 
 the 

Fit 

 
Using Grid Options with the Print Options, you can very closely match chart recorder output: 

similar to the standard 
computer print dialog but 
contains two additional 
“P

These two Print Option

windows; they do not ap
to journals. 

 
 

_ plots per page  Allows you to control how many plots appear per page when the file is print

 

to print records on considerably fewer pages than standard
most effective when only a few channels of data are being
¾ For example, if this option was selected so that two pl

printed on that page into two graphs — one graph printing at the top of
page, the second graph printing at the bottom of the page.  

to __ pages  Allows you to print the contents of a window across multiple pages by dividing 
the amount of data on the screen (the amount of data to be printed) by the 
number of pages entered in the dialog box. The graph on the screen is then 
printed across the number of pages specified. 
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Printer Setu
Choosing Prin p dialog box 
that allows you to setup any available printers. All th ns in this dialog box function as described in 

p / Page Setup 
ter Setup (PC) or Page Setup (Macintosh) produces a standard printer setu

e optio
your system manual. 

 
There is also a Properties button that allows you to make several printing adjustments with respect to 
font
 

s, image orientation, and graphics presentation. 
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Preferences... 

 
The File>Preferences command displays a sub-menu with re ournal and Markers. 
Each option generates its respective Preferences dialog. 
 
The File>Preferences submenu may also display an option 
for Output Control Preferences, but only if an output control 
is active. See Output Control on page 120 for more 
information. 
 
 
General Preferences 
Selecting File>Preferences>General generates a Display 
Preferences dialog that allows control of measurement and 
waveform display, and other BSL PRO features. 

th e options: General, J

File > Preferences > General: Display Preferences Dialog 

Measurement 
Options 

Measurement Options allows control of the measurement boxes for each channel at 
the top of the graph window.  

Show X 
measurement 

rows 

Controls how many measurement rows are displayed in the window at any one 
time. By default, this is set to “1” but may be set to any value between 1 and 8 by 
choosing a number from the pull-down menu. When you change this setting, all 
the current measurement values are cleared (set to "None"). (Note: To Show or 
Hide the measurement rows altogether, toggle the option in the Display > Show > 
Measurements menu. See page 238 for more information.) 

Show X digits of 
precision 

Allows control of the precision with which measurements are displayed. The 
default is 6 digits, but precision can be set to any value between 1 and 8 by 
choosing a number from the pull-down menu. This option controls the number of 
digits displayed right of the decimal place for all visible measurement windows. 
For instance, if this value is set to 3, one measurement window might show 
125.187 while another reads 0.475. 
When the precision is changed, the value will be rounded up or down based on the 
selected data value. The precision does not alter the data file. For example, if the 
selected data value is 0.00480000, 4-digit precision will display 0.0048, 3-digit 
will display 0.005, and 2-digit will display 0.00 (not 0.01 which would be a round-
up from 0.005 rather than from the selected value of 0.00480000). 

Waveform 
Display Options 

These options control how waveforms are displayed on the screen. 

Draft mode Allows for some (“compressed”) waveforms to be plotted in “draft” mode, which 
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File > Preferences > General: Display Preferences Dialog 
for compressed 

waves  
results in faster plotting time, although the display is not exact. A waveform is
considered compressed when more than three sample poin

 
ts are plotted per pixel 

pressed waveform would 
be any type of waveform displaying more than 2400 samples on the screen at any 
one time. Using the default horizontal scale (which plots eight seconds of data on 
the screen), any data sampled at more than 300 samples per second would be 
considered “compressed.” 

ault 
ay 
 

Update screen 
interval 

The Update screen interval option lets you adjust the rate that the screen is 
updated, which can be useful when ou have a large data file (as in sleep studies) 

er page 
n set the interval to update in full page, half page, or quarter page 

increments. Click in the circle next to the desired interval in the “Update screen 
te in the selected interval when you scroll 

 ba
e region and choose the desired screen interval 

” at the bottom of the dialog. The first two options 
 filtered 

xis. 

 after 
transformations 

Automatically rescales all waveforms after a transformation to provide the “best 
fit” along the amplitude axis. 

Tile after 
transformations 

Tiles all visible waveforms after any transformation, and is mutually exclusive of 
the Autoscale command. Waveforms appear to be stacked on top of each other. 

Use all available 
memory 

Attempts to use all the available memory for loading data. Otherwise, a variable 
sized buffer is used to load portions of large data files. This option works best if 
there is enough free memory to load the entire data file. 

Interpolate 
pastings 

Interpolates/extrapolates time base data to fit the sample rate of the destination 
window when working with data sampled at two different rates. 

Note  When you Interpolate pastings, you should copy data to a higher resolution 
window. Although it is possible to copy data in the other direction (from high 
resolution to low resolution), it is not recommended since some resolution will be 
lost in the process. 
For example, if y form sampled at 50 samples per 

rm 

 
Journal Preferences 
S l o ol 
t en

on the screen. 
For example, on a display that is 800 pixels wide, a com

Enable tools 
during 

Activates the selection, I-beam, and zoom tools during an acquisition. The def
is to dis

acquisition 
able these tools during acquisition. Use of tools during an acquisition m

create display problems. It is recommended that you only turn on tools for very
slow acquisitions. 

y
and you want to quickly jump through the data. 

Full, Half or You ca
Quart

at a time interval” section and the screen will upda
through the data using the the horizontal scroll

9 TIP Right-click in the Horizontal Scal
from the menu. 

Other Options There are four “Other Options

r. 

control the amplitude (vertical) axis after data has been transformed (e.g.,
or mathematically operated on). Neither option affects the horizontal a

Autoscale

ou have one 30-second wave
second, and another 30-second waveform sampled at 2,000 samples per second, 
you can copy the contents of one window into another using the insert wavefo
command. This will interpolate one waveform so that both appear to be 30 
seconds long. In this example, data would be copied from the 50Hz (low 
resolution) window to the 2,000Hz (high resolution) window. 

electing the Journa
he format of data wh

ption in the File > Preferences menu generates a dialog that allows you to contr
 it is displayed in the journal. 
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The Tabs and Font selections will be used t l and will be applied to all text 
within all open Journal w ttings). 

o display and print the Journa
indows (they are global application settings rather than file specific se

 
 

File > Preferences > Journal: Journal Preferences Dialog 

Tabs The Ta umber of inches between tabs. The Journal display 
ma

Ch
 

Yo
sta

Measurement 
paste options 

 

Include the 
measurement 

name 

Pastes the measurement name (i.e., BPM, delta T, Freq, and so forth) along with 
the values. 

Include the 
measurement 

s 

Pastes the measurement units (i.e., volts, mmHg, and so forth) after the numeric 
values. 

e the 
channel number 

Inc

Put each 
m

Us

Wave Data Paste 
Options 

 

Include time 
values option 

Copies the horizontal scale values along with the waveform data when data is 
copied to the clipboard. This means that when you paste data from the BSL PRO 
screen into a spreadsheet or similar application, horizontal scale information is 
retained. 

 
Marker Preferences 
Selecting the Marker option in t
File > Preferences menu 
generates a dialog that allows yo
to control the options for markers. 

bs setting specifies the n
y or may not appear accurate, but tabs will be accurate for printing. 

u can specify the font to use for journal text display. This button leads to the 
ndard font dialog. 

ange font 

unit

Includ ludes the channel number at the top of each column of data. 

es separate lines in the journal/clipboard. 
easurement on a 

separate line 

he 

u 
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here are four tabs of settings options in the Marker Preferences dialog: Append Markers, Events 
nt Markers (Sequential), and Journal Summary. For information about using 

Markers and setting Marker Preferences, see page 164. 
 
Quit 

Selecting Quit from the File menu exits 
the BSL PRO application and prompts 
you to save any open graph or journal 
files that have been modified since they 
were last saved. 

T
Markers (Fixed), Eve
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Chapter 12 Edit menu commands 

  
On
cut
allo
Un
Wi  carried out by Biopac Student 
Lab y deleted or modified. The 
Undo c
filtering and mat  
as “Undo Paste.”
 

Can’t Undo 
There are some exceptions to the Undo command, and you should be aware of them before you choose 
to use any command. The following commands cannot be undone: 
¾ Display options (i.e., changing the horizontal scale or changing the color of a waveform) cannot 

be undone, since they are easier to manipulate and less drastic than cutting data out of a waveform. 
If you modify the screen scale (or other display parameters) you will still be able to undo your 
latest data modification, which is much more difficult to recover than a screen parameter change. 

¾ Clear All cannot be undone. It is a good idea to make backup files before performing any editing, 
especially when using this command. 

¾ Remove Waveform cannot be undone. It is a good idea to make backup files before performing 
any editing, especially when using this command. 

¾ Insert Waveform cannot be undone, but selecting the inserted channel and choosing Remove 
Waveform from the Edit menu effectively undoes this operation. 

¾ Rewind button cannot be undone. 

9 TIP If you accidentally remove a waveform or choose clear all, one way to recover the data 
is to close the file without saving the changes. The data file can then be reopened as it was 
when it was last saved; any changes made since it was last saved will be lost. 

e of the most useful features in the Biopac PRO software is the ability to edit and work with data by 
ting sections and copying sections from one window to another. The Edit menu contains options that 
w you to work with data much as a word processor lets you work with text. 
do 
th some exceptions, the Undo command will undo the last command

PRO are. This allows you to restore data that was unintentionall softw
ommand applies not only to editing commands, but also to transformations (such as digital 

hematical operations). When Undo is enabled, it will list the command it can undo, such
 When a command can’t be reversed, the Undo option will read Can’t undo. 
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W d, the selecte  active channel (waveform) is removed and 
copied to a cl e it is available for pasti
fr a shifts l  
after the selected area will be shif

9 TIP The Cut function al
consider alternative ng the 
section of the data using smoothing, digital filtering, or the Connect Endpoints functions. 

Cut 
hen Cut is selecte d (highlighted) area of the

ipboard, wher
om a waveform, the dat

ng into other waveforms. When a selected area is cut 
eft to “fill in” the deleted area. So, if ten sample points are cut, all data
ted ten sample points to the left. 

ters the relationship of events to the time base, so you might want to 
s to cutting sections of data. Other options include transformi

 
Area selected using editing tool 

 
Same data with
after the selected area has shifted forward in time. 

 
Copy 
Choosing Copy will copy the sele  clipboard without modifying the 
waveform on the screen. Once the
either the Paste or the Insert Wa form to another channel in the same 
graph window, choose the Duplicate Waveform command. 
 
Paste 
The Paste command will take the contents of the clipboard and paste it into the currently active channel at 
the cursor point. If no point is selected, the data will be pasted at the beginning of the waveform. 

 selected area deleted. Note that data  

cted area of a waveform to the
 area has been copied, it can be inserted in another waveform using 

veform commands. To copy a wave
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Clea
The Clear command works much the same way as the Cut command, with the key difference being that 
data is not copied to the clipboard. This function deletes the selected area from the selected channel only. 
If the d (as
the waveform data and leave an emp
on only one channel, and when a por the waveform is cleared, the remaining data will shift left. If 
multiple channels of data are present ted 
area of data from multiple channels, 
 
Clear All 
Choosing Clear All will delete the s
that data is removed and is not copie
section of data from all waveforms, n
¾ When Select All is chosen prior  data for all 

channels will be deleted. 
¾ The Undo command does not w
 
Inse
The Insert Waveform command is u r a section of a waveform) from one 
window to another. To do this, first select the area to be copied using the cursor and the Copy command. 
Next open the graph window you wi
into the same graph it was copied fro ay 
to do this. Once you have selected the graph you wish to insert the waveform into, choose Insert 
Waveform from the Edit menu. A n ied 
into the empty channel. 
The new channel will always take on
¾ The Undo command does not w , but selecting the inserted channel and 

choosing Remove Waveform fr  the Edit menu effectively undoes this operation. 
 
Duplicate Waveform 
Choosing Duplicate Waveform will create a new channel in a graph window and copy an entire 
waveform (or a selected area) to the e 
selected area will be duplicated. To d
Duplicate from the Edit menu. 

9 TIP Right-click a waveform
 
Select All 
When Select All is chosen from the Edit menu, the entire selected channel is highlighted. For almost all 
commands, when a waveform is selected using Select All, subsequent operations apply to the selected 
channel only. The exception is when 
all waveforms will be deleted. 
 
Remove Waveform 
The Remove Waveform command d rm, regardless of what other options 
are selected. 
¾ T mmand does not w

r 

 entire waveform is selecte  with the Select All command), the Clear command will delete all 
ty channel. As with the Cut command, the Clear function operates 
tion of 
, one channel will be “shorter” than the others. To remove a selec
use the Clear All command. 

elected area from all channels. This is similar to the Clear function in 
d to the clipboard. The Clear All command, however, removes a 
ot just from the selected channel. 

to performing the Clear All function, all waveform

ork for Clear All. 

rt Waveform 
seful for copying a waveform (o

sh to insert the waveform into; it is possible to insert the waveform 
m, although the Duplicate Waveform is a more straightforward w

ew (empty) channel will then be created and the data will be cop

 the lowest available channel number. 
ork for Insert Waveform
om

new channel. When a portion of the waveform is selected, only th
uplicate the entire waveform, choose Select All and then select 

 and select Duplicate from the pull-down menu.  

Clear All is chosen after Select All. When this occurs, all data from 

eletes the entire selected wavefo

he Undo co ork for Remove Waveform. 
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Clipboard 

 
Each clipboard command involve nt Lab PRO to the standard OS 
clipboard, where the contents of t ther applications. Data can be 
copied to the clipboard in two formats: alphanumeric and graphic. The Copy Measurement and Copy 
W for
G sfers the image on the  graphic format. In either case, 
transferring data through the clipb
closed the graph window and/or q
 

Copy Measurement 
Copies the contents of all g with the values associated 
with these windows. By d e 
this by increasing or decr
copied, they can be paste
processors, drawing packages, and page layout programs. A sample of measurements pasted from 
the BSL PRO into a word processor follows: 

BPM = 85.714 BPM delta T =  0.700 sec p-p = 0.8170 Volts 
 

Copy Wave Data 
Copies wave data (in numeric  and includes a header line. 
When an area is selected, only the data in the selected area will be copied to the clipboard. For 
example: 

Hand Dynamometer EMG 
-0.0293386 -0.0228271 
-0.0579655 -0.0170898 

When multiple channels of data are copied to the clipboard, the data is stored in columns and 
rows, with data from each channel stored in a separate column with the channel label as the 
header for each column. For a four-channel record, four columns of data will be copied to the 
clipboard. 
As with a text file, the BSL PRO software will insert a delimiter between each column of data. 
The default delimiter is a tab; you can change the delimiter to either a space or comma in the 
Options dialog of the File > Save as Text option (see page 177). 
Transferring data through the clipboard performs essentially the same function as saving data as a 
text file (using the File > Save As command), with the obvious exception that transferring data 
through the clipboard does not save data to disk.  
Once the data is stored in the clipboard, it can be pasted into virtually any application. 

s copying data from the Biopac Stude
he clipboard are made available for o

ave Data commands save in
raph tran

mation to the clipboards in text/numeric format, whereas the Copy 
 screen to the clipboard in .WMF
oard allows you to copy data to other applications even after you have 
uit the Biopac Student Lab PRO. 

 visible measurement pop-up menus, alon
efault, three windows are displayed (on most monitors); you can chang
easing the width of the window. Once the measurements have been 
d into any application that allows paste functions, including word 

 form) for all channels into the clipboard
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C
Copies the graph window as it appears on the screen to the clipboard, where it is stored in 
Windows Metafile format. The graph label and any associated markers, if displayed via Show > 
Markers, will also be copied to the clipboard. You can then place the graphic into a number of 
different types of documents, including word processors, drawing programs, and page layout 
programs. Windows Metafiles are common to almost all applications, and images saved in these 
formats can be edited in most graphics packages and many word processors. 
Using the Copy Graph function is similar to saving a graph window as a Windows Metafile 
(using the File > Save As command), except that using the File > Save command writes a file to 
disk, whereas transferring data through the clipboard does not save a file. 

opy Graph 
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Journal 

 

 
The Journal sub-menu has two options: Paste measurement and Paste wave data. Both options are 

easurements or 
raw data) is pasted directly into the journal rather than copied to the clipboard. 

rement windows to be pasted into the 

surement names and values are pasted into the journal in columns using the Tab spacing 
specified in the File > Preferences > Journal dialog (see page 182). 

¾ Use the Preferences > General dialog (see page 181) to change the number of measurement 
rows displayed (and therefore, available for pasting) or the measurement unit precision. Note 
that when you change the number of rows displayed, all current measurement settings will be 
cleared (set to "None") so you should establish the number of rows required prior to selecting 
measurements.  

similar to those found in the Clipboard menu. The key difference is that data (whether m

Paste Measurement 
Choosing Paste Measurement will cause all visible measu
journal. 
¾ Mea

 
Measurements for “peak-to-peak” from CH 1 and “delta t” 

from CH 2 pasted from the open graph to the journal 
Paste Wave Data 

The Paste Wave Data option converts the selected area of the waveform to numeric format and 
pastes it into the journal in standard text file format. This will paste the selected area from all 
channels, not just the selected channel, and will place a delimiter between the columns when two or 
more channels are being pasted to the journal. By default, tab characters are used to separate columns; 
you can change to comma or space delimiters in the File > Save As > Text Options dialog. See the 
Save As…Text section on page 177 for more information on how to change the column delimiter. 

Visit the online support center at www.biopac.com 
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Wave data (from the previous wave sample) pasted from the open graph to the Journal
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Chapter 13 Transform menu commands 

 
The Biopac Student Lab analysis and 
transformation rations on data, from 

igital filtering and Fourier analysis to Math Functions and histograms. All of these options can be 
nder the Transform menu, and are disabled while an acquisition is in progress. Unless 

ise noted, all of the transformations described here apply to the selected channel only. Some 
llow you to specify a channel (or channels) to be 

ansformed. 
a 

eform Math), and will transform a single 
mple point when only one is selected. Other transformations can only be performed on a selected 

 analysis and digital filtering, for instance), so if a single point is selected the entire 
waveform will be transformed.  
There are two ways to apply a transformation to an entire waveform. 

a) The first method involves selecting an entire waveform using the Edit > Select all command 
prior to selecting the transformation. This will work for all of the transformation functions, 
and is the only way to apply a transformation to an entire waveform for functions that do not 
produce a dialog box (e.g., Math functions, Integral). 
 

b) The second method can be used for any transformation that does produce a dialog box (e.g., 
Digital filters, Expression, FFT). These dialog boxes allow you to check a box (located toward 
the bottom of each dialog box) that will transform the entire waveform (regardless of whether 
a single point, area, or the entire waveform is selected). 

PRO provides a number of options for post-acquisition 
s. These transformations allow you to perform a range of ope

d
found u
otherw
options (the Expression and Math functions) a
tr
It is important to remember that the BSL PRO software is always selecting at least one point. When 
section of a waveform is highlighted, the transformation will apply to that section. If no area is 
defined, the BSL PRO software will always select a single data point. Some transformations can 
operate on a single sample point (e.g., Math Functions, Wav
sa
area (spectral
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Examples of “entire wave” option in Transform menu dialogs 

T
Isol
redu
operations on or 

atterns of data. The Summary functions provide graphical summaries of the data, either in terms of 
e frequency spectra of the data or the measures of central tendency and dispersion of waveform data. 

he table below groups the transformation functions into four general families or clusters. The 
ation functions perform “data cleaning” in that they perform some sort of filtering or data 
ction tasks. The Calculation/Math transformations perform calculations or other mathematical 

 the data. The Search functions allow you to search though the data, either for peaks 
p
th

RAW DATA 
Isolate data 
Smoothing 
Digital Filtering 
Resample 

Calculation/Math 
Expression  
Waveform Math  
Math Functions 
Difference 
Integrate  
Derivative  
Integral 

Search  
Peak Detection Functions 
 Find peak 
  Find Next Peak 

 Find All Peaks 
Template Functions 
  Set Template 

  Correlation 
  Mean Square Error 
  Inverse MSE 

Summary 
Histogram 
FFT  
Find Rate 

  Remove mean 
  Convolution 

BSL PRO Transformation Functions 
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Digital Filters 
There is a fair amount of arcane terminology and theory surrounding the use and implementation of 
digital filters. For a general overview, see Appendix D — Filter Characteristics. 
Two types of post-processing filters are available under the Transform > Digital filters submenu: 
FIR (finite impulse response) filters and IIR (infinite impulse response) filters. 

 
FIR filters are linear phase filters, which means that there is no phase distortion between the original 

 
signal and filtered waveforms. 
IIR filters are not phase linear filters, but are much more efficient than FIR filters in processing data.
The IIR filters are useful for approximating the results of standard biquadric filters of the form: 

z)ys(xs
c)bs(as

2 ++
++

 

sed to mimic filters commonly implemented in electronic analog circuitry and are
e filtering. 

2

IIR filters can be u  
also used for onlin
FIR Filters 
To access the FIR filter dialog box, click the  menu, 
scroll to select D

Transform

 

igital
for the filter options. When you 
corresponding Digital Filter dia
you to specify a number of diffe

 Filters, drag right to FIR and drag right again 
select an FIR filter, the 
log box will be generated, allowing 
rent filtering options.  

In e
se ialo
samples/sec.” 

 most cases, th
ttings. The d

 default settings are optimal, although specific situations may require different 
g will reflect data for the selected area, for example “50 samples at 50.000 

  
 

FIR Digital Filters Dialog 

Window At the top of the dialog box is a Window pop-up menu, which allows you to choose 
 a variety of filtering algorithms. By default, the filter default is set to a 

D) 

dow” refers to a computation that spans a fixed number of adjacent data 
points. Window functions are used to eliminate discontinuities that may result at the 
edges of the fixed span of points for the FIR filter. 

Cutoff Frequency The second option is to provide a Cutoff Frequency, or threshold, for 
function. 
 

from
“Blackman” type. These different Windows (described in detail in Appendix 
allow you to “fine tune” the filter response. 
A “win

the filter 

Visit the online support center at www.biopac.com 
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FIR Digital Filters Dialog 
Filter Type Default Cutoff Frequency  Cutoff range 
Low-pass 0.125 times the sampling frequency Between 0.0000000001Hz and 

0.5 times the sampling rate 
Hi z and gh pass 0.25 times the sampling rate Between 0.0000000001H

0.5 times the sampling rate 
Band-pass :  vlow 0.125 times the sampling rate Any alues, but low and high 
 high: 0.25 times the sampling rate cannot be set to the same value 

Number of 
Coefficients 

The Numb  determines how well the filter will match the desired 
Cutoff Frequ ). By default, this is set to 39. Filters that use a small 
number of ess accurate than filters that use a large number of 
coefficients. E a more accurate filter; however, as 
the number of coefficients essing time required to filter 
the data. To see h ts the way data is filtered, it can be 
useful to examine the filter response patterns. 

9 TIP A good rul s greater than or equal to 
two tim st cutoff frequency specified. For 
example, if running a low pass filter at 1Hz on data sampled at 100Hz, choose at 

 in the filter. Additional coefficients will 

Show Filter 
Response 

Th  plot of the 
filtered data and generates a new graph wi ust save 

 plot se arately. 

er of Coefficients
ency (or range

coefficients tend to be l
ntering a larger value will result in 

increases, so does the proc
ow changing this value affec

e of thumb is to use a number of coefficient
es the sampling rate divided by the lowe

least (2 x 100/1) or 200 coefficients
improve the response. 

e Show Filter Response option instructs the software to produce a
ndow for the response plot. You m

the response p

  
Don’t modify 
waveform 

The Don’t modify waveform Show filter 
response o  software will produce a plot 
showing the filter response, but will not modify the waveform. This allows you to 

 specify different filter options (without modifying the waveform) until the 

Filter entire wave 
 ¾ If you want to keep the original, you need to duplicate it prior to filtering. 

 

 

 option is useful when used with the 
ption. When both boxes are checked, the

repeatedly
desired frequency response is achieved. 

The Filter entire wave option will filter the entire wave and replace the original. 
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FIR Filter example 

 
Compar  stop FIR filters  

In the example above, t d stop filtered using a coefficient range of 39 (upper 
waveform) to 250 (low ta was collected at 500Hz, and the band stop filter was 
designed to remove 60Hz noise using a 55Hz and a high cutoff of 65Hz. Along the 
horizontal axis, the units are scaled in terms of frequency, with lower frequencies at the left of the 
screen. The values along the vertical axis  indicate the extent to which 
various frequencies have been attenuate ere is a downward-
pointing spike that is centered on 60Hz. r response corresponds to a value of 
approximately 0 on the vertical axis, ind ignificantly above or below 60Hz 
were not attenuated to any measurable extent. 
As you can tell, however, the filter does not “c r 65Hz, but gradually 
attenuates the data as it approaches 60Hz. For exam  in the filter response plot 
represents data that was filtered using a value o tively shallow when 
compared to the lower waveform, which rformed with 250 coefficients. 
Although the filter that used 250 coeffic nsform the data, the filter 
response pattern indicates that the data around 60Hz is attenuated to a greater degree. Also, the 250 
coefficient filter started
the default filter began 

ison of 39 coefficient and 250 coefficient band
he same data was ban
er waveform). The da

low cutoff of 

 are scaled in terms of dB/V and
d. In both filter response waveforms, th
 The baseline of the filte
icating that the signals s

hop” the data at either 55Hz o
ple, the upper waveform

f 39 coefficients. The slope is rela
 represents a filter response pe
ients took slightly longer to tra

 to attenuate data considerably closer to the 55Hz and 65Hz cutoffs, whereas 
to attenuate data below 55Hz and above 65Hz. 

 
R FiltersII  
o access the IIR filter dialog box, click the Transform menu, scroll to select DT igital Filters, drag 

right to IIR and drag right again for the filter options. 

 
The IIR filters under the Transform menu are identical to the real-time IIR filters (see the Filter 
Calculation on page 114) but are applied to existing data, in a post-processing environment. For a 
more detailed explanation of digital filters in general, see Appendix D — Filter Characteristics. 
 

Visit the online support center at www.biopac.com 
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Math Functions 

 
You can perform a wide range of mathe
has been completed with the Biopac Stu
Math Function. 

matical and computational transformations after an acquisition 
dent Lab PRO. The table on the following pages explains each 

Unless otherwise noted, each Math functi f 
no area is selected (i.e., a single data point is selected) the cursor will blink and the transformation will 
apply only to the selected point. To perfor
and choose Edit > Select All. 
If a Math Function is set to divide by zer

9 TIP  For complex transformation
Expression solver (see pag  information on this feature). Many of the 
same functions found in the Math functions menu can also be found in the Expression 
solver. 

on applies only to the selected area of the active channel. I

m a Math Function on an entire waveform, select a channel 

o, a zero will be returned. 

s involving multiple functions, you may want to use the 
e 211 for more
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The following table describes the commands available in the Transform > Math Functions menu:  

Math Function Transformation Result 

Abs (Absolute Value) Computes the absolute value of the data. All negative data values are 
made positive, with no change in magnitude. This function can be used 
to rectify data. 
Result: This calculation will always return a positive result. 
 

A a point in radians. 
/2. 

rcTan (Arc Tangent) Returns the arc tangent of each dat
Result: This rescales the data such that the range is from -π/2 to π
 

C cted 
 

ould be removed. You could cut the section 
r to 

ries of the data, you could use the connect endpoints 

onnect endpoints Draws a line from the first selected sample point to the last sele
sample point and interpolates the values on this line to replace the
original data. The connect endpoints function is very useful for 
removing artifacts in the data or in generating waveforms. 
In the example below, the “noise spike” in the data is an undesired 
measurement artifact that sh
of data, but then all subsequent data points would shift left. In orde
preserve the time se
command to draw a straight line (although not necessarily flat) that 
connects the two extreme sample points of the selected area. 

 
Area selected prior to connect endpoints function 

 
Same waveform after connect endpoints transforma

 
tion 

Result: A straight line of the equation:  
                  ynxyxy i ∆+= *)()( 1  
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Math Function Transformation Result 
n – number of sample points; 
i – index of points of straight line; 

1
)()( 1

−
−

=∆
n

xyxy
y n     

 and - the endpoints. 

 

)( 1xy )( nxy

Exp (Exponential)) Computes the function ex, where x is the waveform data and e is 
2.718281828. This is the base of the natural logarithms. 
 

Limit (Limit data values) ‘Clips’ data outside the range specified by the set of threshold in the 
limit dialog box. This function will prompt you for an upper and lower 

s 

ther extreme unaffected. 
ut 

e 

 

limit. 
Any data outside these limits will be clipped at the closer limit. 
Although both an upper and lower threshold must be entered, it i
possible to limit only one extreme (upper or lower) while leaving the 
o
For example, to limit data so that all negative values are set to zero b
the positive values are left unchanged, you need to set the lower 
threshold to zero and the upper threshold to some other positive valu
that exceeds the maximum value for that channel. 

Result: In the range of upper and lower threshold. 
 

Ln (Ln Natural Logarithm) Computes ln x - the natural logarithm of each point of selected area, 
where x- is any positive value. 
 
The inverse of this function is the exponential function (see Exp). 
 
Note: The result for sample points with negative values is zero. 
 
Result: For x <1 – result is a negative value; for x>1 – resul
value. 
 

t is a positive 

Log (Base 10 Logarithm) Computes the base 10 logarithm ( lg x) of selected area, where x – any
positive value. 
 
Note

 

: The result for sample points with negative values is zero. 
Result: For x <1 – a negative value; for x>1 – a positive value. 
 
In order to perform the inverse of this operation of this function which 
would be , use the Waveform Math power operator with the constant 
k=10 as the first operand and the waveform data as the second operand.  
 

x10
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Math Function Transformation Result 

Noise Converts the selected section into random data values between -1.0 and 

Res

+1.0. This is mainly useful for creating stimulus signals and other 
waveforms. 

 
ult: In the range -1.0 to 1.0 

 

Sin (Sine) Cal s assumed to be in 
rad
 
Res

culates the sine of the selected section. The data i
ians. 

ult: for 0< x < π -  is positive, 
     
 

        For π < x < 2 π – negative.  

Sqrt (Square Root) ak
es

T
R

es the square root (√) of each data point in the selected section. 
ult: Always a positive number.  

 

Threshold (Threshold
values) 

Tra  and all points 
below the lower threshold to 0.  
On nue to be set to +1 for the 
upp  crosses the opposite 
thre
f t
hre

The most common application of this function is to serve as a simple 
or phase 

 data nsforms all data points above the upper threshold to +1

ce the data crosses a threshold it will conti
er cutoff and to 0 for the lower cutoff, until it
shold. 

I
t

he initial data lies between the upper threshold (UT) and the lower 
shold (LT), the output is undefined. 

peak detector, the result of which can be used in rate 
calculations. 

 
 
Result: The sequence of 1 and 0 value according to data points. 
 

Note: Real-time Threshold values are +1 and –1 (see page 113). 

Top: Signal + Noise 
Middle: P-P Noise > UT-LT

Bottom: P-P Noise < UT-LT
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Template Functions 

 
s are useful for comparing waveforms. All the template functions perform 

of the template waveform on the waveform to be compared, move one sample
multiplication until the end of the longer

The Template Function a 
mathematical operation  
forward, and repeat the  waveform is reached. Technically, 
the template functions p
template waveform agai
Note: To determine a level of
Set template 
If you detect an abnormality, yo
record. To do that, you need to 
pattern to other data sets in the 
closely. 

Establishing the templa
1)  Highlight the section to be 
2  templat

function
rtion into

template functions. 
3)  Select the waveform

the beginning of the data. 
4)  Choose Correlation from the Template 

functions submenu. 

rovide correlation, convolution and mean square error transformations of a 
nst another waveform. 

 comparison between two waveforms, use the Correlation function. 

u should find out if there are other (similar) abnormalities in the 
select the pattern you’d like to search for, and then compare that 
file. You can use the Zoom tool to inspect the abnormalities more 

te: 
used as a pattern. 

)  Choose Set
Templat

e from the Transform > 
se 

selected po
 submenu. This copies the 
 a buffer for subsequent 

 and position the cursor at 

 
The center waveform in this graph shows the result 
of the correlation and mean square error functions: 
Note the higher amplitude peaks where the 
template data more closely matches the waveform. 
The lower waveform illustrates the mean square 
error function, which is similar to the correlation 
function. 
This indicates that there are two abnormal beats in 
the record. The first one appears at about 21 
seconds and is the one used as a template, the 
second one appears at about 33 seconds. 
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Remove Mean 
A drifting baseline can be a problem u perform a Template function 

f 

s selected and is enabled when a check mark is present. 
the mean amplitude value of the template and the compared section 
rom each other before the sections are compared. This way, a large 

 on the comparison. 
ows the correlation with and without mean removal: 

 in comparing waveforms. If yo
and the template or the waveform has a slowly moving baseline, you can increase the effectiveness o
the comparison by choosing Remove mean from the submenu of the Template function. 
This option is toggled every time it i
The Remove Mean option causes 
of the waveform to be subtracted f
baseline offset will have very little effect
For example, the following graph sh

 
The original waveform is at the top
the same correlation without mean rem
Note how t

, the correlated waveform with mean removal is in the middle, and 
oval is at the bottom. 
 compensates for the drifting baseline in the original he mean removal effectively

waveform. 

Visit the online support center at www.biopac.com 



 203 

Template algorithms 
The template functions employ four algorithms: correlation, convolution, mean square error, and 
inverse mean square error. 
Correlation 

This algorithm is a simple multiplication and sum operation (as shown in the preceding example). 
The template is first positioned at the cursor position in the waveform to be correlated. Each point 
in the template waveform is multiplied by the corresponding point in the data waveform (the 
waveform to be correlated) and summed to produce the resulting data point. The template is then 
moved one data sample forward and the operation is repeated to produce the next resulting data 

 
esulting data point, f (k) is the template waveform data points, and K is the number 

point. The resulting data points replace the waveform to be correlated. 
The correlation function algorithm can be expressed by the following formula, where foutput(n)
is the r template
of data points in the template: 

K

f (n) =  f (k) *  f (n)output template waveform

k = 1
∑  

Convolution 
This function is identical to the correlation function except that the template waveform is reverse
during the operation. This function is not generally useful by itself, but can

d 
 be used as a building 

 algorithm can be 
expressed by the following formula, where foutput(n) is the resulting data point, ftemplate(k) is 

, and N is the number of data points in the template: 

block for more sophisticated transformations. The convolution function

the template waveform data points

f (n) =  f (-k) *  f (n + k)output template waveform

k = -N/2

N/2 - 1

∑  

Mean Square Error 
For this function, the template is first positioned at the cursor position in the waveform to be 
compared. Each point in the template waveform is subtracted from the corresponding point in the 

 summed to produce the resultingwaveform to be compared. The result is squared and
The template is then moved one data sample forwar

 data point. 
e the 

The mean square error function tends to amplify the error (or difference) between the template 
and the waveform, which can be useful when you need an extremely close match rather than a 
general comparison. When a match is found, the mean square error algorithm returns a value 
close to zero. 
The mean square error function algorithm can be expressed by the following formula, where 
foutput(n) is the resulting data point, ftemplate(k) is the template waveform data points, and K is 
the number of data points in the template: 

Inverse Mean Square Error

d and the operation is repeated to produc
next resulting data point. The resulting data points replace the waveform. 

f (n) =  [f (k) -  f (n)]output template waveform

k = 1

K

∑
2

 

 
This function simply inverts the result of the mean square error algorithm. Accordingly, when 
this algorithm finds a match between the template and the data, the algorithm returns the inverse 
of a value close to zero and, typically, a large positive spike will occur at the point of the match. 
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Integral 
The integral function is essentially a running summation of the data. Each point of the integral is 
equal to the sum of all the points up to that point in time. 
 

                 ( ) ( ) ( )[ ]
21

1
xxfxfxF

j

i
iij

∆
∗+= ∑

=
−                                             

Where: 
 

- index for source values (1..n); 
 for destination values (1..n); 

i
j - index
n - number of samples; 

ix , jx - values of points at horizontal axis; 

( )ixf - values of points of a curve; 

( )jxF - integrate values of points of a curve; 

1
1

−
−

=∆
n

xx
x n  - horizontal sample interval; 

t the endpoints of selected area. 1, xxn  - values at horizontal axis a

 
Note: 
The first destination point is always 0 value. 
 
The integral function can be used to compute the area under the curve in a continuous fashion. For 
instance, if you had data acquired by an accelerometer, the integral of the data would be the velocity, 
and the integral of the velocity would be the distance. As with all transformations, this function can be 
applied to either a selected area or to the entire waveform. 
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Derivative 

 
Transfor

The Deriv
m > Derivative dialog box 

the selected area of a waveform (or the entire 

ency components will give you nonsensical results in a 
 pass filtering function is included in the derivative 

type from the pull-down menu. 
 The value should be roughly equivalent to the highest frequency 

component of interest. (See page 194 for more information on low pass 
filters.) 

 only applicable when Show Filter Response is selected. 

ll behaved” (i.e., low pass filtered or contains little or no high 
ce transformation with a 2-sample interval. This 

similar to the Derivative function, but will work much faster. 

ative function calculates the derivative of 
waveform if it has been selected).  

Window Since high frequ
derivative, a low
function. Select a Window 

Cutoff Frequency

Don't modify waveform This option is

9 TIP If the data is already “we
frequency information), use the Differen
will provide results very 

 
 
 
 
 
 
 
 
Integrate 
The Integrate transformation works the same as the Integrate calculation (see page 100 for formulas) 
and details. 
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Smoothing 

 
Smoothing  computes the moving average of a series of data points and replaces each value with the 
mean value of the moving average “window.” Smoothing has the same effect as a crude low pass 

aster than digital filtering. This function is most effective on data with slowly 
changing values (e.g., respiration, heart rate, GSR) when there is noise apparent in the data record. 

Samples To set the size of the window, enter a value in the Transform > Smoothing factor 
RO software allows you to set the width of the moving 

average window (the number of sample points used to compute the mean) to any 
ree. By default, this is set to three samples, meaning that the 

the average of three adjacent samples and replace the value 
 mean before moving on to the next sample. 

9 TIP For data acquired at relatively high sampling rates, set the smoothing 
her value, since smoothing three sample points when 

llected at 1000Hz will only average across three 
ds of data, and may do little to filter out noise. 

g is the default and should be used when noise appears in a 
around the mean of the signal. The Mean value smoothing 

: 
amples Even number of samples 

filter, but is typically f

dialog box. The BSL P

value larger than th
software will compute 
of each sample with the

factor to a hig
data is co
millisecon

Mean value 
smoothing 

Mean value smoothin
Gaussian distribution 
formula is shown below
 Odd number of s

 ( )
( )

s

xf
xF

sj

sji
j

∑ i

− 2/

 

+

+−==

)3(

2/)1( ( )
( )

s

xf
xF

sj

sji
i

j

∑
+

−−==

2/

2/)2(  

Where: 
- index for source values; 

j - index for destination values (1..n); 
n - number of samples; 

- values of points at horizontal axis; 

- values of points of a curve; 

i

ix , jx

( )ixf

( )jxF - integrate values of points of a curve; 

mber of samples to average across. s – nu
Note 
For points where i<=s, the formula cannot be followed because the indexes of the 
points involved in the calculation are negative and the points with such indexes 
don’t exist. 

 
 
 
 

 
 

MoreÆ 
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Median 
value 

Use Median value smoothing
seem to be “wild flyers” in the data set. The Median value s

smoothing 

 if some data points appear completely aberrant and 
moothing formula is 

shown below. 
Odd number of samples to smooth across: 

The Median for odd number of the samples to smooth across is a number 
in the middle of a set of numbers (see formula). 

                          ( ) =ixF   ( )( ) ( )( )( )2/32/1 , −++− sisi xfxf  

Where: 
- index (1..n); 

n - number of samples; 

- values of points at horizontal axis; 

i

ix

( )ixf - values of points of a curve; 

( )ixF - new values of point of a curve; 

s – number of samples to smooth across. 
 
Even number of samples to smooth across: 

The Median for even number of samples to smooth across is an average of 
the two numbers in the middle of a set of numbers (see formula). 

                           ( ) =ixF   
( )( ) ( )( )2/2/2 , sisi xfxf +−−

 

Where: 
- index (1..n); 

n - number of samples; 
i

ix - values of points at horizontal axis; 

( )ixf - values of points of a curve; 

( )ixF - new values of point of a curve; 

s – number of samples to smooth across. 
 

Note 
For points where i<=s, the formula cannot be followed because the indexes of the points 
involved in the c

 

alc h indexes don’t exist.  ulation are negative and the points with suc
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Difference 

 
The Differen plitude) of two sample points separated by an 
arbitra als. The difference is then divided by the total interval between the first 
selected sample and the last selected sample. 

Inte he default Difference interval setting is 1 interval between samples. Using the 
fault Difference setting of 1 interval will produce a “∆P/∆T” waveform when 
e transformation is applied to a blood pressure or similar waveform. 

no high frequency components, a 1-interval difference 
transformation approximates a differentiator. Since it is not implemented as a 
co
 O

    

ce function measures the difference (in am
ry number of interv

rvals T
de
th
For data with 

nvolution, it is much faster than the derivative. 
dd number of samples between the points: 

                             ( ) ( )( ) ( )( )
( ) ( ) 2/12/1

2/12/1

+−−+

+−−+

−
−

=
sisi

sisi
i xx

xfxf
xF     

en number of samples between the points:  Ev

                                 ( ) ( )( )
2/2/ sisi −+

2/2/ sisi
i xx

xF −+

−
xfxf −

=         

Where: 
i - index for source values(1..n); 
j - index for destination values (1..n); 
n - number of samples; 

i jx , x - values of points at horizontal axis; 

( )ixf - values of points of a curve; 

( )ixF - new values of points of a curve; 

s – interval between samples. 
Note 
For points where i<=s, the formula cannot be followed because the indexes of the 
points involved in the calculation are negative and the points with such indexes 
do

 
 

e
available 

n’t exist. 

� Online, r al-time Difference is calculated differently because projected values are not 
(see page 106). 
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Histogram 
The Histogram function produces a histogram plot of the selected area. When a histogram  is created, 

 
idual sample points are sorted into the appropriate bin based on their amplitude value.  

The o
then cou
number
plots th

lowest bin would cont

hold all data points between 67 BPM 
and 69 BPM, and so on, until the tenth 
bin was created. 

the sample points are sorted into “bins” along the horizontal axis that contain ranges of amplitude 
values. These bins divide the range of amplitude values into equal intervals (by default, ten bins) and
the indiv

 Bi pac Student Lab PRO software 
nts the number of “hits” (the 

 of data points) in each bin and 
is number on the vertical axis. 

For instance, if a waveform had a 
range from 65 BPM to 85 BPM, the 

ain all data 
points with a value from 65 BPM to 67 
BPM. The second lowest bin would 

 

 

Use manual range to fix the bin sizes and bin range for 
predetermined values. 
By default, the data is divided into ten bins. You can change 
this by entering a different number in the box to the left of bins 
at the top of the Histogram Options dialog box. 
The frequency of occurrence for each bin is displayed on the 
vertical axis. 

 
surements are not available with the Histogram function. 

te the cumulative frequency, select the entire histogram waveform and c

When 
t e 
w  (or the selected area, if a section is highlighted), and 
c  
(
C
s ined by the extent 
o

The BPM and Freq mea

9 TIP To calcula hoose 
Integrat

9 TIP Since th
categories, the histogram window is likely to display a large number of “hits” in each bin, 
especially if data was collected at a relatively fast sampling rate. If this is the case, you 
may want to resample the data at a lower rate (using the Transform > Resample 
function described below). The caveat to this is that resampling the data may cause a 
bias, unless the data was filtered to remove all frequency components that are more 
than 0.5 the resampling rate. 

 
 

Autorange is checked, the software automatically sets 
he center of the lowest bin equal to the minimum value of th
aveform

enters the highest bin on the maximum value of the waveform
or selected area, if any). 
hecking the Autorange option will simply fit all the data 

elected into a bin. The bin sizes are determ
f the data and the desired number of lines.  

e from the Transform menu. 

e Histogram function sorts sample points into a relatively small number of 
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Resample 

 
This function resamples the entire data file to another rate, which can be used to “compress” data f
by saving the data at a lowe

iles 
r sampling rate. 

� The minimum rate is based on the total number of samples. 

mpling rate at least four times the highest 

-
r) 

 
s case 100Hz. 

d at 250 samples per second for 15 minutes takes up 
about 1.8 MB of disk space. Resampling to 100 samples per second reduces the file size to 
about 720 KB of disk space, a considerable reduction. 

If data is resampled to a lower rate and then resampled again at a higher rate, the waveform will 
maintain the resolution of the lower sampling rate, only with more data points. 
 
Resampling and… 
   Interval You can use Resample to increase the number of sample points per interval (usually 

samples per second). When this is done, the BSL PRO software will interpolate between 
sample points to adjust to the new rate. This will add data points — but not necessarily 
more information. 

 
   Exporting If you plan to export resampled data, you should use this method of resampling: 

1. Select Find peak from the Transform menu. 
2. Select User defined interval and enter a time period for the new sample rate. 
3. Set First cursor to Peak. 
4. Check the Paste measurements to journal option. 
5. Set the measurements for the channel you want to resample. 
� For example, if you set the Value and Time measurements, the software will take 

those measurements and paste the Value and Time results from the resampled 
channel into the Journal. 

6. Select OK and place the cursor at the beginning of the data file. 
7. Select Find all peaks from the Transform menu. 

 
Bias Resampling the data may cause a bias, unless the data was filtered to remove all 

frequency components that are more than 0.5 the resampling rate. 

� The highest sampling rate that a channel can be resampled to is the file acquisition rate (as 
established under MP35/30>Setup Acquisition) 

9 TIP  A good rule of thumb is to select a sa
frequency of interest for the signal. 
For example, the alpha component of an EEG signal has a frequency signature of 8
13Hz, so (assuming you have isolated the alpha component using a band pass filte
you would probably want to sample the data (in this case, isolated alpha waves) at a 
rate of at least 52Hz. The acquisition sample rates are limited and you should choose
the next highest option, or in thi

Resampling data maintains the time scale but reduces the number of samples per second. Whenever 
data is resampled to a lower rate, information is lost. 
� For instance, a 4-channel data file sample
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Expression 
 

  

A post-acquisition Expression transformation is available for performing computations more complex 
than the Math and Function calculation options can manage. The post-acquisition version of the 
Expression transformation includes all the same features as the online version (described on page 
116). The Expression transformation will symbolically evaluate complex equations involving multiple 
channels and multiple operations. 
Unlike the Math and Function calculations, which can only operate on one or two channels at a time, 
the Expression transformation can combine data from multiple analog channels, or specif  other 

 
d 

mponents of 
each Expression can be entered either by selecting items from the pull-down menus in the Expression 
dialog box, or by typing commands directly into the Expression box. 
In the preceding Expression example, the equation took the sum of analog channels 1, 2 and 4, and 
divided by three to return a mean value for the three channels. The result of this was then arcsine 
transformed and saved on the next available channel. Of course, more complex operations are 
possible, and it is possible to divide a complex equation into several steps and perform each part of the 
equation with a separate channel. 
It is important to keep in mind that while different channels, functions, and operators can be 
referenced when using the Expression transformation, this calculation cannot directly reference past or 
future sample points. That is, data from a given point in time on waveform one can be transformed or 
combined in some way with data from the corresponding time index on waveform two. However, data 
from one point in time (on any channel) cannot be combined with data from another point in time (on 
any channel). You can operate on waveforms that are lagged in time by an arbitrary number of sample 
points by duplicating a waveform, and removing some number of sample points from the beginning of 
the record. This will create two channels that are offset by a constant time interval. 

y
calculation channels as input channels for expression channels. Also, computations performed by the 
Expression transformation eliminate the need for “chaining” multiple channels together to produce a 
single output channel. 
To solve an expression and save the result to a new channel, choose Expression from the Transform
menu. A dialog box will appear allowing you to select input source channels, functions, operators, an
output (destination) channels. For each Expression, you need to specify a source channel (or 
channels), the function(s) to be performed, and any erators to be used. The different coop



212 Part D 

 
Source Select a Source channel to perform the transformation on. 

 
Function The Expression transformation offers the following functions (plus others on Mac): 
 Function Expression result 
 ABS Returns the absolute value of each data point. 
 ACOS Computes the arc cosine of each data point in radians. 
 ASIN Calculates the arc sine of each value in radians. 
 ATAN Computes the arc tangent of each sample point. 
 COS Returns the cosine of each data point. 
 COSH Computes the hyperbolic cosine of each selected value. 
 EXP Takes the ex power of each data point. 
 LOG Computes the natural logarithm of each value. 
 LOG10 Returns the base 10 logarithm of each value. 
 ROUND Rounds each sample point the number of digits specified in the 

parentheses. 
 SIN Calculates the sine (in radians) of each data point. 
 SINH Computes the hyperbolic sine for each sample point. 
 SQR Squares each data point. 
 SQRT Takes the square root of each data point. 
 TAN Computes the tangent of each sample point. 
 point. TANH Calculates the hyperbolic tangent of each sample 
 TRUNC Truncates each sample point the number of digits specified in

parentheses. 
 the 

Operator The Expression dialog uses standard mathematical operators. 
 Operator Operation 
 + Addition 
 - Subtraction  
 * Multiplication 
 / Division 
 ^ Power 
 ( Open parentheses 
 ) Close parentheses 
   
Destination This is the channel to display the transformation result on.  
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Waveform Math 

 
The Waveform Math transformation allows arithmetic manipulation of waveforms. Waveforms can 
be added together, subtracted, multiplied, divided or raised to a power. These operations can be 
performed using either two waveforms or one waveform and an arbitrarily defined constant (k). 
You can operate on the entire waveform by choosing Transform entire wave (or Edit >Select All), or 
operate on portions of the waveform that have been selected using the cursor tool. If there is no 
selected area, only one sample point (the one selected by the cursor) will be transformed. 
All of the main components of a Waveform Math transformation can be selected from pull-down 
menus in the dialog box. 

Note:  If you select two waveforms of unequal length as sources, the length 
of the resulting waveform will be equal to that of the shortest one. 
Likewise, if one of the source waveforms extends only into a portion 
of the selected area, the resultant waveform will only be as long as the 
shortest source portion. If Waveform Math is performed on a selected 
area and output to an existing waveform that does not extend into the 
selected area, the resultant waveform is appended to the destination 
waveform. 

k Enter a value for the constant (K). 
Note: If you divide by k = 0 the software will return a value of zero so that 

other channels using the result of this channel can be calculated. 
Operand Select addition, subtraction, multiplication, division or power functions. 
Destination This is where the result of the Waveform Math will be stored. Choose any of 

the active channels or the “New” option, which will create a new channel 
(using the next available channel). 

Source The channels to be used in the transformation are referred to as source 
channels (Source 1 and Source 2), and can be combined using any of the 
operators in the pop-up operand menu. Select any of the existing channels in 
the current window, or a constant (K). 
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WAVEFORM MATH EXAMPLE 

Waveform Math can be used ma orms can be added together. 

wave in channel 14 and a triangle 
wave in channel 16. To add these 
two waveforms: 
1) Select Transform > Waveform 

Math. 
 This will generate a 

Waveform Math dialog. 
 

ny ways. As one example, two wavef

The graph to the right shows a sine 

2) Set Source 1, select an 
Operand, set Source 2, and 
select a Destination. 

 The dialog shown here will 
add CH 14 to CH16 and show 

 

the result on a New channel.  
3)  Click OK to per

transformation 
form the 

 
The graph to the right shows the 
sum of CH14 and CH16 on a new 
channel (the top waveform in this 
example). 
By default, Biopac Student Lab 
displays the frequency of 
occurrence for each bin on the 
vertical axis. 
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FFT Fast Fourier Transformation 

 
The Fast Fourier Transformation (FFT) is an algorithm that produces a description of time series 
data in terms of its frequency components. This is also referred to as the frequency spectrum or 
spectral analysis. The output from an FFT appears in a graph window with magnitude (vertical axis) 
plotted against various frequencies (horizontal axis). A large component for a given frequency appears 
as a positive (upward-pointing) peak. The range of frequencies plotted is from 0Hz to 1/2 the sampling 

ts from 0Hz to 100Hz. 
frequency. Thus, if data were collected at 200 samples per seconds, the BSL PRO software would plot 
the frequency componen
Fourier analysis can yield important information about the frequency components in a data set, and 
can be useful in making determinations regarding appropriate data cleaning techniques (e.g., digital 
filtering). 
The FFT transformation cannot be performed in real time (i.e., during an acquisition). However, it
is possible to emulate an online spectral analysis using several online filters and the Input Values 

 

e 
y to be distorted as result of this startpoint to endpoint 

discontinuity. This can be overcome by “windowing” the data during the transformation. (For more 
information on the windowing feature, see the Window section on page 217.) 
The BPM and Freq measurements are not available with the FFT function. 
 
Pad with z

window. See page 142 for more information on how to display frequency information in real time. 
The FFT algorithm assumes that data is an infinitely repeating periodic signal with the end points 
wrapping around. Thus, to the extent that the amplitude of the first point differs from the last point, th
resulting frequency spectrum is likel

eros / Pad with last point 
The algorithm used by the FFT requires that the length of the data be an exact power of two (i.e., 256 
points, 512 points, 1024 points, and so on). Whenever possible, it is best to use an input waveform 
(select an area) that is an exact power of two. If a section of data is selected that is not a power of two, 
the BSL PRO software will always “pad” data up to the next power of two, filling in the remaining 
data point with either zeros or with the last data point in the selected area. In other words, if 511 data 
points are selected, the BSL PRO software will use a modified version of the waveform as input. The 
modified waveform will have 512 points, and the last point in the modified wave will be  
¾ a zero, if the Pad with zeros option is checked, or 
¾ equal to the 511th point of the original data, if the Pad with last point option is checked. 
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Fast Fourier Transformation  continued… 

 
Remove mean 
Remove mean calculates the mean of all the points in the selected area and then subtracts it from the 
waveform. This is generally useful for windowing a waveform that has a large DC offset. 

 
As an example, you might start with a sine 
wave with a 10-volt DC offset (with a 
little noise added to broaden the 
spectrum), and perform the FFT with and 
without mean removal:  
Note the large spectral components at the 
beginning of the top plot, without mean 
removal. This is due to the offset of the 
original data. The bottom plot is with 
mean removal. 

Since the offset of the waveform is often an artifact of the way it was generated, the remove mean 
 
u 

 the 

By default, the FFT output is described in terms of frequency along the horizontal axis and dBV on the 
vertical axis. dB are derived from the Bell scale, which is logarithmic. 
To scale the output in linear units, click the button next to linear and click OK. Linear means that the 
interval between any two sample points in the filtered waveform will be exactly equal to the distance 
between the corresponding sample points in the original waveform. 
The relationship between log and linear units is: 

dBVout = 20 log VIN. 
Magnitude /Phase 
The standard FFT produces a plot with frequency on the horizontal axis and either dB/V or linear units 
(usually Volts) on the vertical axis. In some cases, it may be useful to obtain phase plots of the 
waveform (as opposed to the default magnitude plots). Phase plots display frequency along the 
horizontal axis, and the phase of the waveform (scaled in degrees) on the vertical axis. This option 
functions exclusive of the magnitude option — you can check either independently, or if you check 
both, two plots will be produced (a magnitude plot and a phase plot). 
 
Show modified input 
Check the Show modified input box to view the modified waveform being used as input for the FFT. 

option provides a more accurate indication of the true spectral components. This is especially true for
applications where low frequency components are of interest. If the data has a large DC offset and yo
plan on windowing the data, you will generally get a more meaningful spectrum if you remove
mean prior to windowing (which is the same order the FFT uses). 
dB / Linear 
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Remove trend 
Sometimes, data contains a positive or 
negative trend that can cause extraneous 

without trend removal

trend removed

 

 

frequency components to “leak” into the 
frequency spectrum. For example, the 
following sine wave has an upward trend 
through the data (positive trend component). 
In this case, you could select remove trend 
when you perform the FFT, which would 
draw a line through the endpoints, and then 
subtract the trend from the waveform. 
The second screen shows FFTs of the skewed 
sine wave data with and without the trend 
removed: 
Note that the spectrum of the data without 
the trend removal has gradually decreasing 
frequency components, while the data with 
the trend removed has far fewer frequency 
components except for the single spike due to 
the sine wave. 

 
Window 
A “window” refers to a computation 
that spans a fixed number of adjacent 
data points. Window functions are 
used to eliminate discontinuities that 
may result at the edges of the fixed 
span of data points for the FFT. 
To apply a window transformation, 
check the box next to Window and 
choose a type of window from the 
pull-down menu. Each of the 
windows has slightly different 
characteristics, although in practice 
each provides similar results within 
measurement error.  
 As noted earlier, the FFT algorithm treats the data as an infinitely repeating signal with a period equal 
to the length of the waveform. Therefore, if the endpoint values are unequal, you will get a frequency 
spectrum with larger than expected high frequency components due to the discontinuity. Windowing 
these data minimizes this phenomenon. 
As shown here, the frequency spectra of the windowed and non-windowed data differ significantly 
when the endpoints are unequal. When the data are not windowed, the very low and very high 
frequencies are not attenuated to the same extent as when the data are windowed. 
 
 
 
 
 
 



218 Part D 

FFT EXAMPLE 
The raw data, prior to FFT: 

es are 
closed. 

This electroencephalogram (EEG) signal 
was acquired as the subject alternated 
between eyes open and eyes closed 
states. Typical results suggest that higher 
levels of alpha activity (with frequency 
components between 8Hz and 13Hz) are 
to be expected when a subject’s ey

Eyes
open

Eyes

Eyes
open

closed

 
 thTo perform e FFT: 

ransform menu and scroll 
 

1) Click the T
to select FFT.

ill gene

2) Establish th
W

This w
dialog. 

rate the FFT Parameters 

e FFT parameters (the 
indow type

uld
K. 

 used here is KaiserBessel, 
but you co
3) Click O

 choose any type). 

 
y domain window (a graph 
laces frequency rather than 
 horizontal axis) will be 
wing the spectrum of the 
e window is named 
he original window name)” 
 the channel number, as 

4) A freque
window

nc
 that p

time along the
generated, sho
input data. Th
“Spectral of (t
and ends with
shown here. The resulting magnitude 
value for each component is equal to the 
peak value of the sine wave contributing 
to that component.  

The entire pattern of frequency 
components is known as the frequency 
spectrum of the data. The somewhat 
erratic appearance of the spectrum is 
usually due to small-scale variations in 
the original waveform. This “noise” can 
be removed by applying a smoothing 
transformation to the FFT output. 
In this example, there is a pronounced 
frequency component centered on 8Hz, 
which corresponds to the alpha wave 
frequency band (8Hz - 13Hz). The 
frequency spectrum (0-20Hz shown) 
used 20-point smoothing. 
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Find Peak (Peak Detector options) 

 
ak function is the primary tool used for waveform data extraction or reduction. It can be 

lected area or the entire data file. This function can automatically analyze the data based 
ned time intervals. 
tector provides a variety of mechanisms to automatically control the I-beam selection tool. 
ds, Find Peak can be used t

The Find Pe
used on a se
on user-defi
The peak de
In other wor o automate tasks which otherwise would have to be performed 
manually us asurements. 
There are two basic 
powerful strategies f

Find Peak: Positive peak or 
negative peak 
¾ Useful for au m

analying in-vitro
data, spike coun
analysis, and EMG analy

Places the cursor (or selected area) at a a specified time offset to 

thresholds and move the I-beam to that found peak or threshold, 
offset in time by some fixed time delta. If the pop-up 
measurements are set to certain functions, the value returned by 

resent in the respective pop-up 

Find Peak: Us
Interval 
¾ Useful for 

data, psych
data, sleep 
other appli
measureme
taken at pre
intervals. 

ted area) at a specified time offset to 
e intervals. 

hen the waveform data reduction 
amining the data around many equally 

his mode is very similar to the “Find Peak: 
 peak” mode, but instead of referencing 
reshold in the data, the algorithm will 

pre-selected time intervals which can be 
set to “chop” the waveform data into equal chunks. 

ing the I-beam selection tool and the respective pop-up me
methods by which the Peak Detector operates. Both of these modes provide 
or reducing data. 

to atically 
 tissue bath 
ting, ECG 

sis. 

locate positive peaks or thresholds or negative peaks (valleys) in 
the data file. Use when you want the waveform data itself to drive 
the waveform data reduction process. 
In this mode, the algorithm will find positive or negative peaks or 

those functions will be p
measurement result box. 

er Defined 

hemodynamic 
ophysiological 

Places the cursor (or selec
regular, pre-specified tim
This mode is very useful w
requirements necessitate ex

data, and any 
cations where 
nts need to be 
-defined 

sized data segments. T
positive peak or negative
the I-beam to a peak or th
reference the I-beam to 
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9 TIP S  Bath Data Analysis and PS148 ECG 
C ugh our web site, or contact BIOPAC for 
a

Don’t Find — lue, valence, and so forth) when 
you exit the pe  useful for setting parameters with an area of a 

e

ee Application Notes PS161 In-Vitro Tissue
omplexes. Application Notes are available thro
 hard copy. 
 Allows you to retain the search parameters (peak va
ak detection dialog box. This is

waveform (d scribed above) and then repositioning the cursor at another point in the record. 

Find Peak: Positive peak / Negative peak 

Thresh er in the threshold box (the units are those of the 

esh

— Fixed The Fixed threshold mode uses a fixed value as the threshold point. 

 

Set first  modified and set to a fixed-distance and offset from 
the reference point. In this mode, the first cursor can be set to any one of the 
following four options, plus or minus a fixed-interval of time: 
a) Previous peak c)  Previous Threshold 
b) Peak d)  Threshold 

Set Second cursor to The second cursor can be set to a peak or threshold plus a fixed-interval of time, 
as long as the first cursor is referenced to a peak or threshold, respectively. 

Paste measurements Values can be automatically written to the Journal by clicking in the box next to 
“Paste Measurements into Journal.” 

old Level Enter the threshold paramet
waveform to be peak detected). 

old mode  Thr

— Tracking The Tracking threshold mode modifies the threshold after it finds a peak, 
depending upon the value of the new peak, and will compensate for a slowly
drifting baseline. 
The amount that the Tracking mode changes the threshold is specified by the  
% of previous value. 

 cursor to The selection area can be

Find Peak: User-defined interval 

Start Point The Start Point can be specified at either the existing cursor (I-beam) location 
or at a specified time. This will work on a selected area. 

Interval The Interval is the reference point of the cursor (I-beam). The cursor will move 
by the specified time Interval as the Peak Detector algorithm automatically 
moves the cursor. 
The “Minimum Interval” is calculated as 1/Sample Rate. 

Set first cursor The selection area can be modified and set to a fixed-distance and offset from 
the reference point. In this mode, the first cursor can be set to either of the 
following options, plus or minus a fixed-interval of time: 
a)   Previous peak b)   Peak 

Set second cursor The second cursor can be set to peak plus a fixed-interval of time. In this 
mode, “peak” refers to the location of the next user-defined interval. 

Paste measurements Values can be automatically written to the Journal by clicking in the box next 
to “Paste Measurements into Journal.” 
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Off-line averaging 

 
The Off-line Averaging option works with all peak detection modes. With this option selected, you 
will be able to average waveform data together from different reference points in the complete data 
record. 

• For instance, if the Find peak: Positive peak mode is selected for the purposes of evaluating 
an ECG record, the off-line averaging feature will generate a composite ECG cycle. This 
composite will be the “average” cycle of some specified number of separate ECG cycles, 
where each cycle is referenced to the peak in the QRS wave.  

  Control Channel The Control Channel (Trigger channel) pull-down menu lets you select a 
channel to use as a trigger while performing the average on the selected 
channel. To select a channel, click the channel box above the display window. 

  Setup Averaging The Setup Averaging button generates the dialog box shown below: 

 
 Averaging Range 

  Entire waveform Use all relevant data in the entire waveform to generate an 
average 

  Selected area Use only relevant data from the selected area of the 
waveform to generate an average 

  From start…# Collect relevant data at the start point and continue until the 
specified number of averages is reached. 

  From start…end Collect relevant data at the start point and continue until the 
end of the data file is reached. 

Artifact rejection 
Artifact rejection is used to eliminate suspect data from the averaging process. 
Suspect data is identified as any sample value in a relevant data block that is 
higher or lower than the respective Reject High and Reject Low levels. 

  Ave Start The OK button switches to “Ave Start.” Click the button to activatethe asettings 
after choosing the control channel and establishing the averaging options. 
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Find Next Peak 

If you select Find Next Peak from the Transform menu (or select the  icon), both cursors 
will move one peak to the right while staying above the threshold. The measurement values will show 
the selected measurements and will automatically update when each new peak is found. 
N
s

ext, repeat the above peak search with the automatic journal e t as before by 
electing the first eak from the Tran Paste 
easurements into journal option and click OK. The journal will now contain the measurement 

alues from the new peak. 

ll Peaks 
hen you choose Find All Peaks from the Transform menu, the software will find all peaks through 
e end of the selected area (or the entire file, as designated) and paste the measurement values into the 

 each time a peak is found, as shown here: 

ntry option enabled. Star
 peak and choosing Find P sform menu. Check the 

m
v
 
Find A
W
th
journal

 
The process uses
mode, one cursor

 the defaul rea bet his 
 tracks the the

previous peak (these “curso  o w as 
“borders” for the propagatin

in the Journal ponds to the measurement val cted (in this case, Value and 
ata file is ver  to find O 
 disk while 

t cursor settings to select the a
 current peak location while the o
rs” are internal to the software and
g selected area). 

ween two adjacent peaks. In t
r cursor marks the location of the 
nly appear in the graph windo

Each column  corres ues sele
BPM). If the d
loads data from

y large, it may take some time
it scans for the peaks. 

 all the peaks, since the BSL PR
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FIND PEAK EXAMPLE TO DETECT THE POSITIVE SPIKE IN THE QRS COMPLEX 

The easiest way to start is to select the area around a peak and then select the  icon, or you 
could choose Find Peak from the Transform menu. 

 
The peak detection dialog will appear and automatically compute a threshold value. If you don’t 
the peak detector to automatically set the threshold, then make sure that no portion of the wavefo
selected prior to choosing Find peak. 
At this poin

want 
rm is 

t, you can select Transform > Find All Peaks or Transform > Find Next Peak or you 
an click the Find Peak icon in the toolbar. You will see one cursor move to the next peak value 

e other cursor remain at the current location, as shown below: 
c
above the threshold and th
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FIND PEAK -- DATA REDUCTION EXAMPLE USING HEMODYNAMIC DATA 

The following example will show you how to automatically reduce a large hemodynamic data file 
down to 5-second measurements. In the example, min, max, mean, and p-p measurements will be 
taken for each 5-second interval. 

 
Hemodynamic data: Carotid pressure and Brachioceph blood flow 

From the Transform menu, select Find Peaks and check the “User defined interval” option. The 
dialog box will allow you to enter a measurement Interval. In this case, 5.00 seconds was entered. 
The time interval is based on the horizontal time axis. If the time scale is set to minutes, the interval 
will be in minutes. However, by zooming in and changing the horizontal scale to seconds, you can set 
the interval to seconds. Check the “Paste measurements into journal” box and click OK. Now choose 
Find All Peaks from the Transform menu. 

 
Peak detector settings for data reduction of hemodynamic data 
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As the following window shows, measurements will be pasted to the journal in a row and column 
format, ready for export to your favorite statistical package. It is possible to paste the measurements 
into the journal without the additional text (name, unit, etc.). The journal file will be saved in a text 
file format. 

 
As an option, you can select “Peak” from the Set first cursor to menu. This allows you to set a time 
window before and after the user-defined time interval. If a larger time interval is used, 10-seconds in 

roviding a 6-this example, it is possible to select a window 3 seconds before and 3 seconds after, p
second measurement period every 10 seconds. 
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FIND PEAK -- OFF-LINE AVERAGING EXAMPLE USING ECG DATA 

See also: Application Note #PS177. 
 data. The following example shows how to average a one-minute segment of ECG

 
One-minute section of ECG data and result of Off-line Averaging 

Select Find Peaks from the Transform menu. For this example, a Fixed threshold of 0.7 Volts was 
used. Select Off-line Averaging and the dialog box will allow you to enter a time window prior to the 
R-wave and after the R-wave. In this example, an averaging window of –0.3 sec before the R-wave 
(first cursor) and .35 sec after the R-wave (second cursor) was used. From Setup Averaging, we also 
chose “Selected Area” for the averaging range. 

 
Peak detector dialog setting for Off-line Averaging example 
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TIME OFFSET EXAMPLE 

One measurement option is to change the time offset of the first cursor. To do this, enter a value in the 
 next to the t first cursor to: area. Entering a value of -0.5 will result in the first cursor 

o a poin e prev
he graph h

Setext box
being set t
selected, t

t 0.5 seconds prior to th
 should like somewhat like t

ious peak, and when the Find next peak command is 
at shown below left: 

  
cted area similar to 

 interval around 
ect Peak from the 

Likewise, setting the offset of the first cursor to a positive value will result in a sele
that shown above right. 
Alternatively, you can choose to locate both cursors at the found peak, and define an
the peak. To do this, go to the Set first cursor to: portion of the dialog box, and s l
Previous peak/Peak pop-up menu. This causes the options for the second cursor to change by adding 

 offset option. hen both cursors are set t
seconds, the find peak command will select a s
As before, it is possible to include a time offset 
or negative, and can be set to an arbitrary time v

 pe r was 
orm

e

a time  W o the found peak and the offsets are each set to zero 
ingle point at the peak maxima of the next found peak. 
for the first cursor. This offset may be either positive 
alue. In the following example, the second cursor was 

set at the found
resulting wavef

ak, while the first curso
 are also shown. 

set 0.5 seconds prior to the peak. The dialog box and 
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, which allows for areas around a peak to be selectedA time offset can be added to the second cursor . 

offset as ciated with the second curso
 be a po tive value, zero, or a negativ

The time 
cursor can

so
si

r must be either zero or positive, whereas the first 
e value. 
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Since a selected area covers all channels, it is possible to highlight an area based on the location of a 
CG 

command could be used to locate peaks on the ws could display 
a value for the corresponding area on the derivative channel as shown in the foll : 

peak found on one channel and take measurements from other channels. For example, suppose E
data was acquired and the derivative of the data was calculated on channel 0. The Find peak 

 ECG channel, and measurement windo
owing graph

 
 

o possible to paste data from other channels using only data within the selected area. 
In the example shown, an area of +/- 0.5 seconds w
on channel 2 (ECG). Measurements were displ
Data from both channels were then pasted to th

Moreover, it is als
as selected based on the location of the peak found 

ayed for the slope and max of the derivative channel. 
e journal along with the horizontal scale values. 
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Find Rate 

 
d Rate function allows you to compute rate calculations (including BPM) for data that has 

 been collected. Although this function uses the same algorithm as the online Rate ca
The Fin

lculation, 
s to perform rate calculations after the data has been acquired. One benefit is that 

 data 

See also: Rate Usage Guidelines in the Rate Calculation section on page 110. 
 Application Note #PS142 for further info ation. 

Function The Function menu lists a variety of calculations. The most commonly used function is the 
Rate (BPM) option, which calculates a rate in terms of beats per minute or BPM. Other 
Rate Functions are discussed in detail in the Rate calculation section on page 108. 

Peak 
detect 

By default, the peak detector searches for positive peaks (upward pointing, such as the R-
wave of an ECG signal) to calculate the rate of a waveform. In some instances, however, 
you may have to base the rate calculation on negative peaks (downward pointing). To do 
this, select “negative” in the Peak detect section of the dialog box. 

Remove 
baseline 

The Remove baseline option applies the optimal high pass filter based on the other 
settings. This option is useful for signals with a slowly fluctuating baseline. 

Auto 
threshold 
detect 

To control for this, check the Auto threshold detect box in the find rate dialog box. When 
this option is selected, Biopac Student Lab will automatically compute the threshold value 
using an algorithm that accentuates peaks and uses information about the previous peak to 
estimate when and where the next peak is likely to occur. This threshold detector is 
typically more accurate than a simple absolute value rate calculation function, and is able to 
compute a rate from data with a drifting baseline and when noise is present in the signal. 
For a detailed description of how the calculation is performed, contact BIOPAC Systems, 
Inc. for the complete Application Note. 

already
it can be advantageou
off-line rate computations do not require that a separate channel (i.e., a calculation channel) be 
acquired. Since the number of acquired channels is reduced, other data can be collected and/or
can be sampled at a higher rate. The Find rate function produces the following Rate Detector dialog, 
which has the following options: 

rm
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Enabling Auto threshold dete  options. 

Noise 
rejection 

Biopac Student Lab constructs an int threshold level when Noise rejection is 
checked. The size of the interval is equal to the value in the noise rejection text box, which by 

 the peak-to-peak range. Checking this option helps prevent noise 
s” from being counted as peaks. 

alculation. 
e upper criterion, but 

 

dow. If no peak is 
fo rms of peak value) 

ac Student Lab will look for the next peak in 
an interval that corresponds to the range set by the upper and lower bounds of the window. 
The interval with associated with the upper band of 180 BPM is 0.33 seconds (60 seconds ÷ 
180 BPM), and the interval for the lower band is 1.5 seconds (1 minute ÷ 40 BPM). If a 
second peak is not found between .33 seconds and 1.5 seconds after the first peak, then 
Biopac Student Lab will look in the area after 1.5 seconds for a “smaller” peak (i.e., one of 
lesser amplitude). For those rate functions that require a window interval in seconds, you will 
probably want to enter numbers like .33 seconds and 1.5 seconds (which correspond to the 
BPM defaults of 40 and 180). These numbers will be suitable for detecting the heart rate of 
an average subject. 
A simple peak detector uses what is called a threshold-crossing algorithm, whereby each 
time the amplitude (vertical scale) value exceeds a given value, the peak detector 
“remembers” that point and begins searching for the next event where the channel crosses the 
threshold. The interval between the two occurrences is then computed and usually rescaled in 
terms of BPM or Hz. This is how the Biopac Student Lab Rate Calculation functions when 
all options are unchecked. 
Windowing Units are related to the selected “Function.” 

• Rate Functions related to peak or peak time specify the unit after the Function. This 
is a fixed unit, so the Windowing Units menu will be disabled. 

ct enables Noise rejection and Window

erval around the 

default is equal to 5% of
“spike

Window The Window section prompts you to specify an upper and lower limit for the rate c
By default, these are set to 40 BPM for the lower criterion and 180 for th
may be adjusted as necessary. Setting the upper and lower bounds for the “window” tells
Biopac Student Lab when to start looking for a peak. Biopac Student Lab will try to locate a 
peak that matches the automatic threshold criteria within the specified win

und, the area outside the envelope will be searched and the criteria (in te
will be relaxed until the next peak is found. 
For instance, once the first peak is found, Biop

 
• Rate Functions related to data within a cycle can be specified in units of frequency 

(Hz) or time (BPM or seconds). The Windowing Units menu will be enabled,a nd 
when a unit is selected the software will convert the Min and Max settings to the 
selected units. 
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 In the sample waveform here, the threshold 
was set to 390 mVolts to detect of the peaks 

f the d provide an accurate rate 
calculation. Since it only recognizes signals 
greater than 390 mVolts as a peak, this 390-
mVolt threshold is referred to as an “absolute 

 

o  waveform an

threshold.” 
Most waveforms are not so well behaved, 
however, and artifact can be introduced as a 
result of movement, electrical interference, 
and so forth. 
Combined with actual variability in the 
signal of interest, this can result in “noise” 
being included with the signal, as well as 
baseline “drift” which can render absolute 
threshold algorithms useless. 

 
Put Result 
in New 
Graph 

When this option is checked, the results from the find rate calculation are plotted in a new 
graph window with data displayed in X/Y format, with time on the horizontal axis. By 
default, this option is unchecked and the resulting transformation is placed in the lowest 
available channel of the current graph. 

Find Rate 
of Entire 
Wave 

When this option is checked, the rate (or other function from the Find Rate command) will 
be calculated for the entire wave (other than the selected area, if any). 

Don’t Find The Don’t Find button is useful when you realize you have not selected an area, or you 
want to change the selected area to perform the Find Rate function on. When you click 
Don’t find, the dialog settings will be saved so that you can close out of the dialog and 
select an area. When you reopen the dialog, the settings will be established as before, and 
you can click the OK button to perform the Find Rate function. This is useful for setting 
parameters using an area of a waveform (described above) and then repositioning the 
cursor at another point in the record. 
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Chapter 14 Display menu commands 

  
The Display menu includes a number of features that control how the waveforms appear on the screen 
and how much data is displayed at a time. Although these options change the appearance of the data, 
they do not change the data itself. In other words, changing the color of a waveform or showing only a 

a on the screen will not alter the data stored in the file. 

9 TIP Click the right mouse button in the data window to generate a shortcuts menu that 
ludes some display options. 

portion of the dat

inc
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Tile Waveforms 
Choosing Tile waveforms centers the waveform in the display window by adjusting the vertical offset 

form. In Chart mode, if there are multiple waveforms displayed, the waveforms 
ill be centered in their tracks. In Scope mode, display is optimized to show all the visible waveform 

 overlap. Tile waveforms is not available in X/Y mode. 

efore Tile Waveforms After Tile Waveforms 

of the selected wave
w
data with no

 B

 
 
Chart
Mode 

 
 
 
Scope 
Mode 

 
TILE WAVEFORMS In Chart Mode In Scope Mode 

Applies to Selected channel 
 

All active (visible) channels 

Effect on Horizontal 
(Time) Scale 

None None 

Effect on Vertical 
(Amplitude) Scale 

When multiple waveforms are 
displayed, each waveform is 
centered in its “track.” If tracks 
were resized, this function will 
reset (equalize) the tracks and 
then center each waveform in its 
track. 

Display is optimized to show all the 
visible waveform data with no 
overlap. Waveforms are spaced 
evenly along the vertical axis of the 
screen. Each channel’s data is 
completely visible and is separated 
from the other channels. 

Channel order 
(top to bottom) 

Numerical order (Top=low, 
Bottom=high) unless channel 
order was manually changed via 
Display>Set Wave Position. 

Numerical order (Top=low, 
Bottom=high) unless channel order 
was manually changed via 
Display>Set Wave Position. 

Limitations None None 

When to use When the vertical offset has 
shifted the channel in its track. 

When multiple waveforms are 
overlapped and hard to distinguish, 
especially if displayed in the same 
color. This pulls the waveforms 
apart, in order to view each channel. 
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Autoscale Waveforms 
When Autoscale waveforms is selected, BSL PRO determines the best fit for each displayed 

ftware adjusts the vertical offset so that each channel is centered in the window (or 
ithin the channel tracks in the chart mode) and adjusts the units per division on the vertical axis so 

that the waveform fills approximately two-thirds of the available area. 
In Chart mode, the screen is evenly divided into horizontal channel tracks and each waveform is 
autoscaled to fit the division without overlapping. To apply to only the selected waveform, hold the 
CTRL key down before selecting Autoscale waveforms. 
In Scope mode, if more than one channel is active, the channels will overlap but each waveform will 
autoscale as if it were the only waveform in the display. This is useful when overlapping waveforms 
that have different units and scales. The vertical scale shown is that of the active channel; to change 
the scale, select another channel. 
 
Optimize Ranges 
When Optimize Ranges is selected from the Display menu, the Vertical Scales will be automatically 
adjusted for all channels

waveform. The so
w

 that have a Range Guide (green band) showing, such that the range limits are 
set to the upper and lower viewable limits of the Vertical Scales. This allows you to quickly see the 
total Range of each input channel. This menu item is active when data is present AND at least one data 
channel has an active Range Guide. 

This item is also selectable using the toolbar icon  or the right-click mouse shortcut. When 
selected with the icon or the right-click, this item only optimizes the Range Guide of the active 
channel. 

nge Guide is the green vertical band that appears in the Vertical Scale region for analog 
hannels only (not for duplicated, copied/pasted, or Calculation channels); see page 42. 

 
Overlap Waveforms 
In Scope mode, when Overlap waveforms is selected, all the currently displayed waveforms are 
“overlapped” into one graph window with the same vertical scale and offset. This allows you to 
compare waveforms by setting all channels to the same vertical scale. The overall chosen scale for all 
the displayed waveforms will be a function of the pk-pk value of the combined waves. Overlap 
Waveforms is best used when comparing similar units. One use, for example, is to examine the 
calculated diastolic, systolic, and mean calculation channels “overlapped” with the raw blood pressure 
waveform. 
 
Compare Waveforms 
It is often useful to compare multiple waveforms by placing them all on the same amplitude (vertical) 
scale, but discount the effect of waveform offset (or baseline). Compare waveforms will 
automatically set the scale to be the same for all channels, and adjust the offset for each channel to 
center all displayed waves. The scale of all the displayed channels is determined by the channel with 
the largest pk-pk range in the display interval. 

 Before Compare Waveforms After Compare Waveforms 

 

Note: The Ra
input c
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The preceding example shows two waveforms that a
before Compare waveforms is performed. Afte

ppear to have approximately the same magnitude 
r using Compare waveforms, you can easily see that 

baseline and
 

The Autosc
duration) on
entire wa e

Note: You tion, but you can use the Display > Zoom 
ommand to revert pre ay 

Zoom Back / Zoom Forward 
The Zoom Back and Zoom Forward functions p ndo” and “redo” commands for the zoom 
tool and any other functions that change the amount ata displayed (either in terms of time or 

e). This effectively undoes cha
use the keyboard shortcuts of Ctrl-min
window to generate a shortcuts menu a
the zoom scale. 

ill redistribute t t displays evenl ch chan el’s 
r you have hanged the bo ndaries. T hich only works in

if you need pand a d y region for ana  retu o the

 Chart Display After Reset Chart Display 

the magnitude is not actually the same — one waveform (the sine wave) has a significantly greater 
 range relative to the other (noise) waveform. 

Autoscale Horizontal 
ale Horizontal command is a convenient way to display the entire data file (in terms of 
 the screen. When this is selected, the display will be adjusted so that the duration of the 

form fits in the graph window. For long waveforms, this can take some time to v redraw. 
You can cancel plotting at any time by pressing the escape Esc key. 

 cannot Undo the Autoscale Horizontal func
back menu c to the vious displ settings. 

 

erform “u
of d

amplitud nges in the horizontal scale, the vertical scale, or both. You can 
us or Ctrl-plus, or click the right mouse button in the data 
nd make the appropriate zoom selection. Changing mode resets 

 
Reset Chart Display 
The Reset Chart Display option w he char y so that ea n
vertical size is the same afte

 
 c u his function, w  

 Chart Mode, can be useful to ex ispla lysis and then rn t
original display. 

 Before Reset

   
 
Set wave positions... 

nels are arranged on the screen based on their channel numbers, with the lower 
played at the  the sc . You can change ng so

 placed in an arbitrary order. 
 Wave Position option of the Display menu generates the Set Waveform Order dialog, 

ng list of all stored channels. The on-screen position of e waveform  is th
same as the ordering shown in the Set Waveform Order dialog (from top to bottom). You can scroll 

the vertical scroll bar at the right. The list will scroll if you ast 
ing and dragging the waveform positions. 

he “Tile” checkbox to the left of each channel enables tiling and autoscaling for each channel when 
checkbox to toggle e enable. This can be useful if y u have some waveforms 

which you don’t want autoscaled with others. 

By default, cha
number channels being dis

n
 top of reen  the orderi  that 

waveforms are
The Set
which contains a scrolli th s e 

through the list by clicking on 
 or bottom when click

 move p
the top
T
checked. Click the th o
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You can reposition the waveforms by reordering the channel labels as they appear in this dialog box. 
To change the order of any waveform, click the channel label (e.g., Ch tion) ow
mouse button, and drag the highlighte bel to the desired p n. 

 237 

You can reposition the waveforms by reordering the channel labels as they appear in this dialog box. 
To change the order of any waveform, click the channel label (e.g., Ch tion) ow
mouse button, and drag the highlighte bel to the desired p n. 

. 4 Respira. 4 Respira , hold d, hold d n the n the 
d lad la ositioositio

   

  

 

 
Set Waveform Order dialogs and corresponding displays 

n until the waveforms are in esired o , then  to a  se
l will reset all waveform positions fore t  dialo

ult in vertical ordering of the individual waveforms. 
in vertical ordering of the individual waveforms after a tiling or 

The Wave Color option of the Display menu lets you
color to discriminate between waveforms. When you a
new waveform, the software assigns the waveform co
but you can use this function to change the color. 

esired color from

s adapter on your computer, 
oose “Custom” to display a 

olor is disabled on computers 
with grayscale monitors. 

e color to identify the selected waveform because the vertic annel text, channel 
units and measurement pop-up menus take on the same color as the selecte aveform. The channel 
label (along the left edge of the display) will be highlighted in the color for that channel. 
 

Repeat this operatio the d rder  click OK pply the lected 
order to the display screen. Cance
opened. 
¾ In Chart mode this will res
¾ In Scope mode this will result 

autoscaling operation.  

to those set be he g was 

 
Wave color 

 use 
dd a 

lor — 

To assign a new color to a selected waveform, choose Wave 
Color and then selecting the d
generated.  
Depending on the type of graphic
you may or may not be able to ch

 the menu that is 

palette of color options. Wave c

You can us al scale, ch
d w
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Horizontal Axis... 
nerates a “Set Horizontal Axis format” dialog with 

two time format options. 

Time (ss.sss) is the default.

This option ge

  

 Time (HH:MM:SS) displays as  and rounds
rmat. 

hen Sho  selec he D enu, 
bmenu appears ou to control a 
ber of options rela

played and what additional information is 
layed in the graph window. 

To enable an item, scrol o select it fr m the
Show submenu. 

ullet (•) or check  appea  next
 when it is enabled. 

 as 
necessary to fit this fo

Show... 
W w is ted from t isplay m
a su  that allows y
num ted to how data is 
dis
disp

l t o  

A b  mark ( 9) rs  to 
the menu item
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SHOW Option Toolbar / Shortcut Explanation 

Channel 
numbers 

Activates the channel box display above the graph window. 
 

 See page 55. 

Chart  Activates the art See  43 Ch display mode.  page . 

Dot plot Click the
button an
Dot plot 
¾ Hold the Ctrl

when

 right mouse 
d scroll to choose 

 key 
 you select to 

hannels. 

Allows you to view data in a “dot” format. The software 
will create user-defined points that map out the 
selected waveform. 
This is often useful for demonstrating the concept of discrete 
digital sampling by dividing the waveform up into data 
points or “dots.” apply to all c

, discrete 

Dot size Click the right mouse 
button and scroll to choose 
Dot size 

Use to specify how large 
each dot will be for Dot 
Plot. Each dot is 
measured by the number 
of monitor pixels it 
occupies. If you select a 
large numb
pixels), then t
waveform will look like 
a series of large dots. 

 

er (like 21 
he 

Grid 
 

Superimposes a set of horizontal and vertical lines on the 
graph window that correspond to horizontal and vertical 
scale divisions. Grids are a useful visual aid to help with 
measurements and when selecting an area. See page 166. 

Grid Options Click the right m
 and scroll ose

Grid buttons 

A ates the d O with ons
nes and idth and color of major 

and minor grid lines. See page 166. 

ouse 
button  to cho  unlock grid li

ctiv  Gri ptions Dialog  opti  to lock or 
 control the w

Journal Opens a Journal window below the data window. 
 

Last dot only Click the right mouse 
button and scroll to choose 

 

Enabled with Dot mode, plots only the most recently 
acquired data point. This is useful when viewing data as it is 
being acquired and when using the X/Y display mode. Last dot only

Line plot Click the right mouse 
ll to choose 

Ctrl
 sel

apply to all c s. 

Plots the waveform by connecting each sample point to the 
next with a line. Line plot waveforms match a true analog 
plot (as closely as possible). This is the default display mode 
for most waveforms—except histogram plots, which are 
displayed in Step plot (see page 209). 

button and scro
Line plot 
¾ Hold the 

when you
 key 
ect to 
hannel

Markers 
 

Activates the marker region display and e math rker tools. 

 See page 164 for Marker details. 

Measurements 
 

Displays the measurement boxes above the graph window. 
See page 149 for an overview of the measurement process 
and page 153 for an explanation of each measurement. 

Scope 
 

Activate the Scope display mode. See page 43. 
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SHOW Option Toolbar / Shortcut Explanation 

Step plot Click the right mouse 
button and scroll to choose 
Step plot 
¾ Hold the Ctrl key 

when you select to 
an

Draws waveforms using a “step” plot which connects 
sample points with either vertical or horizontal lines. Step 
plot is most useful for displaying histograms and similar 
plots, but since it displays data much as it appears to a 
digital processor (like the MP35/30), it can also be useful for 
exa ng the e s of va pling rates.  

p plot is mu e o  pl
apply to all ch nels. mini ffect rious sam

NOTE: Ste tually exclusiv f Line ot. 

Toolbar Click the right m
button at the top o
display by the me

ouse 
f the 
nu items. 

Generates the toolbar display across the top of the 
window. The Toolbar has shortcut buttons for commonly 
used features. See page 35 for an explanation of the buttons. 

data 

X-Scale  Shows/Hides the Horizontal Scale. Hiding the X scale when 
desired allows for use of full screen for X/Y plots. 

Y-Scale  Shows/Hides the Vertical Scale. Hiding the Y scale when 
desired allows for use of full screen for X/Y plots. 

X/Y 
 

Switches the display to X/Y mode. See page 44. 
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Statistics... 
The Statistics command generates a message box with information about the selected channel. 

 

Channel number: the active channel 

Channel label: associated label text (if any) 

Interval: sa

 duration in samples and time 

e fo form data 

Max: maximum value for the waveform data 

Mean: mean value for the waveform data 
 

a  lengt h 
oss  sho form editing out sections of the waveform 

(using Edit > Cut and/or Edit > Clear functions
The interval specified in this message box refle samp PRO software uses to 

sar  same at which as c ta w po
Q, pl ata w not s wi

/sec. to plot the data. 
ou can use the Resample function (described on page 210) or paste 

e sample rate into a graph with data sampled at a different rate. 

Size window... 

mpling rate used for data storage 

Length: waveform

Min: minimum valu r e the wav

Generally, the sampling rate and w
 the case. It is p

veform h information is the same for all channels, althoug
this is not always ible to rten wave

). 
s by 

cts the ling interval the BSL 
store the data, which is not neces

at other than .AC
ily the rate  it w

as 
ollected. If da
t

as im rted or 
ll use saved in a form the sam e interval d ored, and the software 

the default of 100 samples
To modify the sample Interval, y
data collected at on
 

 
The Size Window function lets y
exact dimensions for

ou specify 
 the size of the graph 

se this to create 
nto 

The two text b s allow nter screen wid h and 
both o s of pixels. 

Standard computer displays have 72 pixe per in
(2 pixels/c o a gr w th 0 

 216 pixels high 12.7cm all and 
7.6cm wide. 
When the R

window. You can u
consistently sized windows for pasting i
documents. 

oxe
f which are scaled in term

 you to e t
height, 

ls ch 
pixels 8.3 m), s aph windo at is 36

wide by  would be  t

eset Chart B es bo eck
ries between the waveforms will be reset so that 

each channel “track” is the same size. This function 
o orks in rt mo

he Reset functi irst-order Dis
menu option. See page 236 for an example. 
 

rsor Style 
The Cursor Style option generates a sub-menu with options for the three general cursor styles that are 

er right corner o  graph w

oundari x is ch ed, the 
bounda

nly w  Cha de. 
Note: T on is also a f play 

Cu

displayed in the low f the indow. 

  
Refresh Graph 
This will refresh the screen display. Use this op erase residual I n the graph. tion to -beam lines o
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Chapter 15 Window Menu & Help Menu 
Window menu 

The Window menu is a standard Windows® function with window display options. This menu 
lists all open files, which can be useful for file selection when multiple files are open, and also 
includes several display options. See your Windows® Manual for details. 

 
Help menu 

 
The Help menu lists the BIOPAC support options available wh  are running the program. The 
Tutorial, Manual and Guide files are in PDF format and can be easily searched. 

“browser” to use the “from W tio
not installed Adobe Acrobat Read r (free at www.ado

ile you

� You must have an active eb” op ns. 
om� If you have e be.c ) or it has never been 

used on your OS, you must install or activate Acrobat to see the PDF menu options. 

and of the Help menu (under the BSL PRO m n a tes a g w
ons being us ystem 

u need to call BIOPAC for any reas g also contains 
r MP35/30 unit, which can be useful if you ake a service call.  

About command 
The About comm enu o Mac) genera

nd your s
 dialo ith 

information about the BSL PRO software and firmware versi ed a
on. This dialoparameters, which can be useful if yo

the serial number (S/N) for you  need to m
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Part E — Appendices 
 

 
Appendix A — Sample Data Files 

ac Student Lab PRO installati cludes t llowing ple da hic  
 familiarize f with the BSL

installed to the Biopac Stude t Lab PRO .3.6.6 folder. The path to the folder 

Biopac Studen SL 3.7\BSL PRO 3.7\Samples 
the PRO. 

 file is also in d—see page 249. 

Sample data files 
The Biop on in he fo  sam ta files, w h you are

 PRO System. encouraged to open and review as you yoursel
The “Samples” folder is 

ult installation) is: 
n  v

(from defa
C:\Program Files\

� 
t Lab\B

Ten sample acquisition (.acq)  files are installed with 
� A graph template stalle
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Data file name Screen Shot 

4Channel.acq 

 

BloodPressure.acq 
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Data file name Screen Shot 

EEG.acq 

 

EMGwForce.acq 
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Data file name Screen Shot 

FingerTwitch1.acq 

 

FingerTwitch2.acq 
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Data file name Screen Shot 

HeartTemplate.gtl 

 

 
One graph 
template (.gtl) file 
is installed with 
BSL PRO. See 
page 174 for a 
discussion of 

e” to 

graph templates. 
You must select 
“Files of type 
Graph 
Templat
select this file” 
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Data file name Screen Shot 

NerveConduction 
.acq 

StandardCurve.acq 
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Data file name Screen Shot 

StandardCurveData 
.acq 

ValidateMeasure-
m cq ents.a

 

 



250 Part E  

Visit the online support center at www.biopac.com 

able of Analog Presets for MP35 (Preset parameters may differ slightly for MP30)
 either 50 Hz or 60 Hz as deter  Frequency specified when the 

st be calibrated before . Typically this involves using 
ia MP35 s > View/Change Parameters > 

tion fer to the BSL Hardware Guide 
IO Web Site (www.biopac.com). 

 + The Band Stop Frequency will be 50 Hz  Line Frequency specified 
when the BSL PRO software was installe

Appendix B — T
Notes * Notch Filter is mined by the Line

BSL PRO software was installed. It is used to
from electrical power sources. 

 filter out the interference signal introduced 

 ** The transducer mu the recording begins
the “scaling” dialog (accessible v
Scaling…), but more involved calibra
or Application Notes available on the B

/30 > Setup Channel
 may be required. Re
PAC 

or 60 Hz, based on the
d. 

Analog Preset Name 
Channel Label 
Applicable Calc. Presets 

Gain 
X 

Hardware 
Filters 

AC or DC 
.05 or .5 

HP 
1K or 5K 

LP 

IIR 
Filters 
Type, 

Freq., Q 

Scaling 
(Mapping) 

Units 
label 

Recommended 
Calibration & 
Sample Rate 
(Samples/sec) 

Default This preset can nt when no other preset is applicable or 
when input amp e unknown. It is set to maximum bandwidth, and 

w gain allow d view almost hysiologic  that 
within a +-50 mV input range. 

Min. Sample Ra ency expected or desired. 

 be used as a starting poi
litude and offset ar

e to record ana lo
falls 

ing on any P al signal

te: 2X maximum frequ
Accelerometer (5 g’s max.) 
Accelerometer (5 g), 3 CH 
Use with the BIOPAC SS26L, 0 to 5g, 
Accelerometer 

 
500 

  
D

1K

 
 1 

10 mV > 0 

 
g’s 

 

Calibration 
required** 
Min. Sample 
Rate: 100 S/S 

C 
 LP 

BP 11 mV >

Accelerometer (50 g’s max) 
Accelerometer (50 g), 3 CH  

 
500 D

1K

 
7.5 mV > 10 
6.5 mV > 0 

 
g’s 

 

Calibration 
required** 

mple Use with the BIOPAC SS27L, 0 to 50g 
ter. Accelerome

  
C BP 
 LP Min. Sa

Rate: 100 S/S 
Airflow (SS11LA) 
Airflow transducer 

 

Can be used with the “Lung Volume” 
Calculation Channel preset to obtain 
Volume data. 

1
5,000 D

K

 
-3000 uV > -

10 
00 uV > 10 

 
liters/sec 

 

Min. Sample 
Rate: 100 S/S 

  
C BP 
 LP 

30

Airflow (SS52L) 
Airflow (SS52L) 

 

SS52L System: Airflow (75 kg, 
ing adult) <+-8000 ml/sec.> 

1,000 
1K LP exercis

 
D

  
 

0 mV > 0 
192.5 mV > 1 

 
 

liters/sec 
 

 
 

Airflow 

 
  
C BP 

Airflo (small mouse) 
Airflo mall mouse) 

ystem: Airflow (30 gm, small 

 
 
1,000 

 
 

DC 

 
 

BP 

 
 

0 m

 
 

 
 

w 
w (s

SS45L S
) <

Airflow 

V > 0 

10 

ml/sec 
mouse +-12 ml/sec.> 1K LP 1.285 mV >  

Airflow (mouse) 
Airflow (mouse) 
SS46L System: Airflow (50 gm, mouse)  
<+-20 ml/sec.> 
Airflow 

 
 
1,000 

 
 

DC 
1K LP 

 
 

BP 

 
 

0 mV > 0 
0.770 mV > 

10 

 
 

ml/sec 
 

 
 

Airflow (rat/guinea pig) 
Airflow (rat/guinea pig) 
SS47L System: Airflow (350 gm, 
rat/guinea pig) <+-60 ml/sec.> 
Airflow 
 

 
 
1,000 

 
 

DC 
1K LP 

 
 

BP 

 
 

0 mV > 0 
0.289 mV > 

10 

 
 

ml/sec 
 

 
 

Airflow (cat/rabbit)       
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Analog Preset Name 
Channel Label 
Applicable Calc. Presets 

Gain 
X 

Hardware 
Filters 

AC or DC 
.05 or .5 

HP 
1K or 5K 

LP 

IIR 
Filters 
Type, 

Freq., Q 

Scaling 
(Mapping) 

Units 
label 

Recommended 
Calibration & 
Sample Rate 
(Samples/sec) 

Airflow (cat/rabbit) 
SS48L System: Airflow (750 gm, 
cat/rabbit) <+-150 ml/sec.> 
Airflow 

 
1,000 

 
DC 

1K LP 

 
BP 

0 mV > 0 
1.05 mV > 

100 

 
ml/sec 

 

 

Airflow (small dog) 
Airflow (small dog) 
SS49L System: Airflow (5.5 kg, small 
dog) <+-350 ml/sec.> 
Airflow 

 
 
1,000 

 
 

DC 
1K LP 

 
 

BP 

 
 

0 mV > 0 
0.462 mV > 

 
 

ml/sec 
 

 
 

100 
Airflow (medium dog) 

SS50L System: A g, 
dog)  
<+-1200 ml/sec.> 
Airflow 

 
 

0 

 
 

DC 
1K LP 

 
 

BP 

 
 

0 mV > 0 
1.155 mV > 

1000 

 
 

ml/sec 
 

 
 Airflow (medium dog) 

irflow (15 k medium 1,00

Airflow (large dog) 
Airflow (large dog) 
SS51L System: Airflow (25 kg, large 
dog) <+-3000 ml/sec.> 
Airflow 

 
1,000 

 
DC 

1K

 
BP 

 
 

0 mV > 0 

 
 

ml/sec 
 

 
 

   

 LP 0.482 mV > 
1000 

Blood Pressure (Arterial) 
Blood Pressure (Arterial) 
Use with the SS13L for measur
blood pressure in animals. Can be used 
with several Calculation Presets for real-
time recording of heart rate, Systolic, 
Diastolic, and Mean BP, along 
changes in pressure with respect to time 
(dp/dt). 

  
D

1K

   Calibration 
required** 
Min. Sample 
Rate: 100 S/S 

ing direct 
1,000 

with 

C 
 LP 

BP 0 mV > 0 
2.5 mV > 100 

mmHg 
 

Blood Pressure Cuff 
Blood Pressure Cuff 
Use with the BIOPAC SS19L, B
Pressure Cuff. 

DC 
1K

 
0 mV > 0 

2.5 mV > 100 

 
mmHg 

 

Calibration 
required** 
Min. Sample 
Rate: 100 S/S 

lood 

 
500 

  
BP 

 LP 

BNC (SS9L, -10 to +10 Volts m
BNC Adapter (for MP30)  
<divide by 1000> 
Use when connecting up to external 
devices using the BIOPAC SS9L BNC 
adapter. Voltage amplitudes should be 
greater than +- 1 Volt, and less than +- 
10 Volts. 

 
1,000 

 

 
D

5K

 

 

 

 

 
 
 

Volts 

Min. Sample 
Rate: At least 
2X highest 
frequency of 
interest 

ax.  
    

C 
 LP 

None -1 mV > -1 
1 mV > 1 

BNC (SS9L, -50 to +50 Volts 
B

max.) 
NC Adapter (for MP30)  

g up to external 
OPAC SS9L BNC 

ge amplitudes should be 
grea
+- 5

200 DC 
5K LP 

None -1 mV > -1 
1 mV > 1 

Volts 
 

Min. Sample 
Rate: At least 
2X highest 
frequency of 
interest 

Use when connectin
 the BIdevices using

adapter. Volta
ter than +- 10 Volts, and less than 
0 Volts. 

BNC (SS
BNC Ada

70L, -10 to +10 Volts max.)   
pter (for MP35), Isolated 

<div
 

10 DC 
 

None 
-1000 mV > -

10 
 

Volts 
 

ide by 10> 1000 mV > 
10 
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Analog Preset Name 
Channel Label 
Ap cpli able Calc. Presets 

Gain 
X 

Hardware 
Filters 

AC or DC 
.05 or .5 

HP 
1K or 5K 

LP 

IIR 
Filters 
Type, 

Freq., Q 

Scaling 
(Mapping) 

Units 
label 

Recommended 
Calibration & 
Sample Rate 
(Samples/sec) 

Cardiac Output – dZ/dt 200 DC 
1K LP 

BP 0 mV > 0 
5 mV > 2 

Ohms/se
c 

 
Cardiac Output – dZ/dt 

 
Cardiac Output – Z 
Cardiac Output – Z 
Non-Invasive Cardiac Output Module 

200  
DC 

1K LP 

 
BP 

 
0 mV > 0 

50 mV > 100 

 
Ohms 

 

 

Circuit Probe (Breadboard) 
Circuit Probe 
M X
fo re

 
200 

 
DC 

 
N/A 

 
-50 mV > -5 

 
Volts 

 

P3  Circuit Probe and Power Cable 
r B adboard 

5K LP 50 mV > 5  

Clenc
Clench Force 

se with the BIOPAC SS25LA Hand 
ynamometer. 

500 DC 
1K LP 

BP 0 mV > 0 
3.50 mV > 

100 

 
kg 
 

Calibration 
required**  
Min. Sample 
Rate: 100 S/S 

h Force (kg)     

U
D
Clench Force (lbs) 
Clench Force 
Use with the BIOPAC SS25LA Hand 
Dynamometer. 

500 DC 
1K LP 

BP 0 mV > 0 
3.50 mV > 

220 

lbs Calibration 
required**  
Min. Sample 
Rate: 100 S/S 

Clench Force (N) 
Clench Force (Newtons) 
Hand Dynamometer Clench Force 
Use with the BIOPAC SS25LA Hand 
Dynamometer. 

500 DC 
1K LP 

BP 0 mV > 0 
3.50 mV > 

981 

N Calibration 
required**  
Min. Sample 
Rate: 100 S/S 

CO2 Expired (GASSYS2)  

1K LP 

  

0.04 
11.02 mV > 1 

 

 

 
GAS - CO2 (Used on GAS-System2) 200 DC BP 1.027 mV > % CO2  

 

Current Monitor (BSLCBL10) 
Current/Voltage Drive & Monitor Cable. 
(DS  9M + 

 
 

 
DC 

 
 

 
0 mV >

 
micro 

 

UB DSUB 9F to clip leads) 200 5K LP None 
 0 

50 mV > 50 Amp 
Displace

DC 
1K LP 

BP 
 

0 mV > 0 
1 mV > 1 

 
cm 

 

 ment (cm)    
Displacement; use with SS14L. 500 

Displacement (inches) 
Displacement; use with SS14L. 

500 DC 
1K LP 

BP 0 mV > 0 
1 mV > .394 

inches  

Displacement (AD Inst. DT-475)  
Displacement 

500 DC 
1K LP 

BP 0 mV > 0 
9 mV > 1 

inches  

Dissolved O2 (BSL-TCI16) 
Dissolve
RXP
connecto

      
d O2 using BIOPAC 

ROBE02 and Vernier (BT (RH) 
r)  

200 DC 
1K LP  

BP 0 mV > 0 
25 mV > 100 

% O2 
 

 

Earthwo
Earthworm Action Potential 
 
 
 
 
 
 
 
 
 

5 Hz HP, 5 
HP,  5K LP 

.707 
 

uV > -10 
10 uV > 10 

micro V 100,000 
 

rm Action Potential 10,000 AC HP,  50, -10 
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Analog Preset Name 
Channel Label 
Applicable Calc. Presets 

Gain 
X 

Hardware 
Filters 

AC or DC 
.05 or .5 

HP 
1K or 5K 

LP 

IIR 
Filters 
Type, 

Freq., Q 

Scaling 
(Mapping) 

Units 
label 

Recommended 
Calibration & 
Sample Rate 
(Samples/sec) 

Electrocardiogram (ECG), .05 - 35 Hz 
Use when recording Human ECG 

2,000 
1000 

AC BP -1000 uV > -1 mV Mi

signals using the BIO
Electrode Leads. This preset w

PAC SS2L 
ill 

 and 

Can be
presets
amp d

.05 HP, 1K 
LP 

1000 uV > 1 
-1 mV > -1 
1 mV > 1 

 
n. Sample 

Rate: 100 S/S 

preserve more of the ECG component 
amplitude than the (.5 – 35 Hz) filter, but 
with more baseline drift. Works well if 
subject is completely relaxed
motionless. 

 used with the ECG Calculation 
 to obtain real time Rate, R-wave 

litu e, etc.  
Electroc
Hz, AHA

CG (.05 – 100 Hz, AHA) LP  

0 uV > -1 
1000 uV > 1 
-1 mV > -1 
1 mV > 1 

mV  ardiogram (ECG), .05 - 100 
 American Heart Assoc. 

2,000 
1,000 

AC 
.05 HP, 1K 

LP, 100, 
.707 

-100

E

Electrocardiogram (ECG), .05 - 150 Hz 

Use e
sign
Electrod
used he

ing of the components of the ECG. It 

inte
line 

2,000 AC LP, 150, -1000 uV > -1 

-1 mV > -1 
1 mV > 1 

mV Min. Sample 
Rate: 500 S/S ECG (.05 – 150 Hz) 1,000 .05 HP, 1K 

LP 
.707 

 
1000 uV > 1 

wh n recording Human ECG 
als using the BIOPAC SS2L 

e Leads. This preset is mainly 
w n measuring amplitudes and 

tim
can only work if the subject is 
completely relaxed and motionless (no 

rfering EMG signals), and no power 
(50/60 Hz) interference is present. 

Electrocardiogram (ECG), .5 - 35 Hz 

 
Use e
sign  u
Electrode Leads. This preset will give a 

ean recording with minimal baseline 
ift, however the components of the 

 in 
.  

Can be used with the ECG Calculation 
pres  t
amp d
Add
can be created to filter out unwanted 
EMG interference. 

 
2,000 
1,000 

 
AC 

.5 HP, 1K 
LP 

 
BP 

 
-1000 uV > -1 
1000 uV > 1 
-1 mV > -1 
1 mV > 1 

 
mV 

Min. Sample 
Rate: 100 S/S 
 

ECG (.5 – 35 Hz) 
Electrode Cable with 3 Leads

wh n recording Human ECG 
als sing the BIOPAC SS2L 

cl
dr
ECG may have a slight reduction
amplitude due to the added filters

ets o obtain real time Rate, R-wave 
litu e, etc.  
itional Calculation Channel Presets 

Electrodermal Activity (EDA), 0 - 35 
Hz 
EDA (0 – 35 Hz) 
EDA (GSR) finger electrodes 
EDA (GSR) with electrode pinch leads: 
Use any Preset from SS3LA 
Use when recordingelectrodeermal 
activaty/ Galvanic Skin Response(GSR) 
using the BIOPAC SS3LA transducer. 
Changing baseline may be make this 
preset hard to work with. If only changes 
in the GSR are desired, use the “EDA 
(GSR) Change” preset. 

 
2,000 

 
DC 

1K LP 

 
BP 

 
0 uV > 0 

1000 uV > 10 

 
micro 
Mho 

 

Calibration 
required**  
Min. Sample 
Rate: 100 S/S 
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Analog Preset Name 
Channel Label 
Applicable Calc. Presets 

Gain 
X 

Hardware 
Filters 

AC or DC 
.05 or .5 

HP 
1K or 5K 

LP 

IIR 
Filters 
Type, 

Freq., Q 

Scaling 
(Mapping) 

Units 
label 

Recommended 
Calibration & 
Sample Rate 
(Samples/sec) 

Electrodermal Ac
EDA Change 
Use e
elec de
using the
Bas
Hz High Pa

tion 
d**  

100 S/S 

tivity (EDA) Change 5,000 AC 
.05 HP, 1K 

BP 0 uV > 0 
1000 uV > 10 

delta 
micro 

Calibra
require

wh n recording changes in the  
rto ermal activity (EDA/GSR) 

 BIOPAC SS3LA transducer. 

LP Mho Min. Sample 
Rate: 

eline drift is minimized with the .05 
ss Filter. 

Electroencephal
Hz 
EEG (.5 – 35 Hz) 
Use en reco
signals using the 
Electrode Leads.  

an be used with the EEG Calculation 
resets (alpha, beta, delta, and theta) to 

ific EEG frequency 

20,000 .5 HP, 1K 
BP -10 uV > -10 

10 uV > 10 
micro V Min. Sample 

Rate: 100 S/S 
ogram (EEG), .5 - 35 25,000 AC 

wh rding Human EEG 
BIOPAC SS2L 

LP 

C
p
extract the spec
bands. 
Electroencephalogram (EEG), .5 - 100 
Hz w/notch 
EEG (.5 - 100 Hz, w/notch)  

25,000 
20,000 

AC 
.5 HP, 1K 

LP, 100, 
.707 

-10 uV > -10 
10 uV > 10 

micro V  

Note: Th
extractin

ing the calculation channel preset: 

LP BSLF 
is bandwidth is needed for 
g the gamma frequency band 

 

us
EEG gamma (30 - 90 Hz). 
Electrogastrogram (EGG) 
EGG 

5,000 DC 
 

 

BP -1000 uV > -1 
1000 uV > 1 

 

mV  

Electromyogram (EMG), 5 - 250 Hz 
w/notch 
EMG  – 250

5 HP 
LP, 250, 

.707 
-1 mV > -1 
1 mV > 1 

mV  

 (5  Hz w/notch) BSLF 

1,000 AC 

Electromyogram (EMG), 5 - 500 Hz 1,000 AC 
5 HP 

LP, 500, 
.707 

 

-1 mV > -1 
1 mV > 1 

mV  
EMG (5 – 500 Hz) 

Electromyogram (EMG), 5 - 1000 Hz 
EMG (5 – 1000 Hz) 

1,000 AC 
5 HP 

LP, 
1000, 
.707 

-1 mV > -1 
1 mV > 1 

mV 
 

 

Electromyogram (EMG), 30 - 250 Hz 
w/notch 
EMG (30 – 250 Hz w/notch) 
Use when recording general EMG 

2,000 
1,000 
 

AC 
.5 HP, 5 

Hz, 1K LP 

HP,  30, 
.707 

LP, 250, 
.707 

-1000 uV > -1 
1000 uV > 1 
-1 mV > -1 

mV Min. S
Rate: 5

signals using the BIOPAC SS2L 
d to 
S/S 

 
 

BSLF 
1 mV > 1 

ample 
00 S/S 

Electrode Leads. Bandwidth is limite
250Hz so that a sample rate of 500 
can be used. Notch filter is added to 
minimize electrical interference, but may 
distort the EMG signal. Can be used 
with the EMG Calculation Channel 
presets to obtain “Integrated” or “RMS” 
data. 
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Analog Preset Name 
Channel Label 
Applicable Calc. Presets 

Gain 
X 

Hardware 
Filters 

AC or DC 
.05 or .5 

HP 
1K or 5K 

LP 

IIR 
Filters 
Type, 

Freq., Q 

Scaling 
(Mapping) 

Units 
label 

Recommended 
Calibration & 
Sample Rate 
(Samples/sec) 

Electrom
EMG (30
Use whe
the BIOP
This pres
accuracy  high sample 
rate. No 
electrical
problem.
Calculati
“Integrat

V > -1 

Min. Sample 
Rate: 2000 S/S 

yogram (EMG), 30 - 500 Hz  
 – 500 Hz) 
n recording EMG signals using 

2,000 
1,000 

AC 
.5 HP, 5 

HP,  1K LP 

HP,  30, 
.707 

LP, 500, 

-1000 uV > -1 
1000 uV > 1 
-1 m

mV 

AC SS2L Electrode Leads. 
et will give maximum EMG 
, but will require a

.707 1 mV > 1 

Notch filter is added so 
 interference may pose a 
 Can be used with the EMG 
on Channel presets to obtain 
ed” or “RMS” data. 

Electrom
EMG (30

HP,  LP, -1 mV > -1 

 yogram (EMG), 30 - 1000 Hz 
 – 1000 Hz) 

2,000 
1,000 

AC 
.5 HP, 5 

HP,  30, 
.707 

-1000 uV > -1 
1000 uV > 1 

mV 
 

5K LP 1000, 
.707 

1 mV > 1 

Electroo
OG (.05 – 35 Hz) 
se when recording EOG (eye 

m s using the BIOPAC 
eads. 

1,000 .05 HP, 1K 
LP 

BP -1000 uV > -1 
1000 uV > 1 
-1 mV > -1 

mV Min. Sample 
Rate: 100 S/S 

culogram (EOG), .05 - 35 Hz 2,000 AC 
E
U

ovement) signal
S2L Electrode LS

1 mV > 1 

Finger Displacement (cm) 
F

2,000 DC 
1K LP 

BP  0 

8.89 

cm  
inger Displacement 

0 uV >
300 uV > 

F
F ches) 
F

    

30

  inger Twitch transducer 
inger Displacement (in
inger Displacement 

2,000 DC 
1K LP 

BP 0 uV > 0 
0 uV > 3.5 

inches  
 

F
F
U IOPAC SS12L, Variable 
R ransducer. 

500 DC 
 

BP 
 

 0 
5

 
grams 

Calibration 
required** 

orce (0 – 50 grams) 
orce 
se with the B

Tange Force 

  

1K LP 
0 mV >
 mV > 50  

F ams) 
F
U OPAC SS12L, Variable 
Range Force Transducer. 

BP 
5

 
 

Calibration 
required** 

orce (0 – 100 gr
orce 
se with the BI

500 DC 
1K LP 

0 mV > 0 
 mV > 100 

grams

F
F
Use ble 
R . 

DC 
1K LP 

BP 
5 mV >

grams 
 

Calibration 
required** 

orce (0 – 200 grams) 
orce 

with the BIOPAC SS12L, Varia
ange Force Transducer

500 0 mV > 0 
 200 

F
F
U ariable 
R

0 mV > 0 
5 mV > 500 

grams 
 

Calibration 
required** 

orce (0 – 500 grams) 
orce 
se with the BIOPAC SS12L, V
ange Force Transducer. 

500 DC 
1K LP 

BP 

F rams) 
F
U le 

500 DC BP 0 mV > 0 
5 

grams 
 

Calibration 
required** 

orce (0 – 1000 g
orce 
se with the BIOPAC SS12L, Variab

Range Force Transducer. 

1K LP mV > 1000 

Force (iWorx FT-100)  
Force measurment using WPI, AD 

orx 
1,000 

 
DC 

1K LP 
 

 
BP 0 mV > 0 

2

 
grams 

 

Instruments (CB Sciences) and iW
pin, Female) 

(8 

  

.5 mV > 250 

Galvanic Skin response – G
     See Electrdermal Activity 
 

SR 
– EDA 
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A ame nalog Preset N
Channel Label 
Applicable Calc. Presets 

Gain 
X 

Hardware 
Filters 

AC or DC 
.05 or .5 

HP 
1K or 5K 

LP 

IIR 
Filters 
Type, 

Freq., Q 

Scaling 
(Mapping) 

Units 
label 

Recommended 
Calibration & 
Sample Rate 
(Samples/sec) 

Goniometer 

  
S20L,  SS21L

 
DC 

1K LP 

 
BP 

 
-

90 
2

 
ees 

Calibration 
required**  
Min. Sample 
Rate: 100 S/S 

Goniometer (110 mm max.), 2 CH 
Wrist or ankle, +- 180º
Use with the BIOPAC S
and SS24L Goniometers. 

 

 
2,000 2250 uV > - degr

250 uV > 90 

Goniometer (Intelitool - Flexicomp) 
sing 

pin mini DIN, Female) 

 
BP 

 

5 mV > 150 

  
Goniometery measurement u
Intelitool (6 

  
200 DC 

1K LP 
0 mV > 90 degrees 

Heel/Toe Strike 
ly 

1K LP 

 
-5 mV > -1 

 mV > 1 

 
Impulse 

 

 
Heel/Toe Strike assemb

 
1,000 

 
DC 

 
BP 

5
Microphone (SS17L, .5 – 200 Hz) 

AC SS17L 
o record Physiological 

and Korotkoff 

 
200 

 
AC 

.5 HP, 1K 

 
LP, 200, 

.707 

 
-10 mV > -10 
1  10 

 
mV 

 

Min. Sample 
Rate: 500 S/S Microphone 

Piezo Microphone 
 BIOPUse with the

Microphone t
Sounds (such as heart 
sounds). 

LP 
0 mV >

Microphone for Speech (SS62L)  HP, 30, 
.707 
LP, 

3500, 
.707 

-1
10 mV >

10,000 
 Microphone 

200 AC
5 HP 

0 mV > -10 
 10 

mV 

MP100/150 Interface (BSLCBL
MP100/150 Interface 

14)  -1

1000 mV > 

ts  10 DC 
 

None 000 mV > -
10 

Vol

10 
Nerve Response (BSLCBL3, 4, 9) 

g Cable 
(DSUB 9M to 3x Banana Plugs)  <divi

Input Range (MP30) = +-700 mV 
Input Range (MP35) = +-10 Volts 

 
None 

 
-

1000 uV > 10 
-

 
 

 
100,000 
 

Nerve Response 
Nerve Conduction Recordin

de 

2,000 
1,000 

AC 
.5 HP, 5K 

LP 
by 10> 

  
1000 uV > -

10 
mV

1 mV > -10 
1 mV > 10 

 
Nerve Response (BSLCBL8) 
Nerve Response 
High Impedance Cable 

      

O2 Expired (GASSYS2) 

 on GAS-System2) 

BP 
20.64 mV >

20.93 

 
O2 Expired 
GAS - O  (U2 sed

200 DC 
1K LP 

0 mV > 0 
 

% O2 
 

pH (BSL-TCI21) 

pH Probe (Generic, BNC style) 
use with RXPROBE01) 

 DC 
1K LP 

 
BP  

35 mV > 14 
pH 

 
 pH 

  
200

  
0 mV > 7

Pneumogram 
Pneumogram transducer  
SS67L = SS41L + RX110 + tubing 

 
 
500 

 
DC 

1K LP  

 
 

BP 

 
0  mV > 0 

6.55 mV > 10 

 
 

cm H2O 

 
 

Pressure (+- 2.5 cm H2O) 
Pressure 
SS40L Diff. Pressure Transducer +-2.5 
cm H20 
 

 
1,000 

 
DC 

1K LP 

 
BP 

0 mV > 0 
1.638 mV > 1 

 

 
cm H2O 
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Analog Preset Name 
Channel Label 
Applicable Calc. Presets 

Gain 
X 

Hardware 
Filters 

AC or DC 
.05 or .5 

HP 
1K or 5K 

LP 

IIR 
Filters 
Type, 

Freq., Q 

Scaling 
(Mapping) 

Units 
label 

Recommended 
Calibration & 
Sample Rate 
(Samples/sec) 

Pressure (+- 12.5 cm H2O) 

er +-12.5 

 
500 DC BP 

 
0 mV > 0

        mV   

 
cm H2O 

 
Pressure 
SS41L Diff. Pressure Transduc
cm H20 

  

1K LP                           0.655 > 1  

Pressure (+- 25 cm H2O) 
Pressure  
SS42L Diff. Pressure Transducer +-25 
cm H20 

 
50

 
BP 

 
0 mV >

0.327 mV 
2O 

 

 
0 

 
DC  0 

 
cm H

1K LP   > 1 

Psychological Response 
Psych. Response Indicator 

S43L Variable Asessment Transducer 

 
20

 
BP 

 
0 mV >
0 mV >

onse
 

S
0 

 
DC  0 

 
Resp

1K LP 5  9 
Pulse Plethysmograph (PPG) 
PPG (Pulse) 
Use with the BIOPAC SS4L Pulse 
Plethysmograph (PPG) finger 
transducer to record variations in blood 
density. Can be used with the “Pulse 

 
 
5,000 

LP 

 
 

00 uV

 Sample 
Rate: 100 S/S 

Rate” Calculation Channel preset to 
ate data. obtain real time pulse r

   Min.
 

AC 
 

BP -10  > -1 
 

mV 
.5 HP, 1K 1000 uV > 1  

Reflex Hammer 
Reflex hammer strike 

S36L Reflex Hammer 

 
2,000 

 
00 uV

0 uVS

    
DC BP -10  > -1 

100
mV 

1K LP  > 1  
Reflex Hammer (Intelitool - 
Flexicomp) 
Reflex Hammer 

200 DC -10 mV >
V >5K LP N/A 10 m  10 

  -10 mV  

Respiration (SS5LB) 
Respiration Belt (for Chest), Version 3 
Respiration 
Use with the BIOPAC SS5LB 
Respiratory Effort Transducer to record 
changes in thoracic or abdominal 
circumference. The .05 Hz High Pass 
filter helps to minimize baseline drift. 
Can be used with the “Respiration Rate” 
Calculation Channel preset to obtain 
real time rate data. 

 
1,000 

  
-10 mV >

Min. Sample 
te: 100 S/S 

  
AC BP  -10 mV Ra

.05 HP, 1K 10 mV > 10  
LP 

Stethoscope (Heart Sounds) 
Stethoscope 
Use with the BIOPAC SS30L electronic 
Stethoscope for recording Heart 
Sounds. 

 
2,

   
V > -1 

 
mV 

 

Min. Sample 
Rate: 200 S/S 000 AC HP, 40, 

7
-1000 u

.5 HP, 5 . 07 1000 uV > 1 
HP,  1K LP LP, 60, 

.707 
Stethoscope (Korotkoff Sounds) 
Stethoscope 
Normally used with the BIOPAC SS19L 
for recording a ining Systolic 

d Pressu

 
 
 
 
 
 
 

2,000 AC 

7

mV 
 

Min. Sample 
Rate: 200 S/S 

nd determ
and Diastolic Bloo re. 
 

.5 HP, 5 
HP

.707 
> -1 

1000 uV > 1 
HP,  1K LP LP, 100, 

, 50, -1000 uV 

. 07 
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Analog Preset Name 
Channel Label 
Applicable Calc. Presets 

Gain 
X 

Hardware 
Filters 

AC or DC 
.05 or .5 

HP 
1K or 5K 

LP 

IIR 
Filters 
Type, 

Freq., Q 

Scaling 
(Mapping) 

Units 
label 

Recommended 
Calibration & 
Sample Rate 
(Samples/sec) 

Stimulator - BSLSTM (0 – 10 Volts ) 
Stimulator 
Stimulator Reference cable from 

MA or BSLST

Output” MA

BSLST MB(MP35 only) 
Use for recording the “Reference 

 Pulse of the BIOPAC BSLST  
Stimulator. This preset is used when the 

ange switch on the front of the 
M is in the “0-10V” position. The 

amplitude of the pulse reflects the 
Stimulator output voltage.  
Note that there will be some overshoot 
on the leading edge of the pulse. If this 
is not desirable, then change the Analog 
Filter to 1KHz. 

 
 
200 

  

 0 
> 10 

 
 

Volts 

Calibration: 
optional to 
obtain greater 
accuracy. 
Min. Sample 
Rate: 200 S/S 

R
BSLST

   
DC None 0 mV >

 mV 5K LP 50

 

Stimulator - BSLSTM (0 – 100 Volts ) 
Stimulator 
Use for recording the “Reference 
Output” Pulse of the BIOPAC BSLSTM 
Stimulator. This preset is used when the 
Range switch on the front of the 
BSLSTM is in the “0-100V” position. The 
amplitude of the pulse reflects the 
Stimulator output voltage. 
Note that there will be some overshoot 
on the leading edge of the pulse. If this 
is not desirable, then change the Analog 
Filter to 1KHz. 

200 C 
 LP

0 mV > 0 
 mV > 100 

Volts 
 

Calibration: 
optional to 
obtain greater 
accuracy. 
Min. Sample 
Rate: 200 S/S 

D None 
5K  50

Stroboscope Flash (TSD122) 
Strobosc

200 DC None -50 mV > -10 Volts  
ope Flash 5K LP 50 mV > 10 

SuperLa
SuperLa
SuperLa
Note: Superlab interface y for 
MP35 (consists of 1-SS59L; see BNC 
SS9L preset) 

b Sync. (SS44L) 
b Interface Cable for MP30 
b Sync. 

 
200 

 
DC 

1K LP  

 
None 

 
0 mV > 0 

25 mV > 5 

 
Volts 

 

 assembl

Switch 
Pushbutton Switch 
Use when recording Pushbutton Swit
State using BIOPAC SS10 hBu
HandSwitch. This is useful
testing, etc. 

0 
 

LP, 30, 
.707 

BSLF 

 > -1 
 > 1 

 
Volts 

 

Min. Sample 
Rate: 200 S/S 

ch 
1,00 DC 

1K LP 
L Pus tton 
 for Response 

   
-1 mV
1 mV

Temperature (deg. C) 
Temperature 
Skin Temperature (fast ) 
Response time = .6 sec
Use when recording Ski ratu
in degrees Celsius using PAC
SS6L Temperature Tra  
Calibration required**  
 
 
 
 

00 

 
 

BP 2.22 
1  > 35 

 
 

deg C 
 

Min. Sample 
Rate: 100 S/S 

response
onds 
n Tempe
 the BIO

re 
 

nsducer. 

  
 
2,0

 
DC 

1K LP 

 
 

0 uV > 3
000 uV
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Analog Preset Name 
Channel Label 
Applicable Calc. Presets 

Gain 
X 

Hardware 
Filters 

AC or DC 
.05 or .5 

HP 
1K or 5K 

LP 

IIR 
Filters 
Type, 

Freq., Q 

Scaling 
(Mapping) 

Units 
label 

Recommended 
Calibration & 
Sample Rate 
(Samples/sec) 

Temperature (deg. F) 
Temperature 
Use when recording Skin Temperature 
in degrees Fahrenheit using the 
BIOPAC SS6L Temperature 
Transducer.  

2,000 DC 
1K LP 

BP 0 uV > 90 
1000 uV > 95 

deg F 
 

Min. Sam
Rate: 1

Calibration required** 

ple 
00 S/S 

Temperature (waterproof, vinyl)    
- 

 
- 

 
- 

 
Response time = 1.1 seconds 
     Use any preset from SS6L 

- - 

Tem
Temperature
Use when recordi
changes in deg
BIOPAC SS6
Transducer. Beca
temperature diffe rtant, 
calibration to obta
temperature is not req d

 BP 0 uV > 0 delta Min. Sample 
: 100 S/S 

perature Change (deg. C) 2,000 AC
 Change 

ng Skin Temperature 
es Celsius using the 

.05 HP, 1K 
LP 

1000 uV > 
2.78 

deg C Rate

re
L Temperature 

use only the skin 
rence is impo
in absolute 

uire . 
Temperature Change (de
Tem
Use en reco
changes in d
the BIOPAC SS6
Transducer. Beca
temperature diffe
calibration to ob
tem

1000 uV > 5 
 

deg F 
Min. Sample 
Rate: 100 S/S 

g. F) 2,000 AC BP 0 uV > 0 delta
perature Change 
wh

.05 HP, 1K 
LP rding Skin Temperature 

egrees Fahrenheit using 
L Temperature 
use only the skin 

rence is important, 
in absolute ta

perature is not required. 
Tobacco Ho
Tobacco Hornwo .707 

LP, 250, 

rnworm (BSLCBL8) 
rm 

10,000 AC 
.5 HP, 5 

HP, 

HP,  10, -10 uV > -10 
10 uV > 10 

micro V  

 
1K LP 

LP, 250, 
.707 

BSLF 

 

HP,  30, 
.707 

.707 
BSLF 

Torsiometer 
Torsiometer (110 mm 
Neck, +- 90º  
Use with the BIOPAC SS2
SS23L Torsiometers. 

Calibration 
quired**  

mple 
00 S/S 

max.), 1 CHl 

2L and 

 
2,000 

 
DC 

1K LP 

 
BP 

-2250 uV > -
90 

2250 uV > 90 

 
degrees 

 

re
Min. Sa
Rate: 1
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Name; Label; Source CH 
Calculation Function 

Enabled Options; 
Parameters 

Units label Scaling 
(Units) 

New • New calculation channel details 
start on page 73. 

• To create a new calculation 
channel preset, see page 76. 

 

  
dp/d
dp/dt @ 200 s/s 

Com ssure with respect to time 
(derivative of pressure), so it works in conjunction with a 
pressure source channel. Normally this is used when the 
pressure source channel is measuring direct blood 
pressure from animals. 

Difference 
ween 

0  > 0 
1 > 200 

mmHg/sec t @ 200 samples/sec. 
Intervals bet
samples: 1 Source: Blood Pressure (Arterial) only when sample rate 

is 200 s/s 
putes the change in pre

d
d

p/dt @ 500 samples/sec. 
p/dt @ 500 s/s 
ource: Blood Pressure (Arterial) only when sample rate 

is 500 s/s 

Difference 
Intervals between 
samples: 1 

0  > 0 
1 > 500 

mmHg/sec 

S

dp/dt @ 1000 samples/sec. 
dp/dt @ 1000 s/s  
Source: Blood Pressure (Arterial) only when sample rate 
is 1000 s/s 

Difference 
Intervals between 
samples: 1 

0  > 0 
1 > 1000 

mmHg/sec 

ECG – R-R Interval 
Computes the R wave to next R wave time interval for 
an ECG source channel. This preset is optimized for 
Human ECG (40 – 180 BPM range). 

   

ECG - R-wave Amplitude 
R Amplitude 
Source: Any Human ECG preset listed for SS2L. 
Tracks the R wave amplitude for an ECG source 
channel. This preset is optimized for Human ECG (40 – 
180 BPM range). 

Rate 
Function: Peak Maximum  
Peak detect: Positive 
Auto threshold detect 
Noise rejection: 5% of 
peak  
Window: 
Windowing Units: BPM 
Min: 40 Max: 180 

N/A mV* 

EEG alpha (8 - 13 Hz) 
Alpha 
Source: Any Human EEG preset listed for SS2L. 
Filters out all frequencies except the specific alpha band 
(8 to 13 Hz), which can indicate relaxed and alert states. 

Filter  
Output: Band Pass (l + h) 
LowFreq: 8, HighFreq: 13 
Q: 0.707 

N/A Units of 
source 

channel** 

EEG beta (13 - 30 Hz) 
Beta 
Source: Any Human EEG preset listed for SS2L. 
Filters out all frequencies except the specific beta band 
(which is from 13 to 30 Hz). Frequencies in the beta 
band can indicate levels of alertness and higher 
amplitudes can occur during deep sleep (REM).  

Filter  
Output: Band Pass (l + h) 
LowFreq: 13, HighFreq: 
30 
Q: 0.707 

N/A Units of 
source 

channel** 
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Calculation Preset 
Name; Label; Source CH 

Calculation Function 
Enabled Options; 

Parameters 

Units label Scaling 
(Units) 

EEG delta (0.5 - 4 Hz) 
a 
rce: Any Human EEG preset listed for SS2L. 

Filter  
Output: Band Pass (low + 

N/A Units of 
source Delt

Sou
ilters out all frequencies except the specified delta band  

high) 
LowFreq: 0.5, HighFreq: 4 

channel** 
F
(from 0.5 to 4 Hz). Frequencies in the delta band are
often of higher amplitude when a subject is sleeping. 

Q: 0.707 

EEG theta (4 - 8 Hz) 
ta 

Filter  
Output: Band Pass (low + 

N/A Uni
The

ource: Any Human EEG preset listed for SS2L. high) 

ts of 
source 

channel** S
Filters out all frequencies except the specific theta band 
(which is from 4 to 8 Hz). Frequencies in the theta band 

LowFreq: 4, HighFreq: 8 
Q: 0.707 

are often of higher amplitude when a subject is sleeping. 
EEG
Gam
Sou
(Ele
pres

  gamma (30 - 90 Hz) 
ma 

rce: Requires the higher bandwidth 
ctroencephalogram (EEG), .5 - 100 Hz w/notch) 
et. 

Filter  
Output: Band Pass (low + 
high) 
LowFreq: 30, HighFreq: 
90 
Q: 0.707 

N/A Units of
source 

channel** 

EGG

GG
Sou

N/A Units of 
rce 
nel** 

 (.02 - 125 Hz) Filter 
EGG (.02 - .125 Hz) 
E  

rce: Any Human EGG preset listed for SS2L. 

Band Pass (low+high)
LowFreq: 0.02 
HighFreq: 0.125  Q: 0.707 

sou
chan

EMG - Integrated
Integrated (est.)
Source: Any Human EMG preset listed for SS2L. 
Used as an indication of the EMG output level. Each 
data point of Integrated EMG is calculated using 20 
samples of data from the EMG source channel. Each 
data point used is first Rectified (all negative values are 
inverted), then the Mean value is computed. 

ote: The algorithm performs an average rectified value 

Average over samples 
Samples:  20 
Parameters: Rectify 

10000 > 10 
mV  (estimate) Integrate Parameters            -10000 > -10 

N
(AVR) to approximate an integration. 

EMG - RMS Integrate Parameters 
EMG – RMS 

rce: Any Human EMG preset listed for SS2L. 
d to measure the Standard Deviation of an EMG 
al, which is an excellent way to compare EMG 
ut levels. Any baseline information is removed from 
ata. Each sample point of RMS data is calculated 

g 20 samples of data from the EMG source channel. 

Average over samples 
Samples:  20 
Parameters: Root mean 
square, Remove baseline 

-10000 > -10 
10000 > 10 

Sou
Use
sign
outp
the d
usin
The baseline value is first determined, then each 
computed difference between data point and baseline is 
squared and summed. The square root of this sum is 
then determined. 

mV 

Heart Rate (from ECG) 
Heart Rate 
Source: Any Human ECG preset listed for SS2L. 
Computes the Heart Rate in beats per minute (BPM) for 
an ECG source channel. It computes BPM based on the 
R wave to next R wave interval. This preset is optimized 
for Human ECG (40 – 180 BPM range). 
Note: When recording starts, the data displayed will not 
be accurate until the second R wave is obtained. 

Rate 
Function: Rate (BPM)   
Peak detect: Positive 
Remove baseline 
Auto threshold detect 
Noise rejection: 5% of 
peak  
Window: 
Windowing Units: BPM 
Min: 40 Max: 180 
 
 

N/A BPM* 
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Calculation Preset 
Name; Label; Source CH 

Calculation Function 
Enabled Options; 

Parameters 

Units label Scaling 
(Units) 

L e Animal dp/dt Minimum 
.  
hannel: “dp/dt @ # samples/sec.” calculation 

he minimum value for the dp/dt source channel, 

Rate 
Function: Peak Minimum  
Peak detect: Negative 
Auto threshold detect 
Noise rejection: 5% of 

N/A mmHg/secarg
dp/dt Min
Source C
channel. 
Tracks t

vin

 

* 

gi g one the minimum change in pressure with respect 
to time (derivative of pressure).  

peak  
Window: 
Windowing Units: BPM 
Min: 40 Max: 250 

L e Animal dp/dt Maximum 
x. 
hannel: “dp/dt @ # samples/sec.” calculation 

he maximum value for the dp/dt so

Rate 
Function: Peak Maximum  
Peak detect: Positive 
Auto threshold detect 

N/A mmHgarg
dp/dt Ma
Source C
channel. 
Tracks t urce channel, 

ving one the maximum change in pressure with 
Noise rejection: 5% of 
peak  

Min: 40 Max: 250 

/sec* 

gi
respect to time (derivative of pressure).  
 

Window: 
Windowing Units: BPM 

Large Animal Systolic Blood Pressure (BP) 

rac
ressure), of a direct blood pressure source channel. 

Rate 

d detect 
Noise rejection: 5% of 

N/A mmHg* 
Systolic BP 
Source: Blood Pressure (Arterial) 

ks the Systolic Blood Pressure (or maximum 

Function: Peak Maximum  
Peak detect: Positive 
Auto thresholT

p
This preset is optimized for animals with a heart rate in 
the 40 – 250 beats per minute range. 

peak  
Window: 
Windowing Units: BPM 
Min: 40 Max: 250 

Larg d Pressure (BP) 
iastolic BP 

pressure), of a direct blood pressure source channel. 
This preset is optimized for animals with a heart rate in 

e 40 – 250 beats per minute range. 

Rate 
Function: Peak Minimum  

Noise rejection: 5% of 
peak  
Window: 

N/A mmHg* e Animal Diastolic Bloo
D
Source: Blood Pressure (Arterial) 
Tracks the Diastolic Blood Pressure (or minimum 

Peak detect: Negative 
Auto threshold detect 

th
Windowing Units: BPM 
Min: 40 Max: 250 

L e Animal Mean Blood Pressure (BP) 
n BP 

od Pressure (Arterial) 

Rate 
Function: Mean Value  
Peak detect: Positive 

N/A mmHg* arg
Mea
Source: Blo
Tracks the Mean Blood Pressure pressure of a direct 
blood pressure source channel. This preset is optimized 
for animals with a heart rate in the 40 – 250 beats per 
minute range. 

Auto threshold detect 
Noise rejection: 5% of 
peak  
Window: 
Windowing Units: BPM 
Min: 40 Max: 250 

Large Animal Heart Rate (from ECG) 
Heart Rate 
Source: Any of the human ECG Presets can be used. 
Computes the Heart Rate in beats per minute (BPM) for 
an ECG source channel. It computes BPM based on the 
R wave to next R wave interval. This preset is optimized 
for large animals with a heart rate in the 40 – 250 beats 
per minute range. 
Note: When the recording starts, the data displayed will 

not be accurate until the second R wave is 
obtained. 

Rate 
Function: Rate (BPM)  
Peak detect: Positive 
Remove baseline 
Auto threshold detect 
Noise rejection: 5% of 
peak  
Window: 
Windowing Units: BPM 
Min: 40 Max: 250 

N/A BPM* 
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Calculation Preset 
Name; Label; Source CH 

Calculation Function 
Enabled Options; 

Parameters 

Units label Scaling 
(Units) 

Lung Volume 
Volume 
Source: Airflow (SS11LA) 

Integrate Parameters 
Reset via channel 

-10000 > -10 
10000 > 10 

Liters 

Computes Volume from an Airflow source channel by 
using a special form of integration. This calculation is 
fairly sensitive, and the procedure given in the Manual 
should be closely followed. Note: Airflow signal must be 
bidirectional (Inhales and Exhales) in order for this 
preset channel to work properly. 

Reset thresholds 
LOW 0.00000 
HIGH 0.00000 
Reset trigger: Positive 

Control Channel: 

Pulse Rate (from PPG) 
Pulse Rate 
Source: Human Pulse (PPG) 
C lse Rate in 
a PPG (Pulse) source chann
on the p xt peak inter
optimized for Human pulse ra
B
N splayed will 
s corded. 

Rate 
Function: Rate (BPM)  
Peak detect: Positive 

N/A BPM* 

omputes the Pu

eak to ne

beats per minute (BPM) for 
el. It computes BPM based 
val. This preset is 
tes that fall in the 40 – 180 

Auto threshold detect 
Noise rejection: 5% of 
peak  
Window: 

PM range. 
ote: The data di
econd peak is re

not be accurate until the 
Windowing Units: BPM 
Min: 40 Max: 180 

Respiration Rate 
Source: Respiration 
 ransdu
 Airflo 1LA) 
 Airflow (SS52L) Pne
 Pressure (+- 25 cm 
 Or, if the sensor is p

sure air temper
rature (deg

C piration Ra
(BPM) for a Respiration sourc
BPM based on the peak to ne
preset is optimized for Human respiration rates that fall 
in the 6 – 20 BPM range. 
Note:  The data displayed will not be accurate until the 

second peak is recorded. 

Function: Rate (BPM)  
Respiration T

w (SS1
cer (SS5LB) 

umogram 
H2O) 
laced at the nostril to 

Peak detect: Positive 
Auto threshold detect 
Noise rejection: 5% of 
peak  
Window: 

mea
or Tempe

omputes the Res

ature: Temperature (deg. C) 
. F) 
te in breaths per minute 
e channel. It computes 
xt peak interval. This 

Windowing Units: BPM 
Min: 6 Max: 20 

Rate N/A BPM* 

Small Animal dp/dt Minimum 
dp/dt Min. 
Source Channel: “dp/dt @ # samples/sec.” calculation 
channel 
Tracks the minimum value for the dp/dt source channel, 
giving one the minimum change in pressure with respect 
to time (derivative of pressure).  
 

Rate 
Function: Peak Minimum  
Peak detect: Negative 
Auto threshold detect 
Noise rejection: 5% of 
peak  
Window: 
Windowing Units: BPM 
Min: 40 Max: 600 

N/A mmHg/sec* 

Small Animal dp/dt Maximum 
dp/dt Max. 
Source Channel: “dp/dt @ # samples/sec.” calculation 
channel 
Tracks the maximum value for the dp/dt source channel, 
giving one the maximum change in pressure with 
respect to time (derivative of pressure).  
 

Rate 
Function: Peak Maximum  
Peak detect: Positive 
Auto threshold detect 
Noise rejection: 5% of 
peak  
Window: 
Windowing Units: BPM 
Min: 40 Max: 600 
 
 
 

N/A mmHg/sec* 
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Calculation Preset 
Name; Label; Source CH 

Calculation Function 
Enabled Options; 

Parameters 

Units label Scaling 
(Units) 

Small Animal Systolic Blood Pressure (BP) 

pres ct blood pressure source channel. 

Rate 
um  

Noise rejection: 5% of 

N/A mmHg* 
Systolic BP Function: Peak Maxim
Source: Blood Pressure (Arterial) 
Tracks the Systolic Blood Pressure (or maximum 

sure), of a dire

Peak detect: Positive 
Auto threshold detect 

This preset is optimized for animals with a heart rate in 
the 100 – 600 beat per minute range. 

peak  
Window: 
Windowing Units: BPM 
Min: 40 Max: 600 

Small A
Diastolic

ource: B
racks 

pres
This pres
the 100 –

Function: Peak Minimum  
Peak detect: Negative 

old detect 
 rejection: 5% of 

nimal Diastolic Blood Pressure (BP) 
 BP 

lood Pressure (Arterial) 

Rate N/A mmHg* 

S
T the Diastolic Blood Pressure (or minimum 

sure), of a direct blood pressure source channel. 
Auto thresh
Noise

et is optimized for animals with a heart rate in 
600 beat per minute range. 

peak  
Window: 
Windowing Units: BPM 
Min: 40 Max: 600 

Small An
Mean BP
Source: 
Tracks th
blood pre
for anima
minute ra Window: 

Windowing Units: BPM 
Min: 40 Max: 600 

imal Mean Blood Pressure (BP) 
 

Blood Pressure (Arterial) 

Rate 
Function: Mean Value  
Peak detect: Positive 

N/A mmHg* 

e Mean Blood Pressure pressure of a direct 
ssure source channel. This preset is optimized 
ls with a heart rate in the 100 – 600 beat per 
nge. 

Auto threshold detect 
Noise rejection: 5% of 
peak  

Small An
Heart Ra
Source: 
ECG (10
Compute
an ECG 
R wave t
for small
er minute range. Windowing Units: BPM 

imal Heart Rate (from ECG) 
te 

Any of the human ECG Presets can be used. 
0 – 600 BPM range) 
s the Heart Rate in beats per minute (BPM) for 

Rate 
Function: Rate (BPM)  
Peak detect: Positive 
Remove baseline 
Auto threshold detect 

N/A BPM* 

source channel. It computes BPM based on the 
o next R wave interval. This preset is optimized 
 animals with a heart rate in the 100 – 600 beat 

Noise rejection: 5% of 
peak  
Window: 

p
Note: When recording starts, the data displayed will not 

be accurate until the second R wave is obtained. 
Min: 40 Max: 600 

Scaling (Units) Notes 
   * The u ll n ri e Change Scaling Param log.  They will 

be in c art of st acquis ent. 
   ** The units will be the same s the source channel u be reflected in the Change 

Scaling Parameters dialog. 

nits shown wi
serted automati

ot necessa
ally at the st

ly be seen in th
 the fir

eters dia
ition segm

 a nits, but may not 
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Appendix D — MP35/30 Specifications 
MP35/30 ACQUI ON UNIT 
The MP35/30 data isitio heart of t pac Stu PRO Syste  MP35/30 has 
an internal microprocessor to control data acquisition and communi
MP35/30 unit takes incoming signal converts  into d nals that can cessed with 
your computer. T e four analo t channels, one of w  be used as a  input. You 
will need to connect the MP35/30 to computer and connec des, transduc d I/O devices 
to the MP35/30. You are encouraged to minutes to fam ourself with the MP35/30 prior 
to making any connections. 
The MP35 Data Acquisition System hysiological data recorder designed for medical educational 
purposes. This sy  used in med d on and research facilities. This syste not used for the 
mitigation, cure or diagnosis of disease. e. Subject to IEC60601-1, the 
MP35 Data Acquisition System is CLASS II, type uipme
 
SYMBOLS — M

S Descrip lana

SITI
 acqu n unit is the he Bio dent Lab 

cation with the co
m. The
mputer. The 

s and  them igital sig be pro
here ar g inpu hich can trigger

your 
take a few 

t electro
iliarize y

ers, an

 is a p
stem is ical e ucati m is 

This device is NOT used in the hom
 BF eq nt. 

P35 
ymbol tion Exp tion 

 
Type BF Equipment Classification 

 
Attention Consult accompanying documents 

 
On (partial) power adapter is powered by the mains 

Turns MP35 on assuming AC300A 

 
adapter remains powered by the mains O Turns MP35 off if but AC300A power ff (partial) 

 Direct current Direct current input 

 USB USB port 

 

Functional Earth 
Ground Functional Earth Ground Connection 

 
established by IEC60601-1 Class II Class II Medical Equipment, as  Equipment 

Fuse useEquipment F  

 
COMPLIANC

ted with IEC60601-1. The MP35 is 
designated as Class I Type BF medical equipment 

  EMC 
The MP35 satisfies the Medical Electromagnetic Compatibility (EMC) Test Standards affiliated with 
IEC60601-1-2. 

TYPES OF INPUT DEVICES 

E 
  SAFETY 

The MP35 satisfies the Medical Safety Test Standards affilia
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trodes are relatively simple instruments that attach to the surface of the skin and pick up 

• Transducers, on the other hand, convert a physical signal into a proportional electrical signal. 
• Input/Output devices (I/O for short) are specialized devices like pushbutton switches and 

headphones. 
 
SIMPLE SENSOR CONNECTORS 
Regardless of the type of device connected, every sensor or I/O device connects to the MP35/30 using a 
“Simple Sensor” connector. Simple Sensor connectors are designed to plugs only one way into the 
MP35/30, so you don’t have to worry about plugging things in upside down or into the wrong socket. 

• Electrodes, transducers, and the pushbutton switch all connect to the channel input ports on the 
front panel of the MP35/30. 

• Headphones and the stimulator connect to the “Analog out” port on the back panel of the MP35/30. 
• MP35 only: A digital device may connect to the “I/O Port” on the back panel  
• MP35 only: A trigger device may be connected to the “Trigger” port on the back panel. 

There are three types of devices that connect to the MP35/30: electrodes, transducers, and I/O devices. 
• Elec

electrical signals in the body. 

 
FRONT PANEL 

 
Front Panel, MP35 

The front panel of the MP35/30 has an electrode check port, four analog input ports, and two status 
indicators. 

Electrode Check 

•  The Electrode Check port is a diagnostic tool used with the BSL PRO software to determine 
if the electrodes are properly attached to the subject. See page 143. 

Input ports: CH 1, CH 2, CH 3, and CH 4  

• The inputs on the MP35/30 acquisition unit are referred to as Channels. There are four 9-pin 
female analog input ports on the front of the MP35/30. The Biopac Student Lab Lessons software 
will always check to see that you have the proper sensors connected to the appropriate channel. 

Status indicators 
• The Busy status indicator is activated when the MP35/30 is acquiring data and also during the 

first few seconds after the MP35/30 is powered on to indicate that a self-test is in progress. (When 
the MP35/30 passes the power-on test, the Busy light will turn off.) 

• The Power status indicator is illuminated when the MP35/30 is turned on. 
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BACK PANEL 

 
Back Panel, MP35 

The back panel of the MP35 has an analog output port, a USB port, an I/O Port, a Trigger Port, a DC 

nalog Out port 

USB port (MP35 only) 

input, a fuse holder, and a power switch, and the unit’s serial number. 
The back panel of the MP30 has an analog output port, a serial port, a DC input, a fuse holder, and a 
power switch, and the unit’s serial number. 

A
There is one 9-pin male “D” analog output port on the back of the MP35/30 that allows signals to be 
amplified and sent out to devices such as headphones. 

The MP35 connects to the computer via a USB Port, located just below the word USB. 

 

Serial port (MP
The MP30 conn p ed ju e w  

• Uses a standard MINI DIN 8 connector. 
• Should o o ith ISA or PCMC  

 

Headphone Ou 5 only

� Accepts /4 m) stereo headphone jack. 

 

O Port (MP35 only) 

• Input/Output port used to connect digital devices to the MP35. 

 

Trigger Input (MP35 only) 

 Input port used to send trigger signals from another device to the MP35. 

• Uses a standard USB connector. 
• Should only nnect the MP30 to a PC orbe used to co  Macintosh. 

30 only) 
ects to the computer via a serial ort, locat st below th ord Serial.

nly be used to c nnect the MP30 to a PC (w IA card) or Macintosh.

tput (MP3 ) 

 a standard (1 ” or 6.3m

I/
• Accepts a DB 25 Female connector. 

• Accepts a male BNC connector. 
•
• Used to synchronize MP35 units when more than one MP35 is used. 
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DC Input 

Use the DC Input to connect an AC300A power adapter or BAT100 battery to the MP35. Use 
DC Input to connect an AC100A power adapter or BAT100 battery to the MP30. the 
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•  The power supply requirements for the MP35/30 are 12 VDC @ 1 Amp. Only use t
AC300A power adapter with the MP35. The AC300A is a 12 VDC @ 1.25 Amp po
supply adapter that can connect to any mains rated as 1

he 
wer 

0Hz, 40VA. 
onnector and a 

“-” (negative) input on the connector housing. 

00-250 VAC @ 50/6
• The receptacle is configured to accept a “+” (positive) input in the center of the c

•  The functional earth ground on the AC300A Power Adapter is tied to Mains earth ground
and accessible metal parts on the MP35 unit. 

• 

 

  The AC300A power adapter is Class II and when it is used to power the MP35, the 
MP35/AC300A combination is Class II. The MP35 unit also incorporates an additional 
level of isolation between the AC300A power adapter and the Subject. 

 

Fuse holder 

 The fuse holder contains a fast-blow fuse that helps protect the MP35/30 from shorts on its 
power, analog, and digital I/O lines. The MP35 uses a 1.0 A, 250 V, 3AG, fast-blow fuse and the MP30 
uses a 2.0 A, 250 V, 3AG, fast-blow fuse. 

• To remove the fuse, use a screwdriver to remove the fuse cover located below the word Fuse. 

 

Power switch 

• ON position — powers up the MP35/30 

• OFF position — cuts the flow of power to the MP35/30 
 
MAINS POWER DISCONNECTION 
To completely disconnect the MP35 unit and the AC300A power adapter from all poles of the supply 
mains, extract the power cord plug from the mains outlet. Extract the plug by grasping the plastic shell of 
the plug and pull firmly away from the mains outlet in a direction perpendicular to the face of the mains 
outlet. Take care not to touch the metal blades associated with the plug. This procedure will fully power 
down (de-energize) the MP35 unit and AC300A power adapter. Please note that the power switch on the 
back of the MP35 unit turns power ON and OFF to the MP35 unit only. 
 
CLEANING PROCEDURES 
Be sure to unplug the power supply from the MP35/30 before cleaning. To clean the MP35/30, use a 
damp, soft cloth. Abrasive cleaners are not recommended as they might damage the housing. Do not 
immerse the MP35/30 or any of its components in water (or any other fluid) or expose to extreme 
temperatures as this can damage the unit. 
Sterilization and Disinfection 
Disposable, sterile, single-use-only, accessories are used with the MP35 for educational (teaching) 
applications. Non-disposable accessories can be disinfected, if required, with Cidex® or equivalent.
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Specifications 

SAFETY NOTE 

BIOPAC Systems, Inc. instrumentation is designed for educational and research oriented 
life science investigations. BIOPAC Systems, Inc. does not condone the use of its 
instruments for clinical medical applications. 

Instruments, components, and accessories provided by BIOPAC Systems, Inc. are not 
intended for the cure, mitigation, treatment, or prevention of disease. 

The MP35/30 is an electrically isolated data acquisition unit, designed for biophysical 
measurements. 

Exercise extreme caution when applying electrodes and taking bioelectric measurements 
while using the Biopac Student Lab with other external equipment that also uses 
electrodes or transducers that may make electrical contact with the Subject. 

Always assume that currents can flow between any electrodes or electrical contact points. 
In case of equipment failure, it is very important that significant currents are not allowed 
to pass through the heart. 

If electrocautery or defibrillation equipment is used, it is recommended that the BIOPAC 
instrumentation be disconnected from the Subject. 

 

Specification MP35 Unit MP30 Unit 
Front Panel   
EL

V

0-100 KΩ ECTRODE CHECKER 0-100 KΩ 
Resistance Range (Vin+ and 

in- to GND) 
 

AN
2 unisolated (auxillary) 

–CH 4) 
 

ALOG INPUTS  4 isolated (front panel CH 1–CH 4), 4 (front panel CH 1
Number of channels 
SAMPLE RATE 
Maximum 
Minimum 
Trigger Input 
Threshold 

100K samples/second 
1 samples/second 
Analog or digital channel 
Adjustable threshold; Positive or 
Negative Trigger 

  
2K s/s (8K aggregate on four ch.) 
1 samples/second 
CH 4 input only 
Adjustable threshold; Positive or 
Negative Threshold 

A/D resolution (before digital 
filtering) 

24 bits  10 bits 

Signal to noise ratio > 90 dB (nominal) > 90 dB 
Voltage resolution Gain 
dependent 

1.192 microvolts /bit (Gain 10) to 
0.024 nanovolts /bit (Gain 50,000) 

0.400 microvolts/bit (Gain 100) to 
0.200 millivolts/bit (Gain 25,000) 

Input voltage range (Gain 
dependent) 

400 microvolts to 2.0 Volts p-p 4.0 millivolts to 0.2 Volts p-p 

Input accuracy ±0.01% of Full Scale Range (FSR) ±0.05% FSR 
Input protection; current limited ± 1 mA/V ± 1 mA/V 

Maximum Input Voltage 
(between Vin+ and Vin-) 

2V p-p  130mV p-p 

Differential Input Impedance 
(between Vin

2 MΩ  2 MΩ 
+ and Vin-) 

Filters (automatic or user 
stable) 

3 two-pole IIR digital filters per 
channel  adju

3 two-pole IIR digital filters per 
channel 
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Specification MP35 Unit MP30 Unit 
Com  Input   

 
 
11 MΩ 
1,000 MΩ 

mon Mode
Impedance (between Vin+/Vin- 
and GND) 

 

  DC 
  AC (50/60 Hz) 

 
11 MΩ 
1,000 MΩ  

Gain ranges (automatic preset 
or user adjustable) 

10 – 50,000  100 – 50,000 

Baseline adjustment 
(automatic or user adjustable) 

Gains 10, 20, and 50: ±100mV 
Gains 100 to 50,000: ±10mV 

±10mV all Gains 

Electrode offset potential Gains 10, 20, and 50: 
tolerance 

±2V 
Gains 100, 200, 500: ±200mV 

±70 mV all Gains 

Gains 1,000 to 50,000: ±80mV 
Back Panel   
ANALOG OUTPUT 
  Number of channels 

 
1 

 
1 

  D/A resolution 
curacy 
tput impedance 
tput voltage 

12 bits 
±0.0125% of FSR 
50Ω 
0 - 4.096 V 

8 bits 
±0.2% of FSR 
50Ω 
0 - 5.000 V 

  Ac
  Ou
  Ou

±100 mA maximum   Output drive current ±10 mA maximum 
SERIAL INTERFACE 

nsmission type 
nsmission rate 

 
USB 
Type 2.0 full speed 

 
RS422-clocked asynchronous   Tra

  Tra 524,000 bits per second (KBPS) 
HEADPHONE (MP35 only) Drives low-impedance standard 

stereo headphones 
N/A – MP35 only 

I/O A – MP35 only PORT (MP35 only) 8 TTL compatible inputs and 8 TTL N/
compatible outputs 

TRI mpatible input and 
synchronization port 

N/A – MP35 only GGER (MP35 only) TTL co

DC INPUT Power input; requires 12 VDC @ 1 Power input; requires 12 VDC @ 
 

 
s 

50/60Hz, 40VA. 

Amp. Use the AC300A 12 VDC @ 
1.25 Amp power supply adapter to 
connect to any mains rated as 100-
250 VAC @ 50/60Hz, 40VA. 

1 Amp. Use the AC300A 12 VDC
@ 1.25 Amp power supply
adapter to connect to any main
rated as 100-250 VAC @ 

FUSE 1.0 amp fast-blow fuse 2.0 amp fast-blow fuse 
MP UNIT 
  Dimensions 
  Weight 

 
7 cm x 29 cm x 25 cm 
1.4 Kg 

 
7 cm x 29 cm x 25 cm 
1.4 Kg 
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MP UNIT PIN-OUTS 
 
Electrode Che

LE DSUB 
ck — Front Panel Pin MP35 and MP30 

9-PIN FEMA

 
 
MP Input — Front Panel 
CH 1, CH 2, CH 3, CH 4 

2 Vin+ Electrode connection 
3 GND 
4 Vin- Electrode connection 

9 PIN FEMALE DSUB (1 of 4) 

Pin MP35 MP30 

 
 

3 GND GND 
4 Vin− Vin− 
5 Shield drive Shield drive 
6 +5 V (100 mA max aggregate) +5 V (50 mA max) 
7 ID resistor lead 1; I2C SCL ID resistor lead 1 (+5 V) 
8 ID resistor lead 2; I2C SDA ID resistor lead 2 

1 Shield drive Shield drive 
2 Vin+ Vin+  

9 −5 V (100 mA max aggregate) −5 V (50 mA max) 
 

MP Analog Output — Back Panel 
9 PIN MALE DSUB 

Pin MP35 MP30 
1 Buffered AC output Buffered 

 
 

 V out range MP35: (0 to 4.096 V) MP30: (0 to 5 V) 
3 GND GND 
4 +5.0 V (100 mA max) +7.5 V (100 mA max

AC output 

t 
 Z out = 50 Ω Z out = 50 Ω 

) 
5 Buffered digital output Unbuffered DC output 
 Z out = 1 kΩ Z out = 1 kΩ 

e (0 to 5 V) 
2 V (100 mA max) Not used  

7 I2C SCL Not used  
8 I2C SDA Not used  
9 Not used  Not used 

 Z out = 2,200 µF Cap Z out = 2,200 µF Cap 
 V out range MP35: (+/- 2.0 V) MP30: (+/- 2.5 V) 
2 Buffered DC output Buffered DC outpu

 V out range (0 to 5 V) V out rang
6 +1

 

MP Serial Connector — Back Panel 

  
 MP35 MP30 

1 +5 Digital Output 1 
2 -Data Digital Output 2 
3 Data + Digital Output 3 
4 GND Digital Output 4 
5 n/a GND Unisolated 
6 n/a GND Unisolated 
7 n/a RS-232-RX 
8 n/a  +5 V Unisolated 

 

Pin MP35 MP30 
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MP UNIT PIN OUTS continued 
O Port — MP35 Back Panel  

DSUB 25 (male) 

Pin MP35 Only 
1 Digital Output 1 
2 Digital Output 2 
3 Digi
4 Digi
5 GND 
6 G
7 RS-232-RX 
8 +5
9 I2C-
10 Digi
11 Digital 
12 Digital Input 3 
13 Digital Input 4 
14 D
15 D
16 D
17 D
18 A
19 A
20 RS-232-TX 
21 I2C-SCL 
22 Digi
23 D
24 D
25 Digital 

I/

tal Output 3 
1   

17  18  19

  2     3     4     5 

23  24  25

10  11  12  136     7     8     9 

14  15  16 20  21  22  
7.0-3.7.1 does not support 

tal Output 4 
Unisolated 

ND Unisolated 
Note: BSL 3.

 V Unisolated Pins 7, 9, 18, 19, 20 and 21. 
 SDA 

 tal Input 1 
Input 2 

igital Output 5 
igital Output 6 
igital Output 7 
igital Output 8 
nalog Input — Right 
nalog Input — Left 

tal Input 5 
igital Input 6 
igital Input 7 

t 8 Inpu

MP35 Input>Output Scaling 
35 input (which varies with G ed to the full range of the 

output (4.097) with an Input to Output Offset shift 0, a 
be displayed as a 20.48 p offset of 2.05 V. 

ut Range (mV) Output Scale Factor 

 Max: +1 Volt 2.05 

The full range of the MP ain) is mapp
of 2.05 V. As an example, at a Gain of 10

1mV pk-pk signal would k-pk signal with an 
Gain Inp

x10 Min: -1 Volt

x20 Min: -500 Max: +500 4.097 

x50 Min: -200 Max: +200 10.24 

x100 Min: -100 Max: +100 20.48  

x200 Min: -50 Max: +50 40.97 

x500 Min: -20 Max: +20 2 102.4

x1,000 Min: -10 Max: +10 204.85 

x2,000 Min: -5 Max: +5 409.7 

x5,000 Min: -2 Max: +2 1024.25 

x10,000 Min: -1 Max: +1 5 2048.

x20,000 Min: -0.5 Max: +0.5 4097 

x50,000 Min: -0.2 Max: +0.2 10242.5 

Visit the online support center at www.biopac.com 
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Calibration 
 can provide accurate “relative” measures without calibration. 

� For example, the voltage output of the EDA/GSR transducer (SS3LA) will change by 1 mV given 
a change of 10 micro Mhos across the electrode(s) ducer. 

lute” measurement, the voltage output of the transducer must be correlated exactly to a 
(such as air flow) and must adjust for temp umidity, and orientation 

(gravity effects)—all of which can vary greatly. Factors be sducer’s accuracy also influence 
surement, such as connections in the system or to the subject. While the MP35 is a very 

sensitive, DC stable acquisition unit, too many factors influence true “absolute” measurement to achieve 

Ca
Ca L of the following are true: 

easurements are required. 
sidered better than 5% acc  provide better 

than 5% accuracy without calibration. 
measurements are often acceptable. Meas ans can vary so 

on to person that in most c  of change is 

• For example, when measuring EDA with the SS3LA, the preset: “Electrodermal 
 (GSR) Change” is often u n is required. 

e transducer will be plugged into an Analog Inp
unication between the MP35 and tra ged into the “I/O 

the MP35 (such as the  blood pressure cuff) occurs 
serially; since A/D conversion is not used, atch the output of the 

cted device. 
rational bandwidth of the transducer extends 

are setting (see pag d data as AC 
d or DC Coupled signal values. 

o DC Coupling is appropriate for Te  GSR, Airflow, BNC, Switch, 
Pressure, Force, Hand dynamometer, Stimulator, Strain gauges, and similar data. 

o AC Coupling is appropriate for ECG, EEG, EMG, EOG, PPG, Respiration, and 
similar data. 

ere are a number of technical differences een these coupling settings, but the main 
et. Offsets are values that influence the location of transducer zero. Most 

distinctions between “absolute” and “relati
DC Coupled signals usually have a plitude that drifts 
during the course of the recording. asurements can be calibrated 
directly to account for the Offset. 
AC coupled signals are centered on zero, so Offset is not a factor. 

� Other hardware settings, such as Gain values hange significantly 
 AC and DC, but AC Coupled signals gher Gain settings, 

resulting in slightly higher resolution. 
� When an AC Coupled Preset is selected for a transducer, “relative” measurements are 

nd calibration is not required. 

BIOPAC transducers

connected to the trans
For accurate “abso
physical parameter erature, pressure, h

yond the tran
“absolute” mea

it without calibration. 
 

libration Guidelines 
libration is required if AL

1. Precise, absolute, m
� “Precise” is con urate; some transducers may

� “Relative” urements on hum
greatly from pers ases a “relative” measure
sufficient. 

Activity sed and no calibratio
2. Th ut channel. 

� Comm nsducers that can be plug
Port” on the back of  noninvasive

 readings will directly m
conne

3. The ope down to 0 Hz (DC). 
� The Input Coupling hardw e 97) enables you to recor

Couple
mperature,

� Th
issue is Offs

betw

ve” accuracy are related to Offset. 
o  non-zero Offset in am

 DC Coupled me

o 
or sensitivities, don't c

at hibetween  can use somewh

taken a
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Appendix E - Frequently Questions     
d it seems to take a long time t s there anything I 

ssible remedies for thi
 

1) ck the Draft mode for c  and Use all available 
ry boxes in the Display Preferences dialog (Fil  General). Checking these 

es will cause the BSL PRO software to plot da e precision) and 
uch available memory as possible. You can ca  holding down 

 Asked 
Q: I have a large data file an o redraw the screen. I

can do to speed it up? 
A: Yes. You can choose from four po s: 

ompressed wavesThe simplest solution is to che
memo e > Preferences >
two box ta faster (at the expense of som
use as m ncel the plotting at any time by
the ESC key. 

 
 

e interval per division, which caus yed on the screen at 
uce plot time. 

 
3) o much time to redraw and you ducing the number 

 
4) have a high-resolution video card (one capable of d usands of colors), you 

ay want to reduce the resolution to speed up plotting t
 
 

2) You can reduce the tim
e, and should red

es less data to be displa
one tim

If the data still takes to have a color monitor, try re
of colors displayed. 

If you 
m

isplaying many tho
ime. 
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Q: Can I use other software with the Biopac Student Lab Student 
 PRO software to control other data acquisition h

PRO hardware was design PRO 
an read in previously y the 

oftware. 
 

ts an RS-232/RS-422 signal. C  digital I/O line? 
A: tal output devices have their ow tocols and are more 

al pulses that the Biopac Student L n accept as inputs. 
 

ted a text file and the time scale is wrong. Wha
A:  the Biopac Student Lab P default) that the data 

or 100 samples per second. This s to adjust 
s involve calculating the interval betwee  calculate the sampling 

ta w  sampling interval is 
calculated by dividing one by the sample rate. You can e appropriate 

File > Open dialog box before the data is eady present, 
cale in the Display > Horizontal Axi

 colle ted as a text file, the 
terpret this as data collected at 100 sam the time scale to 
ct the data, change the sampling interva 1 to 0.5 seconds per sample. 

s read in, click the “Options” button in the File > Open> Text 
 the value in the Sampling Interval d the time scale after 

just the units per division in the Display > Horizontal axis dialog box. If the 
 adjust the seconds/s  interval at the bottom of the dialog box. 

This value defines the interval between sample points, and can be changed to fit the rate at which the 
y acquired. 

Q: and now my data file is huge. 
A: W is performed (e.g. digita ath), the entire 

r format (two bytes int format (eight 
ch sample point in the wave  times as much space, 

t  four times as large. The O software still saves 
, and since some of the information stored describes the time base, 

ill not increase by exactly a factor of four. 

 PRO hardware? Can I use Biopac 
Lab ardware? 

A: No. The Biopac Student Lab ed to work with the Biopac Student Lab 
software. However, the BSL PRO software c
Biopac Student Lab PRO or any other s

acquired text files generated b

Q: I have a device that outpu an I connect this to the
No. These types of digi
complex than the digit

n communication pro
ab PRO ca

Q: I impor t happened? 
When a text file is imported, RO software assumes (by 
was sampled at 100Hz  is arbitrary, and there are two way

n sample points. Tothis. Both method
interval, you need to know the rate at which the da as originally sampled. The

 adjust the sampling interval to th
value via the 
change the time s

 read in, or if the data is alr
s dialog box. 

 For instance, if 20 minutes of data was originally cted at 2Hz and impor
software will in ples per second. To set 
accurately refle l from 0.0

 To change this setting before data i
dialog box and change ialog box. To change 
data has been read in, ad
data are time-domain data, you can ample

data was originall
 

 I just filtered a waveform Why is that? 
hen any type of transformation 

form is converted from intege
l filtering, waveform m

le) to floating-powave
by

per samp
form nowtes per sample). Since ea

he file should be approxim
 takes up four

Biopac Student Lab PRately
he file as compactly as possiblet

the file size w
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Q y MP35/30 seems to be connected, but I can’t acquire 
veral conditions: 

k to make sure that the MP35/30 is ON and, if so, that all the connections to the MP35/30 
ade properly. When the MP35/30 is powere he front panel of the MP35/30 

nate. If the power light will not illumina  sure the proper power supply 
he power supply that comes with th  1 Amp, and 

plies may result in damage to the MP35/30. 
pply is connected but the powe t illuminate, disconnect 

nd check the fuse in the back of th  fuse is a standard 2.0 Amp 
 can be changed by unscrewing the fuse cap and replacing the fuse. 

er light does illuminate, the next step is to s tus light (next to the 
ht on the front panel of the MP35/30) illu n the MP35/30 is powered up. 
P35/30 is powered up, the “Busy” status l illuminate for three or four 

nd then extinguish. 
 
Q: ls but I only seem to be acquiring noise. What’s wrong? 
A: na can cause this: 

hat the settings in the Setup Channels dialog e MP35/30 menu) 
ect analog connections to the MP35/30.

2)  hat the Gain settings are too low  increased. 
 o access the Gain settings: pull down the MP35/30 menu, p Channels, click the 

View/Change Settings button to access the Parameters dialog, and use the Gain pull-down menu to 
ng. 

3) ant to select Autoscale waveforms from 
 ust the waveforms to provide the “best fit” in ter

w space. 

t is also possible that the electrodes/transducers themselv  of the noise. 
 de adhesion techniques involve abrading the skin and securing the electrode in place to 

283 for more infor noise. 

: M data. What should I do? 
A: This can be caused by one of se
 a)  Chec

were m d up, a light on t
will illumi te, check to make
is connected. T e MP35/30 is rated at 12 VDC @
using other power sup

 b)  If the proper power su r light still does no
the power supply a e MP35/30. The
fast blow fuse, and

 c)  If the pow ee if the “Busy” sta
“Power” lig minates whe
When the M ight should 
seconds a

 I set up the channe
A number of phenome

 
1) Check to make sure t box (under th

 correspond to the dir
 

Another possible cause is t
T

and should be
select Setu

select another setti
 

You may also w the Display menu. 
This will automatically adj ms of scaling the data to 
fit in the available windo

 
4)  I es are the source

Proper electro
reduce movement artifact. See page mation about electrode 
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Appendix F - Hints for Working w
t uncommon for large data files to be genera

ith Large Files 
It is no
com

ted (on t er of several megabytes) through some 
 acquisitions, a ulti-channel acquisitions. You 

may e limitations) and find such files difficult to work 
wi ry. 

 Lab PRO software stores the data in as co
ghly two bytes of storage space and calculation channel samples take up roughly eight 
ce. When a waveform (or a section of a ormed (i.e., filtered or 

ata point takes up roughly eight bytes. As  after 
re waves. 

Th help you get the most out of the Biopac Student Lab O when working with 
large data files. 

he ord
bination of (a) high-speed acquisitions, (b) long nd (c) m
 encounter system limitations (such as storage spac

th and slow in loading to memo
The Biopac Student mpact a format as possible. Each analog 
sample takes up rou

pabytes of storage s
integrated) each d

 waveform) is transf
 a result, file size can change drastically

transforming one or mo
an e following tips c PR

Use virtual 
memory W

Most computers are able to take advantage of the virtual memory feature. 
hile this is slower than conventio , it will at least make it possible 

e files that might otherwise be impossible to load. 
nal memory

to load som

Remove 
waveforms 

e each waveform adds to the total size of the file, try removing (or copying 
to another file) some of the wavefo l file. This is 
especially true if you would like to ns of some sort on at 
least one of the waves. 

Sample slowly

Sinc
rms from a multi-channe
perform transformatio

 eoretical and me
sampling rate. How
Th thodological concerns will, to a large extent, dictate 

ever, if you c  choose to do so. 
 may also want to resample een collected by using the 
nsform > Resample comma

D

an
data after it has b

 reduce the sampling rate,
You
Tra nd (page 210). 

isplay 
preferences 

Check the “Use all available memo ode for compressed 
waves” options under the File > Pr b-menu. This 

ould decrease the time it takes to low the software 
s all available memory for 

ry” and the “Draft m
eferences > General su

sh
to acces

 redraw waveforms and al
storage. 

Store to hard disk Although slightly slower than st AM), acquiring data 
 to Hard Disk allows you to recover data in the event of a power loss to 

the Biopac Student Lab PRO. Fu  much larger data files can typically 
be stored directly to Hard Disk than to PC Memory. 

 the Append 

oring to PC Memory (R
directly

rthermore,

Use
mode 

The Append mode allows you to p itrary periods. 
This can be helpful when recording only a few key events that will occur 
randomly over a long period of t  reduce unnecessary data. 

ause the acquisition for arb

ime, since it will

Stop plotting and 
change the scale 

If the screen is taking a long tim e data files are large), 
you can stop plotting and decrease e before redrawing. 
To stop plotting, use the ESC key.

e to redraw (because th
the horizontal scale valu
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Appendix G — Filter Characteristics 
Filter types 

tware employs two types 
sponse (FIR) perform all post-acquisition filtering 

2 nfinite Impulse Response (IIR) perform online calculations (filtering performed during an 

Although the similarities between the two types of filters outweigh the differences, so

pically more efficient (faster) than F

The Biopac Student Lab PRO sof of digital filters:  
1)  Finite Impulse Re

)  I
acquisition) 

me important 
distinctions remain. 

IIR filters are ty IR filters. 
This means that IIR filters can filter data faster than are used 

 accurate than FIR filters.

 FIR filters, which is why IIR filters 
for online calculations. 

 
IIR fillers tend to be less  

lly, IIR filters tend to cause phase distortion or “ringing.”  When the phase of a 
d, some data points on a wave r forward or backward in 

time) more than others. This can result in the intervals between events (such as the Q-R interval 
t interval in an ECG waveform) being slightly lengthened or shortened compared 

nal signal. In practice, however, the effect of this distortion is usually minimal since 
 are most distorted are also attenuated the most. 

ast, FIR filters are phase linear, which mea tween any two sample 
points in the filtered waveform will be exactly equal to the distance between the corresponding 

nts in the original waveform. 
 

ave a variable Q setting

Specifica
waveform is distorte form are shifted (eithe

or the inter-bea
to the origi
the frequencies which
By contr ns that the interval be

sample poi

IIR filters h  
ng defines the filter response pattern, but F do not have a Q component. The 
f an IIR filter is 0.707, with lower values nse and higher 

lting in a more peaked response. The default Q for all IIR filters is 0.707 (except for 
Band pass filters where Q defaults to 1), which is app ter applications. 

he examples on the following page, the filter re fferent types of filters are 
filters are 50Hz low pass filte e same data. 

 
IIR filters are also used for real-time filtering in the MP35 and MP30 hardware. The following processing 
rates correspond to the sampling rate: 

es 
/Sec) 

Possible 
with MP35 

 

Possible with
MP30 

 Filter Proc. Rate 
ple/Sec)  

MP30 

(Sample/Sec) 

The Q setti IR filters 
optimal Q o resulting in a flatter respo
values resu

ropriate for nearly all fil
In t sponses of several di
compared. All of the rs operating on th

MP35 
DSP I.I.Sample Rat R. DSP I.I.R. 

Filter Proc. Rate (samples
(Sam

1 YES YES 2,000 20,000 

2 YES YES 2,000 20,000 

2.5 NO YES N/A 2,000 

5 YES YES 20,000 2,000 

10 YES YES 20,000 2,000 

20 YES YES 20,000 2,000 

25 NO YES N/A 2,000 

50 YES YES 20,000 2,000 
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100 YES YES 20,000 2,000 

200 YES YES 20,000 2,000 

250 NO YES N/A 2,000 

500 YES YES 20,000 2,000 

1,000 YES YES 20,000 2,000 

2,000 YES YES 20,000 2,000 

5,000 YES YES 20,000 N/A 

10,000 YES YES 20,000 N/A 

20,000 YES NO 20,000 N/A 

25,000 YES YES 25,000 N/A 

40,000 NO YES N/A N/A 

50,000 YES NO 50,000 N/A 

100,000 YES YES 100,000 N/A 

 
Frequency Cutoff 
When setting up any IIR filter, a good rule of thumb is to limit the HIGHEST frequency cuttoff in the 
filter to be some value less than or equal to the sample rate of the acquisition or data divided by four. 
� For a sampling rate of 200Hz, the cuttoff for a lowpass filter should be no greater than (200/4) or 

50Hz. Alternatively, for a lowpass filter of 30 Hz, the acquisition (sample) rate should be no less 
than (30*4) or 120Hz. 

� For a high pass filter of 250Hz, the acquisition (sample) rate should be no less than (250*4) or 
1000Hz. 

� For a band pass filter of 100Hz to 500Hz, the acquisition (sample) rate should be no less than 
(500*4) or 1,000Hz. 

� For a single frequency band pass (or notch) filter of 60Hz, the acquisition (sample) rate should be 
no less than (60*4) or 240Hz. 

If this rule of thumb is not followed, it becomes increasingly more likely that the data from the output of 
the IIR filter will be meaningless. If the acquisition (sample) rate drops below two times the highest 
cuttoff frequency associated with the filter, the data will be completely corrupted. The zone for 
acquisition rate being between two and four times the highest cuttoff frequency associated with the IIR 
filter is somewhat functional, but the filter break-points will begin to deviate from the expected break-
point. The deviation will result in effectively REDUCED upper frequency cuttoff for the IIR filter, the 
extent of the reduction being more pronounced as the acquisition rate approaches two times the highest 
cuttoff frequency for the IIR filter. 
When an IIR filter is established as a calculation channel, the specified minimum frequency (Freqmin) 
determines the minimum effective Sample Rate (SRmin) as follows: 

SRmin = 4 * Freqmin 
where SRmin is the frequency specified for Low Pass, High Pass, Band Pass and Band 
Stop and is the lower of the two frequencies for Band Pass (low + high) filter 

If the sample rate is lower than this, there is no guarantee as to what will happen to the data because the 
filter can become unstable and huge numbers can be generated. 
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The first graph shows how the number of filter coefficients in FIR filters (Q) affects the filter’s frequency 
response. 
Note that as the number of coefficients (Q) increases, the filter becomes more accurate. 

 
FIR filter performance as a function of number of coefficients (Q) 

The second graph shows how the pole or zero locations of the filter, as related to filter “peaking” 
(specified by Q), affect the frequency response of the filter. The “Q” in this case is not to be confused 
with the Q from the FIR filter. 
Note how increasing “Q” in the IIR filter case affects filter “peaking.” 

 
FIR filter performance as a function of changes in pole or zero locations 

Coincidentally, the FIR (Q = 10) and IIR (Q = 0.707) filters have very similar responses in this case. 
Technically, the coefficient setting for FIR filters determines the number of multiplies performed by the 
filtering algorithm. In practical terms, it determines how “steep” the frequency response of the filter is. 
Filters with a large number of coefficients have a steep roll-off, whereas the frequency response of filters 
with a smaller number of coefficients is not as steep. 
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Window Functions (Filter Characteristics) 

 
A “window” refers to a computation that spans a fixed number of adjacent data points. Typically, window 
functions are used to eliminate discontinuities that may result at the edges of the fixed span of points of 
the digital filter function (FIR filters) or the data points of the FFT. 
 

The following formula, where n = 
0

N 1n−  and A, B, C and D are constants that define the “shape” of the 

window, is used to describe all windows except the Bartlett window: 

N
n32Dcos

N
n22Ccos

N
n2BcosA πππ

−+−  

 
The table below illustrates the different parameter values for most Window types: 

Window Parameter Values 
Type A B C D 

Blackman 0.42323 0.49755 0.07922 0.00000 
Blackman -61 0.44959 0.49364 0.05677 0.00000 
Blackman -67 0.42323 0.49755 0.07922 0.00000 
Blackman -74 0.40217 0.49703 0.09392 0.00183 
Blackman -92 0.35875 0.48829 0.14128 0.01168 
Hamming 0.54000 0.46000 0.00000 0.00000 
Hanning 0.50000 0.50000 0.00000 0.00000 
Kaiser-Bessel 0.40243 0.49804 0.09831 0.00122 
Rectangle 0.00000 0.00000 0.00000 0.00000 

 
Window functions are used for three purposes in the Biopac Student Lab PRO software: 
 

a) Window functions are applied to the impulse response in the FIR digital filtering functions. 
 
b) Window functions are applied as part of the FFT function. 
 
c) Window functions are applied as part of the Derivative transformation. 
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Digital filtering 
When a window is used in digital filtering, the impulse response of the filter (rather than the data 
itself) is modified. When the impulse response smoothly approaches zero at both the beginning and 
end of the data, this works relatively well. 
When the impulse response is not so well behaved, edge effects occur. To minimize edge effects: 
—  Window, or force the edges of the impulse response to smoothly approach zero. The exact 

process depends on the Window selected (see previous page). 
—  Increase the number of coefficients for the FIR filter used to transform the data. 

 
FFT 

The FFT function also windows data, although the nature of the windowing function is somewhat 
different in the sense that the window operates on the data. One of the assumptions of the FFT is that 
the input data is an infinitely repeating signal with the endpoint wrapping around. In practice, the 
endpoints are almost never exactly equal. You can check this by choosing the Delta measurement 
item from the measurement pop-up menus, which returns the amplitude difference between the first 
selected point and the last. To the extent that the endpoints differ, the FFT output will produce high 
frequency components as an artifact of the transformation. 
By windowing the data, the effects of this phenomenon are greatly diminished. When data are 
windowed, a window is moved across the data, much as the smoothing function moves across the 
data. Whereas the smoothing function simply takes the average of a specified number of points, each 
type of window weights the data somewhat differently. 
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Appendix H — About Electrodes 
The purpose of an electrode is to act as a “connector” between the Subject’s skin (where electrical signals 
are easiest to detect) and the MP35/30 acquisition unit (via the SS2L lead cable). If an electrode makes 
good contact with the skin, the signals that are generated will be relatively accurate. 
Although they sound complex, electrodes are very simple devices that consist of a small piece of metal 
designed to make indirect contact with the skin and a larger adhesive plastic disk. Each electrode is about 
1 inch (2.5 cm) in diameter, and is sticky on one side so it will adhere to your skin. The electrode lead 
(cable with connector end) is the interface between the electrode and the MP35/30 acquisition unit. 

 
Electrode lead connector and electrode 

If you look closely at the electrode, you can see that there is a small piece of plastic mesh filled with a 
bluish gel. Since gel conducts electricity (better than your skin, in fact) and is more flexible than the metal 
part of the electrode, your skin can flex and change shape somewhat without losing the electrical 
connection with the metal part of the electrode. 
BIOPAC disposable electrodes are standard disposable electrodes and are widely used in clinical, 
research, and teaching applications. These electrodes come in strips of ten, and you should not remove an 
electrode from the backing until you are ready to use it. 
The following directions will help you get good data from the electrodes by explaining how electrodes 
work and how to attach the electrodes and electrode leads to obtain the best signal. 

Electrode placement 
There are two basic methods of electrode placement: monopolar and bipolar. 
¾ In a monopolar recording, an active electrode is placed over the region of interest and a “reference” 

electrode is attached to a more distant part of the body. 
¾ In a bipolar recording, the voltage difference between two electrodes, placed over the regions of 

interest, is measured with respect to the third “reference” electrode. Leads I, II, and III are standard 
bipolar electrode configurations, and are explained in more detail when used in a Lesson. 

Preparing the Electrode Site 

One way you can improve electrode connections is to gently rub 
the area where the electrode is to be placed. This is known as 
abrading the skin, and removes a thin layer of dead skin from the 
surface of the skin. Since dead skin doesn’t conduct electricity 
very well, removing it improves the connection between the 
electrode and the skin. You can use an ELPAD electrode pad 
(included with the Biopac Student Lab) to abrade the selected 
surface. 
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Visit the online support center at www.biopac.com 

Attaching electrodes 
To attach an electrode, peel the electrode from its backing and place it 
on the area indicated in the lesson. Once in place, press down firmly 
on the electrode with two fingers and rock the electrode back and forth 
for a few seconds. This will ensure that it is adhering to the skin as 
much as possible. 
¾ To help insure that the electrode will make good electrical contact 

with the skin, you may want to squeeze a drop or two of electrode 
gel onto either the surface of the skin or onto the electrode 
(without allowing any to get on the adhesive). 

Connecting the Electrode Lead 
Each electrode lead cable is a different color and each pinch connector on 
the end of the cable needs to be attached to a specific electrode. Note that 
the connector is polarized and needs to be clipped on such that the metal 
extensions inside the clip are on the down side to make surface contact 
with the electrode. The pinch connectors work like a small clothespin, 
but will only latch onto the nipple of the electrode from one side of the 
connector. You should follow the figure provided in the lesson to ensure 
that you connect each lead cable to the proper electrode. 

Reducing Electrode “Noise” 
If an electrode does not adhere well to the skin, the signal plotted on the screen may appear “fuzzy.” This 
is referred to as “noise,” and although it always exists to some degree, it is best to reduce noise as much 
as possible. Electrodes have no moving parts, so there is nothing you have to do to get an electrode to 
“work” but there are several things you can do to reduce noise when electrodes are connected: 
*  Place the electrodes where there is the least amount of hair and/or choose the subject with the least 

amount of hair. A common problem is that something on the surface of the skin is interfering with the 
electrode contact. If there is too much hair (for instance) between the outer layer of skin and the 
electrode, the electrical activity taking place below the surface of the skin may not be detected. 

*  Make sure that everything is connected properly. 
*  Attach the electrodes a few minutes before you are going to use them. The best results are achieved 

by putting the electrodes in place about five minutes before you begin recording data. This gives the 
electrodes time to establish contact with the surface of the skin. 

*  Position the electrode lead cables such that they are not pulling on the electrodes. Connect the 
electrode cable clip (where the cable meets the three individual colored wires) to a convenient 
location (can be on the Subject’s clothes). This will relieve cable strain. 

*  The Subject should not be in contact with nearby metal objects (faucets, pipes, etc.), and should 
remove any wrist or ankle bracelets. 

Removing Electrodes 
Once you have completed a lesson, disconnect the electrode cable pinch connectors, peel the electrode off 
the skin, and dispose of the electrode (BIOPAC electrodes are not reusable). Wash the electrode gel 
residue from the skin, using soap and water. The electrodes may leave a slight ring on the skin for a few 
hours. This is normal, and does not indicate that anything is wrong. 

Electrode Check  
The front panel of the MP35/30 unit includes an Electrode Check port. Use this diagnostic tool with the 
BSL PRO software to determine if the electrodes are properly attached to the subject (see page 143).
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Information in this document is subject to change without notice and 

does not represent a commitment on the part of BIOPAC Systems, Inc. 

Copyright 
This manual and the software described in it are copyrighted with all rights reserved. Under the copyright 
laws, this manual or the software may not be copied, in whole or part, without written consent of BIOPAC 
Systems, Inc., except in the normal use of the software or to make a backup copy. 
The same proprietary and copyright notices must be affixed to any permitted copies as were affixed to the 
original. This exception does not allow copies to be made for others, whether or not sold, but all of the 
material purchased (with all backup copies) may be sold, given, or loaned to another person. Under the 
law, copying includes translating into another language or format. This software is intended for use on 
only one machine at a time. 

Warranty 
BIOPAC Systems, Inc. warrants its hardware products against defects in materials and workmanship for a 
period of 12 months from the date of purchase. If BIOPAC Systems, Inc. receives notice of such defects 
during the warranty period, BIOPAC Systems, Inc. will at its option, either repair or replace the hardware 
products that prove to be defective. This warranty applies only if your BIOPAC Systems, Inc. product fails 
to function properly under normal use and within the manufacturer’s specifications. This warranty does 
not apply if, in the sole opinion of BIOPAC Systems, Inc., your BIOPAC Systems, Inc. product has been 
damaged by accident, misuse, neglect, improper packing, shipping, modification or servicing, by other 
than BIOPAC Systems, Inc. 
Any returns should be supported by a Return Mail Authorization (RMA) number issued by BIOPAC 
Systems, Inc. BIOPAC Systems, Inc. reserves the right to refuse to accept delivery of any shipment 
containing any shipping carton which does not have the RMA number(s) displayed on the outside. The 
Buyer shall prepay transportation charges to the BIOPAC Systems, Inc. designated site. 
BIOPAC Systems, Inc. makes no warranty or representation, either expressed or implied, with respect to 
this software, its quality, performance, merchantability, or fitness for a particular purpose. As a result, this 
software is sold “As is”, and you, the purchaser, are assuming the entire risk as to its quality and 
performance. 
In no event will BIOPAC Systems, Inc. be liable for direct, indirect, special, incidental, or consequential 
damages resulting from any defect in the software or its documentation, even if advised of the possibility 
of such damages, or for damage of any equipment connected to a BIOPAC Systems, Inc. product. 

Trademarks 
Biopac Student Lab PRO and MP35/30 are trademarks of BIOPAC Systems, Inc. 
Windows is a trademark of Microsoft Corporation. 
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Index 
 

A 
A/D boards (third party), 279 
About Biopac Student Lab PRO, 245 
Absolute value 

ABS Expression function, 117, 214 
Abs Math transformation, 200 

AC coupled, 97, 277 
Accelerator Keys, 36 
acquire box, 75 
Acquire, Setup Channels option, 51 
Acquisition Length, Setup Acquisition option, 53, 90 
Acquisition setup, 52, 70 
Acquistion setup, 73 
Active channel, 55 
Airflow/Volume example, 105 
Algorithms, template, 205 
Alpha waves, 221 
Amplitude scale, 79 
Analog channels, 74 

Gain setting, 96 
Hardware filters, 98 
Input coupling, 97 
Offset, 96 

Analog signals, 49 
Append, Setup Acquisition option, 84 
Application Notes, 22 
arbitrary curve fitting, 165 
Arc cosine, ACOS Expression function, 117, 214 
Arc sine, ASIN Expression function, 117, 214 
Arc tangent 

Arc Tan Math transformation, 200 
ATAN Expression function, 117, 214 

Area 
Find Rate function, 108 

Area (measurement), 154 
Auto threshold detect, 233 
Auto Threshold Detect 

Rate calculation option, 107 
AutoPlotting, 146 
Autorange, histogram option, 211 
Autosave file 

Setup Acquisition option, 83 
when Repeat is selected, 91 

Autoscale 

Autoscale after transformations, 184 
Autoscale Horizontal, 38, 40, 45, 239 
Autoscale Vertical, 45 
Autoscale Waveform, 45 

Autoscale final frame, 47 
Average 

Average over samples, Integrate option, 100, 101 
Moving average, 208 
Off-line averaging, 224 

B 
Band Pass filter, 115 
Band Stop filter, 115 
Base Point (Scale dialog option for Grid display), 170 
Baseline adjustment, 96 
Baseline drift, 235 
Blood pressure analysis. See Rate calculations 
BloodPressure.acq sample file, 248 
BPM 

Rate function, 108 
Rate Function Guidelines, 110 

BPM (measurement), 155 
BSL Hardware Guide, 12 
BSL PRO 

Features, 15 
Overview, 28 

BSL PRO launch error, 29 
BSL vs BSL PRO, 63 

C 
Cal 1 and Cal 2 scaling buttons, 79 
Calculate (measurement), 155 
Calculation channels, 72–73 
Calibration, 94 
Calibration Guidelines, 277 
Can’t Undo, 187 
CE Marking, 269 
Center Horizontal/Vertical, 45 
CH# Output Control, 121 
Change font, Journal Preference, 185 
Channel boxes, 55 
Channel setup, 51, 73 
Chart mode, 43 
CISPR Class 11, 270 
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Clear, 189 
Clear All, 189 
Clipboard, 153, 190–91 
Close (File command), 178 
Coefficients (FIR filters), 197, 284 
Colorimeter data, 80 
Column delimiter, 175 
Compare Waveforms, 45 
Compliance, 269 
Compressed waveform plots, 85, 183 
Connect endpoints (Math Transformation), 200 
Constant (K) 

Calculate measurement option, 155 
Math calculation option, 112 
Waveform Math, 216 

Control channel, Integrate, 102 
Convolution (Template function), 205 
Copy 

Copy Graph, Clipboard, 191 
Copy Measurement, Clipboard, 190 
Copy Wave Data, Clipboard, 190 
Edit command, 188 

Correlate (measurement), 156 
Correlation 

Template function, 205 
Cosine, COS Expression function, 117, 214 
Count peaks, 108 
Creating new lessons, 63 
Cursor Style, 244 
Customizing menu display, 64 
Cut, 188 
Cutoff frequency, 197, 207 

D 
Data compression, 212 
Data recording, 49 
DC coupled, 97, 277 
Delay 

Calculation channel Preset, 118 
Delimiter, column, 175, 190 
Delta (measurement), 157 
Delta F(measurement), 157 
Delta S (measurement), 157 
Delta T (measurement), 157 
Delta X (measurement), 157 
Derivative, 207 
Difference 

on-line calculation, 106 
transformation function, 210 

Digital Filters, 196–97, 286 
FIR filters, 196 

IIR filters, 198 
Digital Outputs Control, 122 
Disk space, 53, 84, 85, 178, 212 
Display menu commands, 236 
Display Preferences, 183 
Don’t Find 

Find Rate option, 235 
Dot plot, 242 

Dot size, 242 
Draft mode, 183 
Duplicate Waveform, 189 
Duration, acquisition, 90 

E 
ECG data analysis, 229 
Edge 

Edge effect (windowing), 286 
Edge options (Pos/Neg), 141 

Edit 
Edit menu commands, 187 
Markers, 166 

EEG.acq sample file, 249 
Electrode Checker, 145 
EMGwForce.acq sample file, 249 
Enable Value Display, 51, 75 
Envelope, 101 
Event marker. See Markers 
ex power of a data point 

EXP Expression function, 117, 214 
Exp Math transformation, 201 

Exporting data, 61, 175 
Expression 

on-line calculation, 116 
transformation, 213 

F 
FAQ, 278 
FFT Fast Fourier transformation, 218–21, 286 
File menu commands, 173 
File size, 279, 281 
File… button, Setup Acquisition, 83 
Filter 

Digital filters, 94 
Filter characteristics, 282 
Hardware filters, 98 
on-line calculation, 114 
Show filter response, 197 

Filters, 115 
Find 

Find All Peaks, 225 
Find Next Peak, 225 
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Find Peak (Peak Detector) function, 222 
Find Rate, 233–35 

FingerTwitch1.acq sample file, 250 
FingerTwitch2.acq sample file, 250 
FIR Finite Impulse Response filters, 196, 282 
Font 

Change font, Journal Preference, 185 
Formula 

Area, 154 
BPM, 155 
Convolution (Transform>Template), 205 
Correlation, 156 
Correlation (Transform>Template), 205 
Delta, 157 
Delta T/F/X, 157 
Freq (Frequency), 158 
Hysteresis, Rate trans., 111 
IIR Filters, 196 
Integral, 159 
Lin_reg (Linear regression), 160 
Mean, 161 
Mean square error (Transform>Template), 205 
Mean value smoothing (Transformation), 208 
Median value smoothing (Transformation), 208 
Noise rejection, Rate trans., 111 
Remove baseline, Rate trans., 111 
Slope, 162 
Stddev (Standard deviation), 163 
Threshold, Auto threshold detect, Pos/Neg, 111 
Window functions, 285 

Frequency 
Cutoff frequency, 197, 207 
Filter calculation option (Freq), 114 
frequency spectrum, 221 
measurement (Freq), 158 

Frequency cuttoff, 283 
Frequently asked questions, 278 
Function 

Calculation Preset, 113 
Expression option, 117, 214 
Rate calculation option, 107 
Rate Function menu, 108 

G 
Gain setting, 96 

Range guide (vertical scale), 42 
Getting Started, 28 
Graph Template file sample, 251 
Graph window, 31 
Grids 

Clinical grid settings, 171 
Display > Show, 168 
Grid Options, 168 

H 
Hard Disk, acquisition option, 53, 84 
Hardware filters, 98 
Hardware Guide, 12 
Header, include with text file, 179 
HeartTemplate.gtl sample file, 251 
Help menu, 245 
Help options, 13 
Hemodynamic data analysis, 227 
High Pass filter, 115 
High Speed mode, 85 
Histogram, 211 
Hold relative position 

Horizontal Scale, 40 
Horizontal axis, 20 
Horizontal Axis, 241 
Horizontal scale, 38, 40 
Hot Keys, 36 
Human Subjects, Safety, 139 
Hyperbolic cosine COSH Expression, 117, 214 
Hyperbolic sine SINH Expression, 117, 214 
Hyperbolic tangent TANH Expression, 117, 214 
Hysteresis, 111 

I 
IBI, 108 
IBI inter-beat-interval, 110 
IEC60601, 269 
IIR Infinite Impulse Response filters, 196, 198, 282 
Include 

channel number, 185 
header (with text file), 179 
measurement units, 185 
time values, 186 

INF (measurement value), 153 
Input coupling, 97 
Insert 

Insert Waveform, 189 
Markers, 59, 166 

Installation Guide, 12 
Integral (measurement), 159 
Integrate 

Calculation Preset, 100 
formulas, 103 
transformation, 207 

Inter-beat interval. See IBI 
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Interpolate pastings, 184 
Interval 

Difference option, 106 
Interval, Rate function, 108 
Inverse mean square error (Template function), 205 

J 
Journal, 60, 192 

Journal Preferences, 61, 185 

K 
K (Constant) 

Calculate measurement option, 155 
Math calculation option, 112 
Waveform Math, 216 

Keyboard shortcuts, 36 

L 
Large files, working with, 281 
Last dot only plot, 242 
Launch BSL PRO, 29 
Launch error, BSL PRO or BSL (Lessons), 29 
Lessons, creating your own, 63 
Limit (Math transformation), 201 
Lin_reg (linear regression measurement), 160 
Line plot, 242 
Linear (FFT option), 219 
Logarithm 

base 10 
Log Math transformation, 201 
LOG10 Expression function, 117, 214 

natural 
Ln Math transformation, 201 
LOG Expression function, 117, 214 

Low Pass filter, 115 

M 
Markers, 59, 166 

Marker Preferences, 186 
Printing markers, 167 
Time Stamp, 132 

Math 
Calculation Preset, 112 
Math Functions (Transform), 199 
Waveform Math transformation, 216 

Max (measurement), 161 
Max cycle period, Integrate, 102 
Max T (measurement), 161 
Mean (measurement), 161 
Mean removal, 204 

Mean square error (Template function), 205 
Mean subtraction, Integrate, 102 
Mean value 

Smoothing option, 106 
Mean value smoothing, 208 
Measurement, 57–58 

copy/export measurements, 153 
Table of Explanations, 154 

measurement result, 153 
****, 153 
INF, 153 

Median (measurement), 161 
Median T (measurement), 161 
Median value 

Smoothing option, 106 
Median value smoothing, 208 
Medical equipment, classification, 269 
Menu display, customizing, 64 
Menu structure, 34 
Min (measurement), 161 
Min T (measurement), 162 
Modeling 

Nonlinear 
NLM measurement, 165 

Moving average, 208 
MP30 

MP30 Specifications, 269 
MP35 

Back Panel, 271 
Front Panel, 270 
Menu, 70 
MP35 Specifications, 269 

MP35/30 
Hardware not found, 29 

N 
Negative edge, 141 
NerveConduction.acq sample file, 252 
New (File command), 173 
New Channel Preset button, 76 
Noise 

Math transformation, 201 
Noise rejection, 234 
resolving acquired, 280 

Noise rejection 
Rate calculation option, 107 

None (measurement option), 162 
Nonlinear modeling 

NLM measurement, 165 
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O 
Off-line Averaging, Find peak option, 224 
Offset, 97, 277 
Offset Range, 96 
On-line filtering, 114 
Open (File command), 174 
Option, Save As ACQ button, 179 
Options, Save As Text button, 179 
Organize Channel Presets, 147 
Organize List, Preferences, 129 
Output Control, 119 

CH# to Output, 121 
Digital Outputs, 122 
Preferences, 120 
Pulses, 124 
Stimulator - SS58L, 124 
Stimulator—BSLSTM, 124 
Voltage, 123 

Output, Filter calculation parameter, 114 
Overlap Segments button, 84 
Overlap Segments mode, 44 
Overwrite existing data prompt, 146 

P 
Pad with endpoint/zeros, 218 
Parameters, Integrate, 101 
Paste 

Edit command, 188 
Paste Measurement, Journal, 192 
Paste Wave Data, Journal, 192 

PC Memory, acquisition option, 84 
PDF support documents, 245 
Peak 

Count Peaks, 108 
Peak detect Pos/Neg (Find Rate option), 233 
Peak time, Find Rate function, 109 
Peak to peak, Find Rate function, 109 

Peak Detect 
Rate calculation option, 107 

Peak-to-Peak (P-P measurement), 162 
Phase, 219 
Phase distortion, IIR filter, 282 
Playback mode, 46 
Plot 

AutoPlotting option, 146 
Dot plot, 242 
Last dot only, 242 
Line plot, 242 
Plot on Screen, Setup Channels option, 51 
Plot Standard Curve, 80 

Plots per page, printing option, 181 
Staircase plot, 108 
Step plot, 243 
Time series plots, 179 

Positive edge, 141 
Power supply, 280 
P-P (peak-to-peak measurement), 162 
Precision 

Horizontal Scale, 40 
Vertical scale, 41 

Preferences 
General (display), 183 
Journal, 185 
Markers, 186 
Output Control, 120 

Presets, 92 
Analog, 93 
Calculation, 99 

Delay, 118 
Difference, 106 
Expression, 116 
Filter, 114 
Function, 113 
Integrate, 100 
Math, 112 
Rate, 107 
Smoothing, 106 

New Channel Preset button, 76 
Organize Channel Presets, 147 

Print, 181 
Fit to pages option, 181 
Markers, 167 
Plots per page option, 181 
print entire file, 62 
Printer Setup, 182 

PRO Lessons, 23, 245, 289 
Pulses Output Control, 124 

Q 
Q coefficient (IIR filters), 114, 282 
Questions, frequently asked, 278 
QuickTime movie of BSL PRO, 47 
Quit BSL PRO application, 186 

R 
RAM, acquisition storage, 53 
Range guide (vertical scale), 42 
Rate 

BPM, Hz (Find Rate functions), 109 
Calculation Preset, 107 
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Find Rate transformation, 233–35 
Read Text Options dialog, 175 
Record 

Record last, Setup Acquisition option, 83 
Record, Setup Acquisition option, 83 
Start acquisition, 54 

Recording data, 49 
Rectify, Integrate, 101 
Refresh Graph, 244 
Remove 

Remove mean, 204, 219 
Remove trend, 220 
Remove Waveform, 189 

Remove baseline 
Rate calculation option, 107 

Remove baseline, Integrate, 101 
Repeat, setup acquisition option, 91 
Replay, 46 
Resample, 212 
Reset 

Append acquisition button, 84 
Reset Chart Boundaries (Size Window option), 244 
Reset Chart Display option, 239 
Reset Thresholds, Integrate, 102 
Reset trigger, Integrate, 102 
Reset via channel, Integrate option, 100, 102 

Resize Window, 244 
Right mouse button shortcuts, 37 
Ringing, IIR filter, 282 
Root mean square, Integrate, 101 
ROUND Expression function, 117, 214 
RS-232/RS-422 signal, 279 

S 
Safety, 269 
Safety Note, 12 
Sample (measurement), 162 
Sample data files, 247 
Sample Rate, 53, 85–89 
Samples, Integrate, 101 
Save 

Save (File command), 178 
Save As (File command), 178 
Save once, Setup Acquisition option, 83 

Save Settings, Preferences, 126, 129 
Scaling, 78 

Analog channels, 79 
Calculation channels, 80 

Scope mode, 43 
Scroll 

scroll bars, 38 

Scrolling, MP35/30 menu item, 146 
Section 508 Compliance, 36 
Select 

area, 56 
channel, 55 
Select All (Edit command), 189 
waveform, 55 

Set Template, 203 
Set up Triggering, 141 
Set Wave Positions, 239 
Setup Acquisition, 52 
Setup channels, 73 
Setup Channels, 51 
Shortcuts 

keyboard, 36 
mouse, 37 

Show 
Show Input Values, 75, 143 
Show modified input, 220 

Sine 
SIN Expression function, 117, 214 
Sin Math transformation, 202 

Size Window, 244 
Slope (measurement), 162 
Smoothing 

Calculation Preset, 106 
mean value smoothing, 208 
median value smoothing, 208 
transformation function, 208 

Spectral analysis. See FFT 
Spectrophotometer data, 80, 252 
Square root 

SQRT Expression function, 117, 214 
Sqrt Math transformation, 202 

Square SQR Expression, 117, 214 
Staircase plot, 108 
Standard Curve, 80 

Plot Standard Curve, 80 
Standard Curve Settings, 82 

Standard deviation (Stddev measurement), 163 
StandardCurve.acq sample file, 252 
StandardCurveData.acq sample file, 253 
Starting an acquisition, 54 
Startup file 

Customizing for BSL PRO, 68 
Startup Script, modifying, 64 
Statistics (Display command), 244 
Status indicator, software, 54 
Stddev (standard deviation measurement), 163 
Step plot, 243 
Stimulator 

Stimulator Reference Channel, 139 
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Stimulator - BSLSTM, 124 
Stimulator – SS58L, 124 
Stopping an acquisition, 54 
Summary to Journal, marker menu, 166 
Symbols, MP35 unit, 269 

T 
Tabs, Journal, 185 
Tangent TAN Expression, 117, 214 
Template Functions, 203 
Text files, 61, 174–76, 179 
Threshold 

Auto Threshold detect, Rate option, 107 
Threshold (Math transformation), 202 
Threshold-crossing algorithm, 234 
Tile Waveforms, 45 

Tile after transformations, 184 
Time 

Expression Source, 117 
measurement, 163 
Time offset (Peak option), 230 
Time scale, 279 
Time series plots, 179 

Transform menu, 194 
Derivative, 207 
Difference, 210 
Digital Filters, 196 

FIR filters, 196 
IIR filters, 198 

Expression, 213 
FFT, 218 
Find Peak (Peak Detector), 222 
Find Rate, 233 
Histogram, 211 
Integrate, 207 
Math Functions, 199 
Smoothing, 208 
Template Functions, 203 
Waveform Math, 216 

Trigger, 141 
Troubleshooting, 247–78 
Truncate TRUNC Expression, 117, 214 
TTL signal, trigger, 141 

U 
Undo, 187 
Update screen interval, 184 
Use all available memory, 184 
User-defined interval (Find peak option), 222 

V 
ValidateMeasurements.acq sample file, 253 
Value (measurement), 163 
Vertical axis, 20, 79 
Video capture, create QuickTime movie, 47 
Virtual memory, 281 
Voltage Output Control, 123 

W 
Warn on Overwrite, 146 
Wave Color, 240 
Waveform Arithmetic, 155 
Waveform Math, 216–17 
Waveform Statistics dialog, 244 
Waveform, selecting, 55 
Window 

FFT option, 220 
Find Rate limits, 234 
FIR Filter option, 196 
menu, 245 
Rate calculation option, 107 
Window functions/filter characteristics, 285 
Windowing Units, 107, 234 

Windows Metafile, 191 
WMF files, 61, 180 

X 
X-axis T/F/X (measurement), 164 
X-Y mode, 44 
X-Y Mode 

Plot Standard Curve, 80 

Z 
Zoom Back / Forward, 239 
Zoom tool, 56 
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